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C H A P T E R  1

INTRODUCTION

The Blackbaud FundWare™ Payroll/Personnel module gives you the ability to manage 
and report on your organization’s payroll easily and effectively. With Payroll/Personnel, 
you can:

• Maintain employee master records and history.
• Distribute expenses to multiple departments and/or General Ledger accounts.
• Define custom data items, including taxes, deductions, and employer costs.
• Allow multiple payroll accrual accounts and cash accounts.
• Create timesheets for a group of employees in a single step.
• Enter one or more timesheets for your employees in a single form.
• Process checks (e.g., produce checks, void checks, enter manual checks).
• Create direct deposit files.
• Post financial data to General Ledger, Project/Grant, and Accounts Payable.
• Process your W-2s (e.g., extract information, print W-2s, create electronic file).
• Update your earnings, taxes, deductions, and employer costs using the ToolBox.

THE PAYROLL PROCESS
The following steps represent a typical pay period. Procedures vary for each 
organization; you may not perform all of these steps or you may perform more.

1.  Create employee timesheets.

2. Verify (and correct if necessary) timesheets.

3. Post timesheets.

4. Enter one-time deductions.
Blackbaud, Inc. 1.1
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5. Calculate net pay.

6. Produce and review a Preliminary Check Register.

7. Produce checks and direct deposit payments.

8. Log printed check numbers and direct deposit payments.

9. Reconcile checks and direct deposit payments.

DEPARTMENTALIZATION, COSTCODES, AND DISTRIBUTION TABLES
The most-critical Payroll decision will determine how the system uses your settings and 
entries to resolve (or “build”) the account number to which you post your Payroll costs:

• Are you departmentalized, or 
• Are you not departmentalized?

This setting is defined on your Payroll Parameter and can be different for salaried, 
hourly, or “other” employees (Figure 1.1). (See Defining the Payroll Parameter on page 
1.34 for more information on the parameter.) 

Figure 1.1—Departmentalized Salary and Non-Departmentalized Hourly

Once this has been determined, you can decide if you are using costcodes or distribution 
tables:
Departmentalization, Costcodes, and Distribution Tables 
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• Costcodes can be used with departmentalized or non-departmentalized 
earnings.

• Distribution tables can only be used with non-departmentalized earnings.
The following sections explain these options and general instructions for implementing 
them. Specific instructions for each topic can be found later in this guide: 

• Creating Departmentalized Earnings on page 1.72,
• Implementing Costcodes on page 1.46, or
• Creating Distribution Tables on page 1.67.

For examples of how Payroll uses these settings to resolve the account number during 
timesheet entry, see Appendix C—How Does Payroll Resolve Accounts? on page 1.261.

DEPARTMENTALIZED EARNINGS

The departmentalized earnings option represents a very specialized method of 
accounting. You should use the departmentalized earnings option if all or most of your 
employees have different wage distributions. When you define Salary, Hourly, and/or 
Other as departmentalized, you must also define departments and GLAs for each 
departmentalized option. You can then select and store these settings on the employee 
record.

GLAs are literally “General Ledger accounts.” In everyday usage, they often 
represent the “natural” account or object code of an account number and define 
what the employee does or the cost category to which they belong. However, 
when we refer to GLAs in the program, we are referring to an additional piece 
of your Payroll setup (.H GLA, .S GLA, or .O GLA) and a setting on the 
employee record. You can use the department and GLA to refine how Payroll 
builds your account numbers.

HOW DO YOU IMPLEMENT DEPARTMENTALIZATION?

There are three primary steps that you must complete to prepare your system for 
departmentalization. 
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1.  Define the Salary, Hourly, and/or Other earning type as 2 (Departmentalize) in 
field 1 of the Payroll Parameter (Figure 1.2). 

Figure 1.2—Departmentalized Setting in Division 95 Payroll Parameter

For more information on the payroll parameter, see Defining the 
Payroll Parameter on page 1.34. 

2. You define edit values for each of these employee data items to represent all the 
departments (.S DEPT, .H DEPT, and/or .O DEPT) and GLAs (.S GLA, .H 
GLA, and/or .O GLA) that are needed by your organization.
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3. You define one or more departments and GLAs for each employee on the 
Accounting Information tab of the employee record (Figure 1.3). (This is 
optional. Depending on other settings, the system will still be able to resolve the 
account number if the employee does not have a department and GLA setting.) 

Figure 1.3—Example .S DEPT and .S GLA Entry on Accounting Information Tab

Because you have defined the Salary, Hourly, and/or Other earning type 
as departmentalized, Payroll allows you to enter multiple definitions for 
your salary, hourly, or other settings. Non-departmentalized Salary, 
Hourly, and/or Other earning types allow only one entry (i.e., 100% to a 
single department, GLA, and Additional basis for).

For examples of how Payroll resolves the account number in a departmentalized system, 
see Appendix C—How Does Payroll Resolve Accounts? on page 1.261.

ARE DISTRIBUTION TABLES EASIER?

If you do not use distribution tables for a departmentalized configuration, each change 
to your system may force you to make changes to every employee record. However, you 
may find that defining and maintaining 20–30 distribution tables may be easier than 
adjusting the departmentalized earnings for each employee each time the information 
changes. 

These options are defined as edit values 
to the .S DEPT employee data item.

These options are defined as edit values to 
the .S DEPT employee data item.

.S PCNT

.S GRP
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COSTCODES

You can use costcodes when your organization wants to code wage expenses to a 
specific project or “job” through an account number. In costcode accounting, employees 
usually work in multiple departments but there is no consistent distribution of labor. 
Employees may also have rates of pay that vary by department. 
Defining your system to use costcodes involves settings on a number of different 
records:

• Payroll parameter,
• Earnings items (i.e., historical data items with the History type defined as E—

Earnings), 
• Edit values for employee data items (.COSTCODE and/or .COSTRATE, 

depending on your setup), 
• Employee records, 
• Timesheets.

See the following sections for example uses of costcodes. See Implementing Costcodes 
on page 1.46 for specific instructions to implement costcodes.

EXAMPLE COSTCODE—RATE DEFINED ON EMPLOYEE RECORD

Charles Applecart works for Emerald City’s vehicle maintenance department earning 
$12 per hour. The vehicle maintenance department charges each city department for 
work on city vehicles. For example, Charles may work on police cars year-round (for 
the police department), but work on graders in the summer (for the road maintenance 
department) and snow plows in the winter (for the snow removal department). 
Therefore, we define an edit value for .COSTCODE for each city department to ensure 
that the hours are billed correctly. When we enter a timesheet for Charles Applecart, we 
select the correct edit value for the hours worked. Payroll defaults the rate to the Hourly 
rate defined on the Payroll Information tab of the employee record (which corresponds 
to employee data item .H AMT) and resolves the account number to charge the correct 
city department for these hours.
See Implementing Costcodes—Rate Defined on Employee Record on page 1.46 for 
specific instructions to implement this type of costcode setup. For examples of how 
Payroll resolves the account number using costcodes, see Appendix C—How Does 
Payroll Resolve Accounts? on page 1.261.
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EXAMPLE COSTCODE—RATE DEFINED ON .COSTCODE

Prucilla Pear works for Emerald City’s safety department as an emergency medical 
technician (EMT). However, she occasionally works as a standby firefighter for the city. 
EMTs earn $25 per hour, while firefighters earn $30 per hour. Because Prucilla is paid 
at different rates, we define .COSTCODE edit values for each department, including a 
lookup column 3 to hold the rate. We enter two pieces of information on Prucilla’s 
record:

• Hourly rate on the Payroll Information tab—Payroll will multiply the hourly 
amount by the rate defined by the hours billed. Therefore, to accurately reflect 
our EMT and firefighter rates, we enter 1.00 in the Hourly rate field. 

Certain organizations use this feature to better reflect a more 
complicated payroll calculation.

• .COSTCODE added to the Pay Calculation tab—Because most of Prucilla’s 
time is billed at the EMT rate, we select this edit value. When we enter a 
timesheet for Prucilla, the default .COSTCODE edit value will be EMT. We can 
change this for those hours that should be billed at the firefighter rate.

See Implementing Costcodes—Rate Defined on Employee Record on page 1.46 for 
specific instructions to implement this type of costcode setup. For examples of how 
Payroll resolves the account number using costcodes, see Appendix C—How Does 
Payroll Resolve Accounts? on page 1.261.

EXAMPLE COSTCODE—MULTIPLE RATES DEFINED ON EMPLOYEE RECORD

The Greene County parks and recreation department has three employees: Georgetta 
Berry, Oda Mae Pineapple, and Don Strawberry. Each of the employees may work at a 
variety of tasks:

• Georgetta usually works with wildlife management, where she earns $18 per 
hour. Sometimes she fills in on the night patrol of the park, where she earns $16 
per hour.

• Oda Mae is a researcher and earns $25 per hour. She also spends part of her 
week working with wildlife management, where she earns $20 per hour.

• Don usually works the night patrol, where he earns $17 per hour. However, he’s 
working on an advanced degree in biology and assists in the research 
department on occasion, where he earns $19 per hour.

Because each employee works at a variety of tasks and earns different amounts for each 
task, we decide to use the Costcode with rate override option. This option allows us to 
add an edit value and define a unique rate for each task on the employee’s record.
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We define .COSTCODE edit values for each department, then enter three pieces of 
information on each record:

• Hourly rate on the Payroll Information tab—Payroll will multiply the hourly 
amount by the rate defined by the hours billed. Therefore, to accurately reflect 
our payroll rates, we enter 1.00 in the Hourly rate field. 

Certain organizations use this feature to better reflect a more 
complicated payroll calculation.

• .COSTCODE added to the Pay Calculation tab—Because most of Prucilla’s 
time is billed at the EMT rate, we select this edit value. When we enter a 
timesheet for Prucilla, the default .COSTCODE edit value will be EMT. We can 
change this for those hours that should be billed at the firefighter rate.

• .COSTRATE added to the Pay Calculation tab—For each .COSTCODE that 
we add, we add a corresponding .COSTRATE data item and enter a rate.

See Implementing Multi-Occurring Costcodes (Complex) on page 1.60 for specific 
instructions to implement this type of costcode setup. For examples of how Payroll 
resolves the account number using costcodes, see Appendix C—How Does Payroll 
Resolve Accounts? on page 1.261.

DISTRIBUTION TABLES

You can use distribution tables in situations where wage expenses are consistently 
distributed to the same accounts using the same percentages. You define the accounts 
and percentages to which you are posting and assign that distribution table to employee 
records or to individual timesheet entries for your employees.
This option works well for:

• Salaried employees whose wage expense accounts are the same every period, or 
• Hourly employees whose wage expense accounts are the same regardless of the 

number of hours worked. 

HOW DO YOU IMPLEMENT DISTRIBUTION TABLES?

There are two primary steps that you must complete to prepare your system for 
distribution tables.
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1.  The first step to using distribution tables is to enter Y (Distribution tables are 
used) in the Dist tables field of the Payroll Parameter (Figure 1.4). See Defining 
the Payroll Parameter on page 1.34 for more information on the parameter. 

Figure 1.4—Distribution Table Setting in Division 95 Payroll Parameter

2. After you define the Payroll Parameter to allow distribution tables, you must 
define the tables themselves (Figure 1.5) and modify the .DIST TBL employee 
data item definition. (For specific instructions, see Creating Distribution Tables 
on page 1.67.) 

Figure 1.5—Distribution Table Definition

Once you have completed these setup tasks, there are two ways to implement 
distribution tables.

In Sample Division 
95, the Dist tables 
field is set to Y 
(Distribution tables 
are used).
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• You can attach a distribution table to the Pay Calculation tab of the employee 
record of all relevant employees (Figure 1.6). 

Figure 1.6—Attaching a Distribution Table to the Employee Record

Each time you create a timesheet for the employee, Payroll will provide that 
table as a default distribution table if the earnings item is defined for distribution 
tables (Figure 1.7). 

Figure 1.7—Example Timesheet—Default Distribution Table
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Or you can attach a distribution table directly to the timesheet, bypassing the 
employee record (Figure 1.8). 

Figure 1.8—Example Timesheet—Adding a Distribution Table

For examples of how Payroll resolves the account number using distribution tables, see 
Appendix C—How Does Payroll Resolve Accounts? on page 1.261.

THE PAYROLL/PERSONNEL HOMEPAGE
The Payroll/Personnel HomePage helps you keep an eye on upcoming activities and 
provides you with direct access to produce your reports. The following areas make up 
the Payroll HomePage:

• Activity Reminder area, and
• Reports area.

ACTIVITY REMINDERS

The Activity Reminders area allows you to enter a text note and a due date (optional) for 
module tasks (Figure 1.9). When you open the HomePage, any tasks with due dates 
earlier than the system date of your computer (i.e., “overdue”) will display as red. 

Figure 1.9—Activity Reminders Area
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Use the following instructions to use the Activity Reminders area.
1.  On the General Ledger HomePage, enter up to 100 alphanumeric characters in 

the Activity field (Figure 1.10). 

Figure 1.10—Example Activity Reminder—Prenotification Reminder

2. If this task has a due date, enter the date in the Due Date field. Click the drop-
down arrow to access the calendar. This field is optional.

If you do not have any text associated with a due date, the due date will 
not be saved when you exit the HomePage.

Your entries are saved when you close the HomePage or FundWare. You can edit the 
text or date information at any time.

PRINTING REMINDERS

Click Print to print the information in the Activity Reminders area. The report output 
will reflect the current sorting and displays in a preview window, from which you can 
print the information.

DELETING REMINDERS

Use the following instructions to delete a reminder.
1.  Highlight the row.

2. Click Delete. A confirmation message displays.

3. Click Yes.
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REPORTS AREA

The same categories that you see in Report Manager for the module will also display in 
the Reports Area of the HomePage (Figure 1.11). Each category can expand and 
collapse to show or hide the reports contained within. A single click of a report title will 
display the report parameters screen. Once you enter the details of the report and click 
OK, your report is produced. 

Figure 1.11—Reports Area of the Payroll/Personnel HomePage

USING THE FOLDERS
Folders represent tasks or steps in Payroll/Personnel work flow. The folder tree displays 
on the left in the main Payroll/Personnel window. When you select a folder, the 
information in the selected folder is listed in the detail pane on the right (Figure 1.12). 

Figure 1.12—Payroll Main Window

The buttons at the bottom of the screen will change to match the actions allowed for that 
folder. A disabled (i.e., grayed-out) button can mean that you must first select an item or 
that your security level does not give you access to this function. 
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USING MASKS
A “mask” is an FundWare term for using a “wild card” in an account number to indicate 
a group of accounts. The best use of this feature is for processing and reporting. Where 
an X is placed in a mask, any value in that digit position will be accepted. 

In Sample Division 96, if you enter the mask A01 00-00 111X in the Account 
Selector, you will get five accounts:

• A01 00-00 1110, 
• A01 00-00 1111, 
• A01 00-00 1112,
• A01 00-00 1114, and
• A01 00-00 1115.

SOME FUNDWARE BASICS
The following sections provide you information and instructions for opening and 
working in FundWare.

OPENING FUNDWARE

As you begin using FundWare, certain information is saved by the program and offered 
as a default. This has been designed to help you save time and steps, but you can change 
these defaults at any time by entering new information or selecting from the available 
options (depending on the field).

• User name—The program will enter the user name (or user number) of the last 
person to log into FundWare on that computer.
— For security reasons, your password is not automatically entered. You must 

always enter your FundWare password.
• Business date—Defaults to the current system date (according to your 

computer’s operating system).
• Division—The program automatically selects the division you were working in 

the last time you were in FundWare. 
— If you have only one division (or have security rights to only one division) 

and do not have security rights to the System Administration area, the 
program will bypass the division selection window. 
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— Or, if you only have security rights to the System Administration area, the 
program will bypass the division selection window and open directly to the 
System Administration HomePage.

• HomePage—The program automatically opens to the HomePage of the module 
in which you were working the last time you were in FundWare. 

Use the following instructions to open and log into FundWare.
1.  Double-click the FundWare icon on your desktop or select Blackbaud 

FundWare® Enterprise or Professional from your Windows Start menu. The 
Login window displays. 

Figure 1.13—FundWare Login Window

2. Enter your user name in the User Name text box. You can enter your user 
number instead of your user name, if preferred. 

The User Name field will default to the last entry on this computer and 
the system will move to the Password field.

3. Enter your password in the Password text box. Your password entries will 
display as asterisks (*) as you type to maintain the privacy of your password. 
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4. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

Figure 1.14—Selecting the Date

5. Click OK. If your User Name, Password, and Business Date are verified, the 
Select Division window displays, defaulting to the division you were working 
with the last time you were in FundWare. 

Figure 1.15—Selecting the Division

If your organization uses the password aging feature, you may receive a 
message indicating that your password will or has expired. You will be 
offered the chance to enter a new password at this time. See Changing 
Your Password During Login on page 1.17.

If you have only one division (or have security rights to only one 
division) and do not have security rights to System Administration, the 
program will bypass the Select Division window. Or, if you only have 
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security rights to System Administration, the program will bypass the 
division selection window and open directly to the System 
Administration HomePage.

6. If necessary, select a different division (or System Administration) from the list. 

7. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

For users upgrading from earlier versions of FundWare, please note that you can only 
have one division open at a time in each instance of FundWare (a change in 
functionality). However, you can open the program multiple times for the same or 
different divisions and/or business dates.

CHANGING YOUR PASSWORD DURING LOGIN

If your organization uses the password aging feature (defined through System 
Administration), you may receive a message indicating that your password will or has 
expired. 

Figure 1.16—Password Expiring

Use the following instructions to change the password at this time.
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1.  Click Yes to the password expiration message. The Change Password window 
displays. 

Figure 1.17—Changing Your Password During Login 

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

You can also change your password from within the software. See Changing Your 
Password From the Software on page 1.21.

OPENING FUNDWARE MULTIPLE TIMES

Each “instance” of FundWare (i.e., each time you open the program) represents a single 
division on a single business date. However, you can open as many instances of 
FundWare as necessary to meet your needs. 
When dealing with multiple instances of FundWare, keep the following rules in mind:

• Each instance of FundWare represents a single user, division, and business date, 
or represents access to the System Administration features by a single user. 

• You can open as many instances of FundWare as necessary (i.e., for different 
users, business dates, or divisions).
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• You can still change the business date for the current instance of FundWare 
without opening a new instance. See Changing the Business Date on page 1.20 
for more information.

OPENING ADDITIONAL INSTANCES—FROM THE DESKTOP/START MENU

If you have one or more instances of FundWare open already, you can open additional 
instances of the program from your desktop or the Windows Start menu. You will be 
asked to identify the user, password, business date, and division (the same steps as 
opening the first instance of FundWare).

OPENING ADDITIONAL INSTANCES—FROM THE PROGRAM

You can also open a new division or a new instance of the same division from within 
FundWare. Because you are opening this division from the program, the system applies 
the same user and password to the new instance and allows you to select a new division 
or business date.

If you want to open a new instance of FundWare for a new division or a new 
business date, you can open the program from the desktop or Windows Start 
menu or from the Change Business Date task. For instructions on changing the 
business date, or opening a second instance of the program with a different 
business date, see Changing the Business Date on page 1.20.

Use the following instructions to open a new instance of FundWare for the current user 
and business date.

1.  Select File > Open FundWare from the menu bar. The Open New Instance 
window displays, automatically selecting the division you were working with 
the last time you were in FundWare. 

Figure 1.18—Opening a New Instance of FundWare

2. If necessary, select a different division (or System Administration) from the list. 
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3. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

4. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

CHANGING THE BUSINESS DATE

You can change the business date for your current instance of FundWare or open a new 
instance of the same division with a different business date using the Change Business 
Date task. When you choose to open a new instance of the same division, the system 
applies the same user and password to the new instance and takes you directly to the 
HomePage for the module in which you were last working in that division.

1.  Select Edit > Change Business Date from the menu bar. The Change Business 
Date window displays. 

Figure 1.19—Changing the Business Date 

1 Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you can 
click the down-arrow to select a date from the calendar.

2 Select the applicable option for applying the new business date:
• Current Instance of FundWare—Changes the business date for the current 

instance of FundWare. This option does not apply any changes to other 
instances of FundWare and does not open a new instance of the program.

The “Classic” windows will not accept a changed business date. If you 
have any of the Classic screens open when you attempt to change the 
business date for the current instance of FundWare, the system will 
return a message and not allow you to proceed. Close the Classic 
windows and try again.
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• New Instance of FundWare—Opens a new instance of FundWare to the 
HomePage for the module in which you were last working, applying the 
same user, password, and division but using the new business date.

1.  Click OK. The program applies your selection.

CHANGING YOUR PASSWORD FROM THE SOFTWARE

Use the following instructions to change the password for the current user.
1.  Select Edit > Password from the menu bar. The Change Password window 

displays. 

Figure 1.20—Changing the Current User’s Password

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

If your organization uses the password aging feature (defined through System 
Administration) and your password is nearing or has passed the expiration date, you can 
also change your password during the login process. See Changing Your Password 
During Login on page 1.17.
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USING THE MENU BAR

Each module for which your organization is licensed and to which you have security 
rights displays in the menu bar. From these menu options, you can access all module-
specific tasks (e.g., General Ledger > Journal Entries > New). In addition, you will 
use the menu bar to access specific program tasks (e.g., changing the business date):

• File—Open divisions; access Print Manager, Report Manager, or Financial 
Institutions.

• Edit—Change the business date or your password.
• View—View or close Navigator bar; view full or abbreviated menu names; 

view logged in users.
• Window—See all currently open windows, switch between these windows.
• Help—Access online help for the current module and program information. 

KEYBOARD NAVIGATION

To help you navigate quickly through the program, FundWare allows you to use your 
keyboard instead of your mouse to access program tasks.

• Menu bar—You can access any task listed on the menus using a combination of 
the ALT key and a letter and the arrow keys.
— Press the ALT key.
— Press the underlined letter of the item to display the menu. The menu 

displays.
— Use the arrow key and press ENTER to select a task.

• Shortcut menus—Access any applicable shortcut menus (normally displayed 
when you right-click your mouse) from the keyboard by pressing either 
SHIFT+F10 or the Application key (offered on many newer keyboards, located 
between the WINDOWS key and the CTRL key, to the right of the spacebar).

• Shortcut keys—Shortcut keys combine the CTRL key with a letter to give you 
direct access to certain tasks. These shortcuts are listed on the menus with the 
applicable tasks. 

• Drop-down lists—You can access any drop-down list when focus is on the 
associated field by using a combination of the ALT key and the down arrow key. 
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IS YOUR MENU BAR TOO CROWDED?

If your organization is licensed for a number of FundWare modules, your menu bar may 
be too wide to use conveniently. You can change the module names that are listed in the 
menu bar to display as acronyms, which will decrease the width of the bar:

• Select View > Abbreviated Menu Names from the menu bar. To change back, 
select View > Full Menu Names from the menu bar.

HOW YOUR SECURITY RIGHTS IMPACT THE MENU BAR

Your individual security rights may impact the modules and tasks that you see on the 
menu bar. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the menu bar.

• If your security settings allow you to access some, but not all, tasks in a module, 
the restricted tasks will not be listed in the menu bar.

USING THE NAVIGATOR BAR

The Navigator bar provides you with quick, mouse-driven access to your modules, 
module tasks, and currently open windows through two areas:

• Module navigator, and
• Open windows navigator.

You can resize the Navigator bar to meet the needs of your display by using your mouse 
to click on the right frame of the bar and drag the frame to the position you want. You 
can also hide or show the Navigator bar using the options on the View menu. Select the 
option to hide or show the bar, as applicable. These settings will be retained by the 
system when you close FundWare.

MODULE NAVIGATOR

The module navigator lists the modules for which your organization is licensed (unless 
your individual security settings do not allow you to access a module). When you click a 
module (it just takes a single click), the module expands to display all of the associated 
module tasks. 
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Accessing any of the tasks within the module takes another single click on the specific 
item. Some tasks are “nested” below a title. A single click will expand the title, 
displaying the related tasks below. 

Figure 1.21—Module Navigator—Expanded Menus

If your security settings restrict your access to specific tasks, those tasks will not 
be listed in the menu bar. 
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OPEN WINDOWS NAVIGATOR

The open windows navigator lists the windows that are currently open in this instance of 
FundWare, highlighting the window currently displayed. A single click of an entry in 
the open windows navigator redisplays the window in your workspace. 

Figure 1.22—Open Windows Navigator

As with all Windows applications, the more FundWare windows that you open 
concurrently, the greater impact to your processor speed. You can use the Open 
Windows Navigator to monitor how many windows you have open at any one 
time.

HOW YOUR SECURITY RIGHTS IMPACT THE NAVIGATOR BAR

There is no security impact to the open windows navigator. If your security rights 
allowed you to open a task, then that window will display in the open windows 
navigator. However, your individual security rights may impact the modules and tasks 
that you see on the module navigator. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the module navigator.

• Any tasks within a module from which you are restricted will not be listed in the 
menu bar. 

CUSTOMIZING YOUR DISPLAY

Throughout FundWare, you will encounter forms (similar to a table or spreadsheet) that 
allow you to customize the display through the shortcut menu (accessed by right-
clicking your mouse) or through direct manipulation with your mouse. Most of these 
settings are retained with your user name. Therefore, the forms display according to 
your settings wherever you log in to FundWare. (In other words, the program 
remembers how the form displayed when you closed FundWare. This is how it will 
display the next time you open the program.)
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Not all forms provide these options. If you attempt one of the customization 
options described here and are unsuccessful, it is likely that the option is not 
offered on that form.

HIDING AND DISPLAYING COLUMNS

To add or remove a column from a form, hover your mouse over the pane and right-
click. A shortcut menu displays, which allows you to hide or display columns from the 
form. 

Figure 1.23—Example Shortcut Menu for the GL New Journal Entry Form

The columns currently displayed in the form are indicated with a check mark. Select a 
column from the shortcut menu to add or remove that column to the detail pane.

If you have disabled fields through the module setup (e.g., the Accounts 
Payable parameter or stage settings), the associated column will not be listed on 
the shortcut menu.

RE-ORDERING THE COLUMNS

To re-order the columns in a form, “drag and drop” the column by clicking the column 
heading and moving the column to the desired position (holding the mouse button 
down).

In this example, the Account column is disabled 
because this column must always display. 

The remaining columns are currently displayed in the 
New Journal Entry form.
Some FundWare Basics 
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RESIZING THE COLUMNS

To resize a column, hover your mouse over the column border until the icon changes. 
Figure 1.24—Mouse Icon

Click your mouse button and drag the column border until it is the desired width.

SORTING THE ENTRIES IN A FORM

To resort the entries in a form, click the heading of the column on which you want the 
sort based. To reverse the sort order, click the column heading again. 

Figure 1.25—Sorting the Detail Pane

Sort order is not retained when you close FundWare.

HELP

If you encounter questions or problems while you are working in the program, you can 
access the online help from the Help menu (on the menu bar) or by clicking F1 to access 
the online help for the current module.

Original display.

Entries resorted 
based on Obligation 
number.

Entry order reversed.
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You can also access PDF files (portable document format) of the guides from your 
server:

• FundWare\Data\User Documentation
You must have Adobe Acrobat Reader installed to view the files. This program is 
available from the FundWare CD or as a free download from www.adobe.com.

TRAINING AND CONSULTING SERVICES

Blackbaud, Inc. offers a number of options to help you improve your use of FundWare.
• Regional classes—Training classes held several times per month in various 

cities across the nation. These one- to five-day classes provide a hands-on 
learning environment and low student-to-instructor ratio.

• eClasses—Interactive training classes offered over the Internet provide you and 
your staff the opportunity to receive training from FundWare experts without 
leaving your desk.

• Onsite custom training sessions and consulting—Our training/consulting group 
offers you onsite services, including:
— Training your staff using your data.
— Installing/upgrading and configuring the software to meet the specific needs 

of your organization.
For more information about any of our training or consulting services, please explore 
our Web site (http://www.blackbaud.com) or contact our Client Sales department (800-
551-4458).

USING THIS DOCUMENT

This manual is organized to reflect the most common uses of the module. It provides 
you with overview information of FundWare, followed by specific features and 
functions of the module.
Some FundWare Basics 
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CONVENTIONS

Use Table 1.1 as a reference for conventions used in this document. 

GETTING SUPPORT

The following table provides a quick reference for getting the support you need for 
FundWare modules.

Table 1.1—Icon Conventions
Indicator Description

A caution or warning that must be heeded. Information contained in a warning should be care
reviewed to avoid adverse affect on software operation.
An example, used to clarify an issue.

ENTER Keyboard directions are indicated in small capital letters (e.g., Press ENTER).
demo user Specific text entries are indicated with italics (e.g., Type demo user for User Name).
Click OK An item on the screen that requires user interface is indicated in bold.

Table 1.2—Getting Support
Department Contact Description

Business 
Office

800-551-4458 Obtain general information or contact a sta
member.

Technical 
Support

800-227-7575
e-mail: FWSupport@blackbaud.com

Get help resolving technical issues with th
product. Please have the following informa
ready when you call:
• Blackbaud Site ID
• FundWare version number
• Error message details

Knowledgebase
www.blackbaud.com

A searchable database where you can typ
your questions and get a list of possible 
answers.
• Requires your license number and Black

Site ID.
Blackbaud, Inc. 1.29
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Training 800-551-4458
Ask for the Client Sales department.

www.blackbaud.com

Contact us for more information on our trai
options:
• Regionals—Classes from 1 to 5 days in 

length; held in cities around the country.
• eClasses—Two- to three-hour classes of

over the Internet.
• Onsite custom training and consulting—O

consulting staff can implement FundWar
and/or train your employees using your 
organization’s data.

Product 
Management

www.blackbaud.com Contact our Product Management departm
with any suggestions for improving FundW

All other 
information

www.blackbaud.com Links are available for all other FundWare 
information including replacement software
user guides and software updates.

Blackbaud, Inc.
6430 S. Fiddler’s Green Circle, Suite 200
Greenwood Village, CO 80111
800-551-4458
303-756-3030

Table 1.2—Getting Support (Continued)
Department Contact Description
Some FundWare Basics 
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PAYROLL/PERSONNEL SETUP

Before you can begin working in the Payroll/Personnel module, you must configure the 
program to meet the needs of your organization. Because this module provides you with 
great flexibility, this involves some planning on your part. The elements that you must 
define can include the following, depending on your organization:

• The Payroll parameter,
• Tax historical data items,
• Earning historical data items,
• Deduction historical data items,
• Other (employer cost) historical data items,
• Costcodes/distribution tables/departmentalization,
• The check format, and 
• Direct deposit parameters.

BEFORE YOU BEGIN THE SETUP PROCESS
The Payroll/Personnel module will build (or compile) the account number to which it 
posts in General Ledger based on your settings. Therefore, you must have a thorough 
understanding of the payroll process for your organization and your accounting structure 
before you begin your Payroll/Personnel setup.

Payroll can automatically calculate most of the components of your payroll. 
However, if your organization’s underlying policies and procedures are difficult 
to understand and administer, your payroll setup will be even more complicated. 
If necessary, you may want to explore updating your payroll procedures before 
you begin setting up your Payroll system.

Before you begin the Payroll setup process, you should also:
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• Define journals for Payroll, and
• Defining a Payroll liability account.

GENERAL LEDGER JOURNALS

Before you can define the Payroll Parameter, you should have two journals defined in 
your General Ledger for use by the Payroll/Personnel module:

• Labor, and
• Payroll.

For example, Sample Division 95 has the following two journals defined (Figure 2.1). 

Figure 2.1—Sample Labor and Payroll Journals

When you define the Payroll Parameter (see Defining the Payroll Parameter on page 
1.34), you indicate to which journals you will post for different tasks. Table 2.1 shows 
you how FundWare posts Payroll transactions to General Ledger using journals. 

Table 2.1—Journal Posting Process With General Ledger

Task Example
Journal Debit Credit

Enter and post timesheets Labor Wage Expense Accrued Payroll Liability
Before You Begin the Setup Process 
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If you also use the Accounts Payable module, you may be posting to AP when you log 
checks. Payroll will post to AP using the Expense journal defined in AP Basic Setup. 
Table 2.2 show how FundWare posts to AP using a journal. Payroll will post to AP 
using the Expense journal defined in AP Basic Setup. 

For more information on defining journals, see the Blackbaud FundWare General 
Ledger–Project/Grant Guide.

Calculate taxes, deductions, 
and employer costs

Payrl Tax and Employer Cost 
Expenses

Accrued Payroll Liability

Log checks Payrl Accrued Payroll Liability Cash Account

Table 2.2—Journal Posting Process With Accounts Payable

Task Example
Journal Debit Credit

Log checks/direct deposits Purch Deductions Payable Accounts Payable

Table 2.1—Journal Posting Process With General Ledger (Continued)

Task Example
Journal Debit Credit
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PAYROLL LIABILITY ACCOUNT

You must also define a liability account for accrued payroll. For example, account A01 
00-00 2210 is defined as the payroll liability account in Sample Division 95 (Figure 
2.2). 

Figure 2.2—Sample Accrued Payroll Liability Account

For more information on defining accounts, see the Blackbaud FundWare General 
Ledger–project/grant Guide.

DEFINING THE PAYROLL PARAMETER
You must define the payroll parameter before you begin any other setup tasks. Because 
the parameter controls overall system operation, be very careful in making any changes 
once you have completed this step. 

Changes to the payroll parameter are recorded by business date and user number 
in the fields displayed in the upper right hand corner of the screen.

Use the following steps to define the payroll parameter. 
1.  Click Setup > Payroll Parameter on the module navigator (if the module is not 

expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Payroll Parameter from the menu bar.
Defining the Payroll Parameter 
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2. Type A to add information. Page 1 of the Payroll Parameter displays (Figure 
2.3). 

If you have installed a new ToolBox, type C to change information so 
that any new Employee Data Items will be updated on your system. 
(See Chapter 7—Periodic Processing on page 1.233 for more 
information on the Payroll ToolBox.) 

Figure 2.3—Define Payroll Parameter, Page 1 of 4

3. Complete the entries for Field 1, which determine your earnings types, 
according to Table 2.3. 

Table 2.3—Payroll Parameter—Field 1 (Configuration) Definitions

Field Options Definition

Tax Mode U
C

• U—United States
• C—Canada

Salary 0
1
2

“Salary” is any earning that is a flat amount (e.g., Jane Smith earns $2000 
every two weeks; all employees earn $125 as a flat salary for “on-call pay”).
• 0—There are no salaried employees.
• 1—There are salaried employees whose wages: 

— Are expensed to one department per employee,
— Use distribution tables, or 
— Use costcodes. 

• 2—There are salaried employees whose wages are departmentalized.
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Classified Y
N

• Y—Salary amount does not appear on the employee’s record; the amount 
is selected from a drop-down list of “grades” and “steps.”
— For example, you can use this option if you have employees whose 

salary amount depends on job classification (e.g., a GS1 employee is 
paid $1,000.00 and a GS2 employee is paid $1,100.00).

• N—Salaries are not classified by job. Salary amount and pay period are 
entered on the Payroll Information tab of the employee record.

Hourly 0
1
2

“Hourly” is any earning that is a multiplied by a rate (e.g., Joe Jones earns $12 
dollars for each hour he works; this hourly amount is multiplied by a rate of 1.5 
for overtime). 
• 0—There are no hourly employees.
• 1—There are hourly employees whose wages:

— Are expensed to one department per employee.
— Use distribution tables.
— Use costcodes.

• 2—There are hourly employees whose wages are departmentalized.

Classified Y
N

• Y—Hourly amount does not appear on the employee’s record; the amount 
is selected from a drop-down list of “grades” and “steps.”
— For example, you can use this option if you have employees whose per 

hour wage depends on job classification (e.g., a GS1 employee is paid 
$10.00 per hour and a GS2 is paid $11.00 per hour).

• Hourly wages are not classified by job. Hourly amount and pay period are 
entered on the Payroll Information tab of the employee record.

Other 0
1
2

• 0—There are no other employees. Other is for per unit wages, such as 
piece work.

• 1—There are other employees whose wages:
— Are expensed to one department per employee.
— Use distribution tables.
— Use costcodes.

• 2—There are other employees whose wages are expensed to more than 
one department per employee.

Classified Y
N

• Y—Unit rate does not appear on the employee’s record; the amount is 
selected from a drop-down list of “grades” and “steps.” For example:
— Referee Softball – $30.00 per game
— Referee Soccer – $25.00 per game

• N—Other wages are not classified by job.

Table 2.3—Payroll Parameter—Field 1 (Configuration) Definitions (Continued)

Field Options Definition
Defining the Payroll Parameter 
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4. Press ENTER or PAGE DOWN to move to the next field. Page 2 of the Payroll 
Parameter displays (Figure 2.4). 

Figure 2.4—Define Payroll Parameter, Page 2 of 4

Shift emps Y
N

• Y—Shift differential is paid. In other words, a “premium” or “differential” is 
added to the employee’s base pay. Use this option if:
— You have employees who work different shifts throughout a pay 

period, and
— Those shifts have different rates of pay.

• N—Shift differential is not paid.

Costcode Y
N
O

• Y—Costcodes are used.
• N—Costcodes are not used.
• O—Costcodes with rate override are used.

— After selecting this option, Def Rate-item displays, answer Y to use the 
default rate item. The data item defined for Rate from in the Earnings 
options field displays as the default Rate value in the Edit Timesheets 
task. 

— Answer N to use a no default rate-item. The Rate value field in the Edit 
Timesheets task is blank; no default is entered and any rate from 
defined on the earnings item (historical data item) is ignored.

Dist tables Y
N

• Y—Distribution Tables are used. 
• N—Distribution Tables are not used.

Table 2.3—Payroll Parameter—Field 1 (Configuration) Definitions (Continued)

Field Options Definition
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5. Complete the entries for Field 2, which determine your user options, according 
to Table 2.4. 

Table 2.4—Payroll Parameter—Field 2 (User Options) Definitions

Field Options Definition

Log emp maint Y
N

This option keeps a log of all changes made to employee records if Y 
– Yes is answered. A report listing the date, time, the user making the 
changes, and the change(s) made can be printed with the Employee 
Change Log (PYSESS.L##). 
• Y—Log employee changes (recommended).
• N—No logging of employee changes.

Post to AP Y
N

• Y—Obligations are created automatically in Accounts Payable 
when you post Payroll checks. The Post to AP field is enabled on 
deductions, taxes, and other historical data items to hold the 
vendor number for any data items designated to post automatically 
to Accounts Payable.

• N—No posting will be done to the Accounts Payable module.

Date format 1–4 Format of the date on payroll checks.
• 1—MM/DD/YYYY (e.g., 01/31/2004)
• 2—DD MMM, YYYY (e.g., 31 Jan, 2004)
• 3—MMM DD, YYYY (e.g., Jan 31, 2004)
• 4—DD-MMM-YYYY (e.g., 31-Jan-2004)

Amount format N
S

Format how the check amount prints on the payroll check amount 
line.
• N—Numeric amount format on checks (e.g., 100 dollars and 00 

cents * * * *)
• S—Word amount format on checks (e.g., One hundred dollars and 

no cents * * * *)

Auto employee Y
N

• Y—Search for the next employee number when adding an 
employee. Starts with 1 and increments by 1 for each employee.

• N—Do not search for the next employee number. Requires the 
operator to enter the employee number.

Multiple Checks N
T
P

• N—Multiple checks will not be used. Only one check per employee 
per pay period is allowed. (This setting is required to process 
payroll in the 7.x versions.) 

• T—Multiple checks are used. Check sequence is entered at 
timesheet entry.

• P—Multiple checks are used. Check sequence is determined when 
the timesheets are posted.
Defining the Payroll Parameter 
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6. Press ENTER or PAGE DOWN to move to the next field. Page 3 of the Payroll 
Parameter displays (Table 2.5). 

Figure 2.5—Define Payroll Parameter, Page 3 of 4

Elec fund xfer Y
N

• Y—Electronic Fund Transfer (i.e., “Direct deposit”) is used.
• N—Electronic Fund Transfer is not used.

Ext check title 10 
characters

Enter the word that the system should use for a check.
• United States organizations usually use “check.”
• Canadian organizations usually use “cheque.”
• Municipalities often use “warrant.”
The name displays on reports and in Inquiry tasks.

Scramble 
checks

Not 
editable

Reflects your encryption setting for Payroll checks. For more 
information on this feature, see Encrypting Checks on page 1.44.

Table 2.4—Payroll Parameter—Field 2 (User Options) Definitions (Continued)

Field Options Definition
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7. Complete the entries for Fields 3 and 4, which determine your timesheet and 
ledger options, according to Table 2.5. 

Table 2.5—Payroll Parameter—Field 3 and Field 4 Definitions

Field Options Definition

Timecard Options

Keep History Y
N

• Y—Maintain timesheet history.
— FundWare creates a data file that is updated when you post 

timesheets.
— You should use this option if your organization requires a 3-

part check and/or you are using the daily earnings report. (See 
Producing the Daily Earnings Report on page 2.155.)

• N—Do not maintain timesheet history.

Day check N
Y… max

• N—Day check in clocked timesheet entry is not used.
• Y… max—Day checking is used in clocked timesheet entry.

— Enter the maximum hours over which to report an error. 
— “Day check” only checks clocked time.
— Prints warning on the Timesheet Verification Report if the 

maximum hours per day are exceeded, however, timesheets 
will be posted.

Period check N
Y… max

• N—Pay period check in clocked timesheet entry is not used.
• Y… max—Pay period checking is used in timesheet entry. 

— Enter the maximum hours over which to report an error. 
— “Period check” sums all hours (overtime + VACA + SIC, etc.) 

and checks that sum against the limit.
— Prints warning on the Timesheet Verification Report if the 

maximum hours per day are exceeded, however, timesheets 
will be posted.

Ledger Options

Ledger Post Y
N

• Y—Payroll/Personnel financial information posts to a Financial 
Reporting System such as General Ledger.

• N—Payroll/Personnel is a stand-alone system that does not post to 
a Financial Reporting System. The remaining fields in Ledger 
options are skipped.
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Post units N
Y… ID types
Z… ID types

• N—Units or hours are not posted to General Ledger. 
• Y… ID types—Units or hours are posted to specified ID types.

— Earnings using units or hours that have a zero dollar amount, 
e.g., vacation time, do not post to General Ledger.

— You must post to GL in detail.
• Z… ID types—Units are posted to the specified ID types. 

— Earnings using units or hours are posted regardless of the 
dollar amount, e.g., the units or hours for zero dollar amount 
earnings like vacation time are posted.

— You must post to GL in detail. 
— If you select this option, you should not also compress all 

entries (option 3 for Compress).

Labor journal 5 characters The journal through which timesheets entries are posted to General 
Ledger. Press F1 to select from your existing journals.

• Compress 0–3 This is the level of detail posted to GL from the Labor journal.
• 0—Post all entries in detail.
• 1—Compress accrued payroll liability entries only.
• 2—Compress expense entries by Data Item.
• 3—Compress all entries.

Paid journal 5 characters The journal through which check entries are posted to General 
Ledger. Press F1 to select from your existing journals.

• Compress 0–4 This is the level of detail posted to GL from the Paid journal.
• 0—Post all entries in detail.
• 1—Compress accrued payroll liability entries.
• 2—Compress expense entries.
• 3—Compress all entries.
• 4—Compress all entries; post cash entries in detail.

Accrued 
account

account 
number or 
mask

This is the account or account mask for the Accrued Payroll account 
in GL.
• This account is credited by the Labor journal and debited by the 

Payroll journal.

Table 2.5—Payroll Parameter—Field 3 and Field 4 Definitions (Continued)

Field Options Definition
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SYSTEM HISTORY

The fourth page of the payroll parameter will not display until you initially create the 
parameter. The information on this page is not editable, it is maintained by payroll 
processing tasks (i.e., you cannot enter anything; it is for your information only) (Figure 
2.6). 

Figure 2.6—Define Payroll Parameter, Page 4 of 4

Use the information provided according to Table 2.6. 

Table 2.6—Payroll Parameter—Field 5 Definitions

Field Options Definition

System Information No entry allowed in these fields.

Implementation 0 Setup has not been started.

1 Parameter has been defined.

2 Employees have been defined.

3 Setup is complete.

Last session # – number Each time a user makes a change to an employee record in the Edit 
Employee task, this number is increased by one. 
• Every time a change is made in this task, a session is completed. 
• This number reflects the last session number and corresponds to 

the session number on the Employee Change Log report. 
• This information is tracked if the Log emp maint setting is Y—Log 

employee changes (see field 2).
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Last employee # – number The last employee number used.
• If your setting for Auto employee (see field 2) is Y—Search for 

next employee, the system will look at this entry to determine the 
next employee number.

Last Run # – number The last check run number used.
• Updated each time checks are logged.

Last run date 99/99/9999 The check date of the last check run logged.

Active year 9999 The calendar year of the payrolls being processed. 
• Active year is 0000 until the first posting activity is entered at 

which time the year of the business date used to enter the posting 
activity replaces the 0000. 

• The Timesheet tasks, Check Processing tasks, and Enter 
Employee History task are posting tasks that start up the active 
year. 

• After setup is complete, Active year is updated only when a Roll 
Balances Forward task is used (produces PYLOVR.L##).

• You may post to any date in the Active year or any date in the 
year before the Active year. 

• If you post to the year before the Active year, balances are 
automatically rolled forward to the Active year (produces 
PYLOVR.L##). 

• You may not post to a date in the year after the Active year.

Purged year 9999 The last year purged. 
• A purged year is one that has been deleted from the system.

Saved year 9999 The last year saved. 
• A saved year is one whose detail has been deleted from the 

system but summary information has been retained. 
• Data from saved years may be used in reports.

Time Cards
• Status

0 No timesheets are entered.

1 Timesheets have been entered and need verification.

2 Timesheets have been verified.

Table 2.6—Payroll Parameter—Field 5 Definitions (Continued)

Field Options Definition
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ENCRYPTING CHECKS

The Payroll/Personnel module allows you to encrypt (or “scramble”) your checks. 
Using this option, your check print file displays and prints normally with Print Manager. 
However, when opened in any other program (e.g., Word, Notepad), the information is 
encrypted, thus protecting your check information.

Once this option is activated, it cannot be de-activated without the assistance of 
FundWare Support (800-227-7575).

Use the following instructions to activate the encryption option. When complete, this 
setting is reflected in field 2 of the payroll parameter.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

Task Activity 0 No timesheets are in process.

1 A user is entering timesheets through Edit Timesheets or Create 
Group Timesheets.

2 A user is in the Verify Timesheets task.

3 A user is in the Post Timesheets task.

Number of 
users

1–9999 The number of users currently performing timesheet activities.

History dates mm/dd/yyyy–
mm/dd/yyyy

This field appears if the Keep history field under Timecard options is 
defined as Yes. History data is kept on the system for the date 
range specified.

Table 2.6—Payroll Parameter—Field 5 Definitions (Continued)

Field Options Definition
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 2.7). 

Figure 2.7—System Utilities Window

4. In the Execute Program area, enter the required information according to Table 
2.7 to run the override. 

5. Click Run. A confirmation message displays.

6. Type Y for Yes and press ENTER.

7. Type E to end the task and press ENTER. 

8. Press ESC close the window.

Table 2.7—Encrypting Checks

Field Entry

Program Name PYL006

Switches 23

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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IMPLEMENTING COSTCODES
Costcodes come in two varieties, based on your selection in the Payroll parameter:

• Single-use—Y (Costcodes are used). This is the more common use of the 
.COSTCODE feature.
— You define edit values for the .COSTCODE data item and apply 

.COSTCODE and an edit value once to each employee record. 
— You can enter a rate on the employee record or define a rate as part of the 

.COSTCODE edit value. 
— See Example Costcode—Rate Defined on Employee Record on page 1.5 and 

Example Costcode—Rate Defined on .COSTCODE on page 1.6 for 
examples of these options.

• Multi-use—O (Costcodes with rate override are used). This is a more complex 
application of the .COSTCODE feature and is less common among users.
— You define edit values for the .COSTCODE data item and the .COSTRATE 

data item.
— You apply .COSTCODE and .COSTRATE multiple times to each employee 

record. Your .COSTCODE and .COSTRATE entries will correspond (i.e., 
.COSTCODE entry 2 links to .COSTRATE entry 2).

— See Example Costcode—Multiple Rates Defined on Employee Record on 
page 1.6 for an example of this option.

The following sections provide instructions for configuring your system to use each type 
of costcode.

IMPLEMENTING COSTCODES—RATE DEFINED ON EMPLOYEE RECORD

Use the following steps to define your system to use the .COSTCODE data item and 
define the rate of pay on the employee record. (See Example Costcode—Rate Defined 
on Employee Record on page 1.5 for an example of this setup.)

1.  Click Setup > Payroll Parameter on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Payroll Parameter from the menu bar.
Implementing Costcodes 
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2. Enter Y (Costcode is used) in the Costcode field (Figure 2.8). The system 
automatically creates the .COSTCODE employee data item when you save the 
Payroll parameter. 

Figure 2.8—Costcode Setting “Y” in Division 95 Payroll Parameter

For more information on the payroll parameter, see Defining the 
Payroll Parameter on page 1.34. 

3. Make a list of the edit values you will use (including account masks). 

4. Click Setup > Employee Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Employee Data Items from the menu bar.

5. Type C to change the data item by entering edit values.

In Sample Division 
95, the Costcode 
field is set to Y 
(Costcode is used).
Blackbaud, Inc. 1.47



Blackbaud FundWare Payroll/Personnel Guide—Volume 1

1.48
6. Type .COSTCODE, or press F1 and select the data item from the list. The first 
page of the .COSTCODE definition displays (Figure 2.9). 

Figure 2.9—.COSTCODE Definition—Page 1 of 3

7. If necessary, edit the Description, Short description, Default value, Edit data, 
and Lookup column fields (for more detailed instructions, see Defining 
Employee Data Items on page 1.118).

The setting for Multiple values is N (No entry nbr used w/data item) 
indicates that this is a single-occurring data item. In other words, no 
numbering is used when you add .COSTCODE to the employee record 
because it can be added only once. You cannot edit this field.
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8. Type 5 (the field number) or press PAGE DOWN to access the third page of the 
record. Any existing edit values for .COSTCODE are listed (Figure 2.10). 

Figure 2.10—Example List of Edit Values for .COSTCODE

If you are in the display mode, the second page of the record displays 
system information (Figure 2.11). You cannot modify any of the fields 
on this page. 

Figure 2.11—.COSTCODE Definition—Page 2 of 3
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9. Type A to add an edit value. The system asks you to enter the name of the edit 
value (Figure 2.12). 

Figure 2.12—.COSTCODE Definition—Edit Value Name

10. Enter the edit value name (up to 20 alphanumeric characters) in the Edited 
Value field.

11. Press ENTER. The edit value definition page displays (Figure 2.13). 

Figure 2.13—.COSTCODE Definition—Edit Value Definition

12. Indicate if the edit value is active (Y) or inactive (N—not active, cannot be 
used).
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The In use field is a system-maintained field that indicates if the edit 
value has ever been used on an employee record.

13. Enter a description in Lookup 1 (up to 30 characters of alphanumeric text). This 
description displays in the edit value drop-down list on the Pay Calculation 
tab.

14. Enter an account mask in Lookup 2 (up to 55 characters of alphanumeric mask). 
This mask will be used in the account resolution. See Appendix C—How Does 
Payroll Resolve Accounts? on page 1.261 for examples.

15. Press ESC to return to the Define Edit Values menu. The new edit value is listed 
and you can continue to add more edit values, if necessary. 

16. Type E to exit the edit values task. A confirmation message displays.

17. Type 0 to accept your changes. 

18. Press ESC to display the option menu.

19. Type E to close the window.

20. Click Setup > Historical Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Historical Data Items from the menu bar.

21. Ensure that all earnings items with which you will use .COSTCODE are defined 
to allow costcodes (Figure 2.14). 

Figure 2.14—Example Earnings Item (Hourly) Defined for .COSTCODE

The Use costcode 
field is set to Y (Use 
costcode).
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22. On the Pay Calculation tab of the employee record, add .COSTCODE and 
select an edit value from the drop-down list to the Pay Calculation tab (see 
Completing the Pay Calculation Tab on page 2.43) (Figure 2.15). 

Figure 2.15—Example Costcode Entry on Pay Calculation Tab

The value displayed in the drop-down list matches the description 
entered in Lookup 1 of the data item edit value. 

23. When you are entering timesheets and select the earnings item, the edit value 
from the employee record is the default entry. If you click the drop-down arrow, 
you can see all the edit value information (Figure 2.16). 

Figure 2.16—Example Timesheet With .COSTCODE Edit Values

24. When Payroll processes the timesheet, the system uses the rate defined in the 
Hourly rate field (Payroll Information tab) on the employee record.
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IMPLEMENTING COSTCODES—RATE DEFINED ON .COSTCODE
Use the following steps to define your system to use the .COSTCODE data item. In this 
scenario, we define the rate of pay on each .COSTCODE edit value. (See Example 
Costcode—Rate Defined on .COSTCODE on page 1.6 for an example of this setup.)

1.  Click Setup > Payroll Parameter on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Payroll Parameter from the menu bar.

2. Enter Y (Costcode is used) in the Costcode field (Figure 2.17). The system 
automatically creates the .COSTCODE employee data item when you save the 
Payroll parameter. 

Figure 2.17—Costcode Setting “Y” in Division 95 Payroll Parameter

For more information on the payroll parameter, see Defining the 
Payroll Parameter on page 1.34. 

3. Make a list of the edit values you will use (including account masks and 
corresponding rates). 

4. Click Setup > Employee Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Employee Data Items from the menu bar.

5. Type C to change the data item by entering edit values.

In Sample Division 
95, the Costcode 
field is set to Y 
(Costcode is used).
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6. Type .COSTCODE, or press F1 and select the data item from the list. The first 
page of the .COSTCODE definition displays (Figure 2.18). 

Figure 2.18—.COSTCODE Definition—Page 1 of 3

7. If necessary, edit the Description, Short description, Default value, and Edit 
data fields (for more detailed instructions, see Defining Employee Data Items on 
page 1.118).

8. Define Lookup column 3 for R—Signed (9.6) (Figure 2.19). 

Figure 2.19—.COSTCODE Definition—Page 1 of 3

Enter R in Lookup column 3.
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The setting for Multiple values is N (No entry nbr used w/data item) 
indicates that this is a single-occurring data item. In other words, no 
numbering is used when you add .COSTCODE to the employee record 
because it can be added only once. You cannot edit this field.

9. Type 5 (the field number) or press PAGE DOWN to access the third page of the 
record. Any existing edit values for .COSTCODE are listed (Figure 2.20). 

Figure 2.20—Example List of Edit Values for .COSTCODE

If you are in the display mode, the second page of the record displays 
system information (Figure 2.21). You cannot modify any of the fields 
on this page. 

Figure 2.21—.COSTCODE Definition—Page 2 of 3
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10. Type A to add an edit value. The system asks you to enter the name of the edit 
value (Figure 2.22). 

Figure 2.22—.COSTCODE Definition—Edit Value Name

11. Enter the edit value name (up to 20 alphanumeric characters) in the Edited 
Value field.

12. Press ENTER. The edit value definition page displays (Figure 2.23). 

Figure 2.23—.COSTCODE Definition—Edit Value Definition

13. Indicate if the edit value is active (Y) or inactive (N—not active, cannot be 
used).
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The In use field is a system-maintained field that indicates if the edit 
value has ever been used on an employee record.

14. Enter a description in Lookup 1 (up to 30 characters of alphanumeric text). This 
description displays in the edit value drop-down list on the Pay Calculation 
tab.

15. Enter an account mask in Lookup 2 (up to 55 characters of alphanumeric mask). 
This mask will be used in the account resolution. See Appendix C—How Does 
Payroll Resolve Accounts? on page 1.261 for examples.

16. Enter a rate in Lookup 3.

17. Press ESC to return to the Define Edit Values menu. The new edit value is listed 
and you can continue to add more edit values, if necessary. 

18. Type E to exit the edit values task. A confirmation message displays.

19. Type 0 to accept your changes. 

20. Press ESC to display the option menu.

21. Type E to close the window.

22. Click Setup > Historical Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Historical Data Items from the menu bar.
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23. Ensure that all earnings items with which you will use .COSTCODE are defined 
to allow costcodes (Figure 2.24). 

Figure 2.24—Example Earnings Item (Hourly) Defined for .COSTCODE

24. On the Payroll Information tab of the employee record, enter 1.00 in the 
Hourly rate field (see Completing the Payroll Information Tab on page 2.35) 
(Figure 2.25). Payroll multiplies the Hourly rate by the rate defined on the 
.COSTCODE edit value by the hours worked. Payroll will multiply 1.00 by the 
.COSTCODE rate and hours worked. 

Figure 2.25—Hourly Rate Defined as 1.00 on Payroll Information Tab

The Use costcode 
field is set to Y (Use 
costcode).
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25. On the Pay Calculation tab of the employee record, add .COSTCODE and 
select an edit value from the drop-down list to the Pay Calculation tab (see 
Completing the Pay Calculation Tab on page 2.43) (Figure 2.26). 

Figure 2.26—Example Costcode Entry on Pay Calculation Tab

The value displayed in the drop-down list matches the description 
entered in Lookup 1 of the data item edit value. 

26. When you are entering timesheets and select the earnings item, the edit value 
from the employee record is the default entry. If you click the drop-down arrow, 
you can see all the edit value information (Figure 2.27). 

Figure 2.27—Example Timesheet With .COSTCODE Edit Values

27. When Payroll processes the timesheet, the system uses the rate defined on the 
edit value.
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IMPLEMENTING MULTI-OCCURRING COSTCODES (COMPLEX)
Use the following steps to define your system to use the .COSTCODE data item and 
apply it multiple times to the employee record. (See Example Costcode—Multiple Rates 
Defined on Employee Record on page 1.6 for an example of this setup.)

1.  Click Setup > Payroll Parameter on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Payroll Parameter from the menu bar.

2. Enter O (Costcode with rate override used) in the Costcode field (Figure 2.28). 
The system automatically creates the .COSTCODE employee data item when 
you save the Payroll parameter. 

Figure 2.28—Example Costcode Setting “O” in Division 95 Payroll Parameter

The .COSTCODE and .COSTRATE employee data items are created 
automatically when you saved the payroll parameter. 

3. Make a list of the edit values you will use (including account masks). 

4. Click Setup > Employee Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Employee Data Items from the menu bar.

5. Type C to change the data item by entering edit values.

The Costcode field is set to 
O (Costcode w/rate override 
used).

Default Rate Item is Y. (We 
do not recommend N.)
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6. Type .COSTCODE, or press F1 and select the data item from the list. The first 
page of the .COSTCODE definition displays (Figure 2.29). 

Figure 2.29—.COSTCODE Definition—Page 1 of 3

7. If necessary, edit the Description, Short description, Default value, and Edit 
data fields (for more detailed instructions, see Defining Employee Data Items on 
page 1.118).

The setting for Multiple values is Y (Entry number used w/data item) 
indicates that this is a multi-occurring data item. In other words, each 
entry of .COSTCODE and .COSTRATE on an employee’s record is 
numbered. You cannot edit this field.
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8. Type 5 (the field number) or press PAGE DOWN to access the third page of the 
record. Any existing edit values for .COSTCODE are listed (Figure 2.30). 

Figure 2.30—Example List of Edit Values for .COSTCODE

If you are in the display mode, the second page of the record displays 
system information (Figure 2.31). You cannot modify any of the fields 
on this page. 

Figure 2.31—.COSTCODE Definition—Page 2 of 3
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9. Type A to add an edit value. The system asks you to enter the name of the edit 
value (Figure 2.32). 

Figure 2.32—.COSTCODE Definition—Edit Value Name

10. Enter the edit value name (up to 20 alphanumeric characters) in the Edited 
Value field.

11. Press ENTER. The edit value definition page displays (Figure 2.33). 

Figure 2.33—.COSTCODE Definition—Edit Value Definition

12. Indicate if the edit value is active (Y) or inactive (N—not active, cannot be 
used).
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The In use field is a system-maintained field that indicates if the edit 
value has ever been used on an employee record.

13. Enter a description in Lookup 1 (up to 30 characters of alphanumeric text). This 
description displays in the edit value drop-down list on the Pay Calculation 
tab.

14. Enter an account mask in Lookup 2 (up to 55 characters of alphanumeric mask). 
This mask will be used in the account resolution. See Appendix C—How Does 
Payroll Resolve Accounts? on page 1.261 for examples.

15. Press ESC to return to the Define Edit Values menu. The new edit value is listed 
and you can continue to add more edit values, if necessary. 

16. Type E to exit the edit values task. A confirmation message displays.

17. Type 0 to accept your changes. 

18. Press ESC to display the option menu.

19. Type E to close the window.

20. Click Setup > Historical Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Historical Data Items from the menu bar.

21. Ensure that all earnings items with which you will use .COSTCODE are defined 
to allow costcodes (Figure 2.34). 

Figure 2.34—Example Earnings Item (Hourly) Defined for .COSTCODE

The Use costcode 
field is set to Y (Use 
costcode).
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22. On the Payroll Information tab of the employee record, enter 1.00 in the 
Hourly rate field (see Completing the Payroll Information Tab on page 2.35) 
(Figure 2.35). Payroll multiplies the Hourly rate by the rate defined on the 
.COSTCODE edit value by the hours worked. Payroll will multiply 1.00 by the 
.COSTCODE rate and hours worked. 

Figure 2.35—Hourly Rate Defined as 1.00 on Payroll Information Tab

23. On the Pay Calculation tab of the employee record, add .COSTCODE and 
select an edit value from the drop-down list to the Pay Calculation tab (see 
Completing the Pay Calculation Tab on page 2.43).

The value displayed in the drop-down list matches the description 
entered in Lookup 1 of the data item edit value. 
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24. For each .COSTCODE data item, add the .COSTRATE (Cost Code Override 
Rate) data and enter the rate amount (Figure 2.26). 

Figure 2.36—Example Costcode Entry on Pay Calculation Tab

Each entry of .COSTCODE and .COSTRATE is numbered. These 
numbers link the .COSTCODE edit value with the .COSTRATE 
amount.

25. When you are entering timesheets and select the earnings item, the first edit 
value defined on the Pay Calculation tab is the default entry. If you click the 
drop-down arrow, you can see all the edit value information (Figure 2.37). 

Figure 2.37—Example Timesheet With .COSTCODE Edit Values

26. When Payroll processes the timesheet, the system uses the rate defined on for 
the .COSTRATE associated with the selected .COSTCODE (i.e., with the same 
numbers as entered on the Pay Calculation tab).
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CREATING DISTRIBUTION TABLES
Creating and using distribution tables involves a number of tasks:

• Define the payroll parameter to include the use of distribution tables.
• Define the earnings items (historical data items) that will use distribution tables.
• Define edit values for the .DIST TBL employee data item.
• Define distribution tables. (Note: the distribution table name and the edit value 

name entered on .DIST TBL must match.)
• On the Pay Calculation tab of an employee’s record, add the .DIST TBL and 

select the applicable edit value.
Use the following steps to use distribution tables in your Payroll system. 

1.  Ensure that the payroll parameter Dist Tables field holds Y (Distribution tables 
are used). 

If the field holds this value, the .DIST TBL employee data item was 
created automatically when you saved the Payroll parameter. 

2. Click Maintenance > Historical Data Items on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Maintenance > Historical Data Items from the menu bar.

3. Define the earning items that will use distribution tables to contain a Y for the 
field titled Use dist table (Figure 2.38).

Figure 2.38—Example Earnings Item (Salary) Defined to Use Distribution Tables

The Use dist table 
field is set to Y (Use 
distribution tables).
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4. Click Maintenance > Distribution Tables on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Maintenance > Distribution Tables from the menu bar.

5. Type A to add a distribution table.

6. Enter the name of the distribution table (up to 10 alphanumeric characters).

7. Complete the required fields according to Table 2.8. 

Table 2.8—Field Definitions for Distribution Tables

Field Valid Entry Definition

Entry 1–999 User-defined line item number for the table.

Distribution mask mask The account or account mask for the line item.

Addtl basis Historical data items The additional items that will use the earning for this 
distribution as basis for their calculation.
• This field is optional.

Percentage % The percentage for the line item (e.g., 50.0000 for 
50%). The percentages must total to 100.
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Figure 2.39 shows an example distribution table added to Division 95 for the 
edit value defined in Figure 2.40. 

Figure 2.39—Example Distribution Table 1

8. Press ESC to return to the Define Distribution Tables menu.

9. Type E to save your entries and return to the Payroll/Personnel > 
Maintenance menu.

10. Produce the Distribution Tables List (PYSTDST) (Reports > Master Record 
Lists Distribution Tables List). You will use this to ensure that the table name 
entered as an edit value on the .DIST TBL data item matches exactly the name 
of the distribution table. (For more information on this report, see Producing the 
Distribution Tables List on page 2.168.)

11. Click Maintenance > Edit Values on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Maintenance > Edit Values from the menu bar.

12. Type A to add an edit value for to the .DIST TBL employee data item.
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13. Type .DIST TBL, or press F1 and select the data item from the list. Figure 2.40 
shows an example edit value for the .DIST TBL data item in Division 95. 

Figure 2.40—Example .DIST TBL Edit Value for Division 95

14. In the Edited value field, enter the name of the distribution table as defined in 
the distribution table definition. (The entries must match exactly.)

15. Indicate if the edit value is active (Y) or inactive (N—not active, cannot be 
used).

The In use field is a system-maintained field that indicates if the edit 
value has ever been used on an employee record.

16. Enter a description in Lookup 1 (up to 30 characters of alphanumeric text). This 
description displays in the edit value drop-down list on the Pay Calculation 
tab.

17. Press ESC to return to the Define Edit Values menu.

18. Type E to save your entries and return to the Payroll/Personnel > 
Maintenance menu.
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19. As you add employee records (see Adding Employees on page 2.31), add the 
distribution table to the Pay Calculation tab (see Completing the Pay 
Calculation Tab on page 2.43). Figure 2.41 shows an example employee record 
with the distribution table edit value that we defined earlier (see Figure 2.40). 

Figure 2.41—Example Distribution Table Entry on Pay Calculation Tab

The value displayed in the drop-down list matches the description 
entered in Lookup1 of the data item edit value. The program matches 
the name of the edit value that you select with the name of the 
distribution table to apply the correct distribution.

Now you can create your timesheets:
• Create Group Timesheets—The distribution table on the employee record is 

used.
• Enter/Edit Single Timesheets—The default distribution table is entered 

automatically when you select an earnings item defined for distribution tables. 
You can override this setting.
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DISTRIBUTION TABLES AND ERRORS

If a timesheet has any errors, a message will display in the Account detail area (Figure 
2.42). You must correct the errors before you can continue processing the timesheet. 

Figure 2.42—Example Basis for Selected Line Area

CREATING DEPARTMENTALIZED EARNINGS
Use the following steps to set up Departmentalized Earnings. 

1.  Click Setup > Payroll Parameter on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Payroll Parameter from the menu bar.

2. Type A to enter information or C to change existing information.

Once you define your employees, you will be restricted in how you can 
change the earning type settings. 

3. Type 2 for the earning type in the Configuration field. 

4. Make a list of the departments and General Ledger accounts that you will use. 

5. Click Maintenance > Edit Values on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Maintenance > Edit Values from the menu bar.

6. Define edit values for: 
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• .S DEPT and .S GLA
• .H DEPT and .H GLA
• .O DEPT and .O GLA

7. Enter the name of the data item, or press F1 and select the data item from the 
list. 

8. Press ENTER. The system asks you to identify the new edit value (Figure 2.43). 

Figure 2.43—Entering the Edit Value Name
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9. In the Edited value field, enter the name of the edit value and press ENTER. The 
system displays the remaining fields of the edit value (Figure 2.44). 

Figure 2.44—Entering the Edit Value Information

10. Indicate if the edit value is active (Y) or inactive (N—not active, cannot be used) 
and press ENTER.

The In use field is a system-maintained field that indicates if the edit 
value has ever been used on an employee record.

11. Enter a description in Lookup 1 (up to 30 characters of alphanumeric text). This 
description displays in the edit value drop-down list on the Accounting 
Information tab.
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12. Enter an account mask in Lookup 2 and press ENTER (Figure 2.45). The edit 
value is added to your system. 

Figure 2.45—Entering an Account Mask for Lookup 2

This mask will be used in the account resolution. If you do not enter an 
account number, the system will default to an account with a full mask 
(e.g., AXX XX-XX XXXX) when you leave the field. See Appendix 
C—How Does Payroll Resolve Accounts? on page 1.261 for examples. 

13. Press ESC to return to the Define Edit Values menu.

14. Type E to save your entries and return to the Payroll/Personnel > 
Maintenance menu.
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15. As you add or edit employee records, add the departmentalization information 
to the Accounting Information tab (Figure 2.46). For more information, see 
Completing the Accounting Information Tab on page 2.38. 

Figure 2.46—Example Use of Soccer Field Edit Value

Because you have defined the Salary, Hourly, and/or Other earning type 
as departmentalized, Payroll allows you to enter multiple definitions for 
your salary, hourly, or other settings. However, every entry must 
include a percentage. Non-departmentalized Salary, Hourly, and/or 
Other earning types allow only one entry (i.e., 100% to a single 
department, GLA, and Additional basis for).

 

Creating Departmentalized Earnings 



C H A P T E R  3

USING DATA ITEMS

Data items are the heart of the FundWare Payroll/Personnel module. There are two 
types of data items:

• Historical data items (HDIs), and
• Employee data items (EDIs).

Historical data items:
• Are updated each time you process your payroll.
• Contain the calculation commands and “do the work” when you process your 

payroll.
• Contain the “rules” for building (or compiling) the account to which payroll 

expenses are posted in General Ledger.
• Often use EDIs as well as other HDIs in their definition.

Employee data items:
• Comprise the employee record (i.e., every field on the employee record is an 

EDI).
• Store static values; these values are not updated when you process your payroll.
• Are often used by HDIs in the payroll calculations.

SYSTEM-DEFINED VS. USER-DEFINED DATA ITEMS
There are certain system-defined historical and employee data items that are installed 
with your FundWare Payroll/Personnel module. You can identify system-defined data 
items by the period (or “dot”) at the beginning of the data item name (e.g., .EARN stores 
groupings of earnings, .EMPLOYEE stores the employee number, .DOB stores the date 
of birth).
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SYSTEM-DEFINED HDIS
Four system-defined historical data items are installed with the module:

• .DED—Grouping of deductions
• .EARN—Grouping of earnings
• .OTHER—Grouping of other 
• .TAX—Grouping of taxes

All other system-defined HDIs are installed with the ToolBox (see Updating the 
ToolBox on page 1.233). These data items involve taxes for Federal, state, and state 
taxing authorities.

SYSTEM-DEFINED EDIS
A number of system-defined employee data items are included with Payroll. Table 3.1 
lists the system-defined employee data items that comprise the employee record (with 
the exception of the Pay Calculation tab). 

Table 3.1—System-Defined Employee Data Items Comprising the Employee Record

Data Item Range Description

.ADDR 1 ________ to ________ First line of street address

.ADDR 2 ________ to ________ Second line of street address

.CITY ________ to ________ City

.CONTACT A ________ to ________ Name of alternate emergency contact

.CONTACT E ________ to ________ Name of emergency contact

.COUNTRY ________ to ________ Country

.DOB 00/00/0000 to 99/99/9999 Date of birth

.DOH 00/00/0000 to 99/99/9999 Date of hire

.DOP 00/00/0000 to 99/99/9999 Date of probation

.DOR 00/00/0000 to 99/99/9999 Date of last review

.DOT 00/00/0000 to 99/99/9999 Date of termination

.EFT ACCT ________ to ________ EFT Bank Account number

.EFT ACT ________ to ________ EFT active flag
System-Defined vs. User-Defined Data Items 
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.EFT APR ________ to ________ EFT amount, percent, remainder

.EFT CYCLE ________ to ________ EFT cycle

.EFT DFI ________ to ________ EFT bank transit/routing #

.EFT DP ________ to ________ EFT deposit (checking, savings) or payment

.EFT NBR 1 to 9999999999999.99 EFT amount or percent

.EFT SEL ________ to ________ EFT selection value

.EMPLOYEE 1 to 999999999 Employee number

.H AMT –9999999999999.99 to 
9999999999999.99

Hourly rate of pay

.H DEPT ________ to ________ Name of department–hourly earnings

.H GLA ________ to ________ Name of GLA or object code for hourly earnings

.H GRP ________ to ________ Employee additional basis

.H HRS –999999999.999999 to 
999999999.999999

Normal hours worked

.H PCNT –9999999999999.99 to 
9999999999999.99

Percent expensed–hourly earnings

.HM DEPT ________ to ________ Employee’s home department

.MARITAL ________ to ________ Marital status

.NAME FST ________ to ________ First name

.NAME LFM ________ to ________ Last name, first name, and middle name

.NAME LST ________ to ________ Last name

.NAME MI ________ to ________ Middle initial

.O AMT –999999999.999999 to 
999999999.999999

Rate of pay–other type earnings

.O DEPT ________ to ________ Name of department–other earnings

.O GLA ________ to ________ Name of GLA or object code for other earnings

.O GRP ________ to ________ Employee additional basis

Table 3.1—System-Defined Employee Data Items Comprising the Employee Record (Continued)

Data Item Range Description
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.O PCNT –999999999.999999 to 
999999999.999999

Percent expensed–other earnings

.PHONE ALT (000)000–0000 to 
(999)999–9999

Alternate emergency phone number

.PHONE EMG (000)000–0000 to 
(999)999–9999

Emergency phone number

.PHONE HME (000)000–0000 to 
(999)999–9999

Home phone number

.POSTAL ________ to ________ Postal code

.S AMT –9999999999999.99 to 
9999999999999.99

Salary amount

.S DEPT ________ to ________ Name of department–salaried employees

.S GLA ________ to ________ Name of GLA or object code for salaried 
earnings

.S GRP ________ to ________ Employee additional basis–salaried

.S PCNT –999999999.999999 to 
999999999.999999

Percent expensed–salaried employees

.SEX ________ to ________ Gender

.SHIFT –999999999.999999 to 
999999999.999999

Shift differential

.STATUS ________ to ________ Employment status (active, leave, or 
terminated)

.STATUS P ________ to ________ Payment status (full-time, part-time, or 
seasonal)

.STP ________ to ________ State, territory, or province

.T FREQ ________ to ________ Pay frequency

.T TID ________ to ________ Social security number

.TRC DATE 00/00/0000 to 99/99/9999 Date of last change to employee’s record

.TRC USER 1 to 9999999999 Number of user who made last change to record

Table 3.1—System-Defined Employee Data Items Comprising the Employee Record (Continued)

Data Item Range Description
System-Defined vs. User-Defined Data Items 
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Certain employee data items are created when you define your payroll parameter. These 
data items must be added manually to the Pay Calculation tab (Table 3.2). 

WHAT ARE HISTORICAL DATA ITEMS?
Historical data items maintain employee data for current and historical earnings, taxes, 
and deductions and are updated each time you process the payroll. For each item printed 
on the checks and maintained in employee history, there must be an associated HDI. 
There are four types of historical data items:

• Earnings—Record dollars, hours, or other pay units earned by the 
organization’s employees (i.e., an increase to gross pay). Hourly and salaried 
earnings, overtime, double time, and vacation hours are commonly used 
earnings. 

• Taxes—Deducted from employee earnings (i.e., a reduction of gross pay to net 
pay) as mandated by the state and local taxing authorities applicable to your 
organization. 

• Deductions—Taken out of employee checks to reimburse the employer for 
expenses paid on behalf of the employee, such as health insurance (i.e., a 
reduction of gross pay to net pay). Deductions may also be for a voluntary gift 
to a non-profit organization such as United Way or a contribution to a savings 
plan such as 401K. 

• Other—Employer’s Cost—Used to record employer cost items and benefits 
(e.g., employer’s portion of FICA or Medicare). Does not impact gross or net 
pay.

Table 3.2—System-Defined Employee Data Items Created During Setup

Data Item Range Description

.COSTCODE ________ to ________ Costcode
• Only added to your system when you define 

your setup to use costcodes.

.COSTRATE ________ to ________ Cost rate
• Only added to your system when you define 

your setup to use costcodes with rate override 
(option O on the Payroll parameter).

.DIST TBL ________ to ________ Distribution table
• Only added to your system when you define 

your setup to use distribution tables.
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Historical data item definitions contain information such as name, type, calculation 
frequency and priority, roll forward options, posting to the General Ledger, calculations, 
and rates and tables. HDIs also contain the “rules” for building (or compiling) the 
account number.

Not all historical data items have calculations, rates, and tables. As a general 
rule, earnings do not have calculations and tables, but taxes, deductions, and 
other data items do.

Table 3.3 summarizes the use of each type of historical data item.

RULES FOR HISTORICAL DATA ITEMS

The following rules apply when you add historical data items:

Table 3.3—Types of Historical Data Items

Type Data Task Accounting Examples

Earning Hours, 
dollars, or 
units

Selected when you 
produce single or 
group timesheets.

Determines the debit 
portion of the 
timesheet, usually a 
wage expense 
account.
• Increases gross pay.

Salary, hourly, overtime, 
double time, bonuses, 
vacation time, sick time, 
and per-piece wages.

Tax Dollars Calculated during 
Calculate Net Pay. 
May also be entered 
through One-time 
Deductions.

Determines the credit 
portion of a tax entry. 
Usually a tax liability 
account.
• Decreases gross 

pay to net pay.

FWT, state taxes, FUTA, 
and FICAMED.

Deduction Dollars Calculated during 
Calculate Net Pay 
or entered through 
One-time 
Deductions.

Determines the credit 
portion of a deduction 
entry. Usually a 
deduction liability 
account.
• Decreases gross 

pay to net pay.

401K, PERA, insurance, 
and garnishments.

Other Dollars Calculated during 
Calculate Net Pay.

Determines both the 
debit and credit portion 
of employer cost items 
or benefits.
• No impact to gross 

or net pay.

Employer’s portion of 
FICA, FICAMED, or 
SUTA. Benefits such as 
health and dental 
insurance that are 
company paid.
What Are Historical Data Items? 
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• Because historical data items and employee data items for a division reside in 
the same data file (##CID, where ## represents the division number), an 
historical data item and an employee data item cannot have the same name.

• Once a data item is added to setup, you cannot remove it from your system.
• Always test data items in a test division before adding them to the live division 

and using them in an actual payroll. (Because you can’t remove a data item once 
you’ve added it, this allows you to test the data item first, without impacting 
your live data.)

• Do not wait until a payroll is in process to add a new data item. (In other words, 
always complete your payroll process before adding a new data item.)

• Print and keep hard copies of all data item definitions. If you have some system 
problem, this will help you recreate the data items. (You can print your data 
items using the Historical Data Items List report in Report Manager.)
— When you edit a data item definition, print an updated copy of the 

definition, but keep the original printout of the definition.
• There are certain ToolBox data items that are used by the system to summarize 

all activity each pay period by history type. Do not use these data items to add a 
new data item to your division:
— .DED,
— .EARN,
— .OTHER, or
— .TAX.
For more information on the ToolBox, see What Is the ToolBox? on page 1.84.

• When you add a data item from the ToolBox, the first five characters of the data 
item name (before any spaces) must be unique (e.g., HLTH1, HLTH2)
— EDIs automatically created by HDIs added from the toolbox use the first 

five characters of the HDI name, followed by a space and a descriptor (e.g., 
amt, lamt, rate). For example, the system would create EDIs of HLTH1 
AMT and HLTH2 AMT for HDIs HLTH1 and HLTH2. If you have HDIs 
called HLTH 1 and HLTH 2, the system would create only one EDI called 
HLTH AMT.

For more information on the ToolBox, see What Is the ToolBox? on page 1.84.

CREATING NEW DATA ITEMS BASED ON EXISTING DATA ITEMS

When you create new historical data items, you have the option of using existing data 
items as a “template.” After you enter the name of the new HDI, you will be offered one 
or two options:
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• Use data item—Allows you to select from the existing ToolBox HDIs. 
(Remember: ToolBox HDIs are not associated with specific divisions until you 
copy them to your system. They are not the same as division-specific HDIs.)
— If you use a ToolBox HDI as a template for your new HDI, the system will 

create any associated employee data items.
• Copy data item—Allows you to select from the existing HDIs defined for the 

division.
— If you use a division-specific HDI as a template for your new HDI, the 

system will not create any associated employee data items.
Because the ToolBox HDIs and the division HDIs are not the same, you might 
think you have a data item in your division, when in reality you have a similar 
data item in the ToolBox. Make sure you are looking at your division and not in 
the ToolBox when you are modifying an HDI.

TIPS AND TRICKS FOR HISTORICAL DATA ITEMS

The following tips will help you when you add new historical data items:
• When table rates change, add a new table using the same number so that the 

calculation table commands do not need to be changed.
• Do not remove the old table with the expired effective date; keep the history of 

at least one prior year.
• To create earnings items, copy from existing HDIs as much as possible. You 

should try to create all other types of HDIs (i.e, deductions, taxes, and other 
HDIs) by copying a template from the ToolBox.

• The data item description and short description are not required to be unique 
(i.e., the system won’t stop you from using the same description or short 
description on multiple data items). However, because these descriptions 
display within the system, you should try to keep these descriptions unique so 
that you can make the correct selections.

WHAT IS THE TOOLBOX?
The ToolBox is a set of predefined earnings, taxes, deductions, and employer costs 
(historical and employee data items) that you can use as a template to add HDIs to your 
system during setup or to update your system periodically. Use of ToolBox items can 
greatly reduce the amount of time required to setup a new payroll. Additionally, 
American Fundware, Inc. updates the ToolBox data items at the beginning of each year. 
(As necessary, we also may update ToolBox throughout the year.) 
For more information on the ToolBox, see:
What Are Historical Data Items? 



Chapter 3—Using Data Items
• Adding HDIs From the ToolBox on page 1.104, and
• Updating the ToolBox on page 1.233.

DEFINING HISTORICAL DATA ITEMS
When you define a new historical data item, you can base the new HDI on any of your 
existing user- or system-defined HDIs. This is extremely helpful if you are adding a 
number of related new historical data items. 

You must define the Payroll parameter before you can add user-defined 
historical data items.

Use the following steps to define a historical data item. 
1.  Click Setup > Historical Data Items on the module navigator (if the module is 

not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Historical Data Items from the menu bar.

2. Type A to add a new historical data item. The system asks for the name of the 
new data item (Figure 3.1). 

Figure 3.1—Entering the Historical Data Item Name

3. Enter the name of the data item. This name can be up to 10 alphanumeric 
characters long.

4. Press ENTER. The system asks if you want to use an existing ToolBox data item 
as a template for the new data item.
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• If you do not want to use an existing ToolBox data item as a template for 
the new data item, press ENTER. You skip to step 6 on page 1.86. 

5. Enter a data item name or press F1 to view your existing ToolBox data items 
and select from the list (Figure 3.2). (The system will use the selected ToolBox 
data item as a “template” for your new data item.) 

Figure 3.2—Sample List of ToolBox Data Items in Division 95

The F1 list displays only those data items in the ToolBox. Do not 
mistake this for a list of data items in your division. These data items do 
not exist in your division unless you have added them manually.

6. Press ENTER. The system asks if you want to copy an existing division data item 
as a template for the new data item. This will only display if you did not select a 
ToolBox data item in the previous step.

• If you do not want to use an existing division data item as the basis for the 
new data item, press ENTER. You skip to step 8 on page 1.87. 

The F1 list displays only those data items in your division. ToolBox 
data items are not included in this list.

Example ToolBox data 
item templates
Defining Historical Data Items 
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7. Enter a data item name or press F1 to view your existing data items for the 
division and select from the list (Figure 3.3). 

Figure 3.3—Sample List of Data Items for Division 95

8. Press ENTER. Page 1 of the Define Historical Data Items record displays (Figure 
3.4). 

The information displayed on this and all subsequent pages will reflect 
your selection to use, copy, or create the data item from scratch. In 
other words, if you “used” or “copied” from an existing data item 
(ToolBox or divisional), the information in the original data item will 
populate the fields of the new data item. You can change this 

Example data items for 
Division 95
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information as necessary. If you did not select any existing data item as 
a basis for the new data item, the fields should be blank. Press CTRL + 
HOME to delete inaccessibly information 

Figure 3.4—Example Historical Data Item Based on .E FICA, Page 1 of 7

9. Complete the entries for Fields 1–3 according to Table 3.4. 

Table 3.4—Historical Data Items Field Definitions—Fields 1–3

Field Options Definition

Desc 30 
alphanumeric 
characters

Description of the data item.
• You will see both the data item name and description in the Earnings 

Item drop-down list during timesheet entry an don the Pay 
Calculation tab.

Short desc 15 
alphanumeric 
characters

Brief description that prints on the check stub.
Defining Historical Data Items 



Chapter 3—Using Data Items
User options

History Type E—Earnings • Increases net pay (i.e., is added to paycheck).
• Uses entries in Earning Options field 4.
• Is the key to building the account number for “prorate on” items 

during Calculate Net Pay process.
• May or may not Post G/L in field 6.
• If Post G/L setting is Y, uses Debit option in field 6 (usually a wage 

expense account).
• Available in the Earnings Item drop-down list during timesheet entry 

for group and single timesheets.

D—Deductio
n

• Decreases net pay (i.e., is subtracted from paycheck). (A negative 
deduction increases net pay.)

• Not used for legally required withholdings (i.e., taxes).
• Post G/L setting in field 6 must be Y.
• Uses Credit option in field 6 (usually a liability account).
• Available for use by One-Time Deduction entry during Net Pay 

Calculations.

T—Tax • Decreases net pay (i.e., is subtracted from paycheck), similar to D-
deductions. (A negative tax increases net pay.)

• Used for legally required withholdings, (i.e., taxes).
• Post G/L setting in field 6 must be Y.
• Uses Credit option in field 6 (usually a liability account).
• Available for use by One-Time Deduction entry during Net Pay 

Calculations.

O—Other 
(employer 
costs and 
benefits)

• Does not affect net pay (i.e., no impact to paycheck).
• Used for employer costs.
• Post G/L setting in field 6 may be Y or N.
• If Post G/L setting is Y, uses both Debit option (usually an expense 

account) and Credit option (usually a liability account) in field 6.

Calc cycle N No calculation used. Earnings do not normally have calculations.

Y Calculation is executed each time the Calculate Net Pay task is used.

1–9 Calculation is executed when Calc Cycle is activated during Calculate 
Net Pay.
• Assign a calc cycle number to HDIs that are not calculated with every 

payroll.

Table 3.4—Historical Data Items Field Definitions—Fields 1–3 (Continued)

Field Options Definition
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Calc order 1–999 The order in which the calculation is processed during the Calculate 
Net Pay task. The task begins with 1 and continues numerically 
through the calculations. 
• This number does not need to be unique for every HDI. When HDIs 

have the same calc order, the data item number is used as a 
secondary calc order.

• If an HDI needs to be calculated for it to be used by another HDI’s 
calculation, make suer that the calc order is unique (i.e., do not rely 
on the data item number).

Following a standard format will help you when you contact Support. 
Therefore, we suggest you follow this Calc order format:
• 100–199—Earnings
• 200–299—Tax-deferred (i.e., pre-tax) deductions
• 300–399—Taxes 
• 500–599—Deductions
• 700–799—Other

Print on stub N Do not print historical data item on check stub.
• Typically used for HDIs of type “other.”

Y Print historical data item on check stub.
• Typically used for earnings, taxes, and deductions.

Detail 
register

N Do not produce detail register when checks are produced.

Y Produce detail register when checks are produced. 
• Detail registers are selected with the Preliminary Check Register and 

Final Check Register during the check writing process.
• Detail registers are by data item for all HDIs that have activated this 

feature (as opposed to the check register, which is by employee).
• Tip: During setup, set this to Y for all items for verification. It can be 

changed later.

Post to 
vendor

0 (zero) Do not post the historical data item to an AP vendor.

vendor 
number

Post the historical data item to the AP vendor number entered (i.e., 
create an obligation for the vendor number entered here each time 
checks are produced).
• The vendor must already exist in AP.
• The Post to AP setting in the Payroll parameter (field 2) must be Y for 

this feature to be active.

Table 3.4—Historical Data Items Field Definitions—Fields 1–3 (Continued)

Field Options Definition
Defining Historical Data Items 
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10. Press ENTER or PAGE DOWN to move to the next field. If the new data item is an 
earnings type (as determined by the History type setting in field 1), page 2 of the 
Define Historical Data Items record displays (Figure 3.5). 

Figure 3.5—Example Earning Historical Data Item, Page 2 of 7

This field is only required for certain data items. It it does not display, 
skip to step 12 on page 1.97.
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11. If applicable, complete the entries for Field 4, which determine your earning 
options, according to Table 3.5. 

Table 3.5—Historical Data Items Field Definitions—Field 4

Field Options Definition

Earning Options

Entry type The entry type determines how the account number is built (i.e., compiled).
The following entries are rate override options. When you are entering timesheets, you 
can change the default rate for an employee by entering an override rate.

N No timesheet entry is used. Usually used for taxes, deductions, and 
other items.

H Hours are entered during timesheet entry. Defaults are .H DEPT, .H 
GLA, and .H AMT. Entry is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

A Amount (dollars) entered during timesheet entry. Defaults are .S DEPT, 
.S GLA, and .S AMT. Entry is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Salary option 

on the Accounting Information tab on the employee record.

O Units (other) are entered during timesheet entry. Defaults are .O DEPT, 
.O GLA, and .O AMT. Entry is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Other option 

on the Accounting Information tab on the employee record.
Defining Historical Data Items 
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Entry type 1 Dated hours—Hours are entered during timesheet entry. Defaults are .H 
DEPT, .H GLA, and .H AMT. Entry is dated and numbered: 01/01/2004 
timesheet 1, 01/15/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

2 Clocked hours—Hours are entered during timesheet entry. Defaults are 
.H DEPT, .H GLA, and .H AMT. Entry is dated, clocked and In or Out: 01/
01/2004, 0800, In; 01/15/2004, 1200, Out.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

3 Dated amount—Amounts are entered during timesheet entry. Defaults 
are .S DEPT, .S GLA, and .S AMT. Entry is dated and numbered: 01/01/
2004 timesheet 1, 01/15/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

4 Clocked amounts—Amounts are entered during timesheet entry. 
Defaults are .S DEPT, .S GLA, and .S AMT. Entry is dated, clocked and 
In or Out: 01/01/2004, 0800, In; 01/15/2004, 1200, Out.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

5 Dated units—Units are entered during timesheet entry. Defaults are .O 
DEPT, .O GLA, and .O AMT. Entry is dated and numbered: 01/01/2004 
timesheet 1, 01/15/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

6 Clocked units—Amounts are entered during timesheet entry. Defaults 
are .O DEPT, .O GLA, and .O AMT. Entry is dated, clocked and In or 
Out: 01/01/2004, 0800, In; 01/15/2004, 1200, Out.
• Payroll will only look at the information entered under the Other option 

on the Accounting Information tab on the employee record.

Table 3.5—Historical Data Items Field Definitions—Field 4 (Continued)

Field Options Definition
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Entry Type 
(continued)

The following entries are rate override options. When entering timesheets, you can 
override the default rate for an employee.

7 Hours on cards/rate override. Hour rate can be overridden during 
timesheet entry. Defaults are .H DEPT, .H GLA, and .H AMT. Entry is 
numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

8 Dated hours/rate override. Hour rate can be overridden during timesheet 
entry. Defaults are .H DEPT, .H GLA, and .H AMT. Entry is dated and 
numbered: 01/01/2004 timesheet 1, 01/01/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

9 Clocked hours/rate override. Hour rate can be overridden during 
timesheet entry. Defaults are .H DEPT, .H GLA, and .H AMT. Entry is 
dated, clocked and In or Out: 01/01/2004, 0800, In; 01/01/2004, 1200, 
Out.
• Payroll will only look at the information entered under the Hourly option 

on the Accounting Information tab on the employee record.

X Other on cards/rate override. Other rate can be overridden during 
timesheet entry. Defaults are .O DEPT, .O GLA, and .O AMT. Entry is 
numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Other option 

on the Accounting Information tab on the employee record.

Y Dated other/rate override. Other rate can be overridden during timesheet 
entry. Defaults are .O DEPT, .O GLA, and .O AMT. Entry is dated and 
numbered: 01/01/2004 timesheet 1, 01/01/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Other option 

on the Accounting Information tab on the employee record.

Z Clocked other/rate override. Other rate can be overridden during 
timesheet entry. Defaults are .O DEPT, .O GLA, and .O AMT. Entry is 
dated, clocked and In or Out: 01/01/2004, 0800, In; 01/01/2004, 1200, 
Out.
• Payroll will only look at the information entered under the Other option 

on the Accounting Information tab on the employee record.

Table 3.5—Historical Data Items Field Definitions—Field 4 (Continued)

Field Options Definition
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Rate from 10-character 
employee 
data item 
name

The employee data item containing the amount or rate value used by the 
earning during timesheet entry.
• Entry types H, 1, 2, and 7–9—Default to .H AMT. 
• Entry types A, 3, and 4—Default to .S AMT. 
• Entry types O, 5, 6, X, Y, and Z —Default to .O AMT.
If you leave this field blank (i.e., no default), you must manually enter the 
rate for this earnings item on each single timesheet.

Multiply by $ – amount The factor to by which earnings are multiplied. 
• Default is 1.0.
• Overtime multiplier is 1.5.
• Double-time multiplier is 2.0. 

Use shift .SHIFT The employee data item .SHIFT contains edit values that are added to 
the employees per hour or per unit rate when you enter timesheets. You 
may want to use this option if:
• You have employees who work different shifts throughout a pay 

period, and
• Those shifts have different rates of pay.
This option is only available if the Shift Emps setting is Y in field 1 of the 
Payroll parameter.

Use 
costcode

This field only displays if you have defined the Payroll parameter to use 
costcodes.

Y The earning uses costcodes to build the account number when you 
enter timesheets.

N The earning does not use costcodes to build the account number when 
you enter timesheets.
• The account number entered on the mask line in field 6 (full account; 

no masking characters), or
• The distribution table. 

Table 3.5—Historical Data Items Field Definitions—Field 4 (Continued)

Field Options Definition
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Use dist 
tables

This field only displays if you have defined the Payroll parameter to use 
costcodes.

Y The earning uses distribution tables to build the account number when 
you enter timesheets.

N The earning does not use distribution tables to build the account number 
when you enter timesheets. The account number is built from:
• The account number entered on the mask line in field 6 (full account; 

no masking characters), or
• The costcode. 

Chg acct/
basis

N You cannot change the account number and basis for fields when you 
enter timesheets.

Y You can change the account number and basis for fields when you enter 
timesheets.
• During setup, set to Y to allow you to correct problems quickly. Once 

your payroll is running without account number and basis errors, 
change this setting to N.

Basis for 110 
alphanumeric 
characters

The taxes, deductions, and employer costs to which an earning is 
subject. Completed only for earnings type historical data items. 
• Basis for and Additional basis for on the employee’s record are added 

together to create the total basis. Separate items in the basis by 
commas. For example:
— .FWT, .FICA, .E FICA, .E FICAMED, .SWT CO

• Type carefully! The program will not check your spelling of the data 
items.

Table 3.5—Historical Data Items Field Definitions—Field 4 (Continued)

Field Options Definition
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12. Press ENTER or PAGE DOWN to move to the next field. Page 3 of the Define 
Historical Data Items record displays (Figure 3.6). 

Figure 3.6—Example Historical Data Item Based on .E FICA, Page 3 of 7

13. Complete the entries for Field 5, which determine your roll options (for items 
with balances that carry forward to the new calendar year, such as vacation and 
comp time), according to Table 3.6. 

Table 3.6—Historical Data Items Field Definitions—Field 5

Field Options Definition

Roll Options

Roll forward Typically, the only types of HDIs that you will roll forward are leave balances, loan 
balances, and longevity counters.
Roll forward is for the calendar year only; it is not tied to your organization’s fiscal year.

N Do not roll balance forward to new calendar year.

H Roll hours forward to new calendar year.

A Roll amount balance forward to new calendar year.

B Roll both hours and amount balances forward to new calendar year.

Amount limit $ – 
amount

If the Roll forward option is A or B, enter the maximum amount that can 
be carried forward to the new year.

Hours limit R – rate If the Roll forward option is H or B, enter the maximum number of hours 
that can be carried forward to the new year.
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14. Press ENTER or PAGE DOWN to move to the next field. Page 4 of the Define 
Historical Data Items record displays (Figure 3.7). 

Figure 3.7—Example Historical Data Item Based on .E FICA, Page 4 of 7

15. Complete the entries for Field 6, Ledger options, according to Table 3.7. These 
entries determine the accounts an item uses in the General Ledger. 

Table 3.7—Historical Data Items Field Definitions—Field 6

Field Options Definition

Ledger Options

Post G/L The field’s default will depend on the data item’s History type (in field 3 of the 
definition).
• Only history type O—Other (employer costs and benefits) will allow you to enter a 

setting in this field.
• Data items that debit cannot use the same account mask as data items that credit. In 

this instance, you should enter N—Do not post to General Ledger. 

N Do not post to General Ledger

Y Post to General Ledger
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Debit option • Used when Post G/L setting is Y.
• Used by HDI history types E—Earnings or O—Other (employer costs and benefits).

A Use account from Mask field (defined later in this task). For 
departmentalized setup, the account number cannot contain any Xs (i.e., 
no characters can be masked). 

D Use department from the employee record (or costcode or distribution 
table) and GLA from mask. For history type E—Earnings only.

G Use GLA from the employee record (or costcode or distribution table) 
and department from mask. For history type E—Earnings only.

B Use both the department and GLA on the employee record (or costcode 
or distribution table). 

P Prorate based on the dollars in the historical data items listed in Prorate 
on. Can be combined with portions of the Mask.
• Prorated items are not entered on the timesheet. They are applied 

when you calculate net pay.
•  Entry type (field 4) must be N (no timesheet entry used) if you define a 

Calc cycle (field 3).

H Prorate based on the hours in the historical data items listed in the 
Prorate on. Works the same as Prorate option P except the hours or 
units are used instead of the amounts. Whether hours or units are used 
is based on the individual data items listed in the Prorate on field.
• Prorated items are not entered on the timesheet. They are applied 

when you calculate net pay. 
• Entry type (field 4) must be N (no timesheet entry used) if you define a 

Calc cycle (field 3).

• Prorate on 10-
character 
historical 
data item 
name(s)

Contains the historical data items to use as a base. The account number 
is completed using these data items to complete the account mask (next 
field).
• The option is only available if the Debit Option is to prorate on 

amounts or hours options (i.e., P or H).
• Separate items with commas.
• Type carefully! The program will not check your spelling of the data 

items.

Table 3.7—Historical Data Items Field Definitions—Field 6 (Continued)

Field Options Definition
Blackbaud, Inc. 1.99



Blackbaud FundWare Payroll/Personnel Guide—Volume 1

1.100
• Mask 55-
character 
account or 
account 
mask

The contents of this field are combined with the Debit option to build 
accounts. For earnings HDIs (i.e., history type E—Earnings), the field 4 
earning options can also be used to build accounts.
Following are example entries for this field, based on the selected Debit 
option:

• Debit option: A—You must enter a complete account number (i.e., no 
masked characters)
— A01 00-00 6110

• Debit option: D—Mask the department but define the GLA
— AXX XX-XX 6110

• Debit option: G—Mask the object code but define the department
— A01 00-00 XXXX

• Debit option: B—Mask the department and GLA dimensions:
— AXX XX-XX XXXX

• Debit option: P/H—Mask the dimensions filled by the proration. 
— If the proration is on department and the GLA is 6170, the Mask 

is AXX XX-XX 6170
— The masked characters will be resolved by the HDIs in the 

Prorate On field.

Table 3.7—Historical Data Items Field Definitions—Field 6 (Continued)

Field Options Definition
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Credit 
Options

Completed for taxes, deductions, and other type historical data items.
• Used when Post G/L setting is Y.
• Used by history types D—Deduction, T—Taxes, and O—Other (employer costs and 

benefits.

A Use account from Mask.

D Use first department from the employee record and the GLA from Mask. 
Searches for the department in this order: .H DEPT, .S DEPT, .O DEPT.

G Use the first GLA from the employee record and the department from 
Mask. Searches for the GLA in this order: .H GLA, .S GLA, .O GLA.

B Use both the first department and the first GLA on the employee record.

P Prorate based on the dollars in the historical data items listed in Prorate 
on. Can be combined with portions of the Mask.

H Prorate based on the hours in the historical data items listed in Prorate 
on. Works the same as the Prorate option above except the hours or 
units are used instead of the amounts. Whether hours or units are used 
is based on the individual data items listed in the Prorate on field.

• Prorate on 10-
character 
historical 
data item 
name(s)

Contains the historical data items to use as a base.
• The option is only available if the Credit Option is to prorate on 

amounts or hours options (i.e., P or H).
• Separate items with commas.
• Type carefully! The program will not check your spelling of the data 

items.

• Mask 55-
character 
account or 
account 
mask

The contents of this field are combined with the Credit option to build 
accounts. These rules shown in the following table:

• A—An account definition such as 01 00-00 2110.

• D—Xs with a defined GLA such as XX XX-XX 2110.

• G—Defined department with a masked object code such as 01 00-00 
XXXX.

• B—Xs for department and GLA dimensions. 
XX XX-XX XXXX.

• P/H—Xs for the dimensions not included in the proration. For 
example, if proration is on department and the GLA is 2110, the Mask 
is XX XX-XX 2110.

Table 3.7—Historical Data Items Field Definitions—Field 6 (Continued)

Field Options Definition
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16. Press ENTER or PAGE DOWN to move to the next field. Page 6 of the Define 
Historical Data Items record displays (Figure 3.8). (Field 7, which displays on 
the fifth page of the Data Items record, stores system defined information and 
will not display until you save the record. See Historical Data Item System 
Information (Field 7) on page 1.103.) 

Figure 3.8—Example Historical Data Item Based on .E FICA, Page 6 of 7

17. If this data item does not need calculations or if you are using the calculations 
defined in the source data item, press ESC and type E to move to the last page of 
the definition (Figure 3.9). 

Figure 3.9—Example Historical Data Item Based on .E FICA, Page 7 of 7
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Payroll calculations have a number of options and can become complex 
as a result of your payroll needs. To save time and to realize the full 
power of calculations, many of our customers work with outside 
resources to define their calculations (e.g., Professional Services). For 
more information, please visit the FundWare Web site 
(www.fundware.com). Or see Appendix A—Calculation Commands on 
page 1.247.

18. If this data item does not need rates and tables or if you are using the rates and 
tables defined in the source data item, press ESC and type E to save the data 
item.

If you are adding or modifying calculations, see Using Rates and Tables on 
page 1.108) for instructions on writing data item rates and tables.

HISTORICAL DATA ITEM SYSTEM INFORMATION (FIELD 7)
The fifth page of the HDI will not display until you initially create the data item. The 
information on this page is not editable, it is maintained by payroll processing tasks (i.e., 
you cannot enter anything; it is for your information only). Field 7 does not allow data 
entry (Figure 3.10). 

Figure 3.10—Define Historical Data Items, Page 5 of 7
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Use the information provided according to Table 3.8. 

ADDING HDIS FROM THE TOOLBOX

You can add historical data items from the ToolBox in two ways:
• Use the ToolBox data item as a “template” for a new data item. This option is 

useful if you want to create a new data item that is similar to an existing 
ToolBox data item. However, when FundWare updates the ToolBox and you 
install the updates to your system, you will not be updating data items created 
this way.
— For example, you need a data item for health insurance; however, you do 

not want to update this data item once you define it to meet the needs of 
your organization.

• Install the ToolBox data item directly to your division. In this case, you use the 
exact same name as the ToolBox data item. When FundWare updates the 
ToolBox and you install the updates to your system, you update these data 
items.
— For example, your organization is located in North Carolina, so you install 

the .SWT NC data item for North Carolina taxes. As the taxes for North 
Carolina are changed, FundWare updates the ToolBox, you download the 
updated ToolBox and update the .SWT NC data item.

Use the following instructions to add an historical data item from the ToolBox.

Table 3.8—Payroll Parameter—Field 5 Definitions

Field Definition

Source • I (Initialized)—Added to your division when you define or modify the Payroll 
parameter. 

• S (Defined by system)—The data item is one of the system-defined data items 
added by copying a template from the ToolBox.

• U (Defined by user)—The data item is a user-defined data item.

In use • Y (Data item has been used)—The data item has not yet been used during payroll 
processing.

• N (Data item has not been used)—The data item has been used during payroll 
processing.

Group process May be referenced by FundWare Support when troubleshooting calculations. The 
information in this field has no application for most users.
• Only used by the following system-defined historical data items: .DED, .EARN, 

.TAX, and .OTHER. 
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1.  Click Setup > Historical Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Historical Data Items from the menu bar.

2. Type A to add a new historical data item. The system asks for the name of the 
new data item (Figure 3.11). 

Figure 3.11—Entering the Historical Data Item Name

3. Enter the name of the data item. This name can be up to 10 alphanumeric 
characters long.

Remember, if you want to be able to update this data item from the 
ToolBox, you must use the exact name of the data item. If you do not 
want to update the data item from the ToolBox, you can use a different 
name.

4. Press ENTER. The system asks if you want to use an existing ToolBox data item 
as the basis for the new data item.
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5. Enter a data item name or press F1 to view your existing ToolBox data items 
and select from the list (Figure 3.12). (The system will use the selected 
ToolBox data item as a “template” for your new data item.) 

Figure 3.12—Sample List of ToolBox Data Items in Division 95

The F1 list displays only those data items in the ToolBox. Do not 
mistake this for a list of data items in your division. These data items do 
not exist in your division unless you have added them manually.

6. Press ENTER. The first page of the data item definition displays, defaulting to the 
information contained in the ToolBox definition.

7. Modify or complete the data item definition, as necessary. See Defining 
Historical Data Items on page 1.85 for information about specific fields.

Some data items imported directly to your system will still require you 
to complete certain fields. These fields will not be overwritten when 
you update the data item from the ToolBox.

8. Once you have completed the data item definition, press esc to display the 
option menu for adding historical data items.

9. Type E to end the entry task. You are asked to accept your entries.

10. Type 0 to accept your entries.

11. Press ESC to return to the Define Historical Data Items options menu.
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12. Type E to save your entries and return to the Payroll/Personnel > 
Maintenance menu. 

EMPLOYEE DATA ITEMS CREATED BY TOOLBOX HDIS

When you add historical data items (either using the “template” process or by copying 
the HDI directory to your division), the system will automatically create any employee 
data items needed by that historical data item. Field 8 of the data item definition will 
include notes on any employee data items created this way (Figure 3.13). 

Figure 3.13—Example Setup Notes for .SWT CO

When you update your historical data items from the ToolBox (see Updating Historical 
Data Items on page 1.234), you should also update your employee data items (see 
Updating Employee Data Items on page 1.236).

CREATING HDI CALCULATIONS AND TABLES

The calculations and tables form the heart of historical data items. However, these 
calculations have a number of options and can become complex as a result of your 
payroll needs. Because of the critical nature of the accuracy of payroll information, 
many of our customers work with outside resources to define their calculations (e.g., 
Professional Services). This saves them time, while allowing them to realize the full 
power of calculations designed specifically for their organization. FundWare also offers 
classes in writing and modifying calculations. For more information, please visit the 
FundWare Web site (www.fundware.com).
To learn more about the commands and options available for HDI calculations and 
tables, please turn to Appendix A—Calculation Commands on page 1.247. 
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USING RATES AND TABLES
When you define historical data items, you may also define up to 999 tables to hold rate 
information for that HDI. Each table can hold information for up to 99999 rates (e.g., 
flat amount, instructions for excess amount). Each table also holds an effective date, 
which allows you to maintain various rates that are used based on the current business 
date. 

When you process your payroll using the historical data item, the system looks at the 
date restriction on the table (if defined) and uses the applicable table to calculate taxes 
and deductions. 

EXAMPLE RATES AND TABLES FOR .E FICA
The .E FICA data item has two tables, but a number of different date restrictions that 
determine which definition is used (based on the business date). Figure 3.14 shows .E 
FICA from the Define Rates and Tables task. 

Figure 3.14—Tables Defined for .E FICA (Define Rates and Tables Task)
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The 2003 table for .E FICA holds the wage limit for that tax year (Figure 3.15). 

Figure 3.15—.E FICA Table 2 for 2003

You can see the tables used in the .E FICA calculation (Figure 3.16). 

Figure 3.16—.E FICA Calculation Using Tables
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When you process your payroll using .E FICA, the system looks at your business date 
and uses the applicable table (e.g., if it is within the year 2003, Payroll uses the table 
definition for 2003, shown in Figure 3.15). 

DEFINING RATES AND TABLES

Use the following steps to define rates and tables. 
1.  Click Maintenance > Rates and Tables on the module navigator (if the 

module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Maintenance > Rates and Tables from the menu bar.

2. Type A to add a new table. The system asks for the name of the data item with 
which this table will be associated (Figure 3.17). 

Figure 3.17—Entering the Historical Data Item Name

3. Enter the name of the data item or press F1 to select from a list of existing data 
items.

4. Enter the table number, which must be a number between 1 and 999.

You can define tables with the same table number as long as the 
Effective date field is different.

5. Enter the date that the table becomes effective.

Remember: FundWare Payroll/Personnel will use this date, compared 
to the business date when you log on to process your payroll, to 
determine which tables to use.
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A description field displays (Figure 3.18). 

Figure 3.18—Entering the Table Description

6. Enter a description of the table and press ENTER. This field can hold up to 30 
alphanumeric characters. An entry field displays (Figure 3.19). 

Figure 3.19—Entering the Entry Number
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7. Enter the entry number for this rate (i.e., line number within the table). New 
tables default to the first entry number of 10 and increment by 10 so that 
commonly used entry numbers are 10, 20, 30, 40, etc. The rate page of the table 
displays (Figure 3.20). 

Figure 3.20—Entering the Rate Information

8. Complete the fields according to Table 3.9. 

Table 3.9—Rate Information Field Definitions

Field Valid Entry Definition

Minimum
Maximum

$—amount Range an amount must fall into to receive the rate or flat amount.

Flat 
amount

$—amount Fixed dollar amount to charge for amounts that fall between the 
Minimum and Maximum.

% Rate R—rate Rate to multiply amounts that fall between the Minimum and Maximum.
• The amount is multiplied by the rate.

Excess Y Subtract minimum amount as excess. The line is calculated using the 
following formula so that the difference between the amount pulled into 
the table and the Minimum is part of the calculation:
• Result = flat amount + [(amount - minimum) * % rate]

N Do not subtract minimum amount. The formula is the following:
• Result = flat amount + [amount * % rate]
Difference between the minimum and the amount is ignored.
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9. Press ESC to return to the Define Rates and Tables menu.

10. Type E to end the entry session.

11. Type 0 to save your entries.

12. Type E to save your entries and return to the Payroll/Personnel > 
Maintenance menu.

Figure 3.21 shows that the FICA Table 2, entry 10, contains the FICA flat amount of 
$76,200 effective 01/01/2000.

Figure 3.21—Example Rates and Tables

WHAT ARE EMPLOYEE DATA ITEMS?
Employee data items are pieces of information attached to the employee records, such as 
the city where the employee resides, the department(s) where they work, and the amount 
they pay for a health insurance deduction. Every employee record is composed of EDIs 
(i.e., every field on the employee record is an EDI). Some are predefined by the system, 
while you can create others to track information needed by your organization. (See 
System-Defined EDIs on page 1.78 for a complete list of the employee data items 
predefined by the system.)

EDI values are not updated by payroll processing.
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Employee data items must be defined before you can add your employees. 
However, you can add new EDIs at a later date, if necessary.

WHAT KIND OF INFORMATION CAN AN EDI STORE?
EDIs allow you to store all kinds of information. However, you must define the type of 
information in the data item definition. 

Will the data item store number information only (e.g., employee number)? 
Will it store a combination of numbers and/or letters (e.g., vehicle license 
number)? Or maybe the data item will store a financial amount (e.g., deduction 
for vision insurance)?

Employee data items may be defined with edit values and/or multiple values.

WHAT ARE EDIT VALUES?
When you define an employee data item, you can indicate whether that EDI will hold 
unique information (e.g., information unique to each employee, like social security 
number or spouse’s name) or if the entry will be selected from a predefined list. These 
predefined entries are called edit values.
For example, the system-defined data item .STATUS P (Payment status field on the 
Payroll Information tab of the employee record) contains the employee’s payment 
status. Users are allowed to select one of the following edit values from a drop-down 
list:

• Not used
• Full-time hourly
• Full-time salary
• Part-time hourly
• Part-time salary
• Seasonal

WHAT ARE LOOKUP VALUES?
Lookup values are information attached to a data item edit value that can be used “for 
your information” and/or included in reports and calculations. For example, most people 
find it difficult to remember department account numbers for 200 employees. However, 
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the department names are usually meaningful and easy to remember. You can modify 
the system-defined EDI .HM DEPT (for Home Department) to have the following 
lookup values:

• Admin—01 00-00
• Police—02 01-02
• Fire—03 01-02

You can enter one of these three department names and it “looks up” the account 
number. Employee data items may contain up to 10 lookup values; however, most users 
define only one or 2 lookup values.

HOW CAN YOU USE MULTIPLE VALUES?
When you apply or enter information for an employee data item, you are usually 
entering or select a single value. For example, an employee has one “value” for their 
social security number. However, there are some employee data items that have multiple 
values. 

For example, the system-defined EDI .S DEPT contains the department in 
which a salaried employee works. If you have employees who work in more 
than one department, .S DEPT must be able to hold more than one value for the 
system to work correctly.

This concept is called “multiple values.” Let’s say you wanted to keep the names of 
your employees’ family members. You could define an employee data item (e.g., 
“Family”) to hold text, use multiple values, and have no edit values (i.e., you must enter 
a value rather than select from a predefined list). When you add Family to your 
employee records you could enter “Ward,” “June,” and “Wally.” Then you could print 
those values on a report.
You can examine how employee data items are defined in the Division 95 or Division 
96 (the sample divisions) by printing an Employee Data Item List.
To produce the report, click the Employee Data Item List report name on the HomePage 
(Master Records List category). The parameter window displays. 

You can also access the report through Report Manager: select File > Report 
Manager from the menu bar; and select Payroll/Personnel, the Master Records 
List report category, and the Employee Data Item List report name; and double-
click or click Produce.
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CUSTOMIZING THE LABELS ON THE EMPLOYEE RECORD

Employee data items make up each field of the employee record (Figure 3.22). (Adding 
Employees on page 2.31 identifies each EDI on the employee record.) 

Figure 3.22—Example System-Defined Employee Data Items on Payroll Information Tab

By modifying the short description of the employee data item, you can change the label 
for the field on the employee record.

1.  Click Setup > Employee Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Employee Data Items from the menu bar.

You must define the Payroll parameter before you can add user-defined 
employee data items.

.STATUS—Short description “Employ 

.STATUS P—Short description “Payment status”

.T FREQ—Short description “Pay frequency”
What Are Employee Data Items? 



Chapter 3—Using Data Items
2. Type C to change an employee data item. The system asks you for the name of 
the data item (Figure 3.26). 

Figure 3.23—Entering the Employee Data Item Name

3. Enter the name of the data item and press ENTER. Page 1 of the Define 
Employee Data Items record displays (Figure 3.24). 

Figure 3.24—Define Employee Data Items, Page 1 of 3

4. Modify the short description as necessary (up to 15 alphanumeric characters).

5. Press ESC to exit the record. The system asks if your entries are correct.

6. Type Y to accept your entries.
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7. Press ESC to display the option menu.

8. Type E to exit the task and close the window.

9. Locate the PYCEmpInqUtil.exe executable file in the Bin folder (stored in the 
version folder under FundWare, e.g., FundWare > 7.40 > Bin).

10. Double-click to open the Build/Repair Employee Inquiry Table (Figure 3.25). 
This utility will synchronize your data following this editing process. 

Figure 3.25—Build/Repair Employee Inquiry Table

11. Enter the correct data drive, data directory, and division (or accept the defaults).

12. Click Build/Repair. When the process has completed successfully, a message 
displays.

13. Click OK.

DEFINING EMPLOYEE DATA ITEMS
Use the following steps to define an employee data item manually. 

1.  Click Setup > Employee Data Items on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > Employee Data Items from the menu bar.

You must define the Payroll parameter before you can add user-defined 
employee data items.
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2. Type A to add a new employee data item. The system asks you for the name of 
the new data item (Figure 3.26). 

Figure 3.26—Entering the Employee Data Item Name

3. Enter the name of the data item. This name can be up to 10 alphanumeric 
characters long.

4. Press ENTER. Page 1 of the Define Employee Data Items record displays (Figure 
3.24). 

Figure 3.27—Define Employee Data Items, Page 1 of 3
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5. Complete the entries for fields 1–3 according to Table 3.10. 

Table 3.10—Employee Data Item Field Definitions—Fields 1–3

Field Options Definition

Description 30 characters Description of the data item. 
• The description prints on reports and is displayed when you add 

the EDI on the Pay Calculation tab of the employee record.
• Does not need to be unique except to avoid confusion.

Short desc 15 characters Brief description of the data item.

User options

Data type This field determines what kind of information the data item can store and how an HDI 
can use the information.
This field cannot be changed once you save the EDI.

# 15-digit number with no decimal point. Leading zeros are ignored.
• Employee number (system-defined data item .EMPLOYEE)
• Allows edit values

$ 13-digit number with 2 decimal places. Used for flat dollar amount 
earnings or deductions.
• Additional Federal withholding tax (system-defined data item 

.FWT ADDTL)
• Salary amount (system-defined data item .S AMT)
• Allows edit values

R 9-digit rate with 6 decimal places. Used for rates.
• Per-hour wage (system-defined data item .H AMT)
• Percentage deductions
• Allows edit values

D Dates (99/99/9999).
• Date of birth (system-defined data item .DOB)
• Date of hire (system-defined data item .DOH)
• Allows edit values

P Phone numbers (999-999-9999).
• Home phone number (system-defined data item .PHONE HME)
• Emergency phone number (system-defined data item .PHONE 

EMG)
• Allows edit values
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Data type 
(continued)

A 3-character alphanumeric values that usually have “look ups.” Often 
used for Y/N values.
• Marital status (system-defined data item .MARITAL)
• Employee gender (system-defined data item .SEX)
• Allows edit values

K 20-character values which usually have “look ups.”
• Department (system-defined data item .S DEPT)
• Allows edit values

T 30-characters of alphanumeric text.
• First name (system-defined data item .NAME FST)
• Last name (system-defined data item .NAME LST)
• Does not allow edit values

X 55-characters of alphanumeric text. 
• First and second lines of the employee’s address (system-defined 

data items .ADDR 1 and .ADDR 2)
• Does not allow edit values

M 55-character account mask (e.g., the lookup values for .S DEPT and 
.H DEPT).
• Does not allow edit values.

Auto add This field cannot be changed once you save the EDI.

N Item is not automatically added to new employee records. 
• You must manually add the data item to new and existing 

employee records.

Y Item is automatically added to employee records. 
• You must manually add the data item to existing employee 

records.
• Will automatically be included on Pay Calculation tab for all 

employee records added after you complete and save the EDI 
definition.

Default value A value 
dependent on 
the Data type.

The most common value for the date item. For example, A (active) 
is the Default value for .STATUS because the majority of employees 
are active. 
• This is an optional field.
• Defining a default value can save you entry time.

Table 3.10—Employee Data Item Field Definitions—Fields 1–3 (Continued)

Field Options Definition
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6. If the Edit data setting is N—Data values are not edited, you have completed the 
data item definition. Type 0 to save the data item.

Press ENTER or PAGE DOWN. If the Edit data setting is Y—Item has edit values, 
page 2 of the Define Employee Data Items record displays. Continue with the 
next section.

7. Press ESC to display the Employee Data Item options menu.

8. Type E to end the session and return to the Setup menu.

Entry 
Required

N You are not required to enter a value on the employee record.

Y You are required to enter a value on the employee record. 
• Zeros and blank entries for edit values are not allowed.

Multiple 
values

N Data item has one value. For example, .DOB has one value, the 
employee date of birth.

Y Data item may have multiple values. For example, .S DEPT is a 
multiple value employee data item for employees with salaried 
earnings in more than one department.

Scroll N
Y

The field is no longer applicable.
• Select N for ease of maintenance issues.

Edit data Option not available if the data item type (i.e., Data Type field) is T (30 characters of 
alphanumeric text), X (55-characters of alphanumeric text), and M (55-character 
mask).

N The data item does not use edit values.
• You must enter the value of the data item on the employee record.

Y The data item uses edit values.
• You must select the value of the data item from a drop-down list.

Lookup col’s Option only available if Edit data setting is Y—Item has edit values.

n/n/n/n/n/n/n/
n/n/n

You can define up to 10 lookup columns. 
• Press F1 and select the data type (all types available) for the 

applicable column.

Table 3.10—Employee Data Item Field Definitions—Fields 1–3 (Continued)

Field Options Definition
Defining Employee Data Items 
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ENTERING EDIT AND LOOKUP VALUES

Once you complete the first page of the Define Employee Data Items record, the third 
page displays (Figure 3.28). (Field 4, which displays on the second page of the Data 
Items record, stores system defined information and will not display until you save the 
record. See Employee Data Item System Information on page 1.124.) 

Figure 3.28—Adding an Edited Value

Complete the entries for Field 5 according to Table 3.11 if you are defining edit and/or 
lookup values for the data item. 

Table 3.11—Employee Data Item Field Definitions—Field 5

Field Options Definition

Edited value A value of the 
type defined 
in Data type.

One of the entries that displays in the drop-down list of predefined 
data item values and in the employee selector.
• Entry must be of the same type as the type defined in Data type. 

For example, if Data type is K (keyword).
• Edited value may be up to 55 alphanumeric characters, 

depending on the data type.

Active N Edit value is inactive.

Y Edit value is active and can be added to employee records.
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EMPLOYEE DATA ITEM SYSTEM INFORMATION

The second page of the employee data item record displays Field 4, which stores system 
defined information and will not display until you save the record (Figure 3.29). 

Figure 3.29—Define Employee Data Items, Page 2 of 3

In use This field is filled by the system and indicates if the edit value has been used on an 
employee record. If an edit value has been used, you cannot delete it from the data 
item definition.

N Edit value has not been added to employee records. 

Y Edit value has been added employee records (at some point in 
time).

Lookup 
(number)

Lookup value A field will display for each of the lookup columns for which you 
entered a data type in Field 3.
• For example, if you defined the Lookup col’s. field as 

T/M/n/n/n/n/n/n/n/n/n
two fields will display, and you must enter a text lookup entry and 
a mask lookup entry.

• If you defined no lookup columns, this field will not display.

Table 3.11—Employee Data Item Field Definitions—Field 5 (Continued)

Field Options Definition
Defining Employee Data Items 
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Table 3.12 explains the fields when defining an Employee Data Item. 

Table 3.12—Employee Data Item Field Definitions—Field 4

Field Options Definition

Source S Item defined when an HDI was added via the ToolBox.

U Item defined by a user.

I Item defined when the payroll parameter was defined.

In use This field is filled by the system and indicates if the data item has been used on an 
employee record. If a data item has been used, you cannot delete it from the system.

N Item has not been added to employee records.

Y Item has been added to employee records.

Secure This field is filled by the system and indicates if the data item value field is a secure 
value and/or the Social Security Number.

N Value is non-secure.

Y Value is always secure.

S Value is tax ID number.
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EXAMPLE EDI AND THE EMPLOYEE RECORD

To show how an employee data item will display on the employee record, we have 
added a data item to record the name of the employee’s spouse (Figure 3.30). 

Figure 3.30—Employee Data Item—Spouse
Defining Employee Data Items 
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Note that this record is a 30-character alphanumeric field that will be added 
automatically to all new employee records. So when we add a new employee, we see the 
data item on the Pay Calculation tab (Figure 3.31). 

Figure 3.31—Pay Calculation Tab With Spouse EDI

MAINTAINING EDIT VALUES FOR EMPLOYEES
Maintain Edit Values provides you with an efficient way to edit data item values with 
numeric lookup values on employee data items. You can then enter a percent or amount 
increase or decrease to those edit values. An edit value is the number, name, or special 
characters given to the data item. For example, LIFE is the data item for life insurance; Y 
is the value for the data item. (Note: No period in the data item name indicates that this 
is a user-define data item.)
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The percent increase or decrease values should be entered according to Table 3.13.

Be sure to have a complete backup before doing any changes to an employee 
data item with edit values. There is no easy way to back out a change. For 
example, doing a 10% increase on 1000.00 results in 1100.00. Doing a -10% 
decrease (to remove the change) results in 990.00. Also, you can not use this 
task to edit multi-occurring data items.

Use the following steps to edit employee edit values.
1.  Click Maintenance > Employee Edit Values on the module navigator (if the 

module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Maintenance > Employee Edit Values from the menu bar. The 
Maintain Employee Edit Values For Employees window displays (Figure 3.32). 

Figure 3.32—Maintain Edit Values For Employees

2. Select either Percent Increase/Decrease Value or Amount Increase/Decrease 
Value from the Run Options drop-down menu. The example above will 
increase the Cafeteria Plan/Life Insurance Coverage by 10%.

3. Select the appropriate data item from the Data Items drop-down menu.

Table 3.13—Increase/Decrease Results

Percent Increase or 
Decrease Result

10.00 = 10% increase

.10 = .10% increase

-10.00 = 10% decrease
Maintaining Edit Values for Employees 
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4. If you chose Percent Increase/Decrease Value for Run Options, the next field is 
labeled Percent to Change. Enter the percent of increase or decrease here. If you 
chose Amount Increase/Decrease Value, this field would be labeled Amount to 
Change. The example above reflects a 10% increase.

5. Click OK. The next time you run the payroll process, your changes will be 
reflected.

6. When you click OK, Payroll/Personnel automatically creates a report called 
PYLMNT, which reports the old and new values. To print it:

• Select File > Print Manager from the menu bar.
• Select PYLMNT and click Open.

• Click  on the toolbar or select File > Print.

MAINTAINING EMPLOYEE DATA ITEMS
Employee data items can be quickly added, changed, or removed for all employees or 
groups of employees using this feature.This type of “mass edit” can save you time. Use 
Maintain Employee Data Items to:

• Add a new data item and data item value to a group of employees
• Change the value of a data item on a group of employees
• Remove a data item from a group of employees
• Remove a specific data item value and data item from a group of employees
• Allow percent increase or decrease to a data item value
• Allow amount increase or decrease to a data item value

You cannot use Maintain Employee Data Items for multi-occurring data items, 
or with these single-occurring data items: EMPLOYEE (employee number), 
TRC USER (last user to access the employee), and TRC DATE (last date of 
access).

Use the following steps to maintain employee data items:
1.  Click Maintenance > Employee Data Items on the module navigator (if the 

module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Maintenance > Employee Data Items from the menu bar. 
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2. The Employee Data Items window displays (Figure 3.33).

Figure 3.33—Edit Employee Data Items

3. Enter the code for the Run Option or press F1 to view a list of the options.

• Add Data Item—Add a new data item and data item value. If an employee 
already has the data item, it is not affected. 

• Update Data Item—Edit an existing data item value. Employees who do 
not use this data item are not affected.

• Remove Data Item—Delete an existing data item and its value (regardless 
of the value). 

• Remove Data Item Value—Delete a data item and its value for the value 
you enter.

• Percent Increase/Decrease Value—Increase or decrease a data item value 
by a percentage. Employees who do not use this data item are not affected. 
Applies to $ or Rate data items only.

• Amount Increase/Decrease Value—Increase or decrease a data item value 
by an amount. Employees who do not use this data item are not affected. 
Applies to $ or Rate data items only.

4. Enter the name of the data item you wish to change, update, or remove from the 
Data Items drop-down menu.

5. Enter the appropriate amount, value, or percent in the Data Item Value text box.
Maintaining Employee Data Items 
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6. If you want to maintain data items for a group of employees, click PAGE DOWN 
to access the Employee Selector. Bypassing the Employee Selector will perform 
your data item changes on all employees. 

7. Once you’ve completed your choices in the Employee Selector, press ESC to 
display the option menu.

8. Type E to exit the selection task.

9. Type 0 to accept your entries and update data items. When the process is 
complete, the system creates a report called PYLIMNT.L## (where ## 
represents the division number) and asks if you have another maintenance task 
to complete.

10. Type N to exit the task and close the window.
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C H A P T E R  4

USING THE FINANCIAL INSTITUTIONS FEATURE

The Financial Institutions feature provides a way for you to manage your cash and cash-
equivalent accounts. It is the central location for banking information for the Accounts 
Payable, Payroll/Personnel, and modules. 

Figure 4.1—Financial Institutions Diagram

Use this feature to manage your banking process, including:
• Add information (e.g., multiple addresses, phone numbers, and account 

numbers) for each financial institution (e.g., bank, savings and loan).

Financial Institutions FundWare AccountsFinancial Institution Accounts

84-200-18899, 
checking acct 1

85-1987, 
checking acct 2

85-2355, 
savings acct

884-992, 
checking acct

112 075-88, 
savings acct

A01 00-00 1111

A01 01-00 1111

A02 01-00 1110

A01 00-00 1110

A01 01-00 1110

A01 00-01 1110

A02 01-00 1110

Banko Uno

Cranberry National Bank

Alpenglow Federal Bank

100-999, 
checking acct A01 00-00 1112
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• Define each financial institution account (e.g., checking account, savings 
account) for the financial institution.

• Link each financial institution account to Accounts Payable, Payroll/Personnel, 
and/or accounts through General Ledger.

For example, the City of Megalopolis does business with Cranberry National Bank (the 
financial institution). The City has four accounts (financial institution accounts, or FIAs) 
with Cranberry National Bank:

• Checking account 1—Used for Payroll, paid from GL account A01 00-00 1111.
• Checking account 2—Used for Accounts Payable, paid from GL account A01 

00-00 1112. Also receives normal Accounts Receivable payments from GL 
cash account A01 00-00 1113. 

• Savings account—Receives payments from all modules; GL cash accounts are 
A01 00-00 1111; A01 00-00 1112; A01 00-00 1113.

• Money market account—Receives all donations via from GL cash account A01 
00-00 1114.

Each module is associated to each applicable FIA (e.g., Payroll is associated to checking 
account 1 and the savings account).

The following acronyms are used throughout the Financial Institutions feature: 
APE (Accounts Payable), PYL (Payroll/Personnel), CRS. 

This chapter provides you with the information needed to:
• Run the account mapping utility (for existing customers), and 
• Operate Financial Institutions.

HINTS FOR CLIENTS CONVERTING FROM CLASSIC
• In the FundWare Classic Edition, each module had a separate method of 

defining a bank.
• Each “bank” represented an account.
• A Financial Account for a Financial Institution may encompass more than one 

“bank” from an FundWare Classic Edition module.
• “Banks” in the Classic Edition will automatically be converted to Financial 

Accounts by FundWare.
Hints for Clients Converting From Classic 
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MAPPING VERSION 5.8/5.9 BANKS TO THE ACCOUNTS
If you have existing bank information, the first time that you open the Financial 
Institutions feature, FundWare will have you map the existing information through two 
main steps: mapping the old bank to a new Financial Institutions account (FIA), and 
mapping that FIA to the modules that use it and to General Ledger. Use the following 
steps to accomplish these tasks.

1.  Select Maintenance > Financial Institutions > Financial Institutions from 
the menu bar. The Verify GL cash accounts/masks window displays. 

Figure 4.2—Mapping Existing Banks to Accounts

A fourth column, Message, displays only if a GL account/mask has a 
problem. In this event, the problem is described in the column.
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2. When the account information is all correct, click Next. The Assign Banks 
window displays. 

Figure 4.3—Assigning the Banks

Source Module—The module in the FundWare Classic Edition in 
which the bank was defined.

Name Defined in Module—The name used in the FundWare Classic Edition to 
define the bank.

3.
To associate the name of the Financial Institution to the name defined for the 
associated module, click the right side of the cell to activate the drop-down 
arrow, then click the arrow. If you have mapped other Financial Institutions 
during this process, the names will display in the drop-down list. 

4. Select the appropriate Financial Institution from the list or a New Institution, as 
necessary. If you select a Financial Institution from the drop-down list, proceed 
to step 7 on page 1.137.
Mapping Version 5.8/5.9 Banks to the Accounts 
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If you select a New Institution, the Add Financial Institution window displays. 
Figure 4.4—Add Financial Institution Dialog Box

The Name text box defaults to the value for the Name Defined in Module.
5. Modify the name of the financial institution, if necessary.

6. Click OK. The Add Financial Institution window closes and you return to the 
Assign Banks window.

7. Repeat these steps, as necessary, until all accounts have an assigned financial 
institution.

There should now be entries for all the Financial Institutions. 
Figure 4.5—All Financial Institutions Assigned

8. Click Next. The Assign Bank Accounts window displays, containing entries 
from the previous window, as well as a new column: Financial Institution 
Account. The cells in the Financial Institution Account column will be 
Blackbaud, Inc. 1.137



Blackbaud FundWare Payroll/Personnel Guide—Volume 1

1.138
populated by either a default account number and description or --- Not Mapped 
---. The defaults are supplied by the FundWare Classic Edition based on the 
original information.

This window provides you with a way to map financial institution accounts. 
Figure 4.6—Mapping Financial Institution Accounts

Multiple instances of the same General Ledger cash account number 
must be assigned to the same financial institution account (by 
definition, this also means assigned to the same financial institution).

9. To edit default Financial Institution Account information, double-click the cell. 
The edit Financial Institution Account window displays.

10. Edit the Account Description and Account #, as necessary.

11. In the Financial Institution Account column, click the right side of a cell to 
activate the drop-down arrow, then click the arrow.

12. Select the appropriate account description from the drop-down list or a New 
Account, as necessary. If you select an account description from the drop-down 
list, proceed to step 16 on page 1.139.
Mapping Version 5.8/5.9 Banks to the Accounts 
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If you select New Account from the drop-down list within the Financial Institution 
fields, the Add Financial Institution Account window displays. 

Figure 4.7—Add Financial Institution Account

13. Enter the Account Description and Account # (the account number that appears 
on your statement). 

14. If FundWare has not already inserted the appropriate account number, enter the 
account number corresponding to the description in the Account # field.

15. Click OK. The Add Financial Institution Account window closes and you 
return to the Assign Bank Accounts window.

16. Repeat these steps, as necessary, until all accounts have an assigned financial 
institution account.

There should now be entries for all the Financial Institutions. 
Figure 4.8—Entries for All Financial Institution Accounts

17. Click Next.
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When all assignments are complete, the Review Assignments window displays. 
Figure 4.9—Review Assignment

If a Financial Institution is only mapped to one or more General Ledger masked 
account, you will not be able to view or edit that information until an actual 
General Ledger account has been associated to the FI.

Each entry in the Financial Institution Account column corresponds to a Financial 
Institution Account where a module account has been mapped. 

If a Financial Institution Account entry spans more than one source module, this 
indicates that all the source modules have been associated with that Financial 
Institution Account. In the example above, the Cranberry National Bank Payroll 
Account spans APE and PYL, indicating that the account is associated with 
Accounts Payable and Payroll/Personnel.

• Click Previous to return to earlier windows if you need to make any 
assignment changes.

• Click Cancel to exit the Review Assignments window without saving the 
information.

• Click Finish to save the information and proceed further into the Financial 
Institutions feature. 
Mapping Version 5.8/5.9 Banks to the Accounts 
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VIEWING FINANCIAL INSTITUTIONS
The main Financial Institutions window can display the FIA information in a variety of 
ways. When you open the Financial Institutions feature, the window displays the Type 
and Name of each financial institution entered in the system. 

Figure 4.10—Displaying Financial Institution Information

You can remove either of these columns from the display by using the following steps.
1.  Move the cursor anywhere in the Financial Institutions window.

2. Right-click. The drop-down list displays. 

Figure 4.11—Right-Click Menu

3. Select the category to be displayed or hidden (a check mark indicates that the 
category will display).

RE-ORDERING THE DISPLAY

The information in the main Financial Institutions window can be displayed in 
alphanumeric or reverse alphanumeric order, based on each column. To sort on a 
column, click the column heading. The information will be re-ordered based on an 
alphanumeric sort of that column. To display in reverse alphanumeric order, click the 
heading a second time.
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ADJUSTING COLUMN SIZE

To adjust the column size, right-click and select Autosize Columns. Move the cursor to 
the edge of the column in the heading. The arrow will change to a line and two smaller 
arrows. 

Figure 4.12—Adjusting the Column Size

Holding the mouse button down, move the cursor left or right to adjust the column width 
as desired.

ADDING A FINANCIAL INSTITUTION
Use the following steps to add a financial institution (FI).

If, while creating an FI, you decide to cancel the action, the information will be 
retained. There is no function to delete an FI; therefore, even though you cancel 
the action, the FI is permanently part of your system. An FI added this way will 
not cause any errors.

1.  Select File > Financial Institutions > Maintenance from the menu bar. The 
Financial Institutions window displays. 

Figure 4.13—Adding an FIA
Adding a Financial Institution 
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2. Click New. The New Financial Institution window displays, defaulting to the 
General tab. Three tabs display behind the General tab: Address, Phone, and 
Account. 

Figure 4.14—New Financial Institution Record

3. Enter the required information according to the following table:. 

4. Click Apply to save.

Table 4.1—Required Information
Text Box Description

Name Enter the name of the financial institution. This information is used for 
verification purposes of screens and reports. Maximum 40 alphanumeric 
characters.

Type Select the type of financial institution from the drop-down list: Bank or 
Savings and Loan.
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5. Select the Address tab. If addresses have been added, the tab displays the 
window and text boxes, populated with the information for the first entry in the 
window. If no addresses have been entered, no fields display. 

Figure 4.15—Address Tab
Adding a Financial Institution 
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6. Click New to add an address (optional). The expanded Address tab displays. 

Figure 4.16—Expanded Address Tab

7. Enter the information according to the following table:

8. Click Apply to save. If you have another address to enter for this financial 
institution, click New and repeat step 7. If you do not have another address to 
enter, proceed to the next step.

Table 4.2—Address Tab Information
Text Box Description

Type Select the type of address from the drop-down list (e.g., Business, Home, or Other).
Street 1
Street 2

Enter the street address for this location of the financial institution. Maximum 35 alphanume
characters for each.

City Enter the city for this address. Maximum 19 alphanumeric characters.
State Select the US state from the drop-down list, or enter up to 5 characters for the state, provinc

territory. 
Zip Enter the zip or post code. Maximum 50 alphanumeric characters.
Country Enter the country, if desired. Maximum 35 alphanumeric characters.
Description Enter a description of the location, e.g., main office of the financial institution. Maximum 50 

alphanumeric characters.
Default Select this check box if this address is to be used as the default address when mailing some

to the financial institution.

As you add 
addresses for t
FI, they will 
display in the 
window.
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9. Select the Phone tab. If phone numbers have been added, the tab displays the 
window and text boxes, populated with the information for the first entry in the 
window. If no phone numbers have been entered, no fields display. 

Figure 4.17—Phone Tab
Adding a Financial Institution 
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10. Click New to add a phone number (optional). The Expanded Phone tab 
displays. 

Figure 4.18—Expanded Phone Tab

11. Enter the information according to the following table

12. Click Apply to save. If you have another phone number to enter for this 
financial institution, click New and repeat step 11. If you do not have another 
phone number to enter, proceed to the next step.

Now you have defined the financial institution. You must add the accounts for the FI 
(e.g., two checking accounts and a savings account) on the Account tab. These accounts 
are “FIAs” (financial institution accounts). 

Table 4.3—Expanded Phone Tab
Text Box Description

Type Select the type of phone number from the drop-down list (e.g., Business, Home, or Other).
Number Enter the phone number. Maximum 50 alphanumeric characters.
Description Enter a description of the phone number, e.g., most helpful customer service representative.

Maximum 50 alphanumeric characters.
Default Select this check box if this is to be used as the default phone number when calling the finan

institution.

As you add ph
numbers for th
they will displa
the window.
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ADDING FINANCIAL INSTITUTION ACCOUNTS
You can add as many financial institution accounts (i.e., actual accounts at your banking 
entity) as necessary for each financial institution (i.e., the banking entity).

1.  Select the Account tab. If accounts have been added, the tab displays the 
window and text boxes, populated with the information for the first entry in the 
window. If no accounts have been entered, no fields display. 

Figure 4.19—Account Tab
Adding Financial Institution Accounts 
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2. Click New to add an account (required to use this financial institution). The 
expanded Account tab displays. 

Figure 4.20—Expanded Account Tab

3. Enter the required information according to the following table. 

4. Click Apply to save. If you have another account to enter for this financial 
institution, click New and repeat step 3. (You can also make associations for 
your account at this time. See Associating the Accounts on page 1.150 for more 
information.) If you have completed your entry of accounts, click OK to save 
the changes and return to the Financial Institutions main window.

At this point, your financial institution exists, however, the financial institution accounts 
have not been associated with General Ledger accounts. This mapping can be done at 
any time, however, you will not be able to access the FIAs through Accounts Payable, 
Payroll/Personnel, or until this task is done. 

Table 4.4—Expanded Account Tab
Text Box Description

Type Select the type of account from the drop-down list: Checking Account, or Savings Accou
Number Enter the account number. Maximum 20 alphanumeric characters.
Description Enter a description of the account, e.g., petty cash account. Maximum 30 alphanumeric 

characters.

As you add 
accounts for t
they will displ
the window.
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ASSOCIATING THE ACCOUNTS
You can associate as many General Ledger accounts as you need to your Financial 
Institutions account (FIA), however, a General Ledger account may only be associated 
with one Financial Institution account. The process that you will follow for associating 
your accounts involves a few main tasks:

Once you associate a GL account to a financial institution account, that GL 
account may not be associated with any other FIA.

• Determine the GL cash accounts that will be associated to the FIA.
• Enter the accounts as “GL cash accounts.” (Masked accounts are not allowed. 

To mimic the effect of an account mask, you can define all accounts resulting 
from the mask as GL cash accounts.)

• Associate one or more accounts, or account masks, to the FIA by module (i.e., 
Accounts Payable, Payroll/Personnel, or.)

The following sections provide instructions for associating one or more General Ledger 
accounts to your selected Financial Institutions account. 

1.  Select the Account tab of the applicable financial institution.

2. Select the FIA to be associated from the upper window. The text boxes are 
populated with the information specific to the selected FIA.
Associating the Accounts 
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3. Select the By GL Cash Account radio button. 

Figure 4.21—Expanded Account Tab

4. Click Add. The Add GL Account pop-up displays. 

Figure 4.22—Add GL Account Dialog Box

5. Enter the GL Cash Account in the text box, or click  to browse for the correct 
account. The Account Selector window displays. Use the selector to select the 
appropriate account.

6. Click OK to save. A confirmation message displays.

7. Click Yes. The Add GL Account pop-up closes and you return to the Account 
tab.

8. Click Apply to save.

9. If you have another General Ledger account to map to this Financial Institution 
account, repeat these steps.
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10. Select the By Use radio button.

11. Click Add. The Select Module window displays. 

Figure 4.23—Select Module Dialog Box

12. Select the appropriate module from the drop-down list: Accounts Payable, 
Payroll/Personnel, or.

13. Click OK. The module-specific window displays. 

See the following sections for instructions to complete the module-specific window.
Associating the Accounts 
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ASSOCIATING THE ACCOUNTS—ACCOUNTS PAYABLE

Use the following instructions to complete the Accounts Payable By Use window 
Figure 4.24—Accounts Payable “By Use” Associations

As accounts are added, they 
are displayed in this window.

For reference, this is the Financial Institutions 
account to which you are mapping.

Usage Information displays a brief list of the most recent activities in this 
account.
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1.  Enter the required information according to the following table 

Table 4.5—AP User Required Information
Accounts Payable Text 

Box Description

Usage Definition—GL 
Cash Acct

Select the GL cash account to be associated with this financial institution account 
the drop-down list or enter an account mask. 
• You cannot create new accounts through FI. The account or accounts must exis

GL.
Usage Definition—
Usage ID

Enter a unique identifier for this association. This ID will be used to identify the acc
when you produce checks. 
• Maximum 10 alphanumeric characters.
When you produce checks, FundWare will create a unique file for each FIA by 
attaching the ID number to “OTCK.” For example, if the usage ID is 146983, the fi
name is OTCK146983.L## (where ## represents your division number).
• If the usage ID is fewer than four characters, the file name will include Xs. For 

example, if the usage ID is 135, the file name is OTCK135X.
Usage Definition—
Description

Enter a unique description for this association. This description will display in the 
Accounts Payable module when you select the account from which to draw funds
• Maximum 35 alphanumeric characters.

Usage Information Summary information concerning the usage of the account association displays in
window.

Data Items Printed on 
Check Stub

Click the right side of the text box to activate a drop-down arrow. From the drop-d
list, select three data items to be printed on the Accounts Payable checks. 
• Data items are optional. 

Distribution Report—
Reporting Option

Select one of six options to define the amount of detail included with the check reg
• N—No accounting distribution report
• Y—With all check registers
• 1—With preliminary register only
• 2—With final check register only
• 3—With reprint register only
• 4—With final check and reprint registers

Distribution Report—
Report ID Type

This would normally be the General Ledger ID type.

Distribution Report—
Break Dimension/
Description

In the grid that displays when you select a report ID type, click the Break Dimensi
and select a dimension on which the register will enter a page break from the drop
down list.
Enter a Description for each Break Dimension. This text that will print on the repo
the break line. 
• Maximum 20 characters for both selections.
Associating the Accounts 
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2. If you have additional Accounts Payable accounts that you would like to map to 
this FIA, click New. If not, click OK. The Accounts Payable By Use window 
closes and you return to the Account tab.

3. Click Apply to save the financial institution. If you have another account to 
enter for this financial institution, click New and repeat the necessary steps. If 
you have completed your entry of accounts, click OK to save the changes and 
return to the Financial Institutions main window.

User Options Select a check option from the drop-down list: System Numbered, User Numbere
Laser Checks.
• System Numbered—Checks are automatically numbered by the computer. If 

needed, this number can be changed through the check parameters. Use this o
for pre-printed checks.

• User Numbered—For each batch of checks that you print, you must enter the fi
check number. Use this option for pre-printed checks.

• Laser Checks—Checks are automatically numbered. You cannot change the ch
number. Use this option for blank check stock.

Last Check Number Enter the last check number in this text box. Subsequent checks will be numbered
starting with the next number (e.g., you type 1220 in this text box, the checks will b
with 1221).
If you leave this field blank, the system applies 0 to the field. When you begin writ
checks, the system starts counting from 1.

Table 4.5—AP User Required Information (Continued)
Accounts Payable Text 

Box Description
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ASSOCIATING THE ACCOUNTS—PAYROLL/PERSONNEL

Use the following instructions to complete the Payroll/Personnel By Use window. 
Figure 4.25—Payroll/Personnel “By Use” Associations

As accounts are added, they are 
displayed in this window.

For reference, this is the Financial Institutions 
account to which you are mapping.

Usage Information displays a brief list of the most recent activities in this 
account.
Associating the Accounts 
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1.  Enter the required information according to the following table:. 

2. If you have additional Payroll/Personnel accounts that you would like to map to 
this Financial Institutions account, click New. If not, click OK. The Payroll/
Personnel By Use window closes and you return to the Account tab.

3. Click Apply to save. If you have another account to enter for this financial 
institution, click New and repeat the necessary steps. If you have completed 
your entry of accounts, click OK to save the changes and return to the Financial 
Institutions main window.

Table 4.6—Payroll/Personnel Required Information
Payroll/Personnel Text Box Description
Usage Definition—GL 
Cash Acct

Select the GL cash account or enter a GL account mask to be associated with t
financial institution account from the drop-down list. (You cannot create new acco
through FI. The account or accounts must exist in GL.)

Usage Definition—Usage 
ID

Enter a unique identifier for this association. This ID will be used to identify the 
account when you produce checks. 
• Maximum 10 alphanumeric characters.
When you produce checks, FundWare will create a unique file for each FIA by 
attaching the ID number to “OTCK.” For example, if the usage ID is 146983, the
name is OTCK146983.L## (where ## represents your division number).
• If the usage ID is fewer than four characters, the file name will include Xs. For

example, if the usage ID is 135, the file name is OTCK135X.
Usage Definition—
Description

Enter a unique description for this association. This description will display in th
Payroll/Personnel module when you select the account from which to draw fund
Maximum 35 alphanumeric characters.

Usage Information Summary information concerning the usage of the account association displays
this window. 

Data Items Printed on 
Check Stub

Click the right side of the text box to activate a drop-down arrow. From the drop-
list, select three data items to be printed on the Payroll/Personnel checks. 
• Your selections will print in the lower left quadrant of the check stub.

User Options—Auto 
Number Checks

Select this check box to have the payroll/personnel checks numbered automatic
by the system. If you do not select this check box, you will need to enter the firs
check number for each batch of checks that you print.

User Options—Last Check 
Number

If you selected to auto number your payroll/personnel checks, enter the last che
number in this text box. Subsequent checks will be numbered starting with the n
number (e.g., you type 1220 in this text box, the checks will begin with 1221).
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ASSOCIATING THE ACCOUNTS—
Accounts Receivable and Cash Receipts customers: Accounts Receivable 
includes Cash Receipts, which also uses the Financial Institutions feature. 
While the process is the same for both modules, the interface will reflect the 
module for which you are licensed. However, this guide will display the 
Accounts Receivable screens by default.

Figure 4.26—Accounts Receivable Cash Receipts By Use Associations
As accounts are added, they 
are displayed in this window.

For reference, this is the Financial Institutions 
account to which you are mapping.
Associating the Accounts 
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1.  Enter the required information according to the following table:. 

2. If you have additional accounts that you would like to map to this Financial 
Institutions account, click New. If not, click OK. The By Use window closes 
and you return to the Account tab.

3. Click Apply to save. If you have another account to enter for this financial 
institution, click New and repeat the necessary steps. If you have completed 
your entry of accounts, click OK to save the changes and return to the Financial 
Institutions main window.

EDITING AN FIA
Use the following steps to edit the information concerning a financial institution.

1.  From the Financial Institutions main window, select the financial institution that 
you want to edit and click Edit, or double-click the institution in the window.

The window displays with the text boxes populated with the information specific to 
the selected financial institution. 

2. Select the tab containing the desired information. For addresses and phone 
numbers, select the entry in the window. The specific address or phone 
information populates the text boxes.

3. Edit the information, as necessary.

4. Click Apply to save the changes on each tab. 

5. Click OK to save when you have completed your edits. You return to the 
Financial Institutions main window.

Table 4.7—Required Information
Text Box Description

GL Cash Acct Select the GL cash account or enter a GL account mask to be associated with this fina
institution account from the drop-down list. (You cannot create new accounts through F
The account or accounts must exist in GL.)
• If you enter an account mask, the valid account will be determined using the masked

account digits in the account.
Description Enter a unique description for this association. This description will display in the mod

when you select the account to which you will deposit funds. Maximum 35 alphanume
characters.
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EDITING AN ASSOCIATION
Use the following steps to edit the association information concerning a financial 
institution.

1.  From the Financial Institutions main window, select the financial institution that 
you want to edit and click Edit, or double-click the institution in the window.

The window displays with the text boxes populated with the information specific to 
the selected financial institution. 

2. Select the Account tab.

3. Select the FI account to be edited.

4. Select the By Use radio button. The accounts display in the lower window. 

Figure 4.27—Displaying Accounts

5. Select the account to be edited.
Editing an Association 
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6. Click Edit. A window displays, defined by the module associated with the 
account selected. 

Figure 4.28—Dialog Box as Defined by the Module

All the accounts associated to that module display in the window above. The 
information concerning the selected account populates the text boxes below.

7. Edit the information, as necessary.

8. Click Apply to save the information or click OK to save the information and 
exit the window.

9. Repeat these steps, as necessary.

10. When you have completed your edit of the association information, click OK.
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DELETING AN FIA
You cannot delete a financial institution from FundWare. Any financial institution for 
which you add information and save is permanently retained in the system. This is true 
even if you cancel out of the action at a later point in the creation. For example, you 
create a new financial institution and enter the name and type, then click Apply to save 
the information. If you then click Cancel, that financial institution is still retained.

If you add this information and click Cancel (not Apply), the financial institution 
displays in the list of Financial Institutions, but will disappear if you close, then re-open, 
the application.

DELETING A GL CASH ACCOUNT ASSOCIATION
To delete an association, that association cannot be in use elsewhere in the program. Use 
the following steps to delete an association.

1.  From the Financial Institutions main window, select the financial institution that 
you want to edit and click Edit, or double-click the institution in the window.

The window displays with the text boxes populated with the information specific to 
the selected financial institution. 

2. Select the Account tab.

3. Select the FI account to be modified.

4. Select the association from the lower window.

5. Click Delete. The association is removed from the lower window.

If the association is used elsewhere in the program, a message will 
display and the action will not be completed.
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DEFINING CHECK FORMATS

When you defined an FIA (Financial Institution account), a default check format for that 
FIA was added for you. Those default values are for standard check stock. Since your 
organization may want to format your own checks, the software allows you to modify 
the standard form. However, only one check format per FIA is allowed.
Defining Check Formats allows you to define size, position, and content of the stub, the 
check and the timesheet history.
Formatting the check requires the entry of character positions and field sizes for the data 
printed on the check. A form template is very helpful in the process of designing your 
checks. If you have pre-printed checks, your printer may be able to furnish layout 
information. For an example of a three-part check listing timesheet history, see Sample 
Three-Part Direct Deposit Stub on page 1.226.

CHECK TERMS
Table 5.1 provides definitions for terms used in connection with your check forms. 

Table 5.1—Check Forms Terms

Term Definition

Form In this task, Form refers to the actual checks. This consists of the check number, date, 
payee name and address, and dollar amount.

Column The starting vertical position of a piece of information in characters. If zero (0) is entered, 
the field is not printed. Valid values are zero (0) to 132. For example, a Column value of 
6 places information six characters from the left margin.

Length The Length defines the allowed width in characters. For example, a Length of 10 means 
that 10 characters are allowed for the field on the check.
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DEFINING CHECK FORMATS
Because a default check format for that FIA was added when you defined your FIAs 
(Financial Institution accounts), use the following steps to modify the existing check 
format. (Remember: You can define only one check format per FIA.)

1.  Click Setup > Check Formats on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Check Formats from the menu bar. 

2. Type C to enter information. The system asks for the FIA (or “Bank”) name 
(Figure 5.1). Press F1 to see a list of your payroll FIAs (i.e., FIAs with a By Use 
association with Payroll/Personnel). 

Figure 5.1—Enter FIA Name

Line The horizontal position of a piece of information. Lines are counted from the top of the 
form. Zero (0) may be entered to suppress printing of the field.

Option Field specific information. Press F1 for a list of valid options.

Table 5.1—Check Forms Terms (Continued)

Term Definition
Defining Check Formats 
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3. Enter the FIA name or select from the F1 list. Page 1 of the Define Check 
Format record displays (Figure 5.2). 

Figure 5.2—Define Check Formats, Page 1 of 9

4. Complete fields 1 and 2, which define the printing and stub options, according 
to Table 5.2. 

Table 5.2—Define Check Formats Field Definitions—Fields 1 and 2

Field Options Definition

Print Options This field defines how the stub portion of the form is printed.

Suppress 
Feed

Y Suppress initial form feed. The first check prints on the check form 
currently in the printer. The waste of check forms is determined by the 
printer and the operating system.

N Do not suppress initial form feed. Advances one form, then prints the 
first check. 

Suppress 
Fcount

Y Suppress the **** Number of lines printed **** message. 

N Do not suppress the **** Number of lines printed **** message. One 
form is lost at the end since it contains this message.

Laser print Y Laser printing is used for checks. Select only if you are using an 
ACOM printer.

N Laser printing for checks is not used.
• Enter N unless you are using ACOM printers.
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Timecard hist Timesheet history can be printed on the check stub if timesheet 
history is maintained by answering Y in the Keep history field under 
Time card options in the payroll parameter.

Y Print timesheet history.

N Do not print timesheet history.

R Print history—sum by rate.

Stub vertical Defines the vertical position of the stub portion of the form.

Y Stub vertical position is used. Using 300 dots per inch as the rule, 
enter a Y position.

N Stub vertical position is not used. A standard check with stub on the 
top is used.
• Enter N unless you are using ACOM printers.

Note: Defining the stub vertical, form vertical and time vertical is only available for laser check printing, if 
you answered Laser print–Y–Laser printing is used for checks and you are using ACOM printers. You 
determine the order of the stub, the body of the check, and timesheet history that print on the check. 
Refer to your printer manual for specific information.

Form vertical Defines the vertical position of the check portion of the form.

Y Check vertical position is used. Using 300 dots per inch as the rule, 
enter a Y position.

N Check vertical position is not used. A standard check with stub on the 
top is used.

Time vertical Defines the vertical position of the timesheet portion of the form.

Y Check vertical position is used. Using 300 dots per inch as the rule, 
enter a Y position.

N Check vertical position is not used. A standard check with stub on the 
top is used.

Detail line options

Stub dtl lines The number of lines of earnings, taxes, and deductions to appear on the check stub.
• 0—No stub detail is printed.
• 1–50—Number of detail lines on stub; 11 is the default.

Table 5.2—Define Check Formats Field Definitions—Fields 1 and 2 (Continued)

Field Options Definition
Defining Check Formats 
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5. Press ENTER or PAGE DOWN to move to the next field. Page 2 of the Define 
Check Format record displays (Figure 5.3). 

Figure 5.3—Define Check Formats, Page 2 of 9

Time dtl lines The number of lines of timesheet history, earning items, and amounts to appear on the 
timesheet history stub.

0 No information is printed.

1–50 Number of detail lines on timesheet history stub; 0 is the default.
Note: If you have more timesheet history detail lines than are defined, 
the system will total the remaining lines. For example, Time dtl lines is 
5, you have 7 lines of timesheet history. The first four lines of 
timesheet history will print in detail and the remaining three lines will 
be summed and printed on the remaining line.

Table 5.2—Define Check Formats Field Definitions—Fields 1 and 2 (Continued)

Field Options Definition
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6. Complete field 3, which defines the placement of the stub header line, according 
to Table 5.3. 

7. Press ENTER or PAGE DOWN to move to the next field. Page 3 of the Define 
Check Format record displays (Figure 5.4). 

Figure 5.4—Define Check Formats, Page 3 of 9

Table 5.3—Define Check Formats Field Definitions—Field 3

Field Options Definition

Stub heading These fields define the content and placement of the stub header line. For each 
possible field on the check stub, a Column and Length must be specified. Optional 1 
and Optional 2 may contain an employee data item. Enter zeroes to not print a field.

Emp 
nbr–name

Employee number 
and name.

Minimum length is 9 characters.

Optional 1 Employee data item Optional information that will print at the top of the stub. 
Minimum length is 1.

Optional 2 Employee data item Optional information that will print at the top of the stub. 
Minimum length is 1.

Date Date Minimum length is 12 characters.

Form number Check number Minimum length is 12 characters (7 digits for the system 
number, 1 digit for the hyphen, and 4 digits for the form 
sequence number).
Defining Check Formats 
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8. Complete field 4, which defines the placement of the stub detail, according to 
Table 5.4. 

Table 5.4—Define Check Formats Field Definitions—Field 4

Field Options Definition

Stub detail These fields define the content and placement of stub earning information. For each 
possible field on the check stub, a Column and Length must be specified. The Length 
field has a minimum length of 5 characters. For each field containing hours or 
amounts, you must also enter an option for the printing of commas and decimals. 
Valid options are:

ENTER Normal format with commas and decimals.

1 Suppress commas.

2 Suppress decimal places.

3 Suppress both commas and decimals.

4 Commas and decimals must be considered in field length.

Earnings desc Short description for an earnings item (field 2 of the HDI 
definition)

Cur hours Current hours

Cur amount Current amount

Ytd hours Year-to-date hours

Ytd amount Year-to-date amount

Taxes/deds 
desc

Short description for taxes and deductions (field 2 of the HDI 
definition)

Cur amount Current amount

Ytd amount Ytd amount
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9. Press ENTER or PAGE DOWN to move to the next field. Page 4 of the Define 
Check Format record displays (Figure 5.5). 

Figure 5.5—Define Check Formats, Page 4 of 9

10. Complete field 5, which defines the placement of check detail information, 
according to Table 5.5. 

Table 5.5—Define Check Formats Field Definitions—Field 5

Field Options Definition

Form detail This field defines content and layout of the detail portion of the check. Line, Column, 
and Length must be entered for each field.

Form number Internal system number. Minimum length is 12 characters.

Amount 
(alpha)

Amount of the check written out like Seven hundred and fifty 
dollars. Minimum length is 40. If amount does not meet 
maximum size, it is filled with *** to prevent modification of the 
check amount.

Date Check date. Minimum length is 10 characters.

Amount 
(number) 

Numeric amount of check. If amount does not meet maximum 
size, it is filled with *** to prevent modification of check 
amount.

Address 1–5 Name and address of employee. If smaller field lengths are 
entered, the information is truncated.
Defining Check Formats 
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11. Press ENTER or PAGE DOWN to move to the next field. Page 5 of the Define 
Check Format record displays (Figure 5.6). 

Figure 5.6—Define Check Formats, Page 5 of 9

12. Complete field 6, which defines the placement of Data Items and their values to 
print on the check form, according to Table 5.6.

The monthly hours for the Historical Data Item Hourly is defined to 
print after the text Hours Worked on the check form. 

Table 5.6—Define Check Formats Field Definitions—Field 6

Field Options Definition

Form Items These fields define the content and placement of up to three data items values and 
text that can appear on the check form. For each data item defined for the check form, 
a Line, Column, and Length must be defined.

Option N
E
C
M
Q
H
Y
B
T
A

Not used (default)
Employee item
Current total
Monthly total
Quarterly total
Half year total
Yearly total
Beginning total
Total for year
Annual total
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13. Press ENTER or PAGE DOWN to move to the next field. Page 6 of the Define 
Check Format record displays (Figure 5.7). 

Figure 5.7—Define Check Formats, Page 6 of 9

Extract N
H
A
O
1
2
3

Not used (default)
Hours
Amount
Other
Basis hours
Basis amount
Basis other

Data item Press F1 for a list of existing data items in the system to select, a list of historical data 
items is displayed for all Option selections except E—Employee Item. If E—Employee 
item is selected, pressing F1 displays a list of Employee Data Items.

Text Text to prefix data item printed on the check form. The text will not print if the data item 
does not exist for the employee or the data item value is zero.

Table 5.6—Define Check Formats Field Definitions—Field 6 (Continued)

Field Options Definition
Defining Check Formats 
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14. Complete field 7, which defines the heading for the optional third part of the 
check form (timesheet history), according to Table 5.7. Note: These fields will 
not display if the Payroll parameter Keep History option (field 3) is defined as 
N. 

15. Press ENTER or PAGE DOWN to move to the next field. Page 7 of the Define 
Check Format record displays (Figure 5.8). 

Figure 5.8—Define Check Formats, Page 7 of 9

Table 5.7—Define Check Formats Field Definitions—Field 7

Field Options Definition

Time heading These fields define the content and placement of the timesheet header line. For each 
possible field on the timesheet stub, a Column and Length must be specified. Optional 
1 and Optional 2 may contain an employee data item. Enter zeroes to not print a field.

Emp 
nbr–name

Employee number and name. Minimum length is 9 characters.

Optional 1 Optional information, enter an employee data item. Minimum length is 1 character.

Optional 2 Optional information, enter an employee data item. Minimum length is 1 character.

Date Date. Minimum length is 10 characters.

Form number Internal system number. Minimum length is 12 characters.

First date First date of timesheet history. Minimum length is 10 characters.

Last date Last date of timesheet history. Minimum length is 10 characters.
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16. Complete field 8, which defines the detail for the optional third part of the check 
form (timesheet history), according to Table 5.8. 

Table 5.8—Define Check Formats Field Definitions—Field 8

Field Options Definition

Time detail These fields define the content and placement of timesheet detail information. For 
each possible field on the timesheet stub, a Column and Length must be specified. 
Enter a 0 for columns not to appear. The Length has a minimum length of 5 
characters. For Hours and Rate, the following options apply for the printing of commas 
and decimals. For Amount, only the first three options apply:

ENTER Normal format with commas and decimals.

1 Suppress commas.

2 Suppress decimal places.

3 Suppress commas and decimals.

4 Print only 2 decimals.

5 Print 2 decimals, no commas.

Date Business date of the timesheet.

Entry Unique number for each timesheet.

Earn item Historical Data Item used to create timesheets.

Rate item Employee Data Item that contains the salary amount, hourly, or unit rate of pay.

Shift item Employee Data Item that stores shift differentials.

Rate value Rate value
• For classified setups, this is the name of the rate edit value.

Shift value Shift value
• For classified setups, this is the name of the rate edit value.

Costcode Costcode
• For classified setups, this is the name of the rate edit value.

Hours Hours

Rate Rate

Amount Amount
Defining Check Formats 
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17. Press ENTER or PAGE DOWN to move to the next field. Page 8 of the Define 
Check Format record displays (Figure 5.9). 

Figure 5.9—Define Check Formats, Page 8 of 9

Page 8 and Page 9 of the Define Check Formats record are used only if 
set the Laser print parameter (Field 1) to Y—Use laser printer. You 
should only use that setting and the fields on Page 8 and Page 9 if you 
use an ACOM printer.

18. If you are not using ACOM printers, all settings should be N. However, if you 
are using ACOM printers, complete field 9 to define the use of laser codes, 
according to Table 5.9. 

Table 5.9—Define Check Formats Field Definitions—Field 9

Field Options Definition

Laser options This field defines the use and position of numerous laser codes.

Send init code Y Use initial codes.

N Do not use initial codes.

F Download a file. File name: ##_CK1 where ## is the division 
number.

Symbol Y Check symbol is printed; enter X and Y positions.

N Check symbol is not printed.
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Signature Y Print signature; enter X and Y positions.

N Do not print signature.

Logo Y Print company logo; enter X and Y positions.

N Do not print company logo.

FIA logo Y Print FIA logo; enter X and Y positions.

N Do not print FIA logo.

AUX on-us
(MICR)

Y Print auxiliary on-us MICR codes; enter X and Y positions.

N Do not print auxiliary on-us codes.

Transit 
(MICR) 

Y Print transit codes, enter X and Y positions.

N Do not print transit codes.

On-us (MICR) Y Print on-us codes, enter X and Y positions.

N Do not print on-us codes.

MICR font Y MICR font is used.

N MICR font is not used.

Send addit 
code

Y Additional codes are used.

N Additional codes are not used.

F Download a file. File name: ##_CK2 where ## is the division 
number.

Send term 
code

Y Send termination codes.

N Do not send termination codes.

Table 5.9—Define Check Formats Field Definitions—Field 9 (Continued)

Field Options Definition
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19. Press ENTER or PAGE DOWN to move to the next field. Page 9 of the Define 
Check Format record displays (Figure 5.10). 

Figure 5.10—Define Check Formats, Page 9 of 9

20. If you are not using ACOM printers, all settings should be N. However, if you 
are using ACOM printers, complete field 10 to define the actual laser codes, 
according to Table 5.9. 

Table 5.10—Define Check Formats Field Definitions—Field 10

Field Options Definition

Laser codes This field defines the actual laser codes. You are only prompted for fields that were 
activated. A Y was entered in the Laser options field. For all of these fields, a single 
pipe symbol (|) indicates an escape character; a double pipe symbol (||) indicates a 
carriage return/new line sequence.

Init codes 20 characters The initial codes.

Symbol codes 55 characters The check symbol codes.

Signature 
code

55 characters The codes that make up the signature.

Logo codes 55 characters The codes that define the company logo.

FIA logo 
codes

55 characters The codes that define the FIA logo.
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AUX on-us 
codes

space = prints 
space
0–9 = print nbr
& = transit symbol
$ = amount symbol
/ = on-us symbol
- = dash symbol
@ = check number

The auxiliary on-us codes in the MICR line.

Transit codes space = prints 
space
0–9 = print nbr
& = transit symbol
$ = amount symbol
/ = on-us symbol
- = dash symbol

The transit codes in the MICR line.

On-us codes space = prints 
space
0–9 = print nbr
& = transit symbol
$ = amount symbol
/ = on-us symbol
- = dash symbol
@ = check number

The on-us codes in the MICR line.

MICR font 
code

55 characters The font for the MICR line.

Additional 
codes

55 characters The additional codes.

Terminate 
codes

20 characters The termination codes.

Table 5.10—Define Check Formats Field Definitions—Field 10 (Continued)

Field Options Definition
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USING THE TIMESHEET HISTORY STUB FEATURE

When you produce your timesheets, FundWare can include an additional stub with 
timesheet history, earning items, and amounts. To use this feature, certain fields in the 
Payroll parameter and check format must be defined with specific settings, according to 
the following instructions.

1.  Click Setup > Payroll Parameter on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Payroll Parameter from the menu bar. 

2. Type C to change information. Page 1 of the Payroll Parameter displays (Figure 
5.11). 

Figure 5.11—Define Payroll Parameter, Page 1 of 4
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3. Access field 3—Timecard options, on page 3 of the Payroll Parameter (Table 
5.12). 

Figure 5.12—Define Payroll Parameter, Page 3 of 4

4. Ensure that Keep history setting is Y—Keep time card history. 

5. Press ESC and type 0 to save your settings.

6. Type E to exit the task.

7. Click Setup > Check Formats on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Check Formats from the menu bar. 

8. Type C to enter information. The system asks for the FIA (or “Bank”) name. 
Press F1 to see a list of your payroll FIAs (i.e., FIAs with a By Use association 
with Payroll/Personnel). 
Defining Check Formats 
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9. Enter the FIA name or select from the F1 list. Page 1 of the Define Check 
Format record displays (Figure 5.2). 

Figure 5.13—Define Check Formats, Page 1 of 9

10. Access field 1—Print Options. 

11. In the Timecard history field, ensure that the setting is either of the following:

• Y—Print timesheet history.
• R—Print history—sum by rate.
If the setting is N—Do not print timesheet history, FundWare will not produce 
the timesheet history stub.

12. Access field 2—Detail Line Options. 

13. In the Time dtl lines field, enter the number of lines that FundWare should 
display in the timesheet history stub for timesheet history, earning items, and 
amounts:

• 0—No information is printed.
• 1–50—Number of detail lines on timesheet history stub; 0 is the default.

If you have more timesheet history detail lines than are defined, the 
system will total the remaining lines. For example, Time dtl lines is 5, 
you have 7 lines of timesheet history. The first four lines of timesheet 
history will print in detail and the remaining three lines will be summed 
and printed on the remaining line.
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14. Move to field 7—Time heading on page 6 of the Define Check Format record 
(Figure 5.7). 

Figure 5.14—Define Check Formats, Page 6 of 9

15. Complete the fields to define the heading for the timesheet history stub, 
according to Table 5.11. Note: These fields will not display if the Payroll 
parameter Keep History option (field 3) is defined as N. 

16. Press ESC and type 0 to save your settings.

Table 5.11—Define Check Formats Field Definitions—Field 7

Field Options Definition

Time heading These fields define the content and placement of the timesheet header line. For 
each possible field on the timesheet stub, a Column and Length must be specified. 
Optional 1 and Optional 2 may contain an employee data item. Enter zeroes to not 
print a field.

Emp nbr–name Employee number and name. Minimum length is 9 characters.

Optional 1 Optional information, enter an employee data item. Minimum length is 1 character.

Optional 2 Optional information, enter an employee data item. Minimum length is 1 character.

Date Date. Minimum length is 10 characters.

Form number Internal system number. Minimum length is 12 characters.

First date First date of timesheet history. Minimum length is 10 characters.

Last date Last date of timesheet history. Minimum length is 10 characters.
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17. Type E to exit the task. 

18. When producing checks, you can control the information included in the 
timesheet history stub by entering a date range (Figure 5.15) on the Produce 
Checks window of the Check Wizard. 

Figure 5.15—Produce Checks

LASER PRINTING
American Fundware, Inc. is not liable for rejected checks created with the Laser Printing 
feature for ACOM printers only. It is the sole responsibility of the client to ensure that:

• The MICR line is accurate, 
• Printed within tolerances, 
• Printed on 24-pound or greater long-grain paper, and 
• The toner used has the proper signal strength. 
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We strongly advise that you test the check format by printing example checks (Figure 
5.16). Additionally, you should strictly control and monitor access to the cartridge. 

Figure 5.16—Sample Check

 

Stub 
heading

Stub 
detail

Form 
detail
Laser Printing 
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DEFINING DIRECT DEPOSIT

Direct deposit (also know as Electronic fund transfer, or EFT) allows you to produce a 
file for the electronic transfer of payroll funds rather than physical check forms. You 
submit this file to the financial institutions to transfer the monies to the accounts 
specified by the employee.
Implementing direct deposit into your organization will be a major task initially, but 
once it is functioning, paperwork will be significantly reduced.

• No checks to print. Direct deposit stubs can be produced on plain paper. 
(Similar to paychecks, stubs provide the same information but display “Non-
negotiable.”)

• No checks to sign.
• No checks to be reconciled.
• No checks to be lost by employees or lost in the mail; therefore, no checks to 

reissue.
• Employees can indicate multiple distributions for their pay. For example, 

Employee A deposits 80% of net to a checking account and 20% to a savings 
account. Employee B deposits $1,000 to checking, makes a $400 payment to 
her mortgage, and deposits the remainder in a Christmas savings fund.
Employees with direct deposit errors are not included in the direct deposit file. 
These employees do not receive an direct deposit form; instead a physical check 
is produced for employees with direct deposit errors.

If you are setting up your FundWare Payroll system and want to use the direct deposit 
feature, we recommend that you set up and produce at least your first two payrolls as 
regular checks. There is a certain amount of “tweaking” that even the most well-thought 
out setup requires. Get your payroll and your payroll personnel to a solid level of 
confidence and then implement direct deposit, as it is generally more difficult to correct 
errors using direct deposit than physical check forms.
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FILE FORMAT
This feature was developed from information received from the National Automated 
Clearing House Association (NACHA). The files created by the Payroll/Personnel 
check writing task is in accordance with the NACHA file guidelines and is accepted by 
most banks (i.e., you should not need any additional bank software).
The payroll manager or controller for your organization should work with your bank 
(i.e., financial institution) to produce and test a sample file. If NACHA format is not 
accepted, the file will require additional processing, which your bank may or may not be 
willing to perform.
When you complete the check writing task for direct deposit, the system creates the 
following files (where ## is your division number):

• ##PYN file in the Data folder, and
• ##PY2 in your Data folder if you answered T or U in the File format field in the 

direct deposit parameter record. You will submit the ##PY2 file to your 
financial institution.

• PYSTUB.L## in your Data folder. Print this file and distribute to the employee.
##PYN and ##PY2 cannot be viewed through Print Manager. If you wish to 
view these files, you must use a Note Pad (or similar text program).

WARNING—PAYROLL ALWAYS OVERWRITES THESE FILES

As you work with the direct deposit feature, you must constantly be aware that each 
time you produce checks and direct deposits through the check wizard, the system 
overwrites the previous file. You must make sure that you have completed the direct 
deposit process before you can begin a new direct deposit payroll.
For example, if you are using the selection feature (see Using the Selection Feature on 
page 1.228) to create separate files for each financial institution, you must make sure 
that you completely finish one direct deposit process before beginning the next.
Also, when you create a prenotification file (see Creating the Prenotification File 
Separate From the Check Wizard on page 1.211), you are creating the same files 
(##PYN and ##PY2). So you must take care to process a prenotification with the 
understanding that you are overwriting the last direct deposit file.
File Format 
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SETTING UP YOUR DIRECT DEPOSIT SYSTEM
The setup process for Payroll’s Direct Deposit system has a number of steps:

1.  Gather the necessary bank and employee information.

2. Define the payroll parameter setting.

3. Define the direct deposit parameters for each FIA.

4. Define direct deposit form formats for each FIA.

5. Define the direct deposit information for each employee.

6. Create a prenotification file to test the system.

GATHERING YOUR INFORMATION

You need to ask your bank the following questions:
• Can you process a NACHA formatted file? If not, the bank may be willing to 

change the file into a format it can use.
• If NACHA format is acceptable, ask the bank if they want:

— The file control records, and 
— The employer control records. 

• Also, the bank may have a guidebook or other documentation of the tasks 
required to setup and operate direct deposit. Ask your bank when the file will be 
posted and how errors will be addressed.

You should also gather the following information from your employees:
• Bank name(s),
• Account number(s), 
• Deposit and payment amounts or percentages.

With this information find the Depository Financial Institution (DFI) numbers for each 
financial institution, verify account numbers, determine what cycles and direct deposit 
selection values are necessary (if any).
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DEFINING THE PAYROLL PARAMETER SETTING

Before you can begin the direct deposit setup tasks, you must ensure that the payroll 
parameter is defined to allow electronic fund transfers. You probably did this when you 
defined the payroll parameter, but you should ensure that the Elec fund xfer entry in 
Field 2 of the payroll parameter is set to Y—EFT is used (Figure 6.1). 

Figure 6.1—Elec Fund Xfer With an Entry of Y

When you save the payroll parameter, the system creates several employee data items 
(beginning with .EFT) that are required for direct deposit. These data items require no 
editing or changing, and they should be largely invisible to you as a user.

DEFINING THE DIRECT DEPOSIT PARAMETERS

Direct deposit parameters define company information for the transmittal file. Use the 
following steps to modify the direct deposit parameter (created automatically when you 
save the Payroll parameter defined for direct deposit).

You should refer to the NACHA Operating Rules Manual and communicate 
with your bank to define these fields correctly.

1.  Click Setup > EFT Parameters on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
EFT Parameters from the menu bar. 
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2. Type C to enter information. The system asks for the FIA usage ID (Figure 6.2). 
Press F1 to see a list of your payroll FIAs (i.e., FIAs with a By Use association 
with Payroll/Personnel). 

Figure 6.2—Enter FIA Name

3. Enter the FIA usage ID or select from the F1 list. Page 1 of the Define EFT 
Parameters record displays (Figure 6.3). 

Figure 6.3—Define EFT Parameters, Page 1 of 2
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4. Complete field 1, which defines the company information that will be sent to 
bank as part of the direct deposit file, according to Table 6.1. 

Table 6.1—Direct Deposit Field Definitions—Field 1

Field Options Definition

Direct Deposit 
Information

This field defines the company information portion of the file. See the NACHA 
Operating Rules Manual for more detailed information about each field.

Company 
name

16 characters Your organization’s name. Use upper case letters only.

Company ID 10 alphanumeric Your organization’s identification number. Must be one of the 
following options:
• 1######### IRS Employer ID (EIN)
• 3######### Data Universal Numbering System (DUN)
• 9************** (User-defined value)

Discretionary 20 characters Discretionary information. Use upper case letters only.

Entry desc 10 alphanumeric Description of entry. Use upper case letters only.

Effective days 2 digits The day, relative to the check date, the file is posted. For 
example, enter 00 (zero, zero) and the file posts on the check 
pay date. The file is stamped with the check pay date, not the 
creation date.
Effective days are added to the pay date which is the date on 
file. For example, an effective day of 1 indicates that the file 
posts one day after the check date. Verify with your FIA. 
Some FIAs always process files on the next business day. 
Work closely with your ACH agent to obtain the correct entry 
for this file.

Origin DFI ID 8 digits The transit/routing number of the originating DFI number. This 
DFI number is the routing number for the debit offset, if it is 
enabled. 
• The number must be at least 8 digits, including any leading 

zeros. Do not enter the 9th digit in a bank number; it is a 
check digit.

• This field is required. If necessary, enter a fictional number 
to avoid receiving errors when you produce checks.
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5. Press ENTER or PAGE DOWN to move to the next field. Page 2 of the Define EFT 
Parameters record displays (Figure 6.4). 

Figure 6.4—Define EFT Parameters, Page 2 of 2

Incl what rcds This field defines what records are included in the file. Ask 
your FIA what information they need and define this field 
accordingly.

0 Include only PPD entry records.

1 Include file records.

2 Include company records.

3 Include all records.

Table 6.1—Direct Deposit Field Definitions—Field 1 (Continued)

Field Options Definition
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6. Complete field 2, which defines the FIA information, according to Table 6.2. 

Table 6.2—Direct Deposit Field Definitions—Field 1

Field Options Definition

Immed Dest 
Name

23 alphanumeric The name of the ACH Operator or receiving point that will 
process the file. Obtain correct entry from your ACH agent. 
Check with your FIA to define this field. Use upper case 
letters only.

Immed Orig 
Name

23 alphanumeric The name of the ACH Operator or sending point for this file. 
Obtain correct entry from your ACH agent. Check with your 
FIA to define this field. Use upper case letters only.

Immediate 
Dest

10 alphanumeric The transit/routing number of the ACH Operator or receiving 
point that will process the file. Obtain correct entry from your 
ACH agent and check with your FIA to define this field. the 
correct entry for this field is as follows: XYYYYYYYYY where 
X represents a space and Y represents the value given to you 
by your ACH agent.

Immediate 
Orig

10 alphanumeric The financial institution that will submit the ACH data. Obtain 
correct entry from your ACH agent and check with your FIA to 
define this field. The correct entry for this field is as follows: 
XYYYYYYYYY where X represents a space and Y represents 
the value given to you by your ACH agent.

Debit Offset This field allows you to create a detail record in your FIA file 
that will debit the account specified in the Debit Bank Acct 
field. In addition, the number in the Origin DFI ID field is used 
for this entry.

Y Answer Y if your FIA requires an entry for the total of all credit 
entries. This will create a debit offset record in the current FIA 
file.

N No debit offset record for the current FIA file.

Debit Bank 
Acct

17 alphanumeric The Debit FIA account. This is used with the origin DFI for the 
account and FIA for the offset withdrawal. Enter the value of 
the account to be debited here. Remember that the FIA 
number is the value in the Origin DFI ID field and will be the 
DFI value in the FIA file offset record.
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7. Press ESC to display the Define EFT Parameters options.

8. Type E to end the session and return to the Setup menu.

DEFINING DIRECT DEPOSIT FORM FORMATS

When you defined an FIA (Financial Institution account), a direct deposit form for that 
FIA was added for you. You may wish to modify the standard direct deposit form, 
which defines the format of the PYSTUB.L##. Separate format definitions allow you to 
define your checks and direct deposits differently. You may print a three-part direct 
deposit form with the stub, the body of the non-negotiable check, and timesheet history. 
You can define the size, position, and content of the stub, the non-negotiable check, and 
the timesheet history. Formatting the direct deposit form requires the entry of character 
positions and field sizes for the data printed on the direct deposit form. Direct deposit 
stubs can be printed on stub forms or on plain paper. 

Status code This field specifies what type of entry is submitted to the FIA 
file. The usual entry is 1, a financial institution.

0 File is prepared by ACH Operator.

1 Financial institution.

2 Federal Agency, exempt.

File Format Y Include 9 trailer records. Using this entry will allow the size of 
the FIA file to be an exact multiple 940 bytes.
• Produces only the ##PYN file.

N Do not include 9 records.
• Produces only the ##PYN file.

T A carriage return/line feed will be placed after each 94th 
character. In addition, 9 trailer records will be included as 
explained in the Y option above.
• Produces the ##PYN and ##PY2 files. Transmit the ##PY2 

file to your financial institution.

U A carriage return/line feed will be placed after each 94th 
character. 9 trailer records are not used.
• Produces the ##PYN and ##PY2 files. Transmit the ##PY2 

file to your financial institution.

Table 6.2—Direct Deposit Field Definitions—Field 1 (Continued)

Field Options Definition
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Use the following steps to modify the existing Direct Deposit Form Formats record. 
(Remember: You can define only one direct deposit format per FIA usage.)

1.  Click Setup > EFT Form Formats on the module navigator (if the module is 
not expanded, click Payroll/Personnel first) or select Payroll/Personnel > 
Setup > EFT Form Formats from the menu bar. 

2. Type C to enter information. Page 1 of the Define EFT Form Format record 
displays (Figure 6.5). 

Figure 6.5—Define EFT Form Formats, Page 1 of 9

3. Complete fields 1 and 2, which define the printing and detail line options, 
according to Table 6.3. 

Table 6.3—Direct Deposit Field Definitions—Fields 1 and 2

Field Options Definition

Print Options This field defines how the stub portion of the Direct Deposit form is printed.

Suppress 
Feed

Y Suppress initial form feed. The first Direct Deposit form prints 
on the Direct Deposit stub or paper currently in the printer. 
The waste of stubs or paper is determined by the printer and 
the operating system.

N Do not suppress initial form feed. Advances one form, then 
prints the Direct Deposit form.
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Suppress 
Fcount

Y Suppress the ****Number of lines printed **** message. 

N Do not suppress the **** Number of lines printed **** 
message. One form is lost at the end since it contains this 
message.

Laser print Y Laser printing is used for Direct Deposit forms.

N Laser printing for Direct Deposit forms is not used.
• Enter N unless you are using ACOM printers.

Timecard hist Timesheet history can be printed on the Direct Deposit form if 
timesheet history is maintained by answering Y in the Keep 
history field under Timecard options in the payroll parameter. 

Y Print timesheet history.

N Do not print timesheet history.

R Print history–sum by rate. 

Stub vertical Defines the vertical position of the stub portion of the form.

Y Stub vertical position is used. Using 300 dots per inch as the 
rule, enter a Y position.

N Stub vertical position is not used. A standard Direct Deposit 
check format with stub on the top is used.
• Enter N unless you are using ACOM printers.

Note: Defining the stub vertical, form vertical, and time vertical is only available for laser Direct Deposit 
form printing, if you answered Laser print–Y–Laser printing is used for Direct Deposit forms and you are 
using ACOM printers. You determine the order the stub, the body of the non-negotiable check and 
timesheet history print on the Direct Deposit form. Refer to your printer manual for specific information.

Form vertical Defines the vertical position of the non-negotiable check 
portion of the form.

Y Direct Deposit check vertical position is used. Using 300 dots 
per inch as the rule, enter a Y position.

N Direct Deposit check vertical position is not used. A standard 
Direct Deposit check format with the stub on top used.

Table 6.3—Direct Deposit Field Definitions—Fields 1 and 2 (Continued)

Field Options Definition
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Time vertical Defines the vertical position of the timesheet portion of the 
Direct Deposit form.

Y Direct Deposit check vertical position is used. Using 300 dots 
per inch as the rule, enter a Y position.

N Direct Deposit check vertical position is not used. A standard 
Direct Deposit check format with stub on the top is used.

Detail line 
options

The number of lines of earnings, taxes, and deductions to appear on the Direct 
Deposit stub.

EFT dtl lines 0 No stub detail is printed.

1–50 Number of detail lines on stub; 11 is the default.

EFT dist lines 0 No stub detail is printed.

1–50 Number of lines for direct deposit distribution reporting.

EFT time lines The number of timesheet entries, earning items and amounts 
to appear on the direct deposit timesheet history stub.

0 No timesheet detail is printed.

1–50 Number of detail lines on direct deposit timesheet history 
stub; 0 is the default.
Note: If you have more timesheet history detail lines than are 
defined, the system will total the remaining lines and place the 
totals on the line with the description “Other misc.”

Table 6.3—Direct Deposit Field Definitions—Fields 1 and 2 (Continued)

Field Options Definition
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4. Press ENTER or PAGE DOWN to move to the next field. Page 2 of the Define EFT 
Form Format record displays (Figure 6.6). 

Figure 6.6—Define EFT Form Formats, Page 2 of 9

5. Complete field 3, which defines the placement of the Direct Deposit stub header 
line, according to Table 6.4. 

Table 6.4—Direct Deposit Field Definitions—Field 3

Field Options Definition

Stub heading These fields define the content and placement of the Direct Deposit stub header line. 
For each possible field on the Direct Deposit check stub, a Column and Length must 
be specified. Optional 1 and Optional 2 may contain an employee data item. Enter 
zeroes to not print a field. 

Emp 
nbr–name

Employee number and name. Minimum length is 9 characters.

Optional 1 Optional information. Enter an Employee Data Item. Minimum length is 1.

Optional 2 Optional information. Enter an Employee Data Item. Minimum length is 1.

Date Date. Minimum length is 10 characters.

Form number Check number. Minimum length is 12 characters (7 digits for the system number, 1 
character for the hyphen and 4 digits for the form sequence number).
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6. Press ENTER or PAGE DOWN to move to the next field. Page 3 of the Define EFT 
Form Format record displays (Figure 6.7). 

Figure 6.7—Define EFT Form Formats, Page 3 of 9

7. Complete field 4, which defines the placement of the Direct Deposit stub detail, 
according to Table 6.5. 

Table 6.5—Direct Deposit Field Definitions—Field 4

Field Options Definition

Stub detail These fields define the content and placement of Direct 
Deposit stub earning information. For each possible field on 
the Direct Deposit check stub, a Column and Length must be 
specified. The Length field has a minimum length of 5 
characters. For each field containing hours or amounts, you 
must also enter an option for the printing of commas and 
decimals. Valid options are:

ENTER Normal.

1 Suppress commas.

2 Suppress decimal places.

3 Suppress both commas and decimals.

4 Commas and decimals must be considered in field length.

Earnings desc Description for an earning

Current hours Current hours
Setting Up Your Direct Deposit System 



Chapter 6—Defining Direct Deposit
8. Press ENTER or PAGE DOWN to move to the next field. Page 4 of the Define EFT 
Form Format record displays (Figure 6.8). 

Figure 6.8—Define EFT Form Formats, Page 4 of 9

Cur amount Current amount

Ytd hours Year-to-date hours

Taxes/deds 
desc

Description for taxes and deductions

Cur amount Current amount

Ytd amount Ytd amount

Table 6.5—Direct Deposit Field Definitions—Field 4 (Continued)

Field Options Definition
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9. Complete field 5, which defines the placement of Direct Deposit form detail 
information, according to Table 6.6. Note: the words “Non-negotiable” print on 
the Direct Deposit form. 

10. Press ENTER or PAGE DOWN to move to the next field. Page 5 of the Define EFT 
Form Format record displays (Figure 6.9) 

Figure 6.9—Define EFT Forms Formats, Page 5 of 9

Table 6.6—Direct Deposit Field Definitions—Field 5

Field Options Definition

Form detail This field defines content and layout of the detail portion of the Direct Deposit non-
negotiable check. Line, Column, and Length must be entered for each field. A line 
specifying “NON-NEGOTIABLE” prints on the Direct Deposit form. 
Note: To produce a Direct Deposit stub ONLY, enter all 0s (zeroes) for this screen to 
suppress printing the form detail.

Form number Check number. Minimum length is 12 characters.

Amount 
(alpha)

Amount of the Direct Deposit check written out, like Seven hundred and fifty dollars. 
Minimum length is 40. If amount does not meet maximum size, it is filled with *** to 
prevent modification of the check amount.

Date Check date. Minimum length is 10 characters.

Amount 
(number)

Numeric amount of check. If amount does not meet maximum size, it is filled with *** 
to prevent modification of check amount.

Address 1–5 Name and address of employee. If smaller field lengths are centered, the information 
is truncated. 
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11. Complete field 6, which defines the placement of Data Items and their values to 
print on the Direct Deposit form, according to Table 6.7. 

Table 6.7—Direct Deposit Field Definitions—Field 6

Field Options Definition

Form items These fields define the content and placement of up to three Data Items values and 
text that can appear on the Direct Deposit check form. For each Data Item defined for 
the Direct Deposit check form, a Line, Column, and Length must be defined.

Option N
E
C
M
Q
H
Y
B
T
A

Not used (default)
Employee item
Current total
Monthly total
Quarterly total
Half year total
Yearly total
Beginning total
Total for year
Annual total

Extract N
H
A
O
1
2
3

Not used (default)
Hours
Amount
Other
Basis hours
Basis amount
Basis other

Data item Press F1 for a list of existing data items in the system to select. A list of Historical Data 
Items is displayed for all Option selections except E—Employee item. If E—Employee 
item is selected, pressing F1 displays a list of Employee Data Items.

Text Text to prefix data item printed on the Direct Deposit check form. The text will not print 
if the Data Item does not exist for the employee or the Data Item value is zero.
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12. Press ENTER or PAGE DOWN to move to the next field. Page 6 of the Define EFT 
Form Format record displays (Figure 6.10). 

Figure 6.10—Define EFT Forms Formats, Page 6 of 9

13. Complete field 7, which defines the heading for the optional third part of the 
Direct Deposit form (i.e., the timesheet history), according to Table 6.8. Note: 
These fields will not display if the Payroll parameter Keep History option (field 
3) is defined as N.

Table 6.8—Direct Deposit Field Definitions—Field 7

Field Options Definition

Time heading These fields define the content and placement of timesheet card header line. For each 
possible field on the timesheet stub, a Column and Length must be specified. Optional 
1 and Optional 2 may contain an employee data item. Enter zeroes to not print a field.

Emp 
nbr–name

Employee number and name. Minimum length is 9 characters.

Optional 1 Optional information. Enter an Employee Data Item. Minimum length is 1 character.

Optional 2 Optional information. Enter an Employee Data Item. Minimum length is 1 character.

Date Date. Minimum length is 10 characters.

Form number Check number. Minimum length is 12 characters.

First date First date of timesheet history. Minimum length is 10 characters.

Last date Last date of timesheet history. Minimum length is 10 characters.
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14. Press ENTER or PAGE DOWN to move to the next field. Page 7 of the Define EFT 
Form Format record displays (Figure 6.11). 

Figure 6.11—Define EFT Forms Formats, Page 7 of 9

15. Complete field 8, which defines the detail for the optional third part of the 
Direct Deposit form (i.e., the timesheet history), according to Table 6.9. Note: 
These fields will not display if the Payroll parameter Keep History option (field 
3) is defined as N.

Table 6.9—Direct Deposit Field Definitions—Field 8

Field Options Definition

Time detail These fields define the content and placement of timesheet 
detail information. For each possible field on the timesheet 
stub, a Column and Length must be specified. Enter a 0 for 
columns not to appear. The Length has a minimum length of 5 
characters. For Hours and Rate, the following options apply 
for the printing of commas and decimals. For Amount, only 
the first three options apply:

ENTER Normal format with commas and decimals.

1 Suppress commas.

2 Suppress decimal places.

3 Suppress commas and decimals.

4 Print only 2 decimals.

5 Print 2 decimals, no commas.
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Date Business date of the timesheet.

Entry Unique number for each timesheet.

Earn item Historical Data Item used to create timesheets.

Rate item Employee Data Item that contains the salary amount, hourly, or unit rate of pay.

Shift item Employee Data Item that stores shift differentials.

Rate value Rate value
• For classified setups, this is the name of the rate edit value.

Shift value Shift value
• For classified setups, this is the name of the rate edit value.

Costcode Costcode
• For classified setups, this is the name of the rate edit value.

Hours Hours

Rate Rate

Amount Amount

Table 6.9—Direct Deposit Field Definitions—Field 8 (Continued)

Field Options Definition
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16. Press ENTER or PAGE DOWN to move to the next field. Page 8 of the Define EFT 
Form Format record displays (Figure 6.12). (This screen is only used if you 
have indicated that you are using the laser printing option.) 

Figure 6.12—Define EFT Forms Formats, Page 8 of 9

Page 8 and Page 9 of the Define EFT Check Formats record are used 
only if set the Laser print parameter (Field 1) to Y—Use laser printer. 
You should only use that setting and the fields on Page 8 and Page 9 if 
you use an ACOM printer.

17. If you are not using ACOM printers, all settings should be N. However, if you 
are using ACOM printers, complete field 9 to define the use of laser codes, 
according to Table 6.10. 

Table 6.10—Direct Deposit Field Definitions—Field 9

Field Options Definition

Laser options This field defines the use and position of numerous laser codes.

Send init code Y Use initial codes.

N Do not use initial codes.

F Download a file. File name: ##_CK1 where ## is the division 
number.

Signature Y Print signature; enter X and Y positions.

N Do not print signature.
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18. Press ENTER or PAGE DOWN to move to the next field. Page 9 of the Define EFT 
Form Format record displays (Figure 6.13). (This screen is only used if you 
have indicated that you are using the laser printing option.) 

Figure 6.13—Define EFT Forms Formats, Page 9 of 9

DEFINING THE EMPLOYEE DIRECT DEPOSIT TAB

Use the following instructions to complete the Direct Deposit tab.

Logo Y Print company logo; enter X and Y positions.

N Do not print company logo.

Send addit 
code

Y Additional codes are used.

N Additional codes are not used.

F Download a file. File name: ##_CK2 where #3 is the division 
number.

Send term 
code

Y Send termination codes.

N Do not send termination codes.

Table 6.10—Direct Deposit Field Definitions—Field 9 (Continued)

Field Options Definition
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1.  Select the Direct Deposit tab (Figure 6.14). 

Figure 6.14—Employee Record—Direct Deposit

2. Complete the fields on the Direct Deposit tab according to Table 6.11. 

Table 6.11—Field Definitions for the Direct Deposit Tab

Field Definition

Inactive, Active, or 
Pre-notification

Select the radio button under Direct Deposit to choose the status for this 
employee:
• Inactive—This employee is not active in the direct deposit program and will 

receive a regular pay check. (Default setting until you change this selection.) 
• Active—This employee is active in the direct deposit program.
• Pre-notification—This employee is in pre-notification for the current pay cycle, 

and will receive a regular check. The Payroll Administrator must change this 
field to Active after the pre-notification is submitted. 

Selection If you are using more than one bank for Direct Deposits, click the drop-down 
arrow to choose the appropriate box. This option allows you to complete the 
direct deposit process separately by financial institution.
• If you have only defined one bank, this field will say Not Used (i.e., the direct 

deposit will go to this bank because there are no others to select).
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Line Entry Line numbers control the order in which information is processed. Enter a 2-digit 
line number. 
• We recommend that you number lines 10, 20, 30, etc., and number the last line 

99. 
• If the employee is directing their check to be deposited to one account, they will 

only have line 99. 

Cycle Click the drop-down arrow and choose the appropriate Direct Deposit Cycle. 
Cycles are activated in the Preliminary Check Register or when producing 
checks, and determine when the direct deposit occurs. 

Type Click the drop-down arrow and choose the amount type:
• Amount—A flat amount.
• Percentage—A percentage of net pay. 
• Remainder—The remaining amount after all previous lines have been 

processed. All active or pre-note direct deposits must have the last line of their 
direct deposit information be a remainder line. 

Transfer Type Click the drop-down arrow and choose the type of direct deposit:
• Checking Deposit (C)—A credit to a checking account. Performs the same 

function as Checking Deposit (D).
• Checking Deposit (D)—A credit to a checking account. Performs the same 

function as Checking Deposit (C).
• Deposit—A credit to an account. 
• Checking Pre-notification—A pre-notification for zero dollars for a checking 

account. (Use only when an active direct deposit employee directs a change to 
his/her direct deposit.)

• Payment—A debit to a loan or mortgage account.
• Payment Pre-notification—A pre-notification for zero dollars for a payment.
• Savings Deposit—A credit to a savings account.
• Savings Pre-notification—A pre-notification for zero dollars for a savings 

account. (Use only when an active direct deposit employee issues a change.)

Amount/Percent If you chose Amount in the Transfer Type field, type in the amount here. If you 
chose Percentage, enter the percentage here. If you chose Remainder, enter 
zero here.

Bank DFI Number The bank’s Depository Financial Institution number. Enter the number, which 
must be at least 8 digits, including any leading zeros. Do not enter the 9th digit in 
a bank number; it is a check digit that will be calculated by Payroll.

Bank Account 
Number

The employee’s bank account number. Up to 30 characters allowed.

Table 6.11—Field Definitions for the Direct Deposit Tab (Continued)

Field Definition
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To save your work and remain in the employee record, click Apply. 
Clicking OK will save your work and close the employee record.

DIRECT DEPOSIT CYCLES

Direct deposit cycles are assigned to each line of the distribution and control when a 
payment or deposit is made. (You will indicate the cycle when you complete the Check 
Writing task.) Cycles can be a number between 1 and 9, Always Calculate, or Never 
Calculate. If all employees make the same deposits/payments every pay period, you do 
not need to use cycles. But if any payments are made every other pay period or only on 
designated dates, you must use the cycles feature.

Employee A nets $1000 every paycheck. The first paycheck of the month 
applies $800 to her mortgage. This payment doesn’t impact the second 
paycheck of the month. Therefore, you would set up two cycles. The first 
paycheck of the month would be in cycle 1, the second paycheck of the month 
would be in cycle 2.

The Remainder direct deposit line should be set to Always Calculate.

DIRECT DEPOSIT TAB—ADDITIONAL TIPS

• The lines are processed “top down”, so the lines with the highest priority should 
be entered first. In some cases, the later lines cannot be processed because of a 
lack of dollars.

• If there are not enough funds for the last lines, the message Insufficient funds is 
reported. Conversely, if there is an overflow of funds, the message EFT 
distribution not = net pay. Not posted. is reported.

• The last line of distribution should always be a Remainder deposit to a savings 
or checking account. This line will send 100% of the remainder, be it $200 or 1 
cent, to a valid account. This line takes care of pennies created by rounding.

The exception to this rule is if an employee has 100% of their pay check 
deposited to a single bank account. You will only need a line 99 
specifying a Remainder deposit and the bank account information.

• A line can be either a deposit or a payment. A deposit normally increases the 
balance of a checking or savings account and is considered a “credit” to the 
bank. A payment normally decreases the balance of a liability account like a 
mortgage or loan, and is considered a “debit” to the bank.

• To delete an entry, click the far left cell to highlight the entire line and click 
Delete.
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WHAT IS A PRENOTIFICATION FILE?
Whenever you add or change the direct deposit setup for one or more employees, you 
should create a prenotification file to transmit to the employee’s bank to verify the 
correctness of routing transit numbers and account numbers (no dollar transactions are 
included in the prenotification file). 

Check with each institution for specific information to determine how many 
banking days prior to running your payroll you must send the prenotification 
file. 

When you create a prenotification file, the system creates the following files (where ## 
is your division number):

• ##PYN file in the Data folder, and
• ##PY2 in your Data folder if you answered T or U in the File format field in the 

direct deposit parameter record. You will submit the ##PY2 file to your 
financial institution.

When you create a prenotification file, you are creating the same files as the direct 
deposit process (##PYN and ##PY2). So you must take care to process a prenotification 
with the understanding that you are overwriting the last direct deposit file. You will send 
the ##PYN or ##PY2 files to your financial institution. 
You can create a prenotification file two ways:

• Automatically when you create your checks through the check wizard, or
• Manually through an option on the menu.

CREATING A PRENOTIFICATION FILE WHEN YOU CREATE CHECKS

When you create a prenotification file for a specific payroll cycle using the check 
wizard, the employee receives a regular printed pay check and the system creates a 
prenotification file to verify the accuracy of routing transit numbers and account 
numbers (as with a prenotification file, no dollar transactions are included in the file). 
Use the following instructions to create a prenotification file when you create your 
checks.

1.  Enter the employee’s pay distribution on the Direct Deposit tab.
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2. Select the Pre-notification radio button (Figure 6.15). 

Figure 6.15—Example Prenotification Setting on Direct Deposit Tab

You cannot create a prenotification file for a Remainder type. 
Therefore, you should select either Percentage or Amount and complete 
the prenotification process. When the account information has been 
accepted by the employee’s bank, you can change the type to 
Remainder.

3. Complete your payroll cycle as you would normally. Payroll creates the 
necessary files.

4. Transmit the ##YPY2 file to the appropriate financial institution.

5. If the information is correct and accepted by the financial institution, change the 
setting on the employee’s Direct Deposit tab from Pre-notification to Active. 
(You must do this before the next payroll cycle, or the employee will receive 
another paper check.)

Because this involves more interaction on your part, we recommend 
that you use this method for small numbers of employees.

The next payroll will produce a “live” direct deposit transaction and direct deposit form. 
No changes are required for the direct deposit distribution lines.

CREATING THE PRENOTIFICATION FILE SEPARATE FROM THE CHECK WIZARD

You can also create a prenotification file through a task on the menu (i.e., you do not 
need to wait until you process your checks with the wizard to create the prenotification 
file). You then transmit the file to the employee’s bank to verify the correctness of 
routing transit numbers and account numbers (no dollar transactions are included in the 
prenotification file).
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Use the following steps to create a prenotification file for direct deposit without 
processing checks.

1.  Click Maintenance > Prenotification of Employees’ EFT on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Maintenance > Prenotification of Employees’ 
EFT from the menu bar. The Prenotification of Employees’ EFT screen 
displays (Figure 6.16). 

Figure 6.16—Entering the Bank Number

2. Enter the number of the Bank (i.e., the use ID number of the FIA), or press F1 to 
select from a list of available FIAs.
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3. Press ENTER. The system asks for the item number (Figure 6.17). Because you 
can add more than one parameter to select the employees included in the 
prenotification file, this number indicates which parameter you are entering. 

Figure 6.17—Entering the Parameter Item Number

4. Enter the item number (between 1 and 10).

5. Press ENTER. The system asks for the data item that will be used to filter 
employees for the prenotification file (Figure 6.18). 

Figure 6.18—Entering the Data Item

6. Enter the data item, or press F1 and select from the list of data items.
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7. Press ENTER. The system displays the parameters for the prenotification file 
filter (Figure 6.19). 

Figure 6.19—Entering the Parameters

You will usually select .EFT ACT and include all employees with a 
status of Pre-notification on the Direct Deposit tab (i.e., First value and 
Last value of P). However, you must remember to change the setting to 
Active after the file has been accepted or the employee will receive a 
normal (i.e., paper) paycheck.

8. Complete the options according to Table 6.12 

Table 6.12—Field Definitions for the Prenotification Parameters

Field Definition

First value Enter the first value of the data item that you wish to use when you filter 
employees.

Last value Enter the last value of the data item that you wish to use when you filter 
employees.

Entry range This option will only display if the data item select allows multiple entries. This 
allows you to further filter the information included in the prenotification file.

Inclusion Select the inclusion or exclusion option.
• 1—Include of all values found.
• 2—Include of any values found.
• 3—Exclude of all values found.
• 4—Exclude of any values found.
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9. If necessary, enter additional filter parameters.

10. Press ESC to display the Define EFT Parameters options.

11. Type E to end the session.

12. Type 0 to accept your changes and return to the Maintenance menu. 

13. Transmit the ##PYN or ##PY2 files to the applicable financial institution to 
confirm the direct deposit information.

14. When the information has been confirmed and accepted by the financial 
institution, you are ready to “go live” with your direct deposit!

EXAMPLE DIRECT DEPOSIT—MULTIPLE ACCOUNTS

Every pay period, Employee A splits the net pay between two accounts at United Bank. 
Note that the last line of the distribution is a “Remainder” line for rounding and unusual 
problems. (Note: This setup will work regardless of whether the payroll is setup with 
cycles or not.) 

Figure 6.20—Example Direct Deposit Formula—Employee A

A remainder line should always be the last line, as you will see in the following 
examples.

EXAMPLE DIRECT DEPOSIT—PAYMENTS AND CYCLES

Employee B’s organization has designed their payroll with two cycles: cycle 1 is 
activated for the first payroll of the month and cycle 2 for the second. On the first 
payroll of the month (cycle 1), Employee B makes a car payment ($345.09) and deposits 
the remainder in a checking account. On the second payroll (cycle 2), the mortgage is 
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paid ($830.00) and the remainder is again deposited to the checking account. Because 
the remainder is always calculated it is included in all payroll cycles. Note that the 
mortgage and checking accounts are with the same financial institution (i.e., same DFI 
number), while Employee B’s car payment is made to a different institution. 

Figure 6.21—Example Direct Deposit Formula—Employee B

EXAMPLE DIRECT DEPOSIT—CHECKING AND SAVINGS ACCOUNTS

Employee C receives a base salary of $800 and a commission, which varies from pay 
period to pay period. So that she never has to address what the commission amount is, 
Employee C has decided to deposit her base salary to her checking account and the 
commission funds directly to her savings account. 

Figure 6.22—Example Direct Deposit Formula—Employee C

EXAMPLE DIRECT DEPOSIT—MULTIPLE OPTIONS

Employee D’s organization has also designed their payroll with two cycles: cycle 1 is 
activated for the first payroll of the month and cycle 2 for the second. On the first 
payroll of the month (cycle 1), Employee D deposits 80% of his paycheck to his 
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checking account and the remainder to his savings account. On the second payroll (cycle 
2), Employee D makes a car payment ($250.25) to a separate financial organization, 
deposits 60% of his paycheck to his checking account, and deposits the remainder to his 
savings account. 

Figure 6.23—Example Direct Deposit Formula—Employee D

EXAMPLE DIRECT DEPOSIT—ADDING A BONUS

Now let’s say Employee D’s organization decides to pay a bonus twice a year. 
Employee D still makes the same payments and deposits throughout the year, but 
chooses to put all bonus funds (100%) into a separate money market account at his 
financial institution. Therefore, the payroll department designates cycle 3 as the bonus 
cycle for the employee. 

Figure 6.24—Example Direct Deposit Formula—Employee D With Cycle 3
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CHANGING AN EMPLOYEE’S DIRECT DEPOSIT DISTRIBUTION
When you change an employee’s direct deposit distribution, you must first enter the 
changes as “prenotifications” while keeping the existing distribution lines as they are. 
When you run your next payroll (after making the changes), FundWare will:

• Distribute the employee’s paycheck according the existing distribution, and 
• Create prenotification files to verify the account information in the direct 

deposit distribution changes.
When the financial institution has confirmed the account information, you must remove 
the old distribution lines and change the prenotification lines to the correct Transfer 
Type.
Use the following guidelines when changing an employee’s direct deposit distribution, 
then review the examples that follow to better understand the process.

• Click Add to add a new distribution line.
• To remove a distribution line, click the far left of the line to select the entire 

entry and click Delete.
• Click Apply to save the changes and remain in the employee record.
• Click OK to save the changes and close the employee record.

EXAMPLE DIRECT DEPOSIT—CHANGING ACCOUNTS

Employee E is currently active on the direct deposit system, sending all of his paycheck 
to a checking account each pay period by using the Remainder command. Employee E’s 
Direct Deposit tab looks like Figure 6.25 

Figure 6.25—Original Direct Deposit Tab for Employee E
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Employee E decides to change the account to which his paycheck is deposited. The new 
account is also a checking account and is located at the same financial institution. For 
one pay period, we add a Checking Prenotification entry to the Direct Deposit tab for 
100% distribution to the new checking account (line 98), but keep the current 
distribution (line 99) (Figure 6.26). When we run the payroll, the system will create a 
prenotification file to confirm the new checking account information while still 
depositing the funds to the original checking account.

Figure 6.26—Temporary Direct Deposit Tab for Employee E

Remember: We can’t create a prenotification file for the Remainder type. We’ll 
change the entry to remainder when the information has been accepted by the 
employee’s bank.

Once the information has been accepted and confirmed by the financial institution, we 
delete the original distribution and change the new direct deposit entry (i.e., line 98) to 
Type “Remainder” and Transfer Type “Checking Deposit” (Figure 6.27). 

Figure 6.27—Modified Direct Deposit Tab for Employee E
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EXAMPLE DIRECT DEPOSIT—ADDING ACCOUNTS

Employee F is currently active on the direct deposit system, sending all of her paycheck 
to a checking account each pay period by using the Remainder command. Employee F’s 
Direct Deposit tab looks like Figure 6.28 

Figure 6.28—Original Direct Deposit Tab for Employee F

Employee F decides to change her direct deposit distribution so that $50.00 is deposited 
in her savings account at a different financial institution. For one pay period, we add a 
Savings Prenotification entry to the Direct Deposit tab for the distribution to the new 
savings account (line 10), but keep the current distribution (line 99) (Figure 6.29). 
When we run the payroll, the system will create a prenotification file to confirm the new 
savings account information while still depositing all the funds to the checking account. 

Figure 6.29—Temporary Direct Deposit Tab for Employee F

Once the information has been accepted and confirmed by the financial institution, we 
change the Transfer Type for line 10 from Savings Prenotification to Savings Deposit.
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Note that the system will display the line entries in numeric order (i.e., even though we 
added line 10 after line 99, once the file is closed and reopened, line 10 displays before 
line 99). 

Figure 6.30—Modified Direct Deposit Tab for Employee F

EXAMPLE DIRECT DEPOSIT—ADDING MULTIPLE ACCOUNTS

Employee G is currently active on the direct deposit system, sending all of her paycheck 
to a checking account each pay period by using the Remainder command. Employee G’s 
Direct Deposit tab looks like Figure 6.31 

Figure 6.31—Original Direct Deposit Tab for Employee G

Employee G decides to change her direct deposit distribution so that:
• $15 is applied as a payment to an account with her credit union (different 

financial institution), and
• The remainder is deposited to a different checking account (i.e., not the 

checking account to which she is currently depositing her payroll).
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For one pay period, we add two prenotification entries (Payment and Checking) of type 
“Percentage” (50% each) to the Direct Deposit tab for the distribution to the new 
accounts (lines 10 and 20), but keep the current distribution (line 99) (Figure 6.32). 

Remember: We can’t create a prenotification file for the Remainder type. We’ll 
change the Type selections, Transfer Type selections, and Amount/Percentage 
entries to the correct settings when the information has been accepted by the 
employee’s bank.

When we run the payroll, the system will create a prenotification file to confirm the new 
payment and checking account information while still depositing the funds to the 
original checking account. 

Figure 6.32—Temporary Direct Deposit Tab for Employee G

Once the information has been accepted and confirmed by the financial institution, we:
• Delete line 99 (the original checking deposit).
• For line 10—Change the Type from Percentage to Amount, the Transfer Type 

from Payment Prenotification to Payment, and the Amount/Percentage from 
50% to $15.

• For line 20—Change the Type from Percentage to Remainder, the Transfer 
Type from Checking Prenotification to Checking Deposit, and the Amount/
Percentage from 50% to 0.00.
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Note: If you want to be consistent throughout our system, you can enter the information 
so that the Remainder is always line 99 (e.g., edit the information entered on line 99 to 
be the same as line 20, then delete line 20). We have edited the employee record in a 
similar way in Figure 6.33. 

Figure 6.33—Modified Direct Deposit Tab for Employee G

EXAMPLE DIRECT DEPOSIT—ADDING CYCLES AND ACCOUNTS

Employee H is currently active on the direct deposit system, with the following 
distribution with each paycheck:

• $375 to his mortgage (bank account), 
• $45 to his savings account (credit union), and 
• The remainder to his checking account (bank account).

Employee H’s Direct Deposit tab looks like Figure 6.34 

Figure 6.34—Original Direct Deposit Tab for Employee H

Employee H’s organization decides to implement payroll cycles, so he changes his 
paycheck distribution as follows:
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• Cycle 1—$90 to his savings account (credit union), 
• Cycle 2—$700 to his mortgage (bank account), 
• Cycles 1 and 2—The remainder to his checking account (bank account).

For one pay period, we add two prenotification entries (Payment and Savings) to the 
Direct Deposit tab for the new cycle distribution (lines 30 and 40), but keep the current 
checking account distribution (Remainder line 99) (Figure 6.35). (Because this is 
always calculated, this distribution is not impacted by the change to cycles.) When we 
run the payroll, the system will create a prenotification file to confirm the new payment 
and checking account information while still depositing the funds to the original 
checking account. 

Figure 6.35—Temporary Direct Deposit Tab for Employee H

Once the information has been accepted and confirmed by the financial institution, we 
delete lines 10 and 20 (Figure 6.36). 

Figure 6.36—Modified Direct Deposit Tab for Employee H
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ERRORS IN THE DIRECT DEPOSIT FILE
If an employee has direct deposit errors that were not seen on the Preliminary Check 
Register, the system will:

• Create the direct deposit file(s),
• Exclude the employee from the direct deposit file(s), and
• Create a regular (i.e., paper) paycheck for the employee.

Once you have completed the direct deposit process, you must correct the employee’s 
direct deposit information for the next pay period.

In basic practice, you should correct the employee’s information with 
prenotification settings. Therefore, the employee will receive a regular (i.e., 
paper) paycheck for the next pay period as well. If the prenotification 
information is accepted, you can active the direct deposit for the period after.

LOGGING THE DIRECT DEPOSIT TRANSACTIONS
When you complete the check writing process, Payroll logs the direct deposit 
transactions using the computer-assigned system numbers. In addition, Payroll produces 
a check register, journal entries, and a trace report.
In the Payroll/Personnel system, your direct deposit transactions should be referred to 
by the computer-assigned system numbers. Direct deposit payments are summed by 
check run and posted as one total to the reconciliation system with a check number of 0.

If your organization uses the FundWare Bank Reconciliation module, your 
direct deposit entries are not summed and posted as one total. Each direct 
deposit entry posts individually.

Log only printed check information in the From number, To number, and Check number 
fields. You must complete this task for any direct deposit payments; however, no entry 
is necessary for direct deposit payments in these fields. Direct deposit payments are 
referenced by the internal number assigned by the system (always 200). 
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SAMPLE THREE-PART DIRECT DEPOSIT STUB
You have the option of printing a three-part check listing: the stub, the body of the 
check, and timesheet history. To print timesheet history, you must define the Payroll 
parameter to save timesheet history (field 3) and define the EFT form parameter for the 
financial institution to print the timesheet history (field 1).
Sample Three-Part Direct Deposit Stub 
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Figure 6.37 shows a sample three-part direct deposit stub. 

Figure 6.37—Example Direct Deposit Stub

3   –   F r a n k l i n  F  P o m e g r a n a t e 0 3 / 3 1 / 1 9 9 8 1 5 2 2

E a r n i n g s C u r  h r s C u r  a m t Y t d  h r s  Y t d  a m t T a x e s / D e d s C u r  a m t Y t d  a m t
= = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = =
V a c a  h o u r s 1 2 . 0 0 F W T 7 7 . 9 7 1 , 3 1 5 . 4 3
S i c k  h o u r s 1 2 . 0 0 F i c a 7 4 . 4 0 6 5 6 . 0 4
H o u r l y 8 0 . 0 0 1 , 2 0 0 . 0 0 8 4 2 . 0 0 1 0 , 0 2 0 . 0 0 F i c a  M e d ’ l 1 7 . 4 0 3 4 . 8 0
E  H e a l t h 9 5 . 0 0 9 5 0 . 0 0 C o l o .  S W T 3 2 . 1 9 2 2 9 . 6 7
E  P e n s i o n 6 0 . 0 0 5 0 1 . 0 0 U n i t e d  W a y 4 0 . 0 0
E  L i f e  I n s 3 0 . 0 0 C a f e / H l t h 2 0 0 . 0 0 2 , 0 0 0 . 0 0

C a f e / L i f e 1 4 0 . 0 0
C a f e / D e n t l 7 5 . 0 0

E a r n i n g s .  : 1 , 2 0 0 . 0 0 1 0 , 0 2 0 . 0 0 E m p l o y e e  .  .  .  .  .  .  .  .  :   3
L e s s  t a x  .  : 2 0 1 . 9 6 2 , 2 3 5 . 9 4
L e s s  d e d  : 2 0 0 . 0 0 2 , 2 5 5 . 0 0
N e t  p a y  .  : 7 5 3 . 5 5 5 , 6 3 3 . 3 6

A m o u n t D e p / P a y A c c o u n t M e s s a g e
= = = = = = = = = = = = = = = = = = = = = = = = = = = =
1 0 0 . 0 0 S a v  D e p 2 3  5 6  8 9 1
6 9 8 . 0 4 C h k  D e p 3 4  2 1  8 9 0

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

H o u r s  W o r k e d 8 0 . 0 0 1 5 2 2

* * *  * *  * *  * *  * *  N O N - N E G O T I A B L E  * *  * *  * *  * *  * *  N O N - N E G O T I A B L E  * *  * *  * *  * *  * * *
* * * * * * * * * * * * * * * 7 9 8  D o l l a r s  a n d  0 4  C e n t s   0 3 / 3 1 / 1 9 9 8    * * * * * * * * * * * * * * * 7 9 8 . 0 4

F r a n k l i n  F  P o m e g r a n a t e
B o x  7 7 8 8 0 0
3 3  H o n e y s u c k l e  D r i v e  N W
S t e a m b o a t  S t r i n g s  C O   8 0 4 7 7

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
3   –   F r a n k l i n  F  P o m e g   0 3 / 3 1 / 1 9 9 8 1 5 2 2 0 0 / 0 0 / 0 0 0 0 9 9 / 9 9 / 9 9 9 9

D a t e E n t r y E a r n  I t e m R a t e  S h i f t R a t e S h i f t H o u r s R a t e A m o u n t
= = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = = =
0 3 / 3 1 / 1 9 9 8 1 H o u r l y H o u r l y 4 0 . 0 0 1 5 . 0 0 6 0 0 . 0 0
0 3 / 3 1 / 1 9 9 8 2 H o u r l y H o u r l y 4 0 . 0 0 1 5 . 0 0 6 0 0 . 0 0
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USING THE SELECTION FEATURE

If you choose to use the Selection feature, you will assign edit values to the .EFT SEL 
employee data item and apply these edit values to the employee record. This allows you 
to include or exclude these employees, based on the Selection setting, when you 
complete the check writing task.

This is an optional feature. You are not required to use the Selection value. If 
you do not set up your system for the Selection feature (i.e., you do not add edit 
values to the .EFT SEL employee data item), “Not used” will be the only option 
in the Selection drop-down list.

You can add financial institutions as edit values to the .EFT SEL employee data item 
(Figure 6.38). 

Figure 6.38—Example Edit Values for .EFT SEL
Sample Three-Part Direct Deposit Stub 



Chapter 6—Defining Direct Deposit
These edits then display in the Selection drop-down list on the Direct Deposit tab 
(Figure 6.39). 

Figure 6.39—Selection Drop-Down List With Edit Values

Each time you run the check writing task to create your direct deposit files, the 
system overwrites the previous file. Therefore, if you are using the selection 
feature to create separate files for each financial institution, you must make sure 
that you completely finish one direct deposit process before beginning the next.
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When you complete your payroll, you can use the Employee Selector to include (or 
exclude) employees assigned to a specific financial institution (Figure 6.40). 

Figure 6.40—.EFT SEL Filtering in the Employee Selector

DIRECT DEPOSIT TIPS
• Before you set up direct deposit in your division, create a test division (i.e., a 

copy of your existing division) and test the process. Set up all the parameters 
and employees as you would in your “live” division and ensure that the process 
works. Then you can proceed with your real division.
— This will take extra time, but the process is complicated enough that it may 

pay off in the end to work through any problems in the test division!
• Each time you create a direct deposit file, produce and file the proof report 

(PYLPEFT.L##). (See Producing a Direct Deposit Proof List on page 1.231 for 
instructions.)
Direct Deposit Tips 
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PRODUCING A DIRECT DEPOSIT PROOF LIST
After producing the checks and Direct Deposits, you may wish to review the Direct 
Deposit transactions that will be transmitted to the bank. Print and file the Direct 
Deposit Proof List along with your check registers.
Use the following steps to Produce a Direct Deposit Proof List.

1.  Click Processing > Check Processing > Produce EFT Proof List on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Processing > Check Processing > Produce 
EFT Proof List from the menu bar. A confirmation message displays.

2. Enter Yes to produce this report. A second confirmation message displays.

3. Enter Yes to file this report. The system produces the report and closes the 
window.

4. Through Print Manager, access the PYLPEFT.L## report. 
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 Producing a Direct Deposit Proof List 



C H A P T E R  7

PERIODIC PROCESSING

There are a number of tasks that you should or must complete periodically. These 
include:

• Using the ToolBox—The ToolBox is a set of predefined earnings, taxes, 
deductions, and employer costs. At least annually, FundWare posts an update to 
the ToolBox on the Support Web site (www.fundware.com/Support/
support.asp). 

• Rolling Balances Forward—Refreshes balances and carries forward accrued 
hours, units, and/or amounts (e.g., vacation hours, sick hours) to a new calendar 
year. 

• Purging Data—Periodically purging information will free up disk space on your 
computer or server. You may purge:
— Timesheet history, 
— Check detail information, 
— The employee change log, or 
— All information from a prior year. 

Additionally, you may import data to your Payroll/Personnel system. Instructions for 
importing can be found in the Blackbaud FundWare System Administration Guide.

UPDATING THE TOOLBOX
The ToolBox is a set of predefined earnings, taxes, deductions, and employer costs 
(historical and employee data items) that you can copy into your system during setup or 
to update your system periodically. Use of ToolBox items can greatly reduce the amount 
of time required to setup a new payroll. Additionally, American Fundware, Inc. updates 
the ToolBox data items at the beginning of each year. (As necessary, we also may update 
ToolBox throughout the year.)
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The Setup List (part of the Master Records Lists category) produces a list of ToolBox 
contents (Figure 7.1). 

Figure 7.1—Producing the Setup List to Report on ToolBox Contents

GETTING UPDATED VERSIONS OF TOOLBOX CHANGES

Updated versions of the ToolBox are available from the Support Web site 
(www.fundware.com/Support/support.asp), along with instructions for installing the 
update on your system. If you do not have access to our Web site and need an updated 
ToolBox sent to you, please call 800-551-4458 or 303-756-3030 and ask for the Client 
Sales department.
If you have any technical questions about the ToolBox, please contact our Support 
Department.

UPDATING HISTORICAL DATA ITEMS

Use the following instructions to update your historical data items with current ToolBox 
information. 

You must install the current ToolBox update before beginning this task. 
Installation instructions are available with the ToolBox update from our Web 
site (www.fundware.com/Support/support.asp).

1.  Ensure that all users are logged out of Payroll/Personnel.
Updating the ToolBox 
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2. Click Processing > Periodic Processing > Update Data Items From Toolbox 
on the module navigator (if the module is not expanded, click Payroll/
Personnel first) or select Payroll/Personnel > Processing > Periodic 
Processing > Update Data Items From Toolbox from the menu bar. The 
Update Data Items From Toolbox screen displays (Figure 7.2). 

Figure 7.2—Entering the Data Item to Update

3. Enter the individual historical data items that you wish to update in your 
payroll, or press F1 to select from a list of HDIs.

You can only enter one historical data item at a time.

4. Press ENTER. A confirmation message displays.

5. Type Y to accept your entries. A second confirmation message displays.

6. Type Y to accept your entries and update the specified historical data item. The 
system asks if there are any additional historical data items that you must 
update.

7. Type Y to continue updating HDIs. Type N to end this task and return to the 
Periodic Processing menu.

8. Repeat this process for each of your divisions.
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UPDATING EMPLOYEE DATA ITEMS

When you update the historical data items from the ToolBox, those changes may have 
an impact on some of your employee data items. (These data items are used by the 
historical data items, and were likely created by the system when you added the 
historical data item to your division.) For more information, see Employee Data Items 
Created by ToolBox HDIs on page 1.107.

You must install the current ToolBox update and update your historical data 
items before beginning this task. 

You can update all this information by updating your employee data items with current 
ToolBox information. 

1.  Click Setup > Payroll Parameter on the module navigator (if the module is not 
expanded, click Payroll/Personnel first) or select Payroll/Personnel > Setup > 
Payroll Parameter from the menu bar.

2. Type C to change the payroll parameter.

3. Type 0 to accept the changes. 

You have not actively changed any of the payroll parameter settings. 
However, when you save the “changes,” Payroll updates your employee 
data items.

4. Press ENTER. The system will update the employee data items. When complete, 
the Define Payroll Parameter menu line displays.

5. Press E to end the task and return to the Setup menu.

Your system has now been updated with the current ToolBox information and Payroll/
Personnel is ready to use.

ROLLING BALANCES FORWARD
The Roll Balances Forward task refreshes balances and carries forward accrued hours, 
units, and/or amounts (e.g., vacation hours, sick hours) for a new calendar year. By 
rolling the balances forward, you change the active year to the year to which balances 
are rolled, and roll the balances to a system-maintained beginning balance period. 

This task does not post to your Financial Reporting System. It is also not linked 
to the GL–P/G roll balances task.
Rolling Balances Forward 
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You must roll balances forward before you calculate the first payroll of a new 
calendar year.

DEFINING HDIS TO ROLL BALANCES FORWARD

When you define a historical data item, Field 5 defines the roll options (Figure 7.3). 

Figure 7.3—Example Historical Data Item Based for Vacation

In this field, you must indicate whether hours/units, amounts, or both can be carried 
forward by selecting from the following options:

• N—Do not roll balance forward to new calendar year.
• H—Roll hours forward to new calendar year.
• A—Roll amount balance forward to new calendar year.
• B—Roll both hours and amount balances forward to new calendar year.

If you select N (Do not roll balance forward to new calendar year), no balances will roll 
forward.
Depending on your Roll forward selection, you will also indicate Amount and Hours 
limits:

• Amount limit—Used with Roll forward options A or B. This field holds the 
maximum amount that can be carried forward to the new year.

• Hours limit—Used with Roll forward options H or B. This field holds the 
maximum number of hours that can be carried forward to the new year.
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ROLLING BALANCES FORWARD

Use the following steps to roll balances forward. 
1.  Click Processing > Periodic Processing > Roll Balances Forward on the 

module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Processing > Periodic Processing > Roll 
Balances Forward from the menu bar. The Roll Balances Forward screen 
displays (Figure 7.4). 

Figure 7.4—Roll Balances Forward

2. Enter the new year to which the balances will roll forward. Once complete, the 
beginning balance for HDIs impacted by this task will change for the year 
entered.

3. Press ENTER. A confirmation message displays.

4. Type Y to accept your entries and roll your balances forward. When the process 
is complete, you return to the Periodic Processing menu.

Any balances rolled forward by this task are listed in the Roll Forward report 
(PYRLOVR.L##, where ## represents the division number). Open Print Manager to 
view or print this report.
Rolling Balances Forward 
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PURGING DATA
Periodically purging information will free up disk space on your computer or server. 
You may purge:

• Timesheet history, 
• Check detail information, 
• The employee change log, or 
• All information from a prior year. 

Under no circumstances should you purge data until you have a backup of your 
data. Because this process permanently removes the data from your system, you 
will have no other way to recover the information.

PURGING TIMESHEET HISTORY

If you maintain timesheet history and have run all necessary timesheet history reports, 
you may wish to delete some of the timesheet history. This will free up disk space on 
your computer or server. 

You should have a backup of your data before purging timesheet history. 
Because this process permanently removes the data from your system, you will 
have no other way to recover the information.

Use the following steps to purge timesheet history.
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1.  Click Processing > Periodic Processing > Purge Timesheet History on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Processing > Periodic Processing > Purge 
Timesheet History from the menu bar. The task window displays (Figure 7.5). 

Figure 7.5—Purge Timesheet History

2. Enter the ending date of the period for which you are purging timesheet history.

3. Press ENTER. A confirmation message displays.

4. Type Y to accept your entries and purge the timesheet information. When the 
process is complete, another message displays.

5. Press ENTER to exit the task and close the window.

6. Locate the PYCEmpInqUtil.exe executable file in the Bin folder (stored in the 
version folder under FundWare, e.g., FundWare > 7.40 > Bin).
Purging Data 
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7. Double-click to open the Build/Repair Employee Inquiry Table (Figure 7.6). 
This utility will synchronize your data following this purging process. 

Figure 7.6—Build/Repair Employee Inquiry Table

8. Enter the correct data drive, data directory, and division (or accept the defaults).

9. Click Build/Repair. When the process has completed successfully, a message 
displays.

10. Click OK.

SAVING SUMMARY INFORMATION AND PURGING A YEAR

The Purge/Save Year option is a two-step process that allows you to purge:
• All information from a prior year, or 
• The check detail information, leaving monthly summary information available 

for reports. 
— If you run comparative reports between years or reports that cross payroll 

years, you need to save summary information from the prior year. When the 
information is no longer needed, execute the purge option of this task for 
the year.

Performing this task frees up disk space on your computer or server. It will also 
allow you to remove terminated employees and “reuse” employee numbers. Do 
not purge information until you have successfully produced all your year-end 
tax forms.

You should store a permanent data backup in a safe or off site before purging a 
year. Because this process permanently removes the data from your system, you 
will have no other way to recover the information.

Use the following steps to purge or save year. (You must save a year before that year can 
be purged.)
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1.  Click Processing > Periodic Processing > Purge/Save Year on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Processing > Periodic Processing > Purge/Save 
Year from the menu bar. The task window displays (Figure 7.7). 

Figure 7.7—Purge/Save Year

2. Select which task you are completing:

• P—Purge entire year.
• S—Save summary information—Each year must be saved before you can 

purge.
Purging Data 



Chapter 7—Periodic Processing
3. Press ENTER. The remaining parameters of the task display (Figure 7.8). 

Figure 7.8—Purge/Save Year Parameters

4. For the Purge task, enter your selection for purging terminated employees in the 
Purge term field

• Y—Purge terminated employees.
• N—Do not purge terminated employees.

5. Enter the year for which you are completing the purge or save task.

6. Press ENTER. A confirmation message displays.

7. Type Y to accept your entries and purge or save the year. When the process is 
complete, another message displays.

8. Press ENTER to end the task and close the window.

PURGING THE EMPLOYEE CHANGE LOG

You can use this task to purge employee change log information. This will free up disk 
space on your computer or server. 

You should print a copy of your Employee Change Log for your records before 
beginning this task.

Use the following steps to purge the employee change log.
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1.  Click Processing > Processing > Periodic Processing > Purge Employee 
Change Log on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Processing > Periodic 
Processing > Purge Employee Change Log from the menu bar. The Purge 
Employee Change Log screen displays (Figure 7.9). 

Figure 7.9—Purge Employee Change Log

2. Enter the date through which you want to purge the change log information.

3. Press ENTER. A confirmation message displays.

4. Type Y to accept your entries and purge employee change log information. 
When the process is complete, another message displays.

5. Press ENTER to end the task and close the window.

6. Locate the PYCEmpInqUtil.exe executable file in the Bin folder (stored in the 
version folder under FundWare, e.g., FundWare > 7.40 > Bin).
Purging Data 
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7. Double-click to open the Build/Repair Employee Inquiry Table (Figure 7.6). 
This utility will synchronize your data following this purging process. 

Figure 7.10—Build/Repair Employee Inquiry Table

8. Enter the correct data drive, data directory, and division (or accept the defaults).

9. Click Build/Repair. When the process has completed successfully, a message 
displays.

10. Click OK.

IMPORTING PAYROLL/PERSONNEL DATA
All instructions for importing Payroll/Personnel data are included in the Blackbaud 
FundWare System Administration Guide. Please refer to this guide for more 
information. You can find all user guides in the FundWare > Data > User 
Documentation folder on your server.
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A P P E N D I X  A

CALCULATION COMMANDS

The Payroll module uses calculations to define earnings and deductions (e.g., 401k, 
health insurance). These calculations have a number of options and can become 
complex as a result of your payroll needs. Because of the critical nature of the accuracy 
of payroll information, many of our customers work with outside resources to define 
their calculations (e.g., Professional Services). This saves them time, while allowing 
them to realize the full power of calculations designed specifically for their 
organization. FundWare also offers classes in writing and modifying calculations. For 
more information, please visit the FundWare Web site (www.fundware.com).
This appendix provides you with an overview of the commands used to create your 
Payroll calculations.
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OVERVIEW OF CALCULATIONS
All calculations are based on the same set of commands. These commands make up the 
internal payroll “language” used by the Payroll/Personnel module. The commands, in 
turn are divided into command groups. Each group of commands have a specific 
purpose. The fields entered for each command are determined by question groups. 
Figure A.1 shows the command and question groups asked by each command. 

Figure A.1—Question Groups

COMMAND GROUPS
The commands and how they are used can be grouped functionally. Each one of these 
groups have specific functions that they perform or some other commonality.

MULTI-OCCURRING DATA ITEM COMMANDS

These commands are used when processing multi-occurring employee data items. They 
provide a looping mechanism so that each occurrence of a data item may be processed. 
To define the loop, the EACH ... END commands must be used. The EACH defines the 
beginning and the END defines the end of the loop. Any command may be used 
between the EACH ... END including another EACH loop. EACHs may be nested 5 
levels deep. The other commands specific to multi-occurring fields are:
Overview of Calculations 
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• MATCH—Causes the specified data item to be matched by date and entry 
number with the data item defined by the EACH command.

• BREAK—Causes the processing of the EACH loop to be terminated and the 
command after the END command to be processed next.

• CONT—Causes the processing of the current EACH loop to be terminated. 
Processing continues with the next value of the EACH data item starting at the 
first command after the EACH.

CONDITIONAL TYPE COMMANDS

These commands allow the optional execution of a group of commands based on the 
comparison of a register or data item. The ordering of the conditional commands is very 
important, and must be as follows:

• IF—Defines the beginning of a group of commands to be optionally executed. 
If the result of the IF comparison is true, the intervening commands, those 
between the IF and the ELIF, ELSE, or FI are executed. Any other command 
may appear between the IF and the ELIF, ELSE, or FI, including another IF. IFs 
may be nested 50 levels deep.

• ANDIF or ORIF—These two optional commands, if used, must immediately 
follow the IF command and allow additional comparisons to be done. 
— The ANDIF indicates that all comparisons must be true for the “true” group 

of commands to be executed. 
— The ORIF indicates that if any comparison is true, the “true” group of 

commands is to be executed. 
There is no limit to the number of ANDIFs or ORIFs that may follow the IF. An 
IF may not have a mixture of ANDIFs and ORIFs.

• ELIF—This is an optional command that is used as a short cut for the ELSE, IF 
command sequence. See the ELSE and IF commands for a full description.

• ELSE—This is an optional command that defines the end of the “true” group 
and the beginning of the “false” group of commands. This command is always 
associated with the current open IF or ELIF commands.

• FI—Defines the end of the current IF command. A FI is required for each IF in 
the report. A FI is not required for an ELIF.
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CASE COMMANDS

These commands provide another way of conditionally executing a group of commands. 
As with the conditional commands, the order the case is specified is very important and 
must be as follows:

• CASE—Defines the beginning of a case group and indicates what data item is 
to be used by the following VALUE commands. A VALUE command must 
immediately follow the CASE command. Within a case group additional case 
groups may be executed. CASEs may be nested 50 levels.

• VALUE—Defines the value for the data item selected in the CASE statement 
that will cause the commands following to be executed. Multiple VALUE 
commands without intervening commands indicate additional values that will 
cause commands following to be executed. Additional VALUE commands with 
intervening commands indicate different groups of conditional commands.

• ESAC—Defines the end of a case group. There must be an ESAC for every 
CASE statement within the report.

OTHER TYPE COMMANDS

These commands do not fall into any particular function or group, but perform 
individual functions.

• COMNT—Allows a comment to be placed into the language. Comments are 
used to clarify what the particular set of instructions is doing in a more English-
like manner.

• REGOP—Allows information to be maintained using registers. This is 
primarily used for summing, counting, and arithmetic types of functions. Forty 
registers are available for use.

• SET ACT—Sets an account number for the data item which overrides the 
account number defined in the Ledger Options field for the historical data item. 
The same historical data item can be used for several employees, but with a 
different account number.

• SET DES—Sets a description for the data item which overrides the Short desc 
field for the historical data item. The same historical data item can be used for 
several employees, but with a different description.

• TABLE—Allows a date related multiplication to be performed using rates and 
table. The first register indicates the source as well as the location of where the 
result is to be stored. Item indicates the table name, and Reg/Value indicates 
which table number to use. The current business date is always used as the date.

• EXIT—Causes the current set of commands to be terminated.
Command Groups 
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QUESTION GROUPS
Question groups are used to categorize the fields that are asked by various commands.
Reg / item question group—Indicates that either a register or data item may be used.

• Register/Item—Determines whether a register or data item is to be entered. 
Valid values are:
— R—Register
— I—Data item

• Internal reg #—If register was selected with the above option, the module asks 
for the register number to use. Valid values range from 1 to 40.

• Data item—If item was selected with the above option, the module asks for the 
data item to use.

• Item value from—After the data item is entered, the module asks for the value 
of the data item to retrieve. Valid values are:
— E—Entry of item. This gets the value of the entry number in the multi-

occurring data item.
— V—Value of item. This gets the actual value of the data item.
— L—Lookup of column. This gets the lookup value of the data item for the 

column selected.
• Lookup of column—If the lookup of column was selected, the column to be 

retrieved must be entered.
Register question group—Indicates that a register is to be used.

• Internal reg #—The register number to use. Valid values range from 1 to 40.
Register operation question group—Indicates that a register operation is to be used. This 
is the primary mechanism for doing arithmetic.

• Reg operation—Defines the type of operation to be performed. Valid values 
are:
— + Add to register
— - Subtract from register
— * Multiply register by
— / Divide register by
— L—Load register with
— A—Load register with Annual
— D—Load register with Deannual
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Relational operator question group—Indicates that a relational comparison is to be 
performed.

• Rel operator—Defines the type of comparison to be performed. Valid values 
are:
— EQ—is equal to
— NE—is not equal to
— LT—is less than
— LE—is less than or equal to
— GT—is greater than
— GE—is greater than or equal to

Register / item / value question group—Indicates that either a register, data item, or 
value (constant) may be used.

• Register/Item/Value—Determines whether a register, data item, or value is to be 
used. Valid values are:
— R—Register
— I—Data item
— V—Value

• Internal reg #—If register was selected with the above option, the module asks 
for the register number to use. Valid values range from 1 to 40.

• Data item—If an item was specified with the above option, the module asks for 
the data item to use.

• Item value from—After the data item is entered, the module asks for the value 
of the data item to retrieve. 
If the data item is an EDI (employee data item), the valid values are:

— E—Entry of item. This gets the value of the entry number in the multi-
occurring data item.

— V—Value of item. This gets the actual value of the data item.
— L—Lookup of item. This gets the lookup value of the data item for the 

column selected.
If the data item is an HDI (historical data item), the valid value is entered as a 
two character field where the first value is one of:

— C—Current total
— M—Monthly total
— Q—Quarterly total
— H—Half year total
Question Groups 
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— Y—Year through reporting date (including beginning balance)
— B—Beginning balance
— T—Total posted for year
— A—Annual total (including beginning balance)
The second character indicates the type of information to be pulled, where one 
of the following must be entered:

— H—Hours
— A—Amount
— O—Other
— 1—Basis hours
— 2—Basis amount
— 3—Basis other

• Lookup of column—If the lookup of column was selected, the column to be 
retrieved must be entered.

• Data type—If value is selected with the above option, the module asks for the 
type of value to be entered. Valid values are:
— N—Not used
— #—Signed(15) Number
— $—Signed(13.2) Amount
— R—Signed(9.6) Rate
— D—Numeric(mm/dd/yyyy) Date
— P—Numeric(10) Phone (area code and nbr)
— A—Alphameric(2) Attribute
— K—Alphameric(10) Key word
— T—Alphameric(30) Text
— X—Alphameric(55) Extended text
— M—Alphameric(55) Account Mask

• xxxxxx—Once the type of value has been entered, then the actual value is 
entered. The “xxxxxx” is replaced with an appropriate prompt for the type of 
value.

Item question group—Used when a data item name is to be entered.
• Data item—The name of the selected data item must be entered.
• Register value question group—The reg value group indicates that either a 

register or value (constant) may be used. Valid values are:
— R—Register
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— V—Value
• Internal reg #—If register was selected with the above option, the module asks 

for the register number to use. Valid values range from 1 to 40.
• Data type—If value is selected with the above option, the module asks for the 

type of value to be entered. Valid values are:
— N—Not used
— #—Signed(15)Number
— $—Signed(13.2)Amount
— R—Signed(9.6)Rate
— D—Numeric(mm/dd/yyyy)Date
— P—Numeric(10)Phone (area code and nbr)
— A—Alphameric(2)Attribute
— K—Alphameric(10)Key word
— T—Alphameric(30)Text
— X—Alphameric(55)Extended text
— M—Alphameric(55)account Mask

• xxxxxx—Once the type value has been entered, then the actual value is entered. 
The “xxxxxx” is replaced with an appropriate prompt for the type of value.

Value question group—Used when a particular value is to be entered.
• xxxxxx—The “xxxxxx” is replaced with an appropriate prompt for the data type 

of the value.

INTERNAL REGISTERS
Up to 40 internal register numbers may be used for any calculation. Internal registers 1 
through 10 are reserved and are used as follows. 

Table A.1—Internal Registers

Register Input/Output Description

1 Output Resulting hours

2 Output Resulting amount

3 Input/Output Basis hours

4 Input/Output Basis amount
Internal Registers 
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The Input/Output column indicates if the register is used as input to the calculation, 
output from the calculation or both.

5 Input Current total “earning” amount

6 Input Current total “earning” hours

7 Input Current total “tax” amount

8 Input Current total “deduction” amount

9–10 Reserved for future use

Table A.1—Internal Registers

Register Input/Output Description
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A P P E N D I X  B

CLOCKED TIMESHEET ENTRY

Clocked Timesheet Entry is a feature where timesheets are entered with clocked hours. 
You may want to use this feature if your employees punch a time clock, and you need to 
report very specific date, hour, and time information. However, you must process your 
timesheets through Classic menu tasks.
There are three methods of Timesheet Entry:

• Numbered entry
• Dated entry
• Clocked entry

NUMBERED ENTRY
Numbered entry is the normal, non-dated, and non-clocked method of entry. The 
timesheets begin numbering at 1 and increment by one for each timesheet. 

Earnings must be defined to use numbered entry. You are prompted for an entry number 
when entering single timesheets.

Table B.1—Numbered Entry

Employee Entry Earnings Amt/Hrs

Sam Smith 1 SALARY $1200

2 VACA TIME 8

3 SICK TIME -8

Jason Jefferson 1 SALARY $1300

2 BONUS $400
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DATED ENTRY
Dated entry consists of a date and a number for each timesheet. There may be multiple 
numbers on a single date. Timesheets begin numbering at one and increment by one for 
each timesheet.

Earnings must be defined to use dated entry. You are prompted for a date and number 
when entering timesheets. Dated entry earnings cannot be used in group timesheets. The 
Timesheet Verification Report will list the date and entry for each timesheet.

CLOCKED ENTRY
Clocked entry consists of a date, clocked time, and In or Out. Earnings must be defined 
to used clocked entry. Clocked entry earnings cannot be used in group timesheets. The 
Timesheet Verification Report will list the date, time, and total for each timesheet. Total 
clocked hours are checked against the Day check maximum in the parameter; warnings 
are issued for employees over the limit. Total of all hourly earnings is checked against 
the Period check maximum in the parameter; warnings are issued for employees over 
the limit. There are two basic methods of clocked time:

• Matching In and Out
• Open In and Out

Table B.2—Dated Entry

Employee Date Entry Earnings Amt/Hrs

Mike Mills 01/15/04 1 HOURLY 1 20

2 HOURLY 2 10

Lisa Linden 01/01/04 1 HOURLY 8

01/02/04 1 HOURLY 8

01/03/04 1 HOURLY 8

01/04/04 1 HOURLY 8
Dated Entry 
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MATCHING IN AND OUT

Using the matching in and out method, every in for an earning must also be 
accompanied by an out. In and outs should not overlap.

In this example, Hourly is defined to use clocked time. 

Table B.3—Matching In and Out

Employee Date Time In/Out Earnings Amt/Hrs

Bill Baxter 01/15/04 0800 I HOURLY 4

1200 O HOURLY 0

1300 I HOURLY 4

1700 O HOURLY 0

Sasha Sears 01/15/04 0800 I HOURLY 6

1400 O HOURLY 0

Peter Prewitt 01/01/04 0800 I HOURLY 6

1500 O HOURLY

01/02/04 0800 I HOURLY 6.25

1515 O HOURLY 0

01/03/04 0830 I HOURLY 6

1530 O HOURLY 0
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OPEN IN AND OUT

Using the open in and out method, an Out is not required for every In for an earning. In 
and outs overlap.

In this example, Hourly is defined as a regular earning using clocked time. Lunch is 
defined as an hourly clocked earning with no Rate and no Basis. The accounting must be 
set up but it should never be used because Lunch has no rate, and therefore no amount to 
post. The key is to define items like Lunch and Break without a rate.

Table B.4—Open In and Out

Employee Date Time In/Out Earnings Amt/Hrs

Bill Baxter 01/15/04 0800 I HOURLY 4

1200 I Lunch 1

1300 I HOURLY 4

1700 O HOURLY 0

Sasha Sears 01/15/04 0800 I SALARY 8

1600 I OVERTIME 3

1900 O OVERTIME 0

Peter Prewitt 01/01/04 0800 I HOURLY 6

1500 O HOURLY 0

01/02/04 0800 I HOURLY 6.25

1515 O HOURLY 0
Clocked Entry 



A P P E N D I X  C

HOW DOES PAYROLL RESOLVE ACCOUNTS?

This appendix is designed to help you understand how your Payroll system can build 
your accounts, based on the settings in your Payroll Parameter, historical data item 
definitions, employee records, costcodes, and/or distribution tables. It is divided into 
two main areas, based on your most-basic Payroll decision: 

• Are you departmentalized, or 
• Are you not departmentalized?

This setting is defined on your Payroll Parameter and can be different for salaried, 
hourly, or “other” employees (Figure C.1). 

Figure C.1—Departmentalized Salary and Non-Departmentalized Hourly

You must define the Payroll Parameter to post to General Ledger (field 4). This will be 
reflected in field 6 of the earnings item and will often be a setting that you cannot 
change for earnings items.

An earnings item is an historical data item as E—Earnings in field three of the 
definition. These HDIs are what you use to define earnings amounts on 
employee timesheets.
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Once you begin to enter timesheets for an employee, the program begins to build the 
account number, starting with the settings on the earnings item. The program looks to 
the Debit option defined for the earnings item to determine how the account will be 
built. Your debit options are:

• A—Use account from Mask field. (The account number defined can not contain 
any masked characters.)

• D—Use department from the employee record (or costcode or distribution 
table) and GLA from mask.

• G—Use GLA from the employee record (or costcode or distribution table) and 
department from mask. 

• B—Use both the department and GLA on the employee record (or costcode or 
distribution table).

• P—Prorate based on the dollars in the historical data items listed in Prorate on. 
• H—Prorate based on the hours in the historical data items listed in the Prorate 

on.
The examples in this appendix use only debit options D, G, or B. Debit options A, P, and 
H are excluded from the examples for various reasons:

• Debit option A defines the account number to which you post; therefore, the 
system does not build any account numbers.

• Debit options P and H do not build account numbers during the timesheet 
process. For more on options P and H, see Chapter 3—Using Data Items on 
page 1.77.

DEPARTMENTALIZED EXAMPLES
The steps involved in building the account number will vary widely, depending on a 
number of settings. However, it will help you to understand the basic path that the 
system follows when building the account number:

1.  Earnings item,

2. Employee record (departments and/or GLAs), and/or

3. Costcodes (can be added to the employee record or the timesheet).

The following examples show some of the more common ways Payroll resolves account 
numbers for departmentalized salary earnings.
Departmentalized Examples 
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OPTION B—DEPARTMENT AND GLA FROM EMPLOYEE RECORD

This example involves the following scenario:
• We selected an HDI that draws both the department and GLA from the 

employee record.
• We have defined both the department and GLA for the employee (saved on his 

employee record).
• We have also defined a costcode for the employee (saved on his employee 

record).
Given these settings and selections, Payroll resolves the account number as follows.

1.  Take the account mask defined on the earnings item (Figure C.2). Note: This 
account mask is entered as a default on the timesheet, and can be overridden (if 
the earnings item definition allows). 

Figure C.2—Example Historical Data Item—Debit Mask
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2. Take the Entry Type defined on the earnings item (Figure C.3). 

Figure C.3—Example Historical Data Item—Rate From

3. Because the Entry Type on the earnings item is an amount option (as opposed to 
an hour or unit option), default to the Salary settings on the Accounting 
Information tab (Figure C.4). 

Figure C.4—Example Employee Record—Accounting Information Tab
Departmentalized Examples 
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4. Take the salary department defined on the employee record and lookup the 
account mask (Lookup 2 on the edit value definition for .S DEPT) (Figure C.5). 

Figure C.5—.S DEPT—Water Edit Value

In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Water department. So here’s how our account is building: 

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-XX XXXX (from the department)

builds to

AXX 02-XX 6110
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5. Take the GLA defined on the employee record (Figure C.6) and lookup the 
account mask (Lookup 2 on the edit value definition for .S GLA). 

Figure C.6—Example Employee Record—Accounting Information Tab

Based on the GLA selection on the Accounting Information tab, we look to 
the .S GLA edit value definition (Figure C.7).

Figure C.7—.S GLA—Sal Edit Value
Departmentalized Examples 



Appendix C—How Does Payroll Resolve Accounts?
In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Sal GLA. So here’s how our account is building: 

6. Take the costcode defined on the employee record (Figure C.8) and lookup the 
account mask. 

Figure C.8—Example Employee Record—Pay Calculation Tab

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-XX XXXX (from the department)

plus

AXX XX-00 XXXX (from the GLA)

builds to

AXX 02-00 6110
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7. Take the account mask from the Lookup 2 for the State Grant 04 edit value 
(Figure C.9).

Figure C.9—.COSTCODE—State Grant 04 Edit Value

In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the State Grant 04 edit value. And our account number is resolved: 

VARIATIONS ON A THEME

The above example is a very simple example of departmentalize earnings using 
costcodes. There are any number of ways to make this more complex:

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-XX XXXX (from the department)

plus

AXX XX-00 XXXX (from the GLA)

plus

A04 XX-XX XXXX (from the costcode)

builds to

A04 02-00 6110
Departmentalized Examples 
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• If the department account mask (i.e., Lookup 2 for the Water edit value on .S 
DEPT) is A01 02-00, then the account is resolved at this step and the process 
goes no further: 

In this case, it does not matter what other definitions might apply (e.g., GLA, 
costcode). The system has a complete account number and looks not further.

• If a number has already been resolved during this process, Payroll will ignore 
any additional numbers in that position. 

• When you enter the timesheet, you could override the costcode default (taken 
from the Pay Calculation tab of the employee record). (Or add a costcode if no 
default has been defined for the employee.)

• The earnings item may not be defined for costcodes. The account resolution 
might look like this: 

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-XX XXXX (from the department)

builds to

A01 02-00 6110

AXX XX-XX 6110 (from the earnings item)

plus

A03 XX-XX XXXX (from the department) The fund is defined at this step…

plus

AXX XX-00 XXXX (from the GLA)

plus

A04 02-XX XXXX (from the costcode) So Payroll ignores the fund definition 
in this step.

builds to

A03 02-00 6110

AXX XX-XX 6110 (from the earnings item)

plus
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• The account could complete all the resolution steps, but not have a complete 
number. In this case, you would receive an message indicating that you must 
complete the number on the timesheet: 

In this example, a message would display on the timesheet that the account was 
not resolved. If the Change account/basis setting on the HDI definition (field 4) 
allow you to change this information, you can edit the account directly. If the 
setting is N—Change not allowed, you must select different options for the 
timesheet entry.

OPTION B—WITHOUT COSTCODES

This example involves the following scenario:
• We selected an HDI that draws both the department and GLA from the 

employee record.
• We have defined both the department and GLA for the employee (saved on his 

employee record).

A04 02-XX XXXX (from the department)

plus

AXX XX-00 XXXX (from the GLA)

builds to

A04 02-00 6110

AXX XX-XX 61XX (from the earnings item)

plus

AXX 02-XX XXXX (from the department)

plus

AXX XX-00 XXXX (from the GLA)

plus

A04 XX-XX XXXX (from the costcode)

builds to

A04 02-00 61XX
Departmentalized Examples 
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• We have not assigned costcodes to the employee record or assigned any during 
timesheet entry.

Given these settings and selections, Payroll resolves the account number as follows.
1.  Take the account mask defined on the earnings item (Figure C.10). Note: This 

account mask is entered as a default on the timesheet, and can be overridden (if 
the earnings item definition allows). 

Figure C.10—Example Historical Data Item—Salary

2. Take the Entry Type defined on the earnings item (Figure C.11). 

Figure C.11—Example Historical Data Item—Rate From and Costcode Option
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3. Because the Entry Type on the earnings item is an amount option (as opposed to 
an hour or unit option), default to the Salary settings on the Accounting 
Information tab. 

Figure C.12—Example Employee Record—Accounting Information Tab

4. Take the salary department defined on the employee record and lookup the 
account mask (Lookup 2 on the edit value definition for .S DEPT) (Figure 
C.13). 

Figure C.13—.S DEPT—Water Edit Value
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In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Water department. So here’s how our account is building: 

5. Take the GLA defined on the employee record (Figure C.14) and lookup the 
account mask (Lookup 2 on the edit value definition for .S GLA). 

Figure C.14—Example Employee Record—Accounting Information Tab

AXX XX-XX 6110 (from the earnings item)

plus

A04 02-XX XXXX (from the department)

builds to

A04 02-XX 6110
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Based on the selection on the Accounting Information tab, we look to the .S 
GLA edit value definition (Figure C.15).

Figure C.15—.S GLA—Sal Edit Value

In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Sal GLA. And our account number is resolved: 

OPTION B—WITH MULTIPLE DEPARTMENTS AND GLAS

This example involves the following scenario:
• We selected an HDI that draws both the department and GLA from the 

employee record.
• We have defined multiple departments and a single GLA for the employee 

(saved on his employee record). The employee’s salary amount is distributed 
across the departments.

AXX XX-XX 6110 (from the earnings item)

plus

A04 02-XX XXXX (from the department)

plus

AXX XX-00 XXXX (from the GLA)

builds to

A04 02-00 6110
Departmentalized Examples 
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• We have not assigned costcodes to the employee record or assigned any during 
timesheet entry.

Given these settings and selections, Payroll resolves the account number as follows.
1.  Take the account mask defined on the earnings item (Figure C.16). Note: This 

account mask is entered as a default on the timesheet, and can be overridden (if 
the earnings item definition allows). 

Figure C.16—Example Historical Data Item—Salary

2. Take the Entry Type defined on the earnings item (Figure C.17). 

Figure C.17—Example Historical Data Item—Rate From and Costcode Option
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3. Because the Entry Type on the earnings item is an amount option (as opposed to 
an hour or unit option), default to the Salary settings on the Accounting 
Information tab. 

Figure C.18—Example Employee Record—Accounting Information Tab
Departmentalized Examples 
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4. Take the salary department defined on the employee record and lookup the 
account mask (Lookup 2 on the edit value definition for .S DEPT) (Figure 
C.19). 

Figure C.19—.S DEPT—Admin, Baseball Park, and Ice Rink Edit Values
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In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Water department. So here’s how our account is building: 

5. Take the GLA defined on the employee record (Figure C.20) and lookup the 
account mask (Lookup 2 on the edit value definition for .S GLA). 

Figure C.20—Example Employee Record—Accounting Information Tab

from the earnings item AXX XX-XX 6110 AXX XX-XX 6110 AXX XX-XX 6110

plus plus plus

from the department A04 01-XX XXXX A04 02-XX XXXX A04 03-XX XXXX

builds to builds to builds to

A04 01-XX 6110 A04 02-XX 6110 A04 03-XX 6110
Departmentalized Examples 
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Based on the selection on the Accounting Information tab, we look to the .S 
GLA edit value definition (Figure C.21).

Figure C.21—.S GLA—Sal Edit Value

In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Sal GLA. And our account number is resolved: 

OPTION D—DEPARTMENT FROM EMPLOYEE RECORD

This example involves the following scenario:
• We selected an HDI that draws both the department from the employee record 

and the GLA from the account mask defined on the HDI.
• We have defined both the department and GLA for the employee (saved on his 

employee record).

from the earnings item AXX XX-XX 6110 AXX XX-XX 6110 AXX XX-XX 6110

plus plus plus

from the department A04 01-XX XXXX A04 02-XX XXXX A04 03-XX XXXX

plus plus plus

from the GLA AXX XX-00 XXXX AXX XX-00 XXXX AXX XX-00 XXXX

builds to builds to builds to

A04 01-00 6110
50% of amount

A04 02-00 6110
25% of amount

A04 03-00 6110
25% of amount
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• We have also defined a costcode for the employee (saved on his employee 
record).

Given these settings and selections, Payroll resolves the account number as follows.
1.  Take the account mask defined on the earnings item (Figure C.22). Note: This 

account mask is entered as a default on the timesheet, and can be overridden (if 
the earnings item definition allows). 

Figure C.22—Example Historical Data Item—Salary

2. Take the Entry Type defined on the earnings item (Figure C.23). 

Figure C.23—Example Historical Data Item—Rate From and Costcode Option
Departmentalized Examples 
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3. Because the Entry Type on the earnings item is an amount option (as opposed to 
an hour or unit option), default to the Salary settings on the Accounting 
Information tab. 

Figure C.24—Example Employee Record—Accounting Information Tab

4. Take the salary department defined on the employee record and lookup the 
account mask (Lookup 2 on the edit value definition for .S DEPT) (Figure 
C.25). 

Figure C.25—.S DEPT—Water Edit Value
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In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Water department. So here’s how our account is building: 

5. Take the costcode defined on the employee record (Figure C.26) and lookup the 
account mask. 

Figure C.26—Example Employee Record—Pay Calculation Tab

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-00 XXXX (from the department)

builds to

AXX 02-00 6110
Departmentalized Examples 
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6. Take the account mask from the Lookup 2 for the State Grant 04 edit value 
(Figure C.27).

Figure C.27—.COSTCODE—State Grant 04 Edit Value

In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the State Grant 04 edit value. And our account number is resolved: 

NOT DEPARTMENTALIZED
The steps involved in building the account number will vary widely, depending on a 
number of settings. Basically, the system uses the following path to look for elements in 
the account number:

1.  Earnings item,

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-00 XXXX (from the department)

plus

A04 XX-XX XXXX (from the costcode)

builds to

A04 02-00 6110
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2. Employee record (departments and/or GLAs),

3. Costcodes (can be added to the employee record or the timesheet), and/or

4. Distribution tables (can be added to the employee record or the timesheet).

The following examples show some of the more common ways Payroll resolves account 
numbers.

OPTION D—DEPARTMENT FROM EMPLOYEE RECORD

This example involves the following scenario:
• We selected an HDI that draws both the department from the employee record 

and the GLA from the account mask defined on the HDI.
• We have defined both the department and GLA for the employee (saved on his 

employee record).
• We have also defined a costcode for the employee (saved on his employee 

record).
Given these settings and selections, Payroll resolves the account number as follows.

1.  Take the account mask defined on the earnings item (Figure C.28). Note: This 
account mask is entered as a default on the timesheet, and can be overridden (if 
the earnings item definition allows). 

Figure C.28—Example Historical Data Item—Hourly
Not Departmentalized 
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2. Take the Entry Type defined on the earnings item (Figure C.29). 

Figure C.29—Example Historical Data Item—Rate From

3. Because the Entry Type on the earnings item is an hour option (as opposed to an 
amount or unit option), default to the Salary settings on the Accounting 
Information tab (Figure C.30) and lookup the account mask (Lookup 2 on the 
edit value definition for .H DEPT). 

Figure C.30—Example Employee Record—Accounting Information Tab
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4. Take the hourly department defined on the employee record and lookup the 
account mask (Lookup 2 on the edit value definition for .H DEPT) (Figure 
C.31). 

Figure C.31—.H DEPT—Admin Edit Value

In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the Admin department. So here’s how our account is building: 

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-XX XXXX (from the department)

builds to

AXX 02-XX 6110
Not Departmentalized 
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5. Take the costcode defined on the employee record (Figure C.32) and lookup the 
account mask. 

Figure C.32—Example Employee Record—Pay Calculation Tab

6. Take the account mask from the Lookup 2 for the State Grant 04 edit value 
(Figure C.33).

Figure C.33—.COSTCODE—State Grant 04-a Edit Value
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In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the State Grant 04 edit value. And our account number is resolved: 

OPTION D—WITH COSTCODES AND DISTRIBUTION TABLES

This example involves the following scenario:
• We selected an HDI that draws both the department and GLA from the 

employee record.
• We have not defined any department and GLA information for the employee.
• We have not defined any costcode or distribution table information on the 

employee record.
• We selected a costcode and a distribution while entering the timesheet.

Given these settings and selections, Payroll resolves the account number as follows.

AXX XX-XX 6110 (from the earnings item)

plus

AXX 02-XX XXXX (from the department)

plus

A04 XX-00 XXXX (from the costcode)

builds to

A04 02-00 6110
Not Departmentalized 
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1.  Take the account mask defined on the earnings item (Figure C.34). Note: This 
account mask is entered as a default on the timesheet, and can be overridden (if 
the earnings item definition allows). 

Figure C.34—Example Historical Data Item—Hourly

2. Take the Entry Type defined on the earnings item (Figure C.35). 

Figure C.35—Example Historical Data Item—Rate From

We have changed the Use costcode setting for the Hourly earnings item 
in Division 95 specifically for this example.
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3. Because the Entry Type on the earnings item is an hour option (as opposed to an 
amount or unit option), default to the Salary settings on the Accounting 
Information tab and lookup the account mask (Lookup 2 on the edit value 
definition for .H DEPT). In this example, the employee does not have any 
department information defined (Figure C.36). Therefore, the program gets no 
accounting information in this step. 

Figure C.36—Example Employee Record—Accounting Information Tab

4. Take the costcode added to the timesheet during entry (Figure C.37). 

Figure C.37—Example Timesheet With Costcode
Not Departmentalized 
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5. Take the account mask from the Lookup 2 for the State Grant 04 edit value 
(Figure C.38).

Figure C.38—.COSTCODE—State Grant 04-a Edit Value

In this example, Payroll takes the numbers defined in the Lookup 2 account 
mask of the State Grant 04 edit value. And our account number is resolved: 

6. Take the distribution table defined on the timesheet (Figure C.39). 

Figure C.39—Example Timesheet With Distribution Table and Costcode

AXX XX-XX 6110 (from the earnings item)

plus

A04 XX-00 XXXX (from the costcode)

builds to

A04 XX-00 6110
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7. Take the account masks and distributions from the Admin - 04 distribution table 
(Figure C.40).

Figure C.40—ADMIN - 04 Distribution Table

And our account numbers are resolved: 

OPTION D—WITH DISTRIBUTION TABLES BUT NO COSTCODES

This example involves the following scenario:
• We selected an HDI that draws both the department and GLA from the 

employee record.
• We have not defined any department and GLA information for the employee.
• We have not defined any costcode or distribution table information on the 

employee record.

AXX XX-XX 6110 (from the earnings item) AXX XX-XX 6110 (from the earnings item)

plus plus

A04 XX-00 XXXX (from the costcode) A04 XX-00 XXXX (from the costcode)

plus plus

AXX 01-XX XXXX (from the dist. table) AXX 02-XX XXXX (from the dist. table)

builds to builds to

A04 01-00 6110—40% of amount A04 02-00 6110—60% of amount
Not Departmentalized 
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• We selected a distribution while entering the timesheet.
Given these settings and selections, Payroll resolves the account number as follows.

1.  Take the account mask defined on the earnings item (Figure C.41). Note: This 
account mask is entered as a default on the timesheet, and can be overridden (if 
the earnings item definition allows). 

Figure C.41—Example Historical Data Item—Hourly

2. Take the Entry Type defined on the earnings item (Figure C.42). 

Figure C.42—Example Historical Data Item—Rate From
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3. Because the Entry Type on the earnings item is an hour option (as opposed to an 
amount or unit option), default to the Salary settings on the Accounting 
Information tab and lookup the account mask (Lookup 2 on the edit value 
definition for .H DEPT). In this example, the employee does not have any 
department information defined (Figure C.43). Therefore, the program gets no 
accounting information in this step. 

Figure C.43—Example Employee Record—Accounting Information Tab

4. Take the distribution table defined on the timesheet (Figure C.44). 

Figure C.44—Example Timesheet With Distribution Table
Not Departmentalized 
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5. Take the account masks and distributions from the Admin - 04 distribution table 
(Figure C.45).

Figure C.45—ADMIN - 04 Distribution Table

And our account numbers are resolved: 

UNDERSTANDING THE INTERACTION WITH THE ENTRY TYPE
Your system could be looking at any of three options for the department and GLA data 
items (Table C.1). How does Payroll know which data item to look at when resolving 
the account?

AXX XX-XX 6110 (from the earnings item) AXX XX-XX 6110 (from the earnings item)

plus plus

A04 01-00 XXXX (from the dist. table) A04 02-00 XXXX (from the dist. table)

builds to builds to

A04 01-00 6110—40% of amount A04 02-00 6110—60% of amount

Table C.1—Department and GLA Created for Departmentalization

Salary Earning Type Hourly Earning Type Other Earning Type

.S DEPT .H DEPT .O DEPT
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The answer to this question is that Payroll looks at the Entry Type defined for the 
earnings item (Table C.2). 

.S GLA .H GLA .O GLA

Table C.2—Historical Data Item Entry Types

Options Definition

N No timesheet entry is used. Usually taxes, deductions, and other items are Ns.

H Hours are entered during timesheet entry. Defaults are .H DEPT, .H GLA, and .H AMT. Entry 
is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

A Amount (dollars) entered during timesheet entry. Defaults are .S DEPT, .S GLA, and .S AMT. 
Entry is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Salary option on the 

Accounting Information tab on the employee record.

O Units (other) are entered during timesheet entry. Defaults are .O DEPT, .O GLA, and .O 
AMT. Entry is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Other option on the Accounting 

Information tab on the employee record.

1 Dated hours—Hours are entered during timesheet entry. Defaults are .H DEPT, .H GLA, and 
.H AMT. Entry is dated and numbered: 01/01/2004 timesheet 1, 01/15/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

2 Clocked hours—Hours are entered during timesheet entry. Defaults are .H DEPT, .H GLA, 
and .H AMT. Entry is dated, clocked and In or Out: 01/01/2004, 0800, In; 01/15/2004, 1200, 
Out.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

3 Dated amount—Amounts are entered during timesheet entry. Defaults are .S DEPT, .S GLA, 
and .S AMT. Entry is dated and numbered: 01/01/2004 timesheet 1, 01/15/2004 timesheet 2, 
etc.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

Table C.1—Department and GLA Created for Departmentalization

Salary Earning Type Hourly Earning Type Other Earning Type
Understanding the Interaction With the Entry Type 
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4 Clocked amounts—Amounts are entered during timesheet entry. Defaults are .S DEPT, .S 
GLA, and .S AMT. Entry is dated, clocked and In or Out: 01/01/2004, 0800, In; 01/15/2004, 
1200, Out.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

5 Dated units—Units are entered during timesheet entry. Defaults are .O DEPT, .O GLA, and 
.O AMT. Entry is dated and numbered: 01/01/2004 timesheet 1, 01/15/2004 timesheet 2, 
etc.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

6 Clocked units—Amounts are entered during timesheet entry. Defaults are .O DEPT, .O GLA, 
and .O AMT. Entry is dated, clocked and In or Out: 01/01/2004, 0800, In; 01/15/2004, 1200, 
Out.
• Payroll will only look at the information entered under the Other option on the Accounting 

Information tab on the employee record.

7 Hours on cards/rate override. Hour rate can be overridden during timesheet entry. Defaults 
are .H DEPT, .H GLA, and .H AMT. Entry is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

8 Dated hours/rate override. Hour rate can be overridden during timesheet entry. Defaults are 
.H DEPT, .H GLA, and .H AMT. Entry is dated and numbered: 01/01/2004 timesheet 1, 01/
01/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

9 Clocked hours/rate override. Hour rate can be overridden during timesheet entry. Defaults 
are .H DEPT, .H GLA, and .H AMT. Entry is dated, clocked and In or Out: 01/01/2004, 0800, 
In; 01/01/2004, 1200, Out.
• Payroll will only look at the information entered under the Hourly option on the 

Accounting Information tab on the employee record.

X Other on cards/rate override. Other rate can be overridden during timesheet entry. Defaults 
are .O DEPT, .O GLA, and .O AMT. Entry is numbered 1, 2, 3, etc.
• Payroll will only look at the information entered under the Other option on the Accounting 

Information tab on the employee record.

Table C.2—Historical Data Item Entry Types (Continued)

Options Definition
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Y Dated other/rate override. Other rate can be overridden during timesheet entry. Defaults are 
.O DEPT, .O GLA, and .O AMT. Entry is dated and numbered: 01/01/2004 timesheet 1, 01/
01/2004 timesheet 2, etc.
• Payroll will only look at the information entered under the Other option on the Accounting 

Information tab on the employee record.

Z Clocked other/rate override. Other rate can be overridden during timesheet entry. Defaults 
are .O DEPT, .O GLA, and .O AMT. Entry is dated, clocked and In or Out: 01/01/2004, 0800, 
In; 01/01/2004, 1200, Out.
• Payroll will only look at the information entered under the Other option on the Accounting 

Information tab on the employee record.

Table C.2—Historical Data Item Entry Types (Continued)

Options Definition
Understanding the Interaction With the Entry Type 



GLOSSARY

A
Account Mask—Allows you to group accounts using only one entry. A mask uses a 
variable (X) in place of an actual number. See also Masking.
Account Number—The number that stores transaction information in a financial 
reporting system.
Account Number Structure—Describes how accounts are categorized to represent 
funds, departments, subdepartments, GLAs, and so on. 
Additional Basis—A field on the employee record that contains taxes, deductions, and 
employee costs for employee earnings. Contents of this field are added to the Basis For 
field on the earning’s Historical Data Item definition for the total basis for the earning. 

B
Bank—See Financial Institution and Financial Institution Account.
Basis Amounts—The dollar amount that an earning, tax, deduction, or employer cost is 
based on. For example, an entry for the employer’s share of FICA for $76.50 has a 
“basis amount” of $1,000 in earnings. 
Basis For—A field in the historical data item record on the earning. Taxes, deductions, 
and other data items that the earning is subject to are listed here. The earning will 
“output” to System Registers 3 and 4 for each of the data items listed here. See Internal 
Registers on page 1.254 for more informatin.
Business Date—The date used to post an entry to a ledger. Also called the posting date.

C
Calculation Trace Reports—Line-by-line presentation of calculations and results. 
Separate from transaction trace reports. See also Trace Reports.
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Check Date—The date of the original check.
Check Number—The 7-digit external form number on the check, which is posted to 
history by the log checks task.
Cost Codes—A method of accounting for earnings that is used when wage expenses 
need to be coded to a specific project or job. You might want to use Cost Codes for:

• Employees who work in multiple departments (Cost Codes) but make the same 
rate of pay regardless of where they work.

• Employees whose rate of pay varies with the job they work and all employees 
who work that job are paid that rate.

• Employees who work in different departments and have different rates of pay.
Cycles—Up to 9 calculation cycles are allowed to determine when deductions occur for 
a payroll run (i.e., checks and direct deposit).

D
Data Item—See Employee Data Items and Historical Data Items.
Department—The dimensions or combination of dimensions that defines who an 
employee’s wage expense belongs to. For example, Admin, Sales, etc.
Departmentalized Earnings—Earnings for one employee that are expensed to multiple 
departments. The earnings can be Salary, Hourly, or Other and must be given a 
percentage, with the percentages for each type adding up to 100%. This is determined by 
entry in the setup parameters.
Dimension—A group of numbers within the account number. 
Direct Deposit—A feature that produces an NACHA file and stubs rather than physical 
checks. The file is given or transferred to a bank. Direct Deposit was called Electronic 
Funds Transfer (EFT) in the Classic Edition Payroll/Personnel.
Distribution Tables—A method of accounting for earnings that is used when wage 
expenses can be consistently distributed to the same accounts using the same 
percentages. Distribution Tables work best for salaried employees whose wage expense 
accounts are the same every period or hourly employees whose wage expense accounts 
are the same regardless of the number of hours worked. Distribution Tables do not work 
well for employees whose wage expense accounts change from pay period to pay 
period. The account mask from the table is added to by the account number determined 
for the earning. If the table contains no Xs, it is used exactly like it is, without additional 
account numbers from the earning item.
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E
Earnings Item—An historical data item defined as, E—Earnings, T—Taxes, 
D—Deductions, or O—Other (employer costs and benefits). These HDIs are what you 
use to define earnings amounts on employee timesheets.
EDI—See Employee Data Item (EDI).
Edit Value—A value attached to an Employee Data Item to restrict values placed on 
employee records. Up to 10 types of Edit Values can be placed on an Employee Data 
Item.
EFT—See Direct Deposit.
Employee Data Item (EDI)—A field that stores information on the employee record. 
There are 2 kinds of Data Items: System-defined and User-defined. System-defined 
Data Items are the fields on the employee record (e.g., name, phone number, date of 
hire, salary amount). User-defined Data Items are for additional fields that you wish to 
attach to the employee record or to use for sorting or selecting information for reports. 
Employee Record—A record containing employee name, address, phone numbers, 
dates and earnings information. There is one Employee Record for each employee. 
Employee Selector—A feature that allows you to restrict (i.e., filter) the range of 
employees or records to include in a task or on a report. Using the Employee Selector 
may be helpful if you cut checks at different times based on an Employee Data Item like 
Department.

F
Financial Institution—Any entity that has custody of, and/or manages, cash or cash-
equivalent accounts (e.g., banks, savings and loans). A financial institution can have 
more than one account.
Financial Institution Account—A unique and specific account within a financial 
institution. An account will have a separate statement from the financial institution 
recording activity for the period. An account must be within a single financial institution 
(e.g., checking account, savings account). Accounts are “mapped” to each module.
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G
GLA—Literally “General Ledger accounts.” In everyday usage, they often represent the 
“natural” account or object code of an account number and define what the employee 
does or the cost category to which they belong. However, when we refer to GLAs in the 
program, we are referring to an additional piece of your Payroll setup (.H GLA, .S GLA, 
or .O GLA) and a setting on the employee record. You can use the department and GLA 
to refine how Payroll builds your account numbers.

H
HDI—See Historical Data Item (HDI).
Historical Data Item (HDI)—Any taxes, deductions, benefits, or earnings types that 
determine or affect an employee’s check. There are 4 types of Historical Data Items: 
earnings, taxes, deductions and other. Each Historical Data Item that affects your payroll 
must be brought in from the ToolBox or created by you manually. Examples are comp. 
hours accrued, vacation hours accrued, total all FICA deferred deductions, etc.

I
Inquiry—Allows you to view information like employee records, checks, employee 
history, tax rates and tables, or direct deposit information. 

L
Log Checks—Enters the pre-printed check number into Payroll/Personnel. When you 
log check numbers, the system matches the check number to the system number in the 
employee check history record. This task also posts to the payroll history files and to 
General Ledger and Accounts Payable, when so defined in the setup parameter.

M
Marked for Reconciliation—Checks that are in the process of being reconciled.
 



Glossary
Masking—A “wild card” code used to represent a group of accounts for reports, 
maintenance, or for account duplication. Use a mask to represent a group of accounts 
using only one entry. A mask uses an X in the place of an actual number in the account 
number.

N
Negative Checks—A paycheck amount may appear as a negative number if low 
earnings cause the deductions to be higher than the wage, a one-time deduction is higher 
than the wage, incorrect data items appear on the employee record, or an incorrect 
calculation formula was entered. You should correct a negative amount before you 
produce and print checks.
Non-Departmentalized Earnings (Other Earnings)—“Other” can be 
departmentalized, and is determined during parameter setup. Hourly, Salary and Other 
are defined on the employee record to allow for only one department and wage account. 
You may have none or as many as three non-departmentalized earnings.

O
One-Time Deductions—Deductions that are not normally part of an employee’s 
paycheck. For example, use One-time Deductions to pay back an advance, or adjust the 
amount of a tax or deduction. 
Outstanding—Checks that have been issued but have not been cleared by the bank.

P
Parameter—Determines system configuration, check format, ledger posting, and 
journals used.
Pay Frequency—Determined by the number of checks issued in a calendar year. Pay 
Frequency is controlled by the .T FREQ edit values. Do not change these edit values 
since they are used in computing taxes.
Preliminary Check Register—A Preliminary Check Register shows the result of the 
net pay calculation and a preview of the actual check register. 
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Pre-Notification—An information record sent to the employee’s bank to verify routing 
transit numbers and account numbers for a Direct Deposit. You should define pre-
notification one payroll cycle prior to the payroll cycle that the Direct Deposit will be 
activated or changed for an employee. 

R
Rates and Tables—Are attached to Historical Data Items and contain rates, 
percentages, or amounts. They are used to calculate Historical Data Items. 
Reconciled Checks—Checks that have been posted as processed by your bank.

S
Shortcut Menu—Menu displayed when you click the right mouse button (i.e., right-
click).
Standard Reports—Reports that come with the software. The original reports should 
not be customized, but you may wish to make a copy of a standard report and edit it.
System Numbers—A number on each check and Direct Deposit that is automatically 
assigned by the Payroll/Personnel software. The number is printed on both the stub and 
the actual check. The System Number consists of two parts: the internal number and the 
form sequence number. For Direct Deposit employees, only the internal number prints 
on the Direct Deposit form. A sample System Number might look like this: 1609-0001

T
Time Cards—See Timesheets.
Timesheet Entries—Each entry of an “earnings item.” Earning items may be a number 
of different things (e.g., flat dollar amount such as salary, or a dollar amount based on 
hours or units such as sick time). Each timesheet entry is added to a single timesheet for 
the employee.
 



Glossary
Timesheets—A computerized record of earnings for an employee. Each employee has 
one timesheet, which can have multiple “timesheet entries” to accommodate the 
different types of earnings (e.g., one timesheet can have entries for salary, bonus, and 
vacation time for a single employee). In earlier versions of Payroll/Personnel, these 
were called Time cards.
ToolBox—A set of predefined earnings, taxes, deductions, and employer costs 
(historical and employee data items) that you can copy into your system during setup or 
to update your system periodically. Use of ToolBox items can greatly reduce the amount 
of time required to setup a new payroll. American Fundware, Inc. updates the ToolBox 
data items at the beginning of each year. (As necessary, we also may update ToolBox 
throughout the year.)
Trace Reports—An “audit trail” of all entries made into the Payroll/Personnel module. 
If you use a FundWare financial reporting system such as General Ledger, each time a 
transaction is posted through a journal, a trace report is automatically created and saved 
to a file. See also Calculation Trace Reports.

U
User-Defined Reports—Reports you define. User-defined reports can contain both 
historical and employee data items in a columnar format. Several reports are already 
defined for you in the Payroll/Personnel module. 

V
Voided Check—Checks that have been declared invalid after being written or 
produced. When a payroll check is voided, all journal entries and account payable 
obligations associated with the check are reversed.
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Symbols
.DED  . . . . . . . . . . . . . . . . . . . . . . . 1.78
.EARN . . . . . . . . . . . . . . . . . . . . . . 1.78
.H GLA  . . . . . . . . . . . . . . . . . . . 1.3, 2.3
.O GLA  . . . . . . . . . . . . . . . . . . . 1.3, 2.3
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.SWT  . . . . . . . . . . . . . . . . . . . . . . 1.104
.TAX  . . . . . . . . . . . . . . . . . . . . . . . 1.78

A
Access

From keyboard  . . . . . . . . 1.22, 2.22
Shortcut menus  . . . . . . . . 1.22, 2.22

Account
Liability . . . . . . . . . . . . . . . . . . 1.34

Account mask  . . . . . . . . . . . . . . . 2.140
Definition  . . . . . . . . . . 1.299, 2.261

Account number
Definition  . . . . . . . . . . 1.299, 2.261

Account number structure
Definition  . . . . . . . . . . 1.299, 2.261

Accounting information . . . . . . . . 2.140
Accounting Information tab

Tips . . . . . . . . . . . . . . . . . . . . . 2.40
Accounting methods

Cost codes . . . . . . . . . . . . . . 1.6, 2.6
Accounts

Resolution . . . . . . . . . . . . . . . 1.261
Accrued account  . . . . . . . . . . . . . . 1.41
Accrued payroll . . . . . . . . . . . . . . . 1.34
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Menu  . . . . . . . . . . . . . . . .1.23, 2.23
Active year . . . . . . . . . . . . . .1.43, 1.236
Activity reminder . . . . . . . . . .1.11, 2.11
Adding

Columns to detail pane  . .1.26, 2.26
Departmentalized earnings to the 

employee record . . .1.3, 2.3
Employees . . . . . . . . . . . . . . . . 2.31
Group timesheets . . . . . . .2.65, 2.66
Manual checks . . . . . . . .2.97, 2.107
One-time deductions . . . . . . . . 2.83
Single timesheet  . . . . . . . . . . . 2.69
User-defined reports  . . . . . . . 2.144

Additional basis
Definition  . . . . . . . . . .1.299, 2.261

Additional basis for  . . . . . . . .2.39, 2.40
Adjusting

Payroll parameter  . . . . . . . . . 2.152
ALT key . . . . . . . . . . . . . . . . .1.22, 2.22
Amount format . . . . . . . . . . . . . . . . 1.38
Amount/percent . . . . . . . . . .1.208, 2.42
Amt/Hrs/Units  . . . . . . . . . . . . . . . . 2.71
ASCII . . . . . . . . . . . . . . . . . . . . . . 2.172
Asterisks . . . . . . . . . . . . . . . . .1.15, 2.15
Auto employee . . . . . . . . . . . . . . . . 1.38

B
Balances

Roll forward  . . . . . . . . . . . . . 1.236
Rolling . . . . . . . . . . . . . . . . . . 1.236

Bank
Definition  . . . . . . . . . .1.299, 2.261
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Bank account # . . . . . . . . . . .1.208, 2.42
Bank DFI # . . . . . . . . . . . . . .1.208, 2.42
Bank reconciliation  . . . . . . . . . . . 2.123

Display checks . . . . . . . . . . . . 2.134
Enter reconciliation . . . . . . . . 2.123
Logging unused checks . . . . . 2.112
Post reconciliation . . . . . . . . . 2.127
Purge reconciliation . . . . . . . . 2.130
Run check reports  . . . . . . . . . 2.131
Voiding a check . . . . . . . . . . . 2.114

Banks
Reports . . . . . . . . . . . . . . . . . . 2.140

Basis . . . . . . . . . . . . . . . . . . . . . . . . 1.96
Basis amounts

Definition . . . . . . . . . . .1.299, 2.261
Basis for

Definition . . . . . . . . . . .1.299, 2.261
Benefits  . . . . . . . . . . . . . . . . . . . . . 1.81
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C H A P T E R  1

INTRODUCTION

The Blackbaud FundWare™ Payroll/Personnel module gives you the ability to manage 
and report on your organization’s payroll easily and effectively. With Payroll/Personnel, 
you can:

• Maintain employee master records and history.
• Distribute expenses to multiple departments and/or General Ledger accounts.
• Define custom data items, including taxes, deductions, and employer costs.
• Allow multiple payroll accrual accounts and cash accounts.
• Create timesheets for a group of employees in a single step.
• Enter one or more timesheets for your employees in a single form.
• Process checks (e.g., produce checks, void checks, enter manual checks).
• Create direct deposit files.
• Post financial data to General Ledger, Project/Grant, and Accounts Payable.
• Process your W-2s (e.g., extract information, print W-2s, create electronic file).
• Update your earnings, taxes, deductions, and employer costs using the ToolBox.

THE PAYROLL PROCESS
The following steps represent a typical pay period. Procedures vary for each 
organization; you may not perform all of these steps or you may perform more.

1.  Create employee timesheets.

2. Verify (and correct if necessary) timesheets.

3. Post timesheets.
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4. Enter one-time deductions.

5. Calculate net pay.

6. Produce and review a Preliminary Check Register.

7. Produce checks and direct deposit payments.

8. Log printed check numbers and direct deposit payments.

9. Reconcile checks and direct deposit payments.

DEPARTMENTALIZATION, COSTCODES, AND DISTRIBUTION TABLES
The most-critical Payroll decision will determine how the system uses your settings and 
entries to resolve (or “build”) the account number to which you post your Payroll costs:

• Are you departmentalized, or 
• Are you not departmentalized?

This setting is defined on your Payroll Parameter and can be different for salaried, 
hourly, or “other” employees (Figure 1.1). (See Defining the Payroll Parameter on page 
1.34 for more information on the parameter.) 

Figure 1.1—Departmentalized Salary and Non-Departmentalized Hourly

Once this has been determined, you can decide if you are using costcodes or distribution 
tables:
Departmentalization, Costcodes, and Distribution Tables 
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• Costcodes can be used with departmentalized or non-departmentalized 
earnings.

• Distribution tables can only be used with non-departmentalized earnings.
The following sections explain these options and general instructions for implementing 
them. Specific instructions for each topic can be found later in this guide: 

• Creating Departmentalized Earnings on page 1.72,
• Implementing Costcodes on page 1.46, or
• Creating Distribution Tables on page 1.67.

For examples of how Payroll uses these settings to resolve the account number during 
timesheet entry, see Appendix C—How Does Payroll Resolve Accounts? on page 1.261.

DEPARTMENTALIZED EARNINGS

The departmentalized earnings option represents a very specialized method of 
accounting. You should use the departmentalized earnings option if all or most of your 
employees have different wage distributions. When you define Salary, Hourly, and/or 
Other as departmentalized, you must also define departments and GLAs for each 
departmentalized option. You can then select and store these settings on the employee 
record.

GLAs are literally “General Ledger accounts.” In everyday usage, they often 
represent the “natural” account or object code of an account number and define 
what the employee does or the cost category to which they belong. However, 
when we refer to GLAs in the program, we are referring to an additional piece 
of your Payroll setup (.H GLA, .S GLA, or .O GLA) and a setting on the 
employee record. You can use the department and GLA to refine how Payroll 
builds your account numbers.

HOW DO YOU IMPLEMENT DEPARTMENTALIZATION?

There are three primary steps that you must complete to prepare your system for 
departmentalization. 
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1.  Define the Salary, Hourly, and/or Other earning type as 2 (Departmentalize) in 
field 1 of the Payroll Parameter (Figure 1.2). 

Figure 1.2—Departmentalized Setting in Division 95 Payroll Parameter

For more information on the payroll parameter, see Defining the 
Payroll Parameter on page 1.34. 

2. You define edit values for each of these employee data items to represent all the 
departments (.S DEPT, .H DEPT, and/or .O DEPT) and GLAs (.S GLA, .H 
GLA, and/or .O GLA) that are needed by your organization.
Departmentalization, Costcodes, and Distribution Tables 
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3. You define one or more departments and GLAs for each employee on the 
Accounting Information tab of the employee record (Figure 1.3). (This is 
optional. Depending on other settings, the system will still be able to resolve the 
account number if the employee does not have a department and GLA setting.) 

Figure 1.3—Example .S DEPT and .S GLA Entry on Accounting Information Tab

Because you have defined the Salary, Hourly, and/or Other earning type 
as departmentalized, Payroll allows you to enter multiple definitions for 
your salary, hourly, or other settings. Non-departmentalized Salary, 
Hourly, and/or Other earning types allow only one entry (i.e., 100% to a 
single department, GLA, and Additional basis for).

For examples of how Payroll resolves the account number in a departmentalized system, 
see Appendix C—How Does Payroll Resolve Accounts? on page 1.261.

ARE DISTRIBUTION TABLES EASIER?

If you do not use distribution tables for a departmentalized configuration, each change 
to your system may force you to make changes to every employee record. However, you 
may find that defining and maintaining 20–30 distribution tables may be easier than 
adjusting the departmentalized earnings for each employee each time the information 
changes. 

These options are defined as edit values 
to the .S DEPT employee data item.

These options are defined as edit values to 
the .S DEPT employee data item.

.S PCNT

.S GRP
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COSTCODES

You can use costcodes when your organization wants to code wage expenses to a 
specific project or “job” through an account number. In costcode accounting, employees 
usually work in multiple departments but there is no consistent distribution of labor. 
Employees may also have rates of pay that vary by department. 
Defining your system to use costcodes involves settings on a number of different 
records:

• Payroll parameter,
• Earnings items (i.e., historical data items with the History type defined as E—

Earnings), 
• Edit values for employee data items (.COSTCODE and/or .COSTRATE, 

depending on your setup), 
• Employee records, 
• Timesheets.

See the following sections for example uses of costcodes. See Implementing Costcodes 
on page 1.46 for specific instructions to implement costcodes.

EXAMPLE COSTCODE—RATE DEFINED ON EMPLOYEE RECORD

Charles Applecart works for Emerald City’s vehicle maintenance department earning 
$12 per hour. The vehicle maintenance department charges each city department for 
work on city vehicles. For example, Charles may work on police cars year-round (for 
the police department), but work on graders in the summer (for the road maintenance 
department) and snow plows in the winter (for the snow removal department). 
Therefore, we define an edit value for .COSTCODE for each city department to ensure 
that the hours are billed correctly. When we enter a timesheet for Charles Applecart, we 
select the correct edit value for the hours worked. Payroll defaults the rate to the Hourly 
rate defined on the Payroll Information tab of the employee record (which corresponds 
to employee data item .H AMT) and resolves the account number to charge the correct 
city department for these hours.
See Implementing Costcodes—Rate Defined on Employee Record on page 1.46 for 
specific instructions to implement this type of costcode setup. For examples of how 
Payroll resolves the account number using costcodes, see Appendix C—How Does 
Payroll Resolve Accounts? on page 1.261.
Departmentalization, Costcodes, and Distribution Tables 
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EXAMPLE COSTCODE—RATE DEFINED ON .COSTCODE

Prucilla Pear works for Emerald City’s safety department as an emergency medical 
technician (EMT). However, she occasionally works as a standby firefighter for the city. 
EMTs earn $25 per hour, while firefighters earn $30 per hour. Because Prucilla is paid 
at different rates, we define .COSTCODE edit values for each department, including a 
lookup column 3 to hold the rate. We enter two pieces of information on Prucilla’s 
record:

• Hourly rate on the Payroll Information tab—Payroll will multiply the hourly 
amount by the rate defined by the hours billed. Therefore, to accurately reflect 
our EMT and firefighter rates, we enter 1.00 in the Hourly rate field. 

Certain organizations use this feature to better reflect a more 
complicated payroll calculation.

• .COSTCODE added to the Pay Calculation tab—Because most of Prucilla’s 
time is billed at the EMT rate, we select this edit value. When we enter a 
timesheet for Prucilla, the default .COSTCODE edit value will be EMT. We can 
change this for those hours that should be billed at the firefighter rate.

See Implementing Costcodes—Rate Defined on Employee Record on page 1.46 for 
specific instructions to implement this type of costcode setup. For examples of how 
Payroll resolves the account number using costcodes, see Appendix C—How Does 
Payroll Resolve Accounts? on page 1.261.

EXAMPLE COSTCODE—MULTIPLE RATES DEFINED ON EMPLOYEE RECORD

The Greene County parks and recreation department has three employees: Georgetta 
Berry, Oda Mae Pineapple, and Don Strawberry. Each of the employees may work at a 
variety of tasks:

• Georgetta usually works with wildlife management, where she earns $18 per 
hour. Sometimes she fills in on the night patrol of the park, where she earns $16 
per hour.

• Oda Mae is a researcher and earns $25 per hour. She also spends part of her 
week working with wildlife management, where she earns $20 per hour.

• Don usually works the night patrol, where he earns $17 per hour. However, he’s 
working on an advanced degree in biology and assists in the research 
department on occasion, where he earns $19 per hour.

Because each employee works at a variety of tasks and earns different amounts for each 
task, we decide to use the Costcode with rate override option. This option allows us to 
add an edit value and define a unique rate for each task on the employee’s record.
Blackbaud, Inc. 2.7



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.8
We define .COSTCODE edit values for each department, then enter three pieces of 
information on each record:

• Hourly rate on the Payroll Information tab—Payroll will multiply the hourly 
amount by the rate defined by the hours billed. Therefore, to accurately reflect 
our payroll rates, we enter 1.00 in the Hourly rate field. 

Certain organizations use this feature to better reflect a more 
complicated payroll calculation.

• .COSTCODE added to the Pay Calculation tab—Because most of Prucilla’s 
time is billed at the EMT rate, we select this edit value. When we enter a 
timesheet for Prucilla, the default .COSTCODE edit value will be EMT. We can 
change this for those hours that should be billed at the firefighter rate.

• .COSTRATE added to the Pay Calculation tab—For each .COSTCODE that 
we add, we add a corresponding .COSTRATE data item and enter a rate.

See Implementing Multi-Occurring Costcodes (Complex) on page 1.60 for specific 
instructions to implement this type of costcode setup. For examples of how Payroll 
resolves the account number using costcodes, see Appendix C—How Does Payroll 
Resolve Accounts? on page 1.261.

DISTRIBUTION TABLES

You can use distribution tables in situations where wage expenses are consistently 
distributed to the same accounts using the same percentages. You define the accounts 
and percentages to which you are posting and assign that distribution table to employee 
records or to individual timesheet entries for your employees.
This option works well for:

• Salaried employees whose wage expense accounts are the same every period, or 
• Hourly employees whose wage expense accounts are the same regardless of the 

number of hours worked. 

HOW DO YOU IMPLEMENT DISTRIBUTION TABLES?

There are two primary steps that you must complete to prepare your system for 
distribution tables.
Departmentalization, Costcodes, and Distribution Tables 
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1.  The first step to using distribution tables is to enter Y (Distribution tables are 
used) in the Dist tables field of the Payroll Parameter (Figure 1.4). See Defining 
the Payroll Parameter on page 1.34 for more information on the parameter. 

Figure 1.4—Distribution Table Setting in Division 95 Payroll Parameter

2. After you define the Payroll Parameter to allow distribution tables, you must 
define the tables themselves (Figure 1.5) and modify the .DIST TBL employee 
data item definition. (For specific instructions, see Creating Distribution Tables 
on page 1.67.) 

Figure 1.5—Distribution Table Definition

Once you have completed these setup tasks, there are two ways to implement 
distribution tables.

In Sample Division 
95, the Dist tables 
field is set to Y 
(Distribution tables 
are used).
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• You can attach a distribution table to the Pay Calculation tab of the employee 
record of all relevant employees (Figure 1.6). 

Figure 1.6—Attaching a Distribution Table to the Employee Record

Each time you create a timesheet for the employee, Payroll will provide that 
table as a default distribution table if the earnings item is defined for distribution 
tables (Figure 1.7). 

Figure 1.7—Example Timesheet—Default Distribution Table
Departmentalization, Costcodes, and Distribution Tables 



Chapter 1—Introduction
Or you can attach a distribution table directly to the timesheet, bypassing the 
employee record (Figure 1.8). 

Figure 1.8—Example Timesheet—Adding a Distribution Table

For examples of how Payroll resolves the account number using distribution tables, see 
Appendix C—How Does Payroll Resolve Accounts? on page 1.261.

THE PAYROLL/PERSONNEL HOMEPAGE
The Payroll/Personnel HomePage helps you keep an eye on upcoming activities and 
provides you with direct access to produce your reports. The following areas make up 
the Payroll HomePage:

• Activity Reminder area, and
• Reports area.

ACTIVITY REMINDERS

The Activity Reminders area allows you to enter a text note and a due date (optional) for 
module tasks (Figure 1.9). When you open the HomePage, any tasks with due dates 
earlier than the system date of your computer (i.e., “overdue”) will display as red. 

Figure 1.9—Activity Reminders Area
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Use the following instructions to use the Activity Reminders area.
1.  On the General Ledger HomePage, enter up to 100 alphanumeric characters in 

the Activity field (Figure 1.10). 

Figure 1.10—Example Activity Reminder—Prenotification Reminder

2. If this task has a due date, enter the date in the Due Date field. Click the drop-
down arrow to access the calendar. This field is optional.

If you do not have any text associated with a due date, the due date will 
not be saved when you exit the HomePage.

Your entries are saved when you close the HomePage or FundWare. You can edit the 
text or date information at any time.

PRINTING REMINDERS

Click Print to print the information in the Activity Reminders area. The report output 
will reflect the current sorting and displays in a preview window, from which you can 
print the information.

DELETING REMINDERS

Use the following instructions to delete a reminder.
1.  Highlight the row.

2. Click Delete. A confirmation message displays.

3. Click Yes.
The Payroll/Personnel HomePage 
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REPORTS AREA

The same categories that you see in Report Manager for the module will also display in 
the Reports Area of the HomePage (Figure 1.11). Each category can expand and 
collapse to show or hide the reports contained within. A single click of a report title will 
display the report parameters screen. Once you enter the details of the report and click 
OK, your report is produced. 

Figure 1.11—Reports Area of the Payroll/Personnel HomePage

USING THE FOLDERS
Folders represent tasks or steps in Payroll/Personnel work flow. The folder tree displays 
on the left in the main Payroll/Personnel window. When you select a folder, the 
information in the selected folder is listed in the detail pane on the right (Figure 1.12). 

Figure 1.12—Payroll Main Window

The buttons at the bottom of the screen will change to match the actions allowed for that 
folder. A disabled (i.e., grayed-out) button can mean that you must first select an item or 
that your security level does not give you access to this function. 
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USING MASKS
A “mask” is an FundWare term for using a “wild card” in an account number to indicate 
a group of accounts. The best use of this feature is for processing and reporting. Where 
an X is placed in a mask, any value in that digit position will be accepted. 

In Sample Division 96, if you enter the mask A01 00-00 111X in the Account 
Selector, you will get five accounts:

• A01 00-00 1110, 
• A01 00-00 1111, 
• A01 00-00 1112,
• A01 00-00 1114, and
• A01 00-00 1115.

SOME FUNDWARE BASICS
The following sections provide you information and instructions for opening and 
working in FundWare.

OPENING FUNDWARE

As you begin using FundWare, certain information is saved by the program and offered 
as a default. This has been designed to help you save time and steps, but you can change 
these defaults at any time by entering new information or selecting from the available 
options (depending on the field).

• User name—The program will enter the user name (or user number) of the last 
person to log into FundWare on that computer.
— For security reasons, your password is not automatically entered. You must 

always enter your FundWare password.
• Business date—Defaults to the current system date (according to your 

computer’s operating system).
• Division—The program automatically selects the division you were working in 

the last time you were in FundWare. 
— If you have only one division (or have security rights to only one division) 

and do not have security rights to the System Administration area, the 
program will bypass the division selection window. 
Using Masks 
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— Or, if you only have security rights to the System Administration area, the 
program will bypass the division selection window and open directly to the 
System Administration HomePage.

• HomePage—The program automatically opens to the HomePage of the module 
in which you were working the last time you were in FundWare. 

Use the following instructions to open and log into FundWare.
1.  Double-click the FundWare icon on your desktop or select Blackbaud 

FundWare® Enterprise or Professional from your Windows Start menu. The 
Login window displays. 

Figure 1.13—FundWare Login Window

2. Enter your user name in the User Name text box. You can enter your user 
number instead of your user name, if preferred. 

The User Name field will default to the last entry on this computer and 
the system will move to the Password field.

3. Enter your password in the Password text box. Your password entries will 
display as asterisks (*) as you type to maintain the privacy of your password. 
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4. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

Figure 1.14—Selecting the Date

5. Click OK. If your User Name, Password, and Business Date are verified, the 
Select Division window displays, defaulting to the division you were working 
with the last time you were in FundWare. 

Figure 1.15—Selecting the Division

If your organization uses the password aging feature, you may receive a 
message indicating that your password will or has expired. You will be 
offered the chance to enter a new password at this time. See Changing 
Your Password During Login on page 2.17.

If you have only one division (or have security rights to only one 
division) and do not have security rights to System Administration, the 
program will bypass the Select Division window. Or, if you only have 
Some FundWare Basics 
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security rights to System Administration, the program will bypass the 
division selection window and open directly to the System 
Administration HomePage.

6. If necessary, select a different division (or System Administration) from the list. 

7. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

For users upgrading from earlier versions of FundWare, please note that you can only 
have one division open at a time in each instance of FundWare (a change in 
functionality). However, you can open the program multiple times for the same or 
different divisions and/or business dates.

CHANGING YOUR PASSWORD DURING LOGIN

If your organization uses the password aging feature (defined through System 
Administration), you may receive a message indicating that your password will or has 
expired. 

Figure 1.16—Password Expiring

Use the following instructions to change the password at this time.
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1.  Click Yes to the password expiration message. The Change Password window 
displays. 

Figure 1.17—Changing Your Password During Login 

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

You can also change your password from within the software. See Changing Your 
Password From the Software on page 2.21.

OPENING FUNDWARE MULTIPLE TIMES

Each “instance” of FundWare (i.e., each time you open the program) represents a single 
division on a single business date. However, you can open as many instances of 
FundWare as necessary to meet your needs. 
When dealing with multiple instances of FundWare, keep the following rules in mind:

• Each instance of FundWare represents a single user, division, and business date, 
or represents access to the System Administration features by a single user. 

• You can open as many instances of FundWare as necessary (i.e., for different 
users, business dates, or divisions).
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• You can still change the business date for the current instance of FundWare 
without opening a new instance. See Changing the Business Date on page 2.20 
for more information.

OPENING ADDITIONAL INSTANCES—FROM THE DESKTOP/START MENU

If you have one or more instances of FundWare open already, you can open additional 
instances of the program from your desktop or the Windows Start menu. You will be 
asked to identify the user, password, business date, and division (the same steps as 
opening the first instance of FundWare).

OPENING ADDITIONAL INSTANCES—FROM THE PROGRAM

You can also open a new division or a new instance of the same division from within 
FundWare. Because you are opening this division from the program, the system applies 
the same user and password to the new instance and allows you to select a new division 
or business date.

If you want to open a new instance of FundWare for a new division or a new 
business date, you can open the program from the desktop or Windows Start 
menu or from the Change Business Date task. For instructions on changing the 
business date, or opening a second instance of the program with a different 
business date, see Changing the Business Date on page 2.20.

Use the following instructions to open a new instance of FundWare for the current user 
and business date.

1.  Select File > Open FundWare from the menu bar. The Open New Instance 
window displays, automatically selecting the division you were working with 
the last time you were in FundWare. 

Figure 1.18—Opening a New Instance of FundWare

2. If necessary, select a different division (or System Administration) from the list. 
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3. Accept the default business date or enter a new date. You can manually enter 
the date (moving from day to month to year using the arrow key or mouse) or 
you can click the down-arrow to select a date from the calendar.

4. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

CHANGING THE BUSINESS DATE

You can change the business date for your current instance of FundWare or open a new 
instance of the same division with a different business date using the Change Business 
Date task. When you choose to open a new instance of the same division, the system 
applies the same user and password to the new instance and takes you directly to the 
HomePage for the module in which you were last working in that division.

1.  Select Edit > Change Business Date from the menu bar. The Change Business 
Date window displays. 

Figure 1.19—Changing the Business Date 

1 Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you can 
click the down-arrow to select a date from the calendar.

2 Select the applicable option for applying the new business date:
• Current Instance of FundWare—Changes the business date for the current 

instance of FundWare. This option does not apply any changes to other 
instances of FundWare and does not open a new instance of the program.

The “Classic” windows will not accept a changed business date. If you 
have any of the Classic screens open when you attempt to change the 
business date for the current instance of FundWare, the system will 
return a message and not allow you to proceed. Close the Classic 
windows and try again.
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• New Instance of FundWare—Opens a new instance of FundWare to the 
HomePage for the module in which you were last working, applying the 
same user, password, and division but using the new business date.

1.  Click OK. The program applies your selection.

CHANGING YOUR PASSWORD FROM THE SOFTWARE

Use the following instructions to change the password for the current user.
1.  Select Edit > Password from the menu bar. The Change Password window 

displays. 

Figure 1.20—Changing the Current User’s Password

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

If your organization uses the password aging feature (defined through System 
Administration) and your password is nearing or has passed the expiration date, you can 
also change your password during the login process. See Changing Your Password 
During Login on page 2.17.
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USING THE MENU BAR

Each module for which your organization is licensed and to which you have security 
rights displays in the menu bar. From these menu options, you can access all module-
specific tasks (e.g., General Ledger > Journal Entries > New). In addition, you will 
use the menu bar to access specific program tasks (e.g., changing the business date):

• File—Open divisions; access Print Manager, Report Manager, or Financial 
Institutions.

• Edit—Change the business date or your password.
• View—View or close Navigator bar; view full or abbreviated menu names; 

view logged in users.
• Window—See all currently open windows, switch between these windows.
• Help—Access online help for the current module and program information. 

KEYBOARD NAVIGATION

To help you navigate quickly through the program, FundWare allows you to use your 
keyboard instead of your mouse to access program tasks.

• Menu bar—You can access any task listed on the menus using a combination of 
the ALT key and a letter and the arrow keys.
— Press the ALT key.
— Press the underlined letter of the item to display the menu. The menu 

displays.
— Use the arrow key and press ENTER to select a task.

• Shortcut menus—Access any applicable shortcut menus (normally displayed 
when you right-click your mouse) from the keyboard by pressing either 
SHIFT+F10 or the Application key (offered on many newer keyboards, located 
between the WINDOWS key and the CTRL key, to the right of the spacebar).

• Shortcut keys—Shortcut keys combine the CTRL key with a letter to give you 
direct access to certain tasks. These shortcuts are listed on the menus with the 
applicable tasks. 

• Drop-down lists—You can access any drop-down list when focus is on the 
associated field by using a combination of the ALT key and the down arrow key. 
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IS YOUR MENU BAR TOO CROWDED?

If your organization is licensed for a number of FundWare modules, your menu bar may 
be too wide to use conveniently. You can change the module names that are listed in the 
menu bar to display as acronyms, which will decrease the width of the bar:

• Select View > Abbreviated Menu Names from the menu bar. To change back, 
select View > Full Menu Names from the menu bar.

HOW YOUR SECURITY RIGHTS IMPACT THE MENU BAR

Your individual security rights may impact the modules and tasks that you see on the 
menu bar. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the menu bar.

• If your security settings allow you to access some, but not all, tasks in a module, 
the restricted tasks will not be listed in the menu bar.

USING THE NAVIGATOR BAR

The Navigator bar provides you with quick, mouse-driven access to your modules, 
module tasks, and currently open windows through two areas:

• Module navigator, and
• Open windows navigator.

You can resize the Navigator bar to meet the needs of your display by using your mouse 
to click on the right frame of the bar and drag the frame to the position you want. You 
can also hide or show the Navigator bar using the options on the View menu. Select the 
option to hide or show the bar, as applicable. These settings will be retained by the 
system when you close FundWare.

MODULE NAVIGATOR

The module navigator lists the modules for which your organization is licensed (unless 
your individual security settings do not allow you to access a module). When you click a 
module (it just takes a single click), the module expands to display all of the associated 
module tasks. 
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Accessing any of the tasks within the module takes another single click on the specific 
item. Some tasks are “nested” below a title. A single click will expand the title, 
displaying the related tasks below. 

Figure 1.21—Module Navigator—Expanded Menus

If your security settings restrict your access to specific tasks, those tasks will not 
be listed in the menu bar. 
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OPEN WINDOWS NAVIGATOR

The open windows navigator lists the windows that are currently open in this instance of 
FundWare, highlighting the window currently displayed. A single click of an entry in 
the open windows navigator redisplays the window in your workspace. 

Figure 1.22—Open Windows Navigator

As with all Windows applications, the more FundWare windows that you open 
concurrently, the greater impact to your processor speed. You can use the Open 
Windows Navigator to monitor how many windows you have open at any one 
time.

HOW YOUR SECURITY RIGHTS IMPACT THE NAVIGATOR BAR

There is no security impact to the open windows navigator. If your security rights 
allowed you to open a task, then that window will display in the open windows 
navigator. However, your individual security rights may impact the modules and tasks 
that you see on the module navigator. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the module navigator.

• Any tasks within a module from which you are restricted will not be listed in the 
menu bar. 

CUSTOMIZING YOUR DISPLAY

Throughout FundWare, you will encounter forms (similar to a table or spreadsheet) that 
allow you to customize the display through the shortcut menu (accessed by right-
clicking your mouse) or through direct manipulation with your mouse. Most of these 
settings are retained with your user name. Therefore, the forms display according to 
your settings wherever you log in to FundWare. (In other words, the program 
remembers how the form displayed when you closed FundWare. This is how it will 
display the next time you open the program.)
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Not all forms provide these options. If you attempt one of the customization 
options described here and are unsuccessful, it is likely that the option is not 
offered on that form.

HIDING AND DISPLAYING COLUMNS

To add or remove a column from a form, hover your mouse over the pane and right-
click. A shortcut menu displays, which allows you to hide or display columns from the 
form. 

Figure 1.23—Example Shortcut Menu for the GL New Journal Entry Form

The columns currently displayed in the form are indicated with a check mark. Select a 
column from the shortcut menu to add or remove that column to the detail pane.

If you have disabled fields through the module setup (e.g., the Accounts 
Payable parameter or stage settings), the associated column will not be listed on 
the shortcut menu.

RE-ORDERING THE COLUMNS

To re-order the columns in a form, “drag and drop” the column by clicking the column 
heading and moving the column to the desired position (holding the mouse button 
down).

In this example, the Account column is disabled 
because this column must always display. 

The remaining columns are currently displayed in the 
New Journal Entry form.
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RESIZING THE COLUMNS

To resize a column, hover your mouse over the column border until the icon changes. 
Figure 1.24—Mouse Icon

Click your mouse button and drag the column border until it is the desired width.

SORTING THE ENTRIES IN A FORM

To resort the entries in a form, click the heading of the column on which you want the 
sort based. To reverse the sort order, click the column heading again. 

Figure 1.25—Sorting the Detail Pane

Sort order is not retained when you close FundWare.

HELP

If you encounter questions or problems while you are working in the program, you can 
access the online help from the Help menu (on the menu bar) or by clicking F1 to access 
the online help for the current module.

Original display.

Entries resorted 
based on Obligation 
number.

Entry order reversed.
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You can also access PDF files (portable document format) of the guides from your 
server:

• FundWare\Data\User Documentation
You must have Adobe Acrobat Reader installed to view the files. This program is 
available from the FundWare CD or as a free download from www.adobe.com.

TRAINING AND CONSULTING SERVICES

Blackbaud, Inc. offers a number of options to help you improve your use of FundWare.
• Regional classes—Training classes held several times per month in various 

cities across the nation. These one- to five-day classes provide a hands-on 
learning environment and low student-to-instructor ratio.

• eClasses—Interactive training classes offered over the Internet provide you and 
your staff the opportunity to receive training from FundWare experts without 
leaving your desk.

• Onsite custom training sessions and consulting—Our training/consulting group 
offers you onsite services, including:
— Training your staff using your data.
— Installing/upgrading and configuring the software to meet the specific needs 

of your organization.
For more information about any of our training or consulting services, please explore 
our Web site (http://www.blackbaud.com) or contact our Client Sales department (800-
551-4458).

USING THIS DOCUMENT

This manual is organized to reflect the most common uses of the module. It provides 
you with overview information of FundWare, followed by specific features and 
functions of the module.
Some FundWare Basics 



Chapter 1—Introduction

fully 

ff 

e 
tion 

e 

baud 
CONVENTIONS

Use Table 1.1 as a reference for conventions used in this document. 

GETTING SUPPORT

The following table provides a quick reference for getting the support you need for 
FundWare modules.

Table 1.1—Icon Conventions
Indicator Description

A caution or warning that must be heeded. Information contained in a warning should be care
reviewed to avoid adverse affect on software operation.
An example, used to clarify an issue.

ENTER Keyboard directions are indicated in small capital letters (e.g., Press ENTER).
demo user Specific text entries are indicated with italics (e.g., Type demo user for User Name).
Click OK An item on the screen that requires user interface is indicated in bold.

Table 1.2—Getting Support
Department Contact Description

Business 
Office

800-551-4458 Obtain general information or contact a sta
member.

Technical 
Support

800-227-7575
e-mail: FWSupport@blackbaud.com

Get help resolving technical issues with th
product. Please have the following informa
ready when you call:
• Blackbaud Site ID
• FundWare version number
• Error message details

Knowledgebase
www.blackbaud.com

A searchable database where you can typ
your questions and get a list of possible 
answers.
• Requires your license number and Black

Site ID.
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Training 800-551-4458
Ask for the Client Sales department.

www.blackbaud.com

Contact us for more information on our trai
options:
• Regionals—Classes from 1 to 5 days in 

length; held in cities around the country.
• eClasses—Two- to three-hour classes of

over the Internet.
• Onsite custom training and consulting—O

consulting staff can implement FundWar
and/or train your employees using your 
organization’s data.

Product 
Management

www.blackbaud.com Contact our Product Management departm
with any suggestions for improving FundW

All other 
information

www.blackbaud.com Links are available for all other FundWare 
information including replacement software
user guides and software updates.

Blackbaud, Inc.
6430 S. Fiddler’s Green Circle, Suite 200
Greenwood Village, CO 80111
800-551-4458
303-756-3030

Table 1.2—Getting Support (Continued)
Department Contact Description
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ADDING AND MAINTAINING EMPLOYEES

Your employee records contain basic data like address and phone number, as well as all 
applicable payroll and accounting information, and are accessed from the Employees 
folder. This folder stores all employees at the main level (i.e., the Employees folder 
level). However, “subfolders” divide the employees by status. Therefore, all your active 
employees can be found in the Employees folder and in the Active subfolder. 
The employees display in the data area to the right. Below the employee records, buttons 
show the actions you may perform here (Figure 2.1). If an action is not available at a 
certain point in the payroll process, or if your security rights do not allow you access to 
a task (e.g., you can add but not edit employee records), the button will be disabled. 

Figure 2.1—Payroll Buttons

ADDING EMPLOYEES
Use the following steps to add a new employee.

Add a new 
employee record

Edit existing 
employee information

Create a group of 
timesheets

Create a single 
timesheet
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1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees folder or the Active subfolder. The records stored in the 
folder display in the detail pane.

3. Click Add or right-click and select Add Employee from the pop-up list. The 
Employee Information window displays, open to the Name and Address tab 
(Figure 2.2). 

Figure 2.2—Employee Record—Name and Address Tab

4. Complete the fields on the Name and Address tab according to Table 2.1. 

Table 2.1—Field Definitions for the Name and Address Tab

Field and EDI Definition

Employee (Number) 
(.EMPLOYEE)

The system can be set to assign an employee number to each new 
employee automatically.
Adding Employees 
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5. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

COMPLETING THE PERSONAL INFORMATION TAB

Use the following instructions to complete the Personal Information tab of the 
employee record.

Name • No restrictions other than size.

• First (.NAME FST) • Type the employee’s first name. The first 18 characters print on the 
check. Maximum characters = 30. 

• Middle (.NAME MI) • Type the employee’s middle name. The first character prints on the 
check. Maximum characters = 10.

• Last (.NAME LST) • Maximum characters = 30. Up to 30 characters print on the check, 
depending on the length of the first name and middle initial. The total 
number of characters printed on the check for the first name, last name, 
and middle initial is 40.

Address No restrictions other than size.

• Street 1 (.ADDR1) • Type the street address. The first 40 characters print on the check. 
Maximum characters = 55.

• Street 2 (.ADDR2) • Type the rest of the street address in this optional field. The first 40 
characters print on the check. Maximum characters = 65.

• City (.CITY) • Type the city. The first 25 characters print on the check. Maximum 
characters = 30. 

• S/T/P (.STP) • Type the first 2-3 characters of the state, territory or province. Only these 
characters print on the check. Maximum characters = 10.

Postal Code (.POSTAL) Enter the zip or postal code, with a hyphen separating the expanded postal 
code (for example, 80030-52144). All 10 characters print on the check. 
Maximum characters = 20. 

Country (.COUNTRY) Type the country. Maximum characters = 30.

Table 2.1—Field Definitions for the Name and Address Tab (Continued)

Field and EDI Definition
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1.  Select the Personal Information tab (Figure 2.3). 

Figure 2.3—Employee Record—Personal Information

2. Complete the fields on the Personal Information tab according to Table 2.2. 

Table 2.2—Field Definitions for Personal Information Tab

Field and EDI Definition

Dates Must be valid numeric dates.

• Birth (.DOB) • Format = mm/dd/yyyy.

• Hire (.DOH) • Format = mm/dd/yyyy.

• Last Review (.DOR) • Format = mm/dd/yyyy.

• Probation (.DOP) • Enter either the first or last date of a probationary period. Format = mm/
dd/yyyy.

• Termination (.DOT) • Enter the date of termination. Format = mm/dd/yyyy. 

Phone Numbers Phone numbers must be numeric and contacts must be alphanumeric.
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3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

COMPLETING THE PAYROLL INFORMATION TAB

Use the following instructions to complete the Payroll Information tab of the employee 
record.

• Home (.PHONE HME) Enter the employee’s home phone number, including the area code. 
Format = (999) 999-9999.

• Emg contact 
(.CONTACT E)

Type the name of the person to contact in case of an emergency. Maximum 
characters = 30.

• Emergency 
(.PHONE EMG)

Enter the phone number of the emergency contact person. Format = (999) 
999-9999. It will format automatically for you.

• Alt contact 
(.CONTACT A)

Enter the name of a different person to contact in case of an emergency. 
Maximum characters = 30.

• Alternate phone 
(.PHONE ALT)

Enter the phone number of the alternate contact person. Format = (999) 
999-9999. It will format automatically for you.

Personal Information

• Gender (.SEX) • Click the drop-down arrow and choose Not Used, Female, or Male. 

• Soc Sec No (.T TID) • Enter a U.S. Social Security Number, Canadian tax ID number, or other 
tax identification number. Maximum characters = 30. Hyphens are 
optional.

Table 2.2—Field Definitions for Personal Information Tab (Continued)

Field and EDI Definition
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1.  Select the Payroll Information tab (Figure 2.4). 

Figure 2.4—Employee Record—Payroll Information

2. Complete the fields on the Payroll Information tab according to Table 2.3. 

Table 2.3—Field Definitions for the Payroll Information Tab

Field and EDI Definition

Payroll Status—Defines the employee with status codes.

• Employ Status 
(.STATUS)

Click the drop-down arrow and choose the Employment Status:
• Active
• Leave (for On Leave)
• Terminated
While you can add status values by adding edit values to the .STATUS 
employee data item, only employees with a status of Active are included in 
group timesheets and only employees with a status of Terminated are 
removed when you purge history. We recommend that you use the 
.STATUS P employee data item to customize status information. Entering 
Edit and Lookup Values on page 1.123.
Adding Employees 
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3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

• Payment Status 
(.STATUS P)

Click the drop-down arrow and choose: 
• Not used
• Full-time hourly
• Full-time salary
• Part-time hourly
• Full-time salary
• Seasonal
These are system defaults; you can change these or add to the list in setup; 
however, any customized settings are overwritten when you update from 
the ToolBox.

• Pay Frequency 
(.T FREQ) 

This is the number of pay periods in a calendar year. Click the drop-down 
arrow and choose:
• Bi-weekly (26 times per year)
• Monthly (12 times per year)
• Semi-monthly (24 times per year)
• Weekly (52 times per year)
These are system defaults; you can change these or add to the list in setup.

Payroll Information—Defines the dollar amounts and accounting information for employee earnings.

• Home (.HM DEPT) Click the drop-down arrow and choose the employee’s home department. 
This field is used for sorting purposes only.

• Salary (.S AMT) An employee must have at least one Salary, Hourly, or Other rate, and may 
have more than one. In this field, enter the flat dollar amount of salary per 
pay period, if applicable.
• If the Payroll parameter defines Salary as classified (field 1), select the 

salary option from a drop-down list.

• Hourly rate (.H AMT) Enter the per-hour rate of pay, if applicable.
• If the Payroll parameter defines Hourly as classified (field 1), select the 

salary option from a drop-down list.

• Other rate (.O AMT) Click the drop-down arrow and choose the employee’s per-unit rate of pay, 
if applicable.
• If the Payroll parameter defines Other as classified (field 1), select the 

salary option from a drop-down list.

Table 2.3—Field Definitions for the Payroll Information Tab (Continued)

Field and EDI Definition
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COMPLETING THE ACCOUNTING INFORMATION TAB

Use the following instructions to complete the Accounting Information tab of the 
employee record. (You will use this tab only if your payroll process is 
departmentalized.)

1.  Select the Accounting Information tab (Figure 2.5). 

Figure 2.5—Employee Record—Accounting Information
Adding Employees 
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2. Complete the fields on the Accounting Information tab according to Table 2.4. 

3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

Table 2.4—Field Definitions for the Accounting Information Tab

Field and EDI Definition

Department Earnings

Hourly rate, Salary, or 
Other rate

Select the radio button under Department Earnings to choose Hourly, 
Salary, or Other for the type of earnings. 
Click Add to begin entering information.

• Hourly or Salary: % 
Expensed (.H PCNT, 
.S PCNT)

• Enter the percentage rate of wages going to the department and General 
Ledger account (GLA). Note that 50% is entered as 50.00. The entries 
should total 100%. 

• Hourly or Salary: 
Salary or Hourly dept 
(.H DEPT, .S DEPT)

• Click the drop-down arrow and choose the Department against which 
these wages will be expensed.

• Hourly or Salary: GLA 
(.H GLA, .S GLA)

• Click the drop-down arrow and choose a General Ledger Account edit 
value. Typical entries include:
— Not used
— Salaried
— Seasonal

• Hourly or Salary: Addtl. 
basis for (.H GRP, 
.S GRP)

• Click the  button to choose additional taxes and/or deductions which 
the earnings amount is subject to that are not already defined for the 
earnings historical data item. These data items are used in addition to 
what is defined for the earning historical data item. You must use a 
defined historical data item. To select a data item, see Additional Basis 
Earnings on page 2.40.

• Other Rate: Hourly 
dept. (.O DEPT)

• Click the drop-down arrow and choose the Department against which 
these wages will be expensed. 

• Other Rate: GLA 
(.O GLA)

• Click the drop-down arrow and choose a General Ledger Account edit 
value.

• Other Rate: Addtl. 
basis for (.O GRP)

• Click the  button to choose additional taxes and/or deductions which 
the earning amount is subject to that are not already defined for the 
earning historical data item. These data items are used in addition to 
what is defined for the earning historical data item. You must use a 
defined historical data item. To select a data item, see Additional Basis 
Earnings on page 2.40. 
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ACCOUNTING INFORMATION TAB—ADDITIONAL TIPS

• Departmentalized Earnings are defined in the payroll parameters as being 
expensed to multiple departments. For each earning which you defined as 
departmentalized, you created a departmental table. 

• We strongly recommend that you define hourly, salary, and other settings when 
you enter an employee record, even if the employee currently only needs one 
setting. If at some point in the future you need this information for the 
employee, the information will be defined already.

• To delete a line, point to the gray area in the line next to the % Expensed 
column, and click Delete.

ADDITIONAL BASIS EARNINGS

Click on a data item from the Available list, then click the right arrow to move the data 
item to the Selected list (Figure 2.6). The double right arrow moves all Available data 
items to the Selected list. The left arrow buttons reverse the process.

Figure 2.6—Additional Basis for Earnings

Remember: These data items are in addition to the basis defined on the earnings 
historical data item.

COMPLETING THE DIRECT DEPOSIT TAB

Before configuring employees for direct deposit, you should review the setup 
information in Chapter 6—Defining Direct Deposit on page 1.185. If you system is 
already configured for direct deposit, use the following instructions to complete the 
Direct Deposit tab the employee record.

This tab will not display if the Payroll parameter is not defined for electronic 
fund transfer (field 2).
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1.  Select the Direct Deposit tab (Figure 2.7). 

Figure 2.7—Employee Record—Direct Deposit

2. Complete the fields on the Direct Deposit tab according to Table 2.5. 

Table 2.5—Field Definitions for the Direct Deposit Tab

Field and EDI Definition

Inactive, Active, or Pre-
notification (.EFT ACT)

Select the radio button under Direct Deposit to choose the status for this 
employee:
• Inactive—This employee is not active in the direct deposit program.
• Active—This employee is active in the direct deposit program.
• Pre-notification—This employee is in pre-notification for the current pay 

cycle, and will receive a regular check. The Payroll Administrator must 
change this field to Active after the pre-notification is submitted. 

Selection (.EFT SEL) If you are using more than one bank for Direct Deposits, click the drop-
down arrow to choose the appropriate box. This option allows you to 
complete the direct deposit process separately by financial institution.
• If you have only defined one bank, this field will say Not Used.
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Line Entry Line numbers control the order in which information is processed. Enter a 
2-digit line number. 
• We recommend that you number lines 10, 20, 30, etc., and number the 

last line 99. 
• If the employee is directing their check to be deposited to one account, 

they will only have line 99. 

Cycle (.EFT CYCLE) Click the drop-down arrow and choose the appropriate Direct Deposit 
Cycle. Cycles are activated in the Preliminary Check Register or when 
producing checks, and determine when the direct deposit occurs. 

Type (.EFT APR) Click the drop-down arrow and choose the amount type:
• Amount—A flat amount.
• Percentage—A percentage of net pay. 
• Remainder—The remaining amount after all previous lines have been 

processed. All active or pre-note direct deposits must have the last line of 
their direct deposit information be a remainder line. 

Transfer Type (.EFT DP) Click the drop-down arrow and choose the type of direct deposit:
• Checking Deposit—A credit to a checking account. 
• Deposit—A credit to an account. 
• Checking Pre-notification—A pre-notification for zero dollars for a 

checking account. (Use only when an active direct deposit employee 
directs a change to his/her direct deposit.)

• Payment—A debit to a loan or mortgage account.
• Payment Pre-notification—A pre-notification for zero dollars for a 

payment.
• Savings Deposit—A credit to a savings account.
• Savings Pre-notification—A pre-notification for zero dollars for a savings 

account. Use only when an active direct deposit employee issues a 
change.

Amount/Percent 
(.EFT NBR)

If you chose Amount in the Transfer Type field, type in the amount here. If 
you chose Percentage, enter the percentage here. If you chose Remainder, 
enter zero here.

Bank DFI Number 
(.EFT DFI)

The bank’s Depository Financial Institution number. Enter the number, 
which must be at least 8 digits, including any leading zeros. Do not enter 
the 9th digit in a bank number; it is a check digit.

Bank Account Number 
(.EFT ACCT)

The employee’s bank account number. Maximum characters = 30.

Table 2.5—Field Definitions for the Direct Deposit Tab (Continued)

Field and EDI Definition
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3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

DIRECT DEPOSIT TAB—ADDITIONAL TIPS

• The lines are processed “top down”, so the lines with the highest priority should 
be entered first. In some cases, the later lines cannot be processed because of a 
lack of dollars.

• A line can be either a deposit or a payment. A deposit normally increases the 
balance of a checking or savings account and is considered a “credit” to the 
bank. A payment normally decreases the balance of a liability account like a 
mortgage or loan, and is considered a “debit” to the bank.

• Direct Deposit Cycles control when a payment or deposit is made. Cycles can 
be a number between one and nine. If all employees make the same deposits/
payments every pay period, cycles are not needed. But if any payments are 
made every other pay period or only on designated dates, cycles must be used.

• In addition to completing this tab, we strongly recommend that you create pre-
notification file and send it to the bank. A pre-notification is a record sent to the 
employee’s bank to verify routing transit numbers and account numbers. Check 
with your financial institution for specific information regarding the number of 
banking days you must do the pre-note before the first Direct Deposit can be 
done.
Only pre-notes are produced in this file, and it can be produced at any time. It 
can also be used for active Direct Deposit employees who are being pre-noted 
for a new account.

COMPLETING THE PAY CALCULATION TAB

Use the following instructions to complete the Pay Calculation tab of the employee 
record. This tab stores any user-defined EDIs that you add to the employee record 
(automatically or manually).
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1.  Select the Pay Calculation tab (Figure 2.8). 

Figure 2.8—Employee Record—Pay Calculation

Any employee data items automatically added to employee records 
(field 3 of the EDI definition) will display on the Pay Calculation tab. 

2. Complete the fields on the Pay Calculation tab according to Table 2.6. 

Table 2.6—Field Definitions for the Pay Calculation Tab

Field Definition

Data Item Click Add to add an additional data item. Whatever data items have been 
set up for the organization will appear here automatically. To delete a data 
item, select the line and click Delete.
• You add the Normal Hours Worked data item to this tab (.H HRS) and 

enter the normal hours that the employee works in a pay period. When 
you create group timesheets for hourly employees, you can tell Payroll to 
look to the Normal Hours Worked defined on each employee’s record. 
See Creating Timesheets for a Group of Employees on page 2.66 for 
more information on this feature.

Value Depending on the type of data item you chose, either type in the value or 
choose the appropriate value from a drop-down menu.
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For more information on the earnings data items (e.g., costcode, 
distribution table, departmentalized earnings), see Implementing 
Costcodes on page 1.46, Creating Distribution Tables on page 1.67, 
and Creating Departmentalized Earnings on page 1.72.

3. When you have finished all tabs, click OK to save the information and return to 
the main menu.

PAY CALCULATION TAB—ADDITIONAL TIPS

• An employee data item is a field that allows you to add information to employee 
records. Common data items include .MARITAL, .FICA TAX, .FWT EXEMP, 
etc. For more information on creating data items, see Chapter 3—Using Data 
Items on page 1.77. 

• Values (i.e., edit values) are defined for some data items. If a data item has no 
value restrictions, such as employee names and addresses, it does not need edit 
values. A data item such as .MARITAL needs to be restricted to Married or 
Single. A .FICA TAX data item can only be Yes or No. Using edit values makes 
employee records easy to maintain because any necessary changes to the values 
are made in only one place, rather than on every record.

EDITING EMPLOYEES
Use the following steps to edit an existing employee.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees folder or the applicable subfolder (e.g., Active). The 
records stored in the folder display in the detail pane.

3. Select the desired employee.

4. Click Edit or double-click the employee.

5. Click the appropriate tab and enter your changes

6. Click OK to save those changes and return to the Payroll/Personnel main 
window. 

For detailed instructions on completing each field, see Adding Employees on page 2.31.
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CHANGING EMPLOYEE STATUS
An employee cannot be “deleted” from Payroll/Personnel. However, you can change an 
an employee’s status (e.g., from active to on leave, from active to terminated, from on 
leave to active). (If you wish to permanently purge employees, see Purging Data on 
page 1.239.)

Timesheets are created only for employees who have active status!

Use the following steps to change an employee’s status.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees folder or the applicable subfolder (e.g., Active). The 
records stored in the folder display in the detail pane.

3. Select the employee.

4. Click Edit or double-click the employee.

5. Select the Payroll Information tab.
Changing Employee Status 
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6. Select the new status from the Click the Employ Status drop-down menu 
(Figure 2.9). 

Figure 2.9—Employee Status Drop-Down Menu

7. Click OK. The employee’s status changes and the employee record moves to 
the applicable subfolder.

ENTERING EMPLOYEE HISTORY
You may wish to enter historical information for employees to create a “history” check. 
You can:

• Enter year-to-date check information for employees if you are starting to use 
Payroll/Personnel in the middle of the calendar year. 
— You must enter the historic information before beginning your regular 

payroll operation. Several calculations (e.g., FICA) require year-to-date 
basis information to calculate accurately. Remember to enter history for 
“Other” type historical data items (e.g., employer’s share of FICA, federal, 
and state unemployment taxes; employer-paid benefits).
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• Enter adjustments, such as corrections to basis hours or amounts. These entries 
do not impact General Ledger.

You will enter the historical information using a history date, which is used to determine 
the reporting period in which the information is included. For example, entries using 6/
30/04 are included in quarter-to-date history for the second quarter and half-year history 
for the first half of the year. You can print this historical information with the Check 
History Report (see Appendix B—Sample Reports on page 2.225) or a customized user-
defined report.
When entering Employee History, you will be prompted for a batch total (the net total of 
the checks) for the group of transactions to be entered. Once you have entered the entire 
batch of transactions, the Balance to go amount should be zero. If not, a net amount may 
be incorrect or missing, or the batch total may be incorrect.
Use the following steps to enter employee history.

1.  Click Transaction Entry > Enter Employee History on the module navigator 
(if the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Transaction Entry > Enter Employee History from the menu 
bar. The task window displays asking you to enter the batch total (i.e., the net 
total of the checks) for the group of transactions to be entered (Figure 2.10). 

Figure 2.10—Enter the Batch Total

2. Enter the net total of checks that you wish to process. You may leave this field 
blank by pressing ENTER. Let the system calculate the total, and enter it before 
posting the batch.
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3. Press ENTER. As you complete each of the required fields on page 1, the next 
field is revealed (Figure 2.11).

Figure 2.11—Enter Employee History, Page 1 of 2

Complete the fields on the first page of the task according to Table 2.7. 

Table 2.7—Enter Employee History—Page 1 of 2

Field Valid Entry Definition

Employee #—number The number of the employee for whom history is being 
entered. Press F1 to look up an employee number. You 
can scroll employees in number order or alphabetically by 
last name.

History 
date

99/99/9999 This date is used to determine the periods to include this 
history in for monthly, quarterly, and half-year reports.
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4. Enter each data item for this history (Figure 2.12). Basis amounts must be 
entered for tax reporting data items. 

Figure 2.12—Enter Employee History, Page 2 of 2

Net 
amount

$—amount or <blank> The net check amount. If the history did not affect an 
employee check, press ENTER to leave the net amount 
zero. For example, accrued vacation hours and employer 
cost items, such as the employer share of FICA, do not 
affect employee checks.
The net check amount must equal the total of all earnings 
entered less taxes and deductions before an entry can be 
added.

Entry 1–99999 A number for the data item within the history check. Each 
history item must have a unique number. Up to 99,999 
pieces of employee history can be entered under one 
history check. Press ENTER to allow the system to 
automatically number entries.

Table 2.7—Enter Employee History—Page 1 of 2 (Continued)

Field Valid Entry Definition
Entering Employee History 
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5. Complete the required fields according to Table 2.8.

All Data Items relating to this history check are entered in Entry field (Figure 
2.13).

Figure 2.13—Example Data Items

6. When complete (i.e., the balance to go = 0.00), press ESC to display the option 
menu and type E to end the session.

Table 2.8—Enter Employee History—Page 2 of 2

Field Valid Entry Definition

Data Item Historical Data Item name The name of the Data Item for which history is to be added.

Hours/units R—rate The number of hours or units. This is an optional field. 
Press ENTER to leave it blank.

Amount $—amount The amount for this Data Item. Press ENTER to leave it 
blank.

Basis hrs/
units

R—rate The number of hours or units on which this Data Item is 
based. For example, vacation time may be based on the 
number of hours worked. Press ENTER to leave it blank.

Basis 
amount

$—amount The amount on which this Data Item is based. For 
example, the basis for FICA is dollar amount of total 
earnings. Basis amounts are used in production of year-
end tax forms and must be entered correctly. Press ENTER 
to leave it blank.
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7. The checks are stored in the PYEHIST report. Print this report to produce your 
checks.

8. File a printed copy of the report for your audit trail.

USING THE EMPLOYEE SELECTOR
Many tasks in the Payroll/Personnel module use a filter that allows you to define the 
employees, records, or transactions to include on a report or in a task, as well as preview 
your results. This feature is called the “Employee Selector”. If you don’t enter criteria in 
the Employee Selector, all tasks and reports will be processed in ID order for all 
employees. 
The Employee Selector appears when you perform the following tasks:

• Employees folder and subfolders:
— Create Group Timesheets

• Timesheets folder:
— Create Group Timesheets
— Post Timesheets

• Net Pay Calculations folder: 
— Calculate Net Pay
— Check Writing

Use the following instructions to complete the Employee Selector.
1.  Scroll through the list of employee data items and select the applicable data 

item, or type the data item name (Figure 2.14). For example:

• .NAME LST—Generates an alphabetical list of employees by last name.
• .HM DEPT—Generates a list of employees who work in specific 

departments.
• .DOH—Generates a list of employees by date of hire. 
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• .STATUS P—Generates a list of full-time or part-time employees. 

Figure 2.14—Employee Selector—Selecting an Employee Data Item

As you select a data item, the First Value and Last Value fields will reflect the 
format of information required, as appropriate (e.g., date format).

2. Enter the First and Last Values to limit the information returned. For example, 
select only employees hired in a six-months period (e.g., from January 1, 2004 
through July 1, 2004):

• Choose .DOH in the Data Item. 
• Enter the beginning date for the period (e.g., January 1, 2004) as the First 

Value.
• Enter the ending date for the period (e.g., July 1, 2004) as the Last Value. 
• Last Value—The employee data item used to expand the information 

returned. Enter F SALARY as the Second Value.
To get all values, skip the First Value and Last Value fields and click 
Add.

If the Entry Range (Recurring Data Items Only) area is enabled, you 
have selected a data item with multiple entries (i.e., multi-occurring 
data items). Please refer to Selection Mode on page 2.56 for instructions 
on this area.

3. Select the applicable Include or Exclude radio button to refine your criteria.
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By default, the records within the range of the First Value and Last 
Value will be included (i.e., the employees who fall within this range 
will be included in the task). However, you can also use this range as an 
exclusionary filter (i.e., the employees who fall within this range will be 
excluded from the task). 

4. Click Add to add the selection the Employee Selector criteria. The details of the 
criterion are shown in the Display Area (Figure 2.15). 

Figure 2.15—Employee Selector—Adding the Data Item Values
Using the Employee Selector 
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5. Click Preview to view the employees included in your selection. The 
employees display in the Search Results area (Figure 2.16). 

Figure 2.16—Employee Selector—Search Results

If you have very large groups of employees (for example, 4,000), the 
execution may take a few seconds.

6. Click OK to apply your selection criteria.
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SELECTION MODE

When salaries are departmentalized, data items such as .S AMT, .S DEPT, .S GLA, .S 
GRP and .S PCNT are defined as multiple entry fields (i.e., Payroll allows you to enter 
multiple definitions for your salary, hourly, or other settings). Each line of salary 
information for an employee is stored separately. When you select a multiple entry data 
item, the system displays an additional field called Selection Mode (Figure 2.17). 

Figure 2.17—Employee Selector—Selection Mode

Selection Mode allows you to require that: 
• All of the values in the specified range are present for it to be included or 

excluded; or 
• If any of the values in the range is present, the employee is included. 

For example:
• You want a list of employees who receive their salary from either the Sales or 

the Marketing Department, so you select the Any May Be True radio button.
• You want a list of employees who receive part of their salary from every 

Department, so you select the All Must Be True radio button.
Use the following instructions if you are entering the criteria for your Employee 
Selector and the Selection Mode is displayed.

1.  Enter the first and last value in the From and To fields.

2. Select the applicable radio button (All Must Be True or Any May Be True).
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3. Click Add and continue enter your Employee Selector criteria.

ADDING INFORMATION TO THE SEARCH RESULTS

The Employee Selector allows you to modify the information displayed in the Search 
Results area.

1.  Click Data Items. The Select Data Items window displays. 

2. Select the data item to add to the Search Results area (Figure 2.18). 

Figure 2.18—Selecting Data Items

3. Click OK. The information is added to the display (Figure 2.19). 

Figure 2.19—Data Items Added to the Search Results
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ADDING AND MAINTAINING TIMESHEETS

All the setup tasks for Payroll/Personnel lead you to this point—creating timesheets for 
your employees. The timesheet process involves three easy steps:

1.  Enter timesheet information for one or more active employees. 

2. Verify the accuracy of the information on the timesheet (i.e., the correct basis 
amounts and valid GL account numbers). 

3. Post the timesheets to the next stage of the process: calculating net pay.

As you define each portion of a timesheet (e.g., earning items, distribution tables), 
Payroll “builds” the account number. (See Departmentalization, Costcodes, and 
Distribution Tables on page 1.2 for more information on this process.) Any problems as 
the account number is built are reflected on the timesheet and in the timesheet detail 
pane.
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For example, Figure 3.1 shows an account error message. 

Figure 3.1—Example Timesheet With Account Error

Once you have entered your timesheets and resolved any account issues, you have to 
verify that the basis amounts and account numbers are valid (e.g., does the account 
number exist). 

Basis is the dollar amount that an earning, tax, deduction, or employer cost is 
based on. For example, if an employer’s share of FICA is $76.50, it has a “basis 
amount” of $1,000 in earnings.

Once you have verified that the timesheets have no errors (or you have corrected and 
reverified the timesheets), you are ready to calculate the net pay. This step is discussed 
further in Chapter 4—Calculating Net Pay on page 2.83. 
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WHAT MAKES A TIMESHEET?
A timesheet is a single record that stores all of the current earnings items (or “line 
items”) for an employee. Each earnings item that you use may require different 
information, based on the item definition:

• The earnings item may require a flat dollar amount (e.g., a $1,500 bonus for an 
employee).

• The earnings item may calculate a dollar amount based on hours or work 
performed (e.g., 40 hours in a week for an hourly employee). 

• The earnings item may be defined by hours, not dollars (e.g., an employee takes 
16 hours of sick time).

Once you save a timesheet entry, this information is stored as a timesheet and combined 
with any other current timesheet entries for the employee.
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ANATOMY OF A TIMESHEET

Each single timesheet is comprised of three areas where you add timesheet entries, 
select basis details for each entry, and resolve account issues (Figure 3.2). 

Figure 3.2—Example Single Timesheet
What Makes a Timesheet? 
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TIMESHEET ENTRY AREA

The timesheet entry area is a grid in which you add your earnings items (Figure 3.3). 
(Remember, your earnings items are the historical data items defined as History type—
E [Earnings] in field 1 of the historical data item record. See Defining Historical Data 
Items on page 1.85 for more information on this definition.) 

Figure 3.3—Example Timesheet Entry Area

The availability of the cells in this grid will reflect your selections. For example, in 
Figure 3.3 the Salary earnings item for this employee only requires amount and rate 
item information. Therefore, the other cells in this line are disabled.

BASIS DETAIL AREA

The Basis detail for selected line area provides information concerning the basis detail 
selections for the earnings item and the employee. Additionally, any messages 
concerning these selections display in the Invalid Basis box (Figure 3.4). 

Figure 3.4—Example Basis for Selected Line Area
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If field 4 of the earnings item definition indicates that change is not allowed, the 
area title (Basis detail for selected line) is disabled and you cannot to modify 
any of the basis selections. 

The items selected in the Basis detail are defined in one of the following locations:
• The Basis for field (field 4) of the historical data item (Figure 3.5) 

Figure 3.5—Example Earnings Item Basis Information

• The employee Accounting Information tab (Figure 3.6). 

Figure 3.6—Example Accounting Information Tab
What Makes a Timesheet? 
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ACCOUNT DETAIL AREA

The Account detail for selected line area displays the account number and description 
built by the selected timesheet entry (i.e., line item). Additionally, any messages 
concerning the account number built by the payroll process display in the Messages box 
(Figure 3.7). 

Figure 3.7—Example Basis for Selected Line Area

If field 4 of the earnings item definition indicates that change is not allowed, the 
area title (Account detail for selected line) is disabled and you cannot to modify 
any of the basis selections. 

WHAT ARE GROUP TIMESHEETS
If you have a group of employees with a fixed earnings amount, you can save time by 
creating their timesheets as a group. This option is especially useful when you are 
creating groups of timesheets for regular earnings, such as:

• Salaried earnings when wages are the same each pay period.
• Hourly earnings for employees who work a fixed number of hours each pay 

period.
• Holiday pay that is recorded for all employees.

You may wish to create a group of timesheets for 80 hours for all hourly 
employees, then edit the timesheets for those few employees who worked less 
than 80 hours.
Blackbaud, Inc. 2.65



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.66
You can create group timesheets if you are using any of the following accounting 
methods (as defined in the Payroll parameter; see Defining the Payroll Parameter on 
page 1.34):

• Distribution tables, 
• Departmentalized earnings, or 
• Costcodes. 

GROUP TIMESHEETS AND THE EARNINGS ITEM

When you create group timesheets, you will select the fixed earnings item (e.g., salary) 
from a drop-down list. This drop-down list displays all “earnings items” defined for 
your system. (If the entry type [field 4] for the earnings item is defined for no timesheet 
entry or for proration, the earnings item will not display.)

Remember, your earnings items are the historical data items defined as History 
type—E (Earnings) in field 1 of the historical data item record. See Defining 
Historical Data Items on page 1.85 for more information on this definition.

CREATING TIMESHEETS FOR A GROUP OF EMPLOYEES
Use the following steps to create timesheets for a group of employees.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees or Timesheets folder (or an applicable subfolder). The 
records stored in the folder display in the detail pane. 

You can only create timesheets for active employees. Therefore, in all 
the Employees subfolders except Active, Group is disabled.
Creating Timesheets for a Group of Employees 
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3. Click Group. The Create Group Timesheets window displays (Figure 3.8). 

Figure 3.8—Create Group Timesheets

4. Select the applicable earning item from the drop-down list. If the earnings item 
requires an entry of hours or units, the check box for Use hours from employee 
record and text box for Hour/Units are enabled.

• Use hours from employee record—The system applies any non-zero 
amount defined for the Normal Hours Worked employee data item. (You 
must manually add this information to the Pay Calculation tab of the 
employee record.) 
— Payroll will not create a timesheet for any employee who does not have 

a definition for Normal Hours Worked, or the entry is zero.
• Hours/Units—The system applies the number of hours or units entered to 

all applicable employees.
5. If enabled, select the Use hours from employee record check box or enter the 

number of hours or units of work in the Hour/Units text box.

6. Ignore the Check Sequence field, if enabled. This field is not applicable in the 
current version of the software.

The Check Sequence field is enabled if you defined the Payroll 
parameter to allow multiple checks with the check sequence determined 
at the entry of the timesheet (i.e., Multiple Checks in field 2 of the 
parameter is defined as T—Check sequence determined at entry).
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7. Click Employee Selector to identify the employees included in this group (or to 
further define employees if you selected the Salary or Hourly earnings item). 
The Employee Selector displays (Figure 3.9). 

Figure 3.9—Employee Selector

8. Enter your selection parameters. (For more instructions on the Employee 
Selector, see Using the Employee Selector on page 2.52.)

9. When you have completed your selections, click OK. The Employee Selector 
closes and you return to the Create Group Timesheets window.

10. Click OK. The program saves the timesheets to the Timesheets folder. 
Depending on the number of timesheets that you are creating, this process may 
take a few seconds. 

Clicking Cancel returns you to the main screen without generating 
timesheets.
Creating Timesheets for a Group of Employees 
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TROUBLESHOOTING

If you should accidentally generate timesheets twice for the same group of employees, 
they will receive one check with double pay. To fix this problem, edit the timesheets to 
correct the error, removing the additional earnings.

CREATING A SINGLE TIMESHEET
You may wish to create a timesheet for one employee at a time. Often single timesheets 
are used to add hours for an employee who used sick or vacation hours, to correct a 
timesheet that was created automatically, or when employee wage expenses change each 
week. Use the following steps to add a single timesheet.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees or Timesheets folder. The records stored in the folder 
display in the detail pane.
Blackbaud, Inc. 2.69



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.70
3. Click Single. The Create Single Timesheet window displays (Figure 3.10). 

Figure 3.10—Create Single Timesheet

4. At Employee ID, enter the employee’s ID number in the first field and move to 
the next field.

If you accessed this form from the Employees folder, you can select the 
employee for which you are adding a single timesheet. When you click 
Single, the Employee ID is prepopulated with the selected employee.

Pressing ENTER from the Employee ID field will dismiss this form. Use 
TAB or your mouse to move to the next field.
Creating a Single Timesheet 
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5. Select the earnings item from the drop-down list. When you move off the 
earnings item cell, the applicable cells on the row will remain enabled while 
cells that are not need for the earnings item will be disabled (Figure 3.11). 

Figure 3.11—Example Timesheet With Disabled and Enabled Cells

Instead of selecting form the drop-down list, you can begin to type the 
earnings item name. The system will search for a match that you can 
select by pressing ENTER. This tip applies to all cells with a drop-down 
list.

To access any drop-down list from your keyboard, press ALT + the 
down-arrow key. You can use the up- and down-arrow keys and ENTER 
to select any option on the drop-down list. This tip applies to all cells 
with a drop-down list.

6. Enter the required information according to Table 3.1. (Again, some of these 
fields will be disabled, based on the needs of the earnings item.) 

Table 3.1—Timesheet Entry Fields

Field Description

Amt/Hrs/Units Enter the amount, hours, or units to apply to the earnings item. (Your entry can but 
does not have to include plus/minus signs, parentheses, or decimal points.) For 
example: 40 hours
• This field may default to a value from the employee record. 

Rate From Select the applicable employee data item from the drop-down list. 
• This field may default to a value from the Rate from field on the earnings item. 
• Changes to this field may change the default Amt/Hrs/Units.

Rate Value Select the applicable edit value for the selected Rate From.
• This field may default to a value from the employee record. 
• Changes to this field may change the default Amt/Hrs/Units.
• Rate Value is usually used for classified earnings.
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Costcode Select the applicable costcode from the drop-down list.
• This field may default to a value from the Pay Calculation tab of the employee 

record. 
• This column will not display if you did not set the Costcode option in the Payroll 

Parameter to “Yes” (field 1). 

Dist Table Select the applicable distribution table from the drop-down list.
• This field may default to a value from the employee record. 
• This column will not display if you did not set the Dist Table option in the Payroll 

Parameter to “Yes” (field 1). 

Shift Item Select a shift item from the drop-down list.
• This column will not display if you did not set the Shift emps option in the Payroll 

Parameter to “Yes” (field 1).
• This field will be disabled if the earnings item has been defined for the following 

Entry type (field 4 of earnings item definition): Amount, Dated, Hours, or None.

Shift Value Select a shift item from the drop-down list.
• This column will not display if you did not set the Shift emps option in the Payroll 

Parameter to “Yes” (field 1).
• This field will be disabled if you have not selected a Shift Item.

Rate Override Enter a rate value or select from the drop-down list.

Date Enter a valid date. 
• This field will be enabled if the entry type for the earnings item (field 4) is one of the 

dated entry options. However, the system will not enter a default date.

Error Type This field is reserved to indicate if the system has encountered an account or basis 
error. The field will indicate the type of error. The actual error is elaborated in the 
Basis Detail and/or Account Detail areas in the lower part of the timesheet.

Table 3.1—Timesheet Entry Fields (Continued)

Field Description
Creating a Single Timesheet 
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7. Review the Basis detail (Figure 3.4). You may not be able to modify these 
selections. (If the title text for this area is disabled, you cannot modify any of the 
basis selections.) 

Figure 3.12—Example Basis for Selected Line Area

8. Address any error message that display in the Invalid Basis box.

9. Review the account built by your entries (Figure 3.7). 

Figure 3.13—Example Basis for Selected Line Area

10. If necessary (and allowed by the earnings item definition), you can click  and 
select an existing, active account number. 
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11. Click OK to create this timesheet, or click Cancel to close the timesheet 
without saving your selections.

EDITING A TIMESHEET
Once a timesheet has been created, the system does not differentiate between a 
timesheet created through the group or single timesheet process. Until you post a 
timesheet, you can change or delete any of the timesheet entries (as always, depending 
on your security settings). 

Because of the complexity of the program, you cannot edit certain information 
on a timesheet (e.g., earnings item, employee ID). You must delete the line item 
or the timesheet and enter the correct information.

Use the following instructions to edit a timesheet.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

3. Double-click the employee whose timesheet you want to enter, or select the 
employee and click Edit.

4. Edit the information, as necessary. The status cell will reflect your changes and 
the entry is updated when you click OK (saving your changes) (Figure 3.14). 

Figure 3.14—Modified Timesheet Entry

Because of the complexity of the calculations necessary for each 
earnings item, you cannot change an earnings item selection (e.g., 
change from Hourly to Salary). You must delete the earnings item and 
add a new item.
Editing a Timesheet 
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5. To delete an entry (i.e., line item), click the Status cell for the line and click 
Delete (Figure 3.15). The status changes to Deleted and the entry is removed 
from the timesheet when you click OK (saving your changes). 

Figure 3.15—Deleted Timesheet Entry

6. When complete, click OK to save your changes and close the timesheet 
window.

DELETING A TIMESHEET
Use the following steps to delete a timesheet.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

3. Select the employee and click Delete. A confirmation message displays.

Although you are selecting the employee in this folder, this task only 
removes all current timesheet entries for this employee. It does not 
remove the actual employee record from your database.

4. Click Yes to delete the timesheet or click Cancel to exit this task without 
deleting the timesheet.

VERIFYING TIMESHEETS
When you add a timesheet (i.e., click OK from the timesheet window), the system 
completes a preliminary check for the basis amount and account number. However, each 
timesheet must also pass a more detailed verification process before you can post it to 
the next step. Verifying confirms that:

• The account numbers built by the timesheet process are active for posting.
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• All basis items are valid historical data items.
Unless you select specific employees to verify, this task is performed on all timesheets 
in the Timesheets folder. Once the process is complete, any errors are indicated in the 
Acct Error or Basis Error columns. You must resolve any outstanding errors before you 
can post the timesheet.

The Post task is also performed on all timesheets in the Timesheets folder. 
However, any timesheets with errors will be ignored. In other words, an error on 
one timesheet will not stop you from posting verified timesheets.

Use the following steps to verify timesheets.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

3. Click Verify. The Verify All Timesheets window displays (Figure 3.16).

Figure 3.16—Verify All Timesheets

4. Select what level of Error Reporting you want to include on the Timesheet 
Verification Report (PYTCARD):

• Report Only Fatal Errors—Report only those employees with one or more 
errors that prevent the timesheet from being verified and posted.
Verifying Timesheets 
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• Report All Timesheets—Report all timesheets, including those with no 
errors. This is the recommended choice; just because valid account and 
basis information exists does not guarantee its accuracy or check for 
missing basis.

• Report Only Fatal and/or Warning Errors—Report only those employees 
with one or more errors that prevent the timesheets from being verified and 
posted, and report warnings, which alert you to possible problems but do 
not prevent a timesheet from being verified and posted. This information 
prints in the Messages column of the Timesheet Verification Report.

See Verification Warnings and Errors on page 2.78 for more information on 
this report.

5. Select the Check for Missing Timesheets check box if you wish to verify that all 
active employees have timesheets. By default, the program will not check for 
missing timesheets.

6. Select the Print Accounting Information check box if you want accounting 
information printed on the report. Not selecting this box will print only account 
errors. This is recommended.

7. Select the Print Basis Information check box (recommended) if you want the 
basis information printed on the report. Not selecting this box will print only the 
errors.

8. Select the Page Break On Change check box if you have chosen to use Sort 
Items and you want a new report page each time the first sort item changes.

9. Click Sort Items if you want to select employee data items to order the 
information in the Timesheet Verification Report. 
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10. Select the employee data item on the left, and click Select to move it to the list 
on the right (Figure 3.17). 

Figure 3.17—Sort Items—Verify Time Cards

Click the Sort Order up or down arrow to move it up or down on the 
list. The list reflects the order in which the data items will appear in the 
report.

11. Click OK to save your settings and close the Sort Items window.

12. Click OK to verify all timesheets in the Timesheets folder. When complete, the 
system returns you to the Timesheets folder. Any errors or problems are 
indicated in the Acct Error and Basis Error columns. 

You are now ready to post any verified timesheets.

VERIFICATION WARNINGS AND ERRORS

Each time you verify timesheets, Payroll generates the Timesheet Verification Report. 
You should print the Timesheet Verification Report to see if there were errors or 
warnings during the verification process. Use the following instructions to view or print 
the report.

1.  Select File > Print Manager from the menu bar.

2. Select PYTCARD and click Open.

3. Click Print  on the toolbar or select File > Print.
Verifying Timesheets 
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TIMESHEET VERIFICATION WARNINGS

The Timesheet Verification Report may include warning messages that inform you of 
possible problems (Table 3.2). However, these problems will not prevent you from 
posting the timesheet. 

TIMESHEET VERIFICATION ERRORS

The Timesheet Verification Report may include error messages that inform you of 
possible problems (Table 3.3). You must correct any errors before you can post the 
timesheet. 

Table 3.2—Message Column Warnings

Timesheet Verification 
Warnings Explanation

Active employee w/ no 
entries.

The Check for Missing Timesheets field was clicked, and an employee 
with no timesheet was found.

Calculated amount is 
zero.

The rate times hours (or units) equals zero, so the Rate item field is zero. 
Go to the employee record to correct the hourly or unit rate of pay. 

Hours exceed day limit. In a 24-hour period, the hours for the employee were over the limit defined 
in the setup parameters.

Hours exceed period limit. In the timesheet period, the hours for the employee were over the limit 
defined in the setup parameters.

Terminated employee. The employee was terminated. Check to see if a check should be issued. 
If not, delete the timesheet.

Terminated employee has 
timesheets.

Review the list of employees.

Table 3.3—Message Column Errors

Timesheet Verification 
Errors Explanation

Account errors Reports the total number of account errors.

Basis errors Reports the total number of basis errors.

Day errors Reports the total number of day errors.

Entry/edit in process Another user is signed on and is adding or editing timesheets. 
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Invalid account - 
change not allowed.

This error occurs when creating a group of timesheets, and means the 
account number is invalid. Check that the Debit Option field of the historical 
data item record (in setup parameters) and the employee’s record are correct. 
You may also edit the Chg acct/basis earnings items field in to allow the 
account to be changed. Then edit the current timesheets, or delete and 
recreate them. 

Invalid account - 
change required.

This error occurs when creating a group of timesheets, and means the 
account number is invalid. Check that the Debit option field of the historical 
data item record and the employee’s record are correct. Then edit the current 
timesheets, or delete and recreate them. 

Invalid basis - change 
not allowed.

This error occurs when creating a group of timesheets. The Basis for field is 
invalid, and the Chg acct/basis field in the historical data item definition does 
not allow the basis to be changed. Check that the Basis for field on the 
historical data item and/or the Addtl basis for field on the employee’s record 
are correct. You may also edit the Chg acct/basis field to allow the basis to be 
changed. Then change the current timesheets, or delete and recreate them.

Invalid basis - change 
required.

This error occurs when creating a group of timesheets. The Basis for field is 
invalid. Check that the Basis for field on the historical data item and/or the 
Addtl basis for field in the employee’s record are correct. Then change the 
current timesheets, or delete and recreate them. 

No “out” for this “in”. An “out” is missing for a clocked “in”.

No “in” for this “out”. The first clocked timesheet is an “out” or there are two “outs” in a row.

Period errors Reports the total number of period errors.

Posting in process. Another user is posting timesheets. You cannot enter or verify additional 
timesheets until the posting completes.

Rate lookup must be 
numeric.

None of the lookup columns on the employee data item entered in the Rate 
Value field is defined as a numeric field. One of the Lookup columns must be 
defined as a whole number, #, an amount, $, a rate, or R.

Rate missing for 
employee.

This occurs when adding a single timesheet. The employee data item entered 
in the Rate Item field does not exist on the employee’s record. Check that the 
employee should receive this earning type. If so, add the earning rate to the 
appropriate earning category on his timesheet. If the timesheet should not 
have been entered, delete it.

Rate must be 
numeric.

The employee data item entered in the Rate Item field must be defined as a 
numeric field. It must be a whole number, an amount, or a rate.

Table 3.3—Message Column Errors (Continued)

Timesheet Verification 
Errors Explanation
Verifying Timesheets 
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To fix errors in an employee’s record, select the desired employee in the Employees or 
Timesheets folder, and double-click or click Edit. After making and saving the 
necessary corrections to the employee’s record, verify the timesheets again and check 
that your correction fixed the error.

POSTING TIMESHEETS
Once you have verified your timesheets, you are ready to post the timesheets to the next 
step in the process. The posting task involves the following:

• Preparing timesheets for net pay calculation and check processing. (You must 
post timesheets to the Net Pay Calculation folder before you can process 
checks.)

• Posting the information to General Ledger using the Labor Journal defined in 
the Payroll Parameter (field 4). (The normal journal entry is a debit to wage 
expense, and a credit to accrued payroll account defined in the Payroll 
Parameter.)

Unless you select specific employees to verify, this task is performed on all timesheets 
in the Timesheets folder. Once the process is complete, the timesheets move to the Net 
Pay Calculations folder. Use the following steps to post timesheets.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

Shift lookup must be 
numeric.

None of the lookup columns on the employee data item entered in the Shift val 
field is defined as a numeric field. One of the columns must be defined as a 
whole number, #, an amount, $, a rate, or R.

Verification in 
process.

Another user is already running Verify Timesheets. If you want to run verify 
again, wait until the first user is finished.

Warning - Timesheets 
cannot be posted.

There are errors in timesheet account, basis, rate, or shift. Review the 
message column of the report to find specific employees with errors. Make 
corrections, verify timesheets again, and print another Timesheet Verification 
Report. Repeat all these steps until all timesheets are verified.

Table 3.3—Message Column Errors (Continued)

Timesheet Verification 
Errors Explanation
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3. Click Post. The Post Timesheets window displays (Figure 3.18).

Figure 3.18—Post Timesheets

Because this feature is not applicable in the current version of the 
software, the Check Sequence text box should be disabled. If it is not, 
please ignore this field.

4. Use the Employee Selector to post timesheets for a select group of employees. 
(By default, the system will post all verified timesheets in the folder.) 

5. Click OK. The Post All Timesheets window closes and you return to the 
Timesheets folder. The verified timesheets are posted to the Net Pay 
Calculations folder and no longer appear in the Timesheets folder.

After timesheets are posted, they are ready to be calculated. Calculating Net Pay is 
covered in Chapter 4—Calculating Net Pay on page 2.83.

 

Posting Timesheets 
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CALCULATING NET PAY

Before you can produce checks for your timesheets, you must calculate and subtract any 
applicable deductions from the timesheet total (i.e., calculate net pay). These deductions 
can include standard deductions (e.g., deduction for insurance) or one-time deductions 
(e.g., correction to tax deduction). 
Once you complete your net pay calculations, you are ready to produce your checks and 
direct deposit files, which you will also do from the Net Pay Calculations folder. 

WHAT ARE ONE-TIME DEDUCTIONS?
The one-time deduction task allows you to enter a deduction manually. (When you 
calculate net pay, you can select deductions based on the calc period.) One-time 
deductions are items that are not normally part of an employee’s paycheck. They can 
include:

• Deductions for an advance,
• Deductions for a one-time wage garnishment, and
• Adjustments or corrections to the amount of a tax or other deduction.

This task uses data items that have been defined as History type—D (Deductions) or T 
(Taxes) in field 1 of the historical data item record. (See Defining Historical Data Items 
on page 1.85 for more information on this definition.) 

ENTERING ONE-TIME DEDUCTIONS
Use the following steps to enter one-time deductions.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.
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2. Select the Net Pay Calculations folder. All timesheets at this stage of the 
payroll process display in the detail pane. 

3. Click One-Time Deductions. (You can also select the timesheet, right-click, 
and select Enter One-Time Deduction from the shortcut menu.) The One-
Time Deductions window displays (Figure 4.1). 

Figure 4.1—One-Time Deductions

4. Select the applicable deduction or tax type from the Data Item drop-down list.

5. Enter the amount to be deducted from the employee’s check in the Amount text 
box. (This field is required; you cannot leave it blank.) Remember:

• A positive number decreases the check amount.
• A negative number increases it.

6. Enter the number of hours on which this deduction or tax is based in the Basis 
Hours text box. (If this field does not apply to this deduction, leave it blank.)

7. Enter the amount on which this deduction or tax is based in the Basis Amount 
text box. (If this field does not apply to this deduction, leave it blank.)

.FICA is based on the dollar amount of total earnings. Your 
organization uses basis amounts in production of year-end tax forms; 
therefore, this information must be entered correctly. However, the 
basis amount was entered incorrectly in the employee’s history. 
Therefore, you add a correcting entry using the one-time deduction 
task. In the Basis Amount field, you enter the dollar amount (i.e., 
wages) on which the correction is based.

8. Click OK. Payroll processes the one-time deduction and closes the One-Time 
Deduction window.
Entering One-Time Deductions 
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You can view the timesheet information, including one-time deductions by selecting the 
timesheet and clicking Detail. (You can also double-click the timesheet, or right-click 
and select Detail from the shortcut menu.)
You can also check the results of your work by printing and reviewing the Preliminary 
Check Register (created during the check writing process), or by producing the 
Calculation Trace report (PYCTNE.L##). (See Producing the Calculation Trace Report 
on page 2.89 for instructions to produce this report.) 

Because a one-time deduction could impact your taxable income (which is 
usually part of the net pay calculation), you should complete any one-time 
deductions before calculating net pay. If you calculate net pay and then add a 
one-time deduction, you must re-calculate net pay (see Calculating Net Pay on 
page 2.86).

CORRECTING ONE-TIME DEDUCTIONS

To correct a one-time deduction entry before checks are produced, enter an adjusting 
one-time deduction entry. For example, you enter a one-time deduction for health 
insurance for $50.00. After reviewing your Preliminary Check Register, you realize the 
deduction should be for $60.00. To correct this, enter another one-time deduction entry 
for $10.00. 

WHAT ARE NET PAY CALCULATIONS?
The net pay calculation task allows you to enter one or more deductions based on the 
calc period defined for the deduction. 
Net pay calculation uses data items that have been defined as History type—D 
(Deductions) or T (Taxes) in field 3 of the historical data item record. (See Defining 
Historical Data Items on page 1.85 for more information on this definition.) 
Additionally, when you defined the data item, you had the option of indicating that the 
calculation is never used, always used, or assigned to one of nine calculation cycles 
(field 3). When you calculate net pay, the data items are grouped by cycle and you can 
apply one or more cycles to the selected timesheets. (Data items that are always used are 
assigned to all cycles.)

A typical use of calculation cycles is for deductions that occur every other pay 
period or employer-paid benefits that are only calculated annually. 
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You may calculate net pay as many times as necessary until the payroll is correct. When 
you rerun this task, it replaces the previously-calculated paycheck with the new 
information.

Because a one-time deduction could impact your taxable income (which is 
usually part of the net pay calculation), you should complete any one-time 
deductions before calculating net pay. If you calculate net pay and then add a 
one-time deduction, you must re-calculate net pay.

CALCULATING NET PAY
Unless you select specific employees to verify, this task is performed on all timesheets 
in the Net Pay Calculations folder. Once the process is complete, you will be ready to 
write checks for any timesheets that calculated correctly (any errors are indicated in the 
Status column). 
Use the following steps to calculate net pay for some or all timesheets in the Net Pay 
Calculations folder.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display. 

2. Select the Net Pay Calculations folder. All timesheets at this stage of the 
payroll process display in the detail pane. 

3. Click Calculate Net Pay. (You can also select the timesheet, right-click, and 
select Calculate Net Pay from the pop-up menu.) The Calculate Net Pay 
window displays short description of the historical data items defined with a 
calculation cycle (field 4). The HDIs are organized by those cycles (Figure 4.2). 

Figure 4.2—Example Calculate Net Pay

In Division 95, we have only 
two cycles. Each cycle has four 
HDIs assigned to it. (Most of 
our HDIs are not assigned to 
specific cycles.)
Calculating Net Pay 
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4. Click Employee Selector to calculate net pay for a specific group of employees 
(i.e., a subset of the employees with posted timesheets). The Employee Selector 
displays (Figure 4.3). 

Figure 4.3—Employee Selector

5. Enter your selection parameters. (For more instructions on the Employee 
Selector, see Using the Employee Selector on page 2.52.)

6. When you have completed your selection, click OK. The Employee Selector 
closes and you return to the Calculate Net Pay detail pane.

7. Select one or more check boxes for the calculation cycles that you wish to 
calculate. 

If you defined your Payroll parameter to allow multiple checks (field 
2), a Check Sequence field may display. However, this feature is not 
supported in the current version of the software and the field must be 
ignored.
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8. Click Calculate. When the program has completed the calculation process, the 
Calculate Net Pay window closes and you return to the Net Pay Calculations 
folder. The calculation status of the timesheets displays in the Status column 
(e.g., Calculated, Calc. Error - Account). 

VIEWING CALCULATION INFORMATION
You can view the timesheet information, including one-time deductions by selecting the 
timesheet and clicking Detail (Figure 4.4). (You can also double-click the timesheet, or 
right-click and select Detail from the shortcut menu.) 

Figure 4.4—Display Calculation Results

You can view the timesheet information in greater detail in a number of ways:
• Calculation error report (PYCTNE.L#)—The details of any calculation errors 

are written to this report. 
— This is the same file name given to the Calculation Trace report, which 

shows the results of each line of a calculation for a single data item for a 
single employee. 

• The Calculation Trace report (PYCTNE.L##)—See Producing the Calculation 
Trace Report on page 2.89 for instructions.

• Preliminary Check Register—The system creates this report during the check 
writing process. See Writing Checks Using the Wizard on page 2.97.

• Distribution After Net Pay Calculations report—A sorted distribution report in 
account dimension(s) order after net calculations and before check production. 
See Producing the Distribution After Net Calculations Report on page 2.152.
Viewing Calculation Information 
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PRODUCING THE CALCULATION TRACE REPORT
The Calculation Trace report (PYCTNE.L##) shows the results of each line of a 
calculation (one-time or net pay) for a single data item for a single employee. (You can 
only run this report for one employee at a time.) However, you can only produce the 
Calculation Trace report when you have a calculated net pay but not yet produced your 
checks (i.e., the Status column displays “Calculated” or “Calc Error”).

This report is a very useful tool for troubleshooting payroll calculation issues (e.g., 
checking a new calculation, investigating a calculation result that seems incorrect). Use 
the following steps to produce the Calculation Trace report.

1.  Click Processing > Check Processing > Calculation Trace Report on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Processing > Check Processing > Calculation 
Trace Report from the menu bar. The first page of the Calculation Trace report 
parameters window displays (Figure 4.5). 

Figure 4.5—Calculation Trace Report—Page 1 of 2

2. Enter the applicable calculation cycle number (or numbers) separated by a space 
or comma and press ENTER. If you used one or more calculation cycles when 
you calculated net pay, you must enter the calculation number (or numbers) in 
this field.
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3. Enter the applicable data item name and press ENTER. (You can access a list of 
data items by pressing F1.) The Items Selection field displays (Figure 4.6). 

Figure 4.6—Calculation Trace Report—Item Selection

4. Enter the order number for the item selection and press ENTER. (This number 
simply helps you organize your entries, it is not used in the report.) 

5. Enter an employee data item (should be .EMPLOYEE to filter by employee 
number, or you can use the employee name to produce the report for one 
employee). The second page of the Calculation Trace report parameters window 
displays (Figure 4.7). 

Figure 4.7—Calculation Trace Report—Page 2 of 2
Producing the Calculation Trace Report 
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6. Enter the first and last values to filter the information in the report, and indicate 
if these records are included or excluded.

7. When complete, press ESC to display the option menu.

8. Type E to end the session 

9. Type 0 to accept your entries.

10. Press ENTER to file a report (accepting the Yes option). The report 
(PYCTNE.L##, where ## represents your division number) is created and saved 
to your Reports folder.

11. Access the report through Print Manager.
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The report consists of the calculation definition (maintained in field 8 of the HDI 
definition) (Figure 4.8) and the line-by-line calculation for the employee (Figure 4.9). 

Figure 4.8—Example Calculation Trace Report—Page 1
Producing the Calculation Trace Report 
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Figure 4.9—Example Calculation Trace Report—Page 2

CORRECTING NEGATIVE CALCULATIONS
A negative check amount (i.e., the sum of the earnings is less than the sum of the taxes 
and deductions) will display in the detail pane and the timesheet detail window in red 
type within parenthesis. A negative net pay can be caused by:

• An incorrect calculation formula;
• Incorrect data items on the employee record;
• Low earnings, which cause the taxes and deductions to be higher than the wage; 

or

The system 
registers display 
at the start of the 
calculation.

The body of the 
report presents the 
calculations results, 
line by line.

The amounts in registers 3 and 4 
come from:

• Earnings items that are 
defined with this data item in 
the basis for field (field 4),

• Additional basis defined on the 
employee record, or

• Distribution tables.
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• A one-time deduction that is higher than the wage.
You can correct this situation by editing the employee record, the one-time deductions, 
or the calculation formulas. 

ENTERING AN OFFSETTING TIMESHEET

To correct a calculated negative amount, you must create an offsetting, positive 
timesheet for this employee.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees or Timesheets folder. All timesheets at this stage of the 
payroll process display in the detail pane. 

3. Click Single. The Create/Edit Single Timesheet window displays.

4. Select the correct earnings item for this employee (e.g., Salary, Hourly) and 
create a timesheet for a positive amount that will offset the negative amount. 
This will reverse the journal entry.

5. Verify the timesheet to check for basis or account errors.

6. Post the timesheet to the Net Pay Calculations folder.

7. Recalculate the net pay. You may recalculate for all employees or use the 
Employee Selector to choose only the employee with the negative timesheet 
amount. 

If the offsetting entry exactly matches the negative amount, this employee will 
disappear from the list in the Net Pay Calculations folder.

PROCESSING NEGATIVE CHECKS

While you may wish to process a negative direct deposit (to correct an error), there is 
little reason to produce a negative check. Payroll/Personnel warns that you have a 
calculated amount that is negative, and prompts you to:

• Use the Employee Selector to skip this check,
• Correct the error, or 
Correcting Negative Calculations 
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• Fix the negative amount (Figure 4.10). 

Figure 4.10—Negative Checks Message

If you do not correct the negative amount before you get to the Log Check Numbers 
window of the Check Writing Wizard (Figure 4.11), you will produce, print, and log a 
negative check. The Bank Accounts folder will reflect the negative amount, and you 
will then need to void the negative check. 

Figure 4.11—Example Negative Check
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PRODUCING CHECKS

After you’ve calculated net pay for your timesheets, you are ready to produce your 
checks. You can create one or more checks using the Check Writing Wizard or you can 
create a single manual check for each timesheet. 

• The Check Writing Wizard guides you through producing and printing checks, 
while also creating a Preliminary Check Register, defining information needed 
for banking, and logging the checks. 

• A manual check is one written outside of FundWare. You must manually enter 
all the required check information for each check to maintain correct employee 
history, including amounts for all historical data items that are normally 
calculated by Payroll/Personnel. 
— Because you must manually enter all this information, we strongly 

recommend that you avoid writing manual checks.
With either method of creating checks, your expenses are posted to General Ledger on 
the business date used when the task is selected. Checks are written for the Check date 
entered for the check.

WRITING CHECKS USING THE WIZARD
Use the following steps to write one or more checks/direct deposits using the wizard.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Net Pay Calculations folder. All timesheets at this stage of the 
payroll process display in the detail pane. 
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3. Click Check Writing. (You can also right-click in the detail pane and select 
Post to Check Writing from the shortcut menu.) The Check Writing Wizard 
displays, open to the Getting Started window (Figure 5.1). 

Figure 5.1—Payroll Check Writing Wizard, Getting Started

4. Select the bank (i.e., Financial Institution account) for this check run (for both 
checks and direct deposits) from the Bank drop-down menu. The Starting Check 
Number field is automatically filled with the next applicable number, based on 
the Financial Institution account definition.

After selecting the appropriate bank, a confirmation message may display 
(Figure 5.2). If this message does not display, move to step 6 on page 2.98. 

Figure 5.2—Delete Old Check File Message

5. Click Yes or No, depending on whether or not you want to delete the check file. 

6. If you are creating an EFT file (i.e., direct deposit file), select one or more 
Direct Deposit Cycles. (These cycles correspond to the cycle setting on the 
Direct Deposit tab of the employee record.)

In this example, PYCK is 
the file name, 1 is the 
bank ID, and l95 is the 
division.
Writing Checks Using the Wizard 
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If you are not creating an EFT file (i.e., you are creating physical 
checks), leave these check boxes blank.

7. Enter a valid date in the Check Dates text box. For checks, this date will appear 
on the printed checks. For direct deposit payments and files, this date will be 
applied to the transactions.

By default, the current business date is entered in this field. You can 
change this date, as necessary; the check date does not need to match 
the business date.

8. If the Starting Check Number field is editable (i.e., not disabled), you can 
change the starting check number, if necessary.

If you selected the Auto Number Checks check box of the FIA 
definition, you cannot edit this field. The system will automatically 
update the Starting Check Number each time you run the Check 
Writing wizard. (For more information on FIAs, see Chapter 4—Using 
the Financial Institutions Feature on page 1.133.)

9. Click Next to proceed to the Define Preliminary Check Register window 
(Figure 5.3). 

Figure 5.3—Payroll Define Preliminary Check Register
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You must create the Preliminary Check Register to produce checks and 
direct deposit payments. The Preliminary Check Register allows you to 
review the result of the net pay calculation and a preview of the actual 
check register. The fields that you complete here determine the amount 
of detail included in the Preliminary Check Register.

10. Select the Detail Register check box to include a detail register for data items. 
The historical data item definition determines which data items will get a detail 
register.

11. Select the Account Info check box to include account numbers. If you do not 
select this check box, you will get year-to-date information.

12. Select the Basis Info check box to include the basis for information from the 
timesheets. If you do not select this check box, you will get year-to-date 
information.

13. Click Sort Items to choose employee data items to order the information in the 
Preliminary Check Register (e.g., produce checks by city, departments, earnings 
type) (Figure 5.4). If you do not want to define a sort order, move to step 17. 

Figure 5.4—Sort Items—Preliminary Check Register

14. Select the employee data item on the left and click Select to move it to the list 
on the right. 

15. Click the Sort Order up or down arrow to move it up or down on the list. The list 
reflects the order in which the data items will appear in the preliminary check 
register.

16. Click OK to save this sort order and return to the Check Writing wizard.
Writing Checks Using the Wizard 



Chapter 5—Producing Checks
17. Click Employee Selector to produce a Preliminary Check Register for a select 
group of employees. If you do not want to define a sort order, Payroll will create 
checks in employee number order for all employees listed in the Net Pay 
Calculations folder and move you to the next step.

18. Click Next to produce the Preliminary Check Register. The Preliminary Check 
Register shows the result of the net pay calculation and a preview of the actual 
check register (Figure 5.5). 

Figure 5.5—Preliminary Check Register

Each time the Preliminary Check Register is produced, it replaces the 
previous one.

To view the entire Register, press PGDN or scroll down.

We recommend that you print and review the Preliminary Check 
Register at this time.

19. Click Print Preliminary Check Register to produce the check register and 
view in Print Manager. Print Manager opens.

20. Through Print Manager, select the PYPREG.L## report and click Open.

21. Select File > Print to print this report.
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22. Review the Preliminary Check Register. If it is incorrect, you may need to 
cancel out of this task and make corrections on the employee record, at the 
timesheet step, or at the net pay calculations step. Once your corrections are 
entered, you must restart the check wizard.

23. Once the Preliminary Check Register is correct, click Next to produce and print 
checks (Figure 5.6). The Produce Checks window displays. 

Figure 5.6—Produce Checks

24. Verify that the check date is correct. If it is not, click Back to return to the 
Getting Started window and enter the correct date.

25. If your system is configured to produce the timesheet history stub, enter a date 
range, based on the business date when you posted the timesheets, for the 
information included in the stub.

To use this feature, certain fields in the Payroll parameter and check 
format must be defined with specific settings. For more information, 
see Using the Timesheet History Stub Feature on page 1.179.
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26. Click Next to produce the checks. The Log Check Numbers task displays 
(Figure 5.7). 

Figure 5.7—Log Check Numbers

Because of printer problems, it is not always possible to use the check 
numbers in sequence; therefore, you should always print your checks 
before logging the check numbers.

27. Open Print Manager and produce your checks from the PYCK (checks) and/or 
PYSTUB (direct deposit) files.

28. If you are doing direct deposit, transmit the appropriate file to the employee’s 
bank (or banks):

• ##PY2 in your Data folder if you answered T or U in the File format field in 
the direct deposit parameter record, or

• ##PYN file in the Data folder.
The report name will include the use ID number of the FIA, as well as 
the division number. For example, Cranberry National Bank in Division 
95 has a use ID number of 1. Therefore, all check files are named 
PYCK1.L95.

Once you print your checks, you are ready to return to the Check Writing Wizard and 
log the check numbers.

If the FIA is defined to autonumber the checks or if the check run is all direct 
deposits, you will not be allowed to log different check numbers. In this case, 
you are ready to click Finish to complete the check writing process. 
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LOGGING YOUR CHECK NUMBERS

After you successfully print your checks, you must log the physical check numbers on 
the Log Check Numbers window of the Payroll Check Writing Wizard. If you have 
closed the wizard, you will return to this window when you click Check Writing (from 
the Net Pay Calculations folder) and select the FIA. 
However, if the FIA is defined to autonumber the checks or if the check run is all direct 
deposits, you will not be allowed to log different check numbers. In this case, you are 
ready to click Finish to complete the check writing process.

You will not be able to calculate net pay for additional timesheets until you 
complete the check writing process for these timesheets by logging your check 
numbers. 

Use the following instructions to log your check numbers.
1.  Select the check or checks to be numbered using your mouse (you can select 

consecutive checks using SHIFT), or enter a range of checks using the check 
sequence number (Figure 5.8). 

Figure 5.8—Using Sequence Numbers to Assign Check Numbers

If you use your mouse to select checks, the From and To sequence 
numbers will reflect your selection. Manually changing the sequence 
numbers will change the checks selected for numbering.

Sequence numbers are system-generated numbers that allow you to 
track the checks before physical check numbers have been assigned.

2. Enter the first (or only) check number in the Start Chk # field. This number is 
the actual printed check number for the first highlighted check; the system will 
number all other highlighted checks sequentially from this number.

If your check run is all direct deposit, the system will disable the From, 
To, and Start Chk # fields.

3. Click Assign. The system assigns the check numbers and displays the numbers 
in the Check column. 
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4. Continue this process until all checks are numbered (Figure 5.9). 

Figure 5.9—Example of Non-Sequential Check Numbers

5. In the Select Final Register Detail area (Figure 5.10), select the applicable 
check boxes to include account and/or basis information in the final register. 

Figure 5.10—Select Final Register Detail Area
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6. Click Sort Items. The Sort Items window displays (Figure 5.11). 

Figure 5.11—Sort Items Window

7. Select the data items on which the checks will be sorted in the PYREG.L## file. 
Use the up and down arrows to prioritize the sort items.

8. Click OK. You return to the Log Check Numbers window.

9. Click Finish to log the checks and exit the Check Writing Wizard. The software 
posts the Direct Deposit payments and/or logged checks to the General Ledger 
according to the business date and updates and posts to the Payroll/Personnel 
module according to the date in the Check Date field.

If the check date is different from the current business date, Payroll 
produces two trace reports.

When the process is complete, a message displays indicating that the 
information has posted to Financial Institutions (produces BRPOST.L##).

10. Click OK.

We strongly recommend that you review the trace report(s).

11. As a final check, you may want to review the final Check Register 
(PYREG.L##) and compare the information with the Preliminary Check 
Register.
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PRODUCING A DIRECT DEPOSIT PROOF LIST

After producing the checks and Direct Deposits, you may wish to review the Direct 
Deposit transactions that will be transmitted to the bank. Print and file the Direct 
Deposit Proof List along with your check registers.
Use the following steps to Produce a Direct Deposit Proof List.

1.  Click Processing > Check Processing > Produce EFT Proof List on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Processing > Check Processing > Produce 
EFT Proof List from the menu bar. A confirmation message displays.

2. Enter Yes to produce this report. A second confirmation message displays.

3. Enter Yes to file this report. The system produces the report and closes the 
window.

4. Through Print Manager, access the PYLPEFT.L## report. 

ENTERING A MANUAL CHECK
A manual check is one written outside of the Payroll/Personnel software. You must then 
enter all the required check information to maintain correct employee history, including 
employer cost items as well as earnings, taxes, deductions, basis amounts, hours, and all 
account numbers. 

Because of the complexity and effort of entering all this information, we 
strongly recommend that you do not create manual checks. Let the program 
calculate and produce all checks, even if the check run consists of a single 
check.

When entering a manual check, you will be prompted for a batch total (the net total of 
the checks) for the check. Once you have entered the entire transaction, the Balance to 
go amount should be zero. If not, a net amount may be incorrect or missing, or the batch 
total may be incorrect. Once you have posted the manual check, the program:

• Posts expenses to General Ledger on the business date used when the task is 
selected. 

• Posts checks on the Check date entered for the check. 
• Files a manual check register and one or more trace reports (i.e., two trace 

reports are created when the business date is different than the check date).
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Use the following steps to enter a manual check.
1.  Click Transaction Entry > Enter Manual Checks on the module navigator (if 

the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Transaction Entry > Enter Manual Checks from the menu bar. 
The system asks you to enter the batch total (i.e., the net total of the check) for 
the check (Figure 5.12). 

Figure 5.12—Enter the Batch Total

2. Enter the net total of check that you wish to process. You may leave this field 
blank by pressing ENTER. Let the system calculate the total, and enter it before 
posting the batch.
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3. Press ENTER. As you complete each of the required fields on page 1, the next 
field is revealed (Figure 5.13).

Figure 5.13—Entering Manual Checks, Page 1 of 3

4. Complete the fields on the first page of the task according to Table 5.1. 

Table 5.1—Manual Check Field Definitions

Field Valid Entry Definition

Batch total $—amount or 
<blank>

The net total of all manual checks to be entered. You may leave 
this field blank by pressing ENTER. Let the system calculate the 
total, and enter it before posting the batch

Bank 1–10 characters The Use ID for the Financial Institutions account for which the 
manual check was written.
• Press F1 for a list of Financial Institutions accounts associated 

with Payroll/Personnel.

Check 
number

#—number The check number for which the manual check was written.

Run System generated The system-assigned run number is displayed.

Check date 99/99/9999 The date on which the check was written.

Employee #—number The number of the employee who received the manual check.

Net amount $—amount The net amount of the manual check.
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5. Press ENTER to move to the second page of the task (Figure 5.14). You will 
enter that data items associated with this check on this page. 

Figure 5.14—Entering Manual Checks, Page 2 of 3

6. As you enter the data items for this check, the Entry number will track which 
item you are entering. You can change this number, as necessary.

7. Press ENTER to begin working on the data item. The fields associated with the 
data item display (Figure 5.15). 

Figure 5.15—Entering Manual Checks, Page 2 of 3 (Data Item)

8. Enter the applicable data item. (You can select from a list of data items by 
pressing F1.)
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9. Complete the Hours/units, Amount, Basis hrs/units, and Basis amount fields, as 
necessary. 

10. When complete, press ENTER. The third page of the task displays, allowing you 
to enter account information for the data item (Figure 5.16). 

Figure 5.16—Entering Manual Checks, Page 3 of 3 (Account Number)

11. Enter the account number for funds applied to this data item and press ENTER. 
(You cannot enter an account mask, and the system does not build an account 
number automatically.)

12. Enter Db or Cr to indicate if this transaction is a debit or credit (Figure 5.17). 

Figure 5.17—Entering Manual Checks, Page 3 of 3 (Debit or Credit)

For data items that can post both debits and credits, such as employer 
paid benefits, indicate whether the amount entered is a debit or credit. 
Both the debit and credit entries must be made.

13. Press ENTER. The system asks if your entry is correct.

14. Type 0 and press ENTER to accept your entries. The system returns focus to the 
Entry field (on the second page of the task) and increases the Entry number.
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15. Continue entering data items, as necessary.

16. When complete, press ESC to display the option menu and type E to exit the task 
and close the window.

17. Enter P to post the manual check. 

A Manual Check Register is automatically filed using the file name PYMREG.L##, 
where ## is the division number. A separate trace report is produced and filed for each 
date for which posting was done; the name is CDS######.L##. A reconciliation trace 
report with the name BRPOST.L## is also filed.

LOGGING UNUSED CHECKS
When you print your checks, you might lose forms because the printer jams or you 
might waste forms at the beginning or end of the printing job. When this happens, you 
should update the bank reconciliation files by logging the check numbers as “unused.” 

An unused or destroyed check is one that was never issued and never will be 
issued. If the check was actually signed and given to the employee and later you 
must reverse the transaction, you should void the check (Voiding a Check on 
page 2.114).

Use the following steps to log one or more unused checks.
1.  Click Bank Reconciliation > Enter Unused Payroll Checks on the module 

navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Bank Reconciliation > Enter Unused Payroll 
Checks from the menu bar. The option menu displays.
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2. Enter A to log unused checks. The system asks you to identify the bank for 
associated with this task (Figure 5.18). 

Figure 5.18—Enter Unused Payroll Checks—Bank

3. In the Bank field, enter the Use ID for the Financial Institutions account and 
press ENTER. (Press F1 for a list of Financial Institutions accounts associated 
with Payroll.) The remaining fields of the task display (Figure 5.19). 

Figure 5.19—Enter Unused Payroll Checks
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4. Complete the required fields according to Table 5.2. 

5. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system logs the check and returns to the Bank field to allow 
you to log additional unused checks.

6. When you have enter all unused checks, press ESC to display the option menu.

7. Type E to end the task. The system asks if you want to post the information to 
the Bank Reconciliation files.

8. Enter Y to post your unused checks and close this window.

Payroll logs the unused checks and files a reconciliation trace report (BRPOST.L##). 
You can also review unused checks using the Check Reports task.

VOIDING A CHECK
When you void a check, FundWare reverses the Payroll entries and posts reversal 
entries to General Ledger and Accounts Payable (if applicable). You can only void 
outstanding checks and outstanding direct deposits (i.e., once reconciled, you cannot 
void a transaction). When voiding a check, the system uses:

• The business date to post the General Ledger and Accounts Payable entries due 
to the impact on W-2s, and

• The original check date to post the Payroll information.
If you void a payroll check and reissue the check in another payroll reporting 
period, quarter, or calendar year, you may need to amend your 941 reports, W-
2s, and any other payroll reports.

Table 5.2—Log Unused Checks Field Definitions

Field Definition

Check Date Enter the date the checks were produced. The date defaults to the business date 
displayed in the upper right corner of your screen.

Check number Enter the number of the check number you did not use. You can only enter one 
check at a time.

Description Enter a brief description that explains why you could not use the check.
• For example, “Jammed in printer.”
Voiding a Check 
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Use the following instructions to void a check.
1.  Click Open on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open from the menu 
bar.

2. Click the applicable FIA folder. 

3. Select one or more check boxes for the check status and click Go to display 
your checks (Figure 5.20). 

Figure 5.20—Example Filter Settings

4. Select the check or checks to be voided. 

Select multiple sequential checks by selecting the first check, pressing 
SHIFT and selecting the last check in the sequence. Select multiple non-
sequential checks by selecting the first check, pressing CTRL, and 
selecting the additional checks.
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5. Click Void. The Void Checks window displays, including the check(s) that you 
selected (Figure 5.21). 

Figure 5.21—Void Checks

If you have multiple items here, you may click on any column header to 
sort them. 

6. Click OK to void these items. (Clicking Cancel will stop the void task and 
return you to the FIA folder.) Once Payroll completed the task, a confirmation 
message displays.

7. Click OK. You return to the FIA folder and the checks or direct deposit entries 
not longer display.

Voided checks must be reconciled when you complete the 
reconciliation process. 

After voiding a check, use Print Manager to review the following reports:
• Void Check Register Report (PYVREG.L##)—occurs automatically
• Bank Reconciliation Posting Report (BRPOST.L##)—occurs automatically.
• GL/AP Journal Entry Trace Report (CS######.L##)—occurs if you are posting 

to the GL.
 

VOIDING AN EFT
Use the following instructions to void a direct deposit.
Voiding an EFT 
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1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System Administration 
> System Utilities from the menu bar. The System Utilities window displays 
(Figure 5.22).

Figure 5.22—System Utilities Window

4. In the Execute Program area, enter the required information according to Table 
5.3 to run the override.

Table 5.3—Voiding a Direct Deposit

Field Entry

Program Name PYL250

Switches 1

Parameters Leave blank
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5. Click Run. The program displays, asking you to enter the total EFT amount that 
you want to void

Figure 5.23—Entering the Batch Total

6. Enter the total net pay amount that you want to void. (You can adjust this 
amount prior to posting, as necessary.)

7. Press ENTER. The system asks you to identify the bank received these funds 
(Figure 5.24).

Business Date Enter the business date that you want to use for the 
voiding transaction.

Division Select the applicable division from the drop-down list.

Table 5.3—Voiding a Direct Deposit

Field Entry
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Figure 5.24—Entering the Applicable Bank

8. Enter the bank number or press F1 to select from a list of your banks.

9. Press ENTER. The system asks you to enter the check number (Figure 5.25).

Figure 5.25—Check Number Field

10. ENTER 0 or press F1 to view all check and EFT entries. (There is no applicable 
“check number” for EFTs; therefore, you must select the EFT entry from the F1 
list.)

11. Select the applicable EFT entry (Figure 5.26).
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Figure 5.26—Selecting the EFT Entry to Void (Check Number)

When you return to the screen, the field will still show a check number of 0.
12. Press ENTER. The system asks you to enter or select the system number of the 

EFT to void (Figure 5.27).

Figure 5.27—System Number Field

13. Enter the system number or press F1 to select the EFT entry (Figure 5.28).
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Figure 5.28—Selecting the EFT Entry to Void (System Number)

14. Press ENTER. The system retrieves the information associated with the selected 
EFT and asks if your entries are correct (Figure 5.29).

Figure 5.29—Confirmation Message

15. Press ENTER (or type Y) to accept your entries and void this EFT. The system 
indicates that the check has been added to the batch (Figure 5.30).
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Figure 5.30—EFT Added to Batch to Be Voided

16. Continue entering any other EFTs to be voided.

If you have completed your entries and there is still a Balance to go (i.e., you 
entered an incorrect Batch total), type B and correct the total.

17. When you have completed your entries, press ESC to display the session menu.

18. Type E to end the session. The batch option menu displays.

19. Type P to post your entries and void the selected EFTs.

20. Print, review, and save the void check register report (PYVREG.L##) and your 
trace reports.
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RECONCILING CHECKS

There are several steps involved in the Bank Reconciliation process: 
• Entering a reconciliation—Checks and Direct Deposits are “marked for 

reconciliation,” in preparation for reconciliation.
• Posting a reconciliation—Changes “marked for reconciliation” items to 

“reconciled” using the current business date.
• Purging a reconciliation—Transactions that are “posted for reconciliation” are 

removed from the payroll reconciliation data files.
• Voiding a check—Void checks that have been logged but not reconciled.
• Logging unused checks—Enter unused checks.
• Producing check reports—Choose selection criteria and generate a report with 

the checks in the system (e.g., outstanding checks).
• Displaying your checks—Display reconcilable items on an include/exclude 

basis.
Another step that you may take when reconciling your checks is to import reconciliation 
information. During this task, you import a text file and change the record of your 
“outstanding” checks to “marked for reconciliation.” For more information on 
importing reconciliation files, see the Blackbaud FundWare System Administration 
Guide.

ENTERING A RECONCILIATION
When you are entering a reconciliation, you can work with individual checks or a range 
of checks to:

• Mark for reconciliation,
• “Unmark” for reconciliation (i.e., change from included in the reconciliation to 

exclude from the reconciliation), or
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• Display bank and transaction information.
Use the following steps to begin the reconciliation process.

1.  Click Bank Reconciliation > Enter Reconciliation on the module navigator (if 
the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Enter Reconciliation from the menu bar. 
The Enter Reconciliation window displays (Figure 6.1). 

Figure 6.1—Enter Reconciliation
Entering a Reconciliation 
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2. Enter the function number representing the task you would like to complete 
(Table 6.1). (In this case, enter 1 to mark a range of checks for reconciliation.) 
You can press F1 to select from a list of options. 

3. Press ENTER. The task-related fields display (Figure 6.2). 

Figure 6.2—Enter Reconciliation—Function 1 (Marking a Range of Checks)

Table 6.1—Enter Reconciliation Field Definitions

Valid Entry Definition

1—Mark a range of checks The selecting of the range of continuous check numbers for which 
reconciliation is to be done.

2—Unmark a range of checks The deselecting of the range of continuous check numbers for which 
reconciliation is to be done.

3—Manual mark/unmark entry The tagging or untagging of individual transactions (one at a time) for 
reconciliation.

4—Automatic mark/unmark 
entry

Automatically brings up each item, one at a time, within the range and 
order selected. The operator may elect to reconcile or not as is 
needed.

5—Display a range of checks Allows the viewing of the processing information for the selected 
range of transactions.
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4. Complete the fields according to Table 6.2. Fields that do not apply to all 
functions are noted. 

Table 6.2—Enter Reconciliation Field Definitions

Field Applicable 
Function Valid Entry Definition

Bank All functions 1–10 characters The Use ID for the Financial Institutions 
account for which the manual check was 
written.
• Press F1 for a list of Financial Institutions 

accounts associated with Payroll/
Personnel.

Type All functions *—All Process all checks and Direct Deposits

C—Checks Process checks only

E—Electronic Fund 
Transfers (Direct 
Deposits)

Process Direct Deposits only. This is the total 
of all employee paychecks for which a Direct 
Deposit has been selected. Each transfer is 
for a specific payroll cycle.

Sort Order Functions 1, 
2, 4, and 5

D—Date order/ref # 
order

Sort by date and then reference (check and/or 
Direct Deposit) number within dates chosen.

R—Reference # order Sort strictly by reference (check and/or Direct 
Deposit) number for the range selected.

Ref # range Functions 1, 
2, 4, and 5

0 to 9999999999 The range of continuous check numbers for 
which processing is to be performed. When 
entered in this screen, only the characters to 
the left of the hyphen (ref #) are necessary.

Ref # Function 3 0 to 9999999999 The single check number that you are 
manually marking/unmarking. When entered 
in this screen, only the characters to the left of 
the hyphen (ref #) are necessary.

Pause Functions 1, 
2, and 5

Y—Pause between 
displays

Pause between displays. The Y response 
permits the viewing speed to be controlled by 
the operator.

N—Do NOT pause 
between displays

Deactivates the pause between displays.
Entering a Reconciliation 
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5. At the confirmation message, type Y or press ENTER to accept your entries.

6. When the task is complete and you have viewed the information, a message 
displays asking if you have additional tasks.

7. Type N to exit this task and close the window.

POSTING A RECONCILIATION
Once you post your reconciled checks, you cannot undo the reconciliation. Therefore, 
this task offers two options:

• Preliminary—Returns a preview of the task results. Allows you to review 
transactions prior to posting.

• Final—Completes the task. Run once you have reviewed the preliminary post 
and found no errors. Generates a listing of all transactions which were posted 
and physically updates the records by marking them as “reconciled.”
You can only post checks that have been “marked for reconciliation” (i.e., using 
function 1, 3, or 4 of the Enter Reconciliation task).

Use the following steps to post a reconciliation.

Mark/
Unmarked

Function 4 *—All Selects both marked for reconciliation and 
unmarked transactions. There will be a 
combination of Ys and Ns appearing in the far 
right hand column.

M—Marked for 
reconciliation

A Y appears in the far right hand column. 
Only those items marked for reconciliation will 
appear on the screen. Enter N or 0 to unmark.

U—Unmarked for 
reconciliation

An N appears in the far right hand column. 
Only those items not marked for reconciliation 
will appear on the screen. Enter Y or 1 to 
mark.

Table 6.2—Enter Reconciliation Field Definitions (Continued)

Field Applicable 
Function Valid Entry Definition
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1.  Click Bank Reconciliation > Post Reconciliation on the module navigator (if 
the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Post Reconciliation from the menu bar. 
The Post Reconciliation window displays (Figure 6.3). 

Figure 6.3—Post Reconciliation

2. Complete the required fields according to Table 6.3. 

Table 6.3—Post Reconciliation Field Definitions

Field Valid Entry Definition

Bank 1–10 characters The bank for which the reconciliation is being run.

Prelim/Final P—Preliminary proof 
report only

This option only generates a report; the check status is not 
changed to “reconciled.”

F—Post reconciliation 
entries

This option generates a posted transaction report and 
changes the check status from “marked for reconciliation” 
to “reconciled.” 

Sort order D—Date order/ref # 
order

Sorts the checks on the report in reference number order 
within the date order.

R—Reference # order Sorts the checks on the report in reference number order 
only.
Posting a Reconciliation 
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3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system asks if you would like to file a report.

4. Type Y or press ENTER to produce the report (BRPROOF.L##, where ## 
represents your division number). When the report has been produced, a 
message displays at the bottom of the window.

5. Press ENTER to exit this task and close the window.

Figure 6.4 shows a Preliminary Recon Proof Report that was sorted in Date/Ref # Order 
and produced using detail option (Figure 6.4).

Figure 6.4—Example Preliminary Recon Proof Report

Report Level S—Summary Includes the Date, Type, Ref #, and Amount.
• Note: The bank recap report is printed with ALL reports.

D—Detail Includes the Ref #, Type, Date, Ref Desc, Src, Emp #, 
Employee Name, and Amount.
• Note: The bank recap report is printed with ALL reports.

R—Recap only Generates only the Recap report

Table 6.3—Post Reconciliation Field Definitions (Continued)

Field Valid Entry Definition
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PURGING A RECONCILIATION
The Purge Reconciliation task allows you to remove all reconciled transactions (i.e., 
checks with a status of “reconciled,” including voided checks), unused checks, as well 
as direct deposits from the reconciliation data file. (The information remains in the 
Payroll files.) Most customers only perform this task to reclaim disk space.

We strongly recommend that you backup your division before you purge 
reconciled checks. If you do not have a division backup, you can restore (if 
necessary) from a system backup.

This task offers two options:
• Preliminary—Returns a preview of the task results. Allows you to review the 

checks that will be purged prior to completing the task.
• Final—Completes the task. Run once you have reviewed the preliminary post 

and found no errors. Generates a listing of all transactions which were posted 
and physically updates the records by marking them as “reconciled.”
You can only purge checks that have been reconciled, voided, or marked as 
unused, or direct deposits that have been reconciled.

Use the following steps to purge reconciled, voided, or unused checks, or reconciled 
direct deposits.

1.  Click Bank Reconciliation > Purge Reconciliation on the module navigator 
(if the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Purge Reconciliation from the menu bar. 
The Purge Reconciliation window displays (Figure 6.5). 

Figure 6.5—Purge Reconciliation
Purging a Reconciliation 
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2. Complete the required fields according to Table 6.4. 

3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system asks if you would like to file a report.

4. Type Y or press ENTER to produce the report (BRPURGE.L##, where ## 
represents your division number). When the report has been produced, a 
message displays at the bottom of the window.

5. Press ENTER to exit this task and close the window.

PRODUCING RECONCILIATION CHECK REPORTS
Payroll allows you to produce a report of the checks entered into your Bank 
Reconciliation system (BRCHKRP.L##). Use the following steps to run a check report.

Table 6.4—Purge Reconciliation Field Definitions

Field Valid Entry Definition

Bank 1–10 characters The Use ID for the Financial Institutions account for which 
the manual check was written.
• Press F1 for a list of Financial Institutions accounts 

associated with Payroll/Personnel.

Date range mm/dd/yy to mm/dd/yy Must be a valid date or all zeros in the first date field. Items 
on or between the dates selected will be deleted. If entered 
as 00/00/0000 to 99/99/9999, the default becomes **ALL**. 
ALL items purges ALL reconciled, unused, and voided 
checks currently present in the reconciliation data files 
regardless of dates.

Prelim/Final P—Reconciliation 
Preliminary Purge 
Report

Only report processing takes place. The report will show all 
entries currently selected for purge.
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1.  Click Bank Reconciliation > Check Reports on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Check Reports from the menu bar. The 
Check Reports window displays (Figure 6.6).

Figure 6.6—Check Reports

2. Enter the required information according to Table 6.5 to define the contents of 
the report. 

Table 6.5—Check Reports Field Definitions

Field Valid Entry Definition

Bank range 1–10 characters The Use ID for the Financial Institutions account for which 
the checks were written.
• Press F1 for a list of Financial Institutions accounts 

associated with Payroll/Personnel.

Date range mm/dd/yyyy The range of dates for which the report is being produced.
Producing Reconciliation Check Reports 
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Status Use the following fields to define the checks that will be displayed, based on status.

• Outstanding I—Include
E—Exclude

Indicate if the results should include or exclude 
outstanding checks (items that have not yet cleared the 
bank statement). If you are including outstanding checks, 
you are asked to enter a second filter:
• * (Marked and Unmarked)—Include all checks that are 

marked and unmarked for reconciliation.
• M (Marked only)—Include only those checks that are 

marked for reconciliation.
• U (Unmarked only)—Include only those checks that are 

not marked for reconciliation.

• Reconciled I—Include
E—Exclude

Indicate if the results should include or exclude reconciled 
checks (items that have already been marked/posted for 
reconciliation).

• Unused I—Include
E—Exclude

Indicate if the results should include or exclude unused 
checks.

• Void I—Include
E—Exclude

Indicate if the results should include or exclude voided 
checks.

Type  *—All Pull both checks and Direct Deposits

C—Checks Pull only checks

E—Direct Deposit Pull only Direct Deposits

Sort by C—Check # order Sort by check number only

D—Date order Sort by date only

P—Payee order Sort by Payee name

Report accounts Y—Report account 
information

Display on the report the account number information

N—Do not report 
account information

Do not include the account information on the report

Table 6.5—Check Reports Field Definitions (Continued)

Field Valid Entry Definition
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3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system asks if you would like to file a report.

4. Type Y or press ENTER to produce the report (BRPROOF.L##). When the report 
has been produced, a message displays at the bottom of the window and the 
system asks if you would like to produce another report.

Type Y or press ENTER, the system returns you to the Bank field. Enter 
the required information for your report. The new report is appended to 
the existing report (BRPROOF.L##).

5. Type N or press ENTER to exit the task and close the window. 

DISPLAYING YOUR CHECKS
The last step in the bank reconciliation process is to view the list of checks for a specific 
bank or review checks written to an employee. The system displays information on the 
selected check (or checks) on the screen or over several screens (i.e., this is not a 
printable report). This information includes the reference number, check date, amount, 
and reconciliation status.

Checks will always be displayed in reference # order in this task. To see checks 
in different sort orders, use either the Enter Reconciliation or Run Check 
Reports tasks.

Use the following steps to display checks.

Page Break N—No page break No page break will occur except on page overflow

S—Page break on 
status

A new page will begin whenever the status changes

T—Page break on 
type

A new page will begin whenever the type changes

Report level S—Summary Only the check number, status, and amount will be on the 
report

D—Detail The detail items shown on the report are the check 
number, date, payee, amount, type, and status

Table 6.5—Check Reports Field Definitions (Continued)

Field Valid Entry Definition
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1.  Click Bank Reconciliation > Display Checks on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Display Checks from the menu bar. The 
task window displays (Figure 6.7).

Figure 6.7—Display Checks

2. Enter the required information according to Table 6.6. 

Table 6.6—Display Checks Field Definitions

Field Valid Entry Definition

Bank 1–10 characters The Use ID for the Financial Institutions account for which the 
manual check was written.
• Press F1 for a list of Financial Institutions accounts 

associated with Payroll/Personnel.
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3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The checks and direct deposits meeting the display criteria are 
displayed (Figure 6.8). 

Figure 6.8—Display Checks—Results

Status Use the following fields to define the checks that will be displayed, based on status.

• Outstanding I—Include
E—Exclude

Indicate if the results should include or exclude outstanding 
checks (items that have not yet cleared the bank statement). If 
you are including outstanding checks, you are asked to enter a 
second filter:
• * (Marked and Unmarked)—Include all checks that are 

marked and unmarked for reconciliation.
• M (Marked only)—Include only those checks that are 

marked for reconciliation.
• U (Unmarked only)—Include only those checks that are not 

marked for reconciliation.

• Reconciled I—Include
E—Exclude

Indicate if the results should include or exclude reconciled 
checks (items that have already been marked/posted for 
reconciliation).

• Unused I—Include
E—Exclude

Indicate if the results should include or exclude unused 
checks.

• Void I—Include
E—Exclude

Indicate if the results should include or exclude voided checks.

Table 6.6—Display Checks Field Definitions (Continued)

Field Valid Entry Definition
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4. Press ESC to end the display, type N to stop any pause in the display, or press 
ENTER to view any remaining checks. When the display is complete, you return 
to the Bank field.

5. Press ESC to display the option menu. The system asks for confirmation.

6. Type Y or press ENTER. The option menu displays.

7. Type E and press ENTER to exit the task and close the window.
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PRODUCING PAYROLL REPORTS

Payroll allows you to produce a variety of reports to suit the needs of your organization. 
Included with this module are a number of standard reports, or reports that have preset 
column headings. You have the ability to select the accounts and to decide what 
information to include in the report rows.
You can also modify any of the standard reports to meet your needs, or create a new 
report definition.

REPORT CATEGORIES
The Payroll/Personnel reports are divided into three categories:

• Master Record Lists—Reports of the current master records. These reports 
should be printed and saved in an offsite or fire-proof location. In the event of 
computer problems, you can use the hard copy of the report to recreate your 
master records.

• Predefined Reports—Summary or detail reports for selected parameters (e.g., 
date, Financial Institution, account number/mask).

• User-Defined Reports—You can use these reports as a model, customizing 
them to fit your payroll reporting needs.You may also create a totally new 
report; instructions are at the end of this chapter. 

PRODUCING PAYROLL/PERSONNEL REPORTS
Each Payroll/Personnel report lets you select and filter specific information. Because 
each report displays unique information, you will see different options for each.

1.  Click the report name on the HomePage. The parameter window displays. 
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You can also access the report through Report Manager: select File > 
Report Manager from the menu bar; and select Payroll/Personnel, the 
report category, and the report name; and double-click or click 
Produce.

The Produce Reports parameters window displays (Figure 7.1). The parameters 
will vary based on the report that you select. 

Figure 7.1—Produce Reports: Setup List

2. Complete the required report settings. Table 7.1 describes what options you 
may be displayed on the parameters window. The options are presented in 
alphabetical order. 

Table 7.1—Report Parameter Options

Option Entry Description

Account Mask Text box Enter the account or account mask to determine what accounts 
are included in the report. For more information on masks, see 
Using Masks on page 2.14. 

Accounting 
Information

Check box If you are printing detailed report information, you can include 
(check mark) or exclude (no check mark) the accounting 
information. (Applies to the Check History report only.)

Banks Radio buttons Select the applicable radio button to include all or a range of 
banks. 
• All—Includes entries assigned to all banks and entries not 

assigned to any bank (e.g., roll forward, history).
• Range—Includes only those entries assigned to banks within 

the selected range.
If you select Range, you must select the first (From) and last 
(To) banks of the range from the drop-down lists.
Producing Payroll/Personnel Reports 
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Check Status Select from 
drop-down list

Select the applicable check status to determine the checks to 
include in the report:
• All checks—Includes checks assigned to all banks and entries 

not assigned to any bank (e.g., roll forward, history).
• Normal checks
• Void checks
• Manual checks

Checks Select a radio 
button

Select the applicable radio button to include all or a range of 
checks. 
• All
• Range
If you select Range, you must enter the first (From) and last (To) 
checks of the range.

Collate Options Select a radio 
button

Indicate if the report should print checks in check number or 
system number order.

Data Items Select a radio 
button

Select the applicable radio button to include all or a range of 
data items. 
• All
• Range
If you select Range, you must select the first (From) and last 
(To) data items of the range from the drop-down lists.

Dates Select a radio 
button

Select the applicable radio button to include all or a range of 
dates. 
• All
• Range
If you select Range, you must enter the first (From) and last (To) 
dates of the range.

Employee 
Selector

Click Button Select employees to be included or excluded from the report.
User-defined reports will include all employees unless you filter 
employees using this selector.
Often you will use the Employee Selector to exclude terminated 
employees from your reports.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
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Formatted Text 
(Space 
Delimited (*.txt)

Check box If you select this option, the program will produce a .txt file 
instead of a Print Manager report (i.e., with an extension of L##, 
where ## represents the division number).
• This option inserts quotes (“) as the separator character and 

drops column titles.
• Generally, you will not need to use this option as the filed 

report in Print Manager is a text file that can be pulled into a 
variety of other software (e.g., Notepad or Excel).

Group or Report 
Name

Select a radio 
button

You can produce a single report or a group of reports. (This 
option is also used with report definitions, i.e., you can produce 
the definition of a single report or a group of reports.)
• Report
• Group
The default selection is Report.

• Report/Group 
text box

Text box The enabled text box reflects the radio button selection. Enter 
the applicable report name or group name in the enabled text 
box.
• Report Name—For user-defined reports, the default report 

name reflects the report that you selected in the list of reports. 
(No default displays when you select the User-Defined Report 
Definitions List.)

• Group Name—The program will produce all reports in the 
group. The same reporting date will be applied to all reports. 
By default, the Group name reflects the group of the report 
that you selected in the list of user-defined reports. Change 
this if necessary.

History From Radio buttons Select the source for the history information:
• Checks
• Timesheets

Page Break on 
Change

Check box Select the check box for the report to insert a page break at 
each change in the information (e.g., the report starts each new 
data item on a new page).
If you are going to select data items by which the report will be 
sorted (the Sort Items option), checking this will cause the 
report to page break at each change of the first Sort Item.
If the report has Print Break Totals enabled on the General tab 
of the report definition, a subtotal will also print at each page 
break.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
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Period Drop-down list Select the applicable period from which the report information 
will be drawn (e.g., Monthly total, Quarterly total, Beginning 
balance).

Report Select the 
applicable radio 
button.

Select the radio button for your desired report output:
• View—Saves a file (using the report name and the letter L 

plus the division name) in the report directory and displays the 
report in Print Manager.

• Print—Saves a file (using the report name and the letter L 
plus the division name) in the report directory and prints the 
report from your default printer.

• File—Saves a file (using the report name and the letter L plus 
the division name) in the report directory.

Report All Select one or 
more check 
boxes

Select one or more check boxes representing the historical data 
item type (or types) to include in the report.
• Earnings
• Taxes
• Deductions
• Other

Report From Select a radio 
button

Select the radio button representing the source of the report 
information:
• System (i.e., your division)
• ToolBox

Report Level Select a radio 
button

Select the radio button for the type of information to be included 
in the report.
• Summary
• Detailed

Report Type Drop-down list Select the type of report from the drop-down list. For example:
• Account/date/data item/employee detail
• Account/date summary
• Account/data item/employee summary

Reporting Date Text box 
formatted for 
date

Any date-dependent information in your report is in reference to 
this date. Enter the appropriate date. 
• Defaults to the current business date.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
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3. Click OK. Click Cancel to exit the Produce Reports window without creating 
the report.

See Appendix B—Sample Reports on page 2.225 for example parameter windows and 
reports.

CREATING A USER-DEFINED REPORTS
Payroll/Personnel provides you with a number of standard reports. The module also 
includes a number of “user-defined” reports, for which you can define the information, 
or columns, contained in them.
User-defined reports are employee-oriented and cannot include accounting information 
(you can use Account Distribution reports for that). You may use user-defined reports to 
gather information within a calendar year and compare prior year information for as 
many years as you keep on your computer. 
When you edit or copy a user-defined reports, you define the information that is printed 
in each of 26 columns, A–Z. Columns can include employee data item values or 
lookups, historical data item information for a specific period of time, calculated 
information that adds two or a range of columns, and subtracts, multiples or divides two 
columns, as well as blank worksheet columns that you may use to manually enter 
information.

Secondary Sort Radio buttons Select the second criterion for sorting the report information:
• Employee name
• Employee number

Select Items Check boxes Select one or more data items that the system will use to 
compile the report.

Sort Items Click Button If you do not indicate a sort order of the data items included in 
your report, the report will present employees in employee 
number order.
You should use a sort if you want Page Break and Print Break 
Totals.

Spreadsheet Check box Saves the file as a .TXT file, using quotes as separator 
characters.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
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Use the following steps to define a new report. 
1.  Select File > Report Manager from the menu bar. The Report Manager 

window displays.

2. Select Payroll/Personnel and the User-Defined Reports category.

3. Click New to set up your customized report. The Report Manager - Edit 
window displays, open to the General tab (Figure 7.2). 

Figure 7.2—Report Manager—Edit

4. Enter a unique 5-character report abbreviation (alphanumeric) in the Name text 
box. This report abbreviation will be used to create the file name in your report 
directory when you produce the report.

5. Enter the 40-character title of the report (alphanumeric) in the Title text box. 
This title will print on your report. 
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The system maintains the Source and Maintain entries. Also, the only option in 
the Report Type drop-down list is the default—User-defined reports. Therefore, 
you do not need to enter anything into these fields.

6. Enter a new Report Group or select an existing Report Group from the drop-
down list. The Report Group is not required; however, this option allows you to 
organize your new reports and print groups of reports with one step.

As you create your own Report Groups, those groups will display in the 
drop-down list. If you have not entered any Report Groups yet, the 
drop-down list will be empty.

7. Enter the total number of lines that can be printed on the page, including 
headings in the Lines per page text box. 

Most reports are printed with 6 lines per inch, so an 11-inch page has 66 
lines. To leave top and bottom margins of 1/2-inch each, enter 60 as the 
number of lines per page. Valid numbers go from 10 to 999.

8. Select the radio button for your Report Spacing: single- or double-spaced. (The 
default selection is single-spaced.)

9. Select one or more of the following Printing Options check boxes:

• Print Page Totals—Includes totals at the end of each page. 
• Print Break Totals—Includes totals each time the first sort item changes. 
• Print Report Totals—Includes totals at the end of the report.

You must select at least one of these options if you intend to include 
any totals in your report.

10. Click Apply to save your report settings (and remain in the report definition 
window).

You can save your report definition at anytime by clicking Apply. If 
you click OK, you will save the report definition and return to Report 
Manager (i.e., close the report definition window).
Creating a User-Defined Reports 
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11. Select the Columns tab to define the body of the report (Figure 7.3). 

Figure 7.3—Columns Tab

12. Click a Column Types button to add the associated column to the report. The 
column appears in the bar above and a pointer indicates the column position 
(Figure 7.4). 

Figure 7.4—Adding a Column Type to the Report

You can “click and drag” to reorder columns (i.e., click the column, 
hold the mouse button down, and move the column to the new 
position). You can also delete a selected (i.e., highlighted) column by 
clicking Delete.

Define the 
data 
parameters 
in this area.

by 
clicking 
a button 
here.

Add a 
column 
here
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Your report can have up to 26 columns.

13. Define the data you want included in the area on the right according to Table 
7.2, Table 7.3, and Table 7.3. Because access to the fields depends on the 
column type, the tables have been divided by column type. 

Table 7.2—Field Definitions for User-Defined Columns—Calculated Amount

Field Definition

Column Type The default entry is the type of column that you selected by clicking the button. 
However, you can change the column type if necessary by selecting from the drop-
down list.

Operation Select the first column of the calculation (first of two columns or first in a range of 
columns) from the drop-down list.
The existing columns defined “before” the current column (i.e., that display to the 
left of the current column) display. You can only define a calculation based on 
columns displayed before the calculation column.
• For example, if the current column is E, you could write a calculation based on 

columns A, B, C, or D, but not F, G, H, etc.

Select a mathematical operation from the drop-down list. Your options are:

• Plus • Times • Percentage of • Variance of

• Minus • Divided by • Sum thru

Select the second column of the calculation (second of two columns or last in a 
range of columns) from the drop-down list.
The existing columns defined “before” the current column (i.e., that display to the 
left of the current column) display. You can only define a calculation based on 
columns displayed before the calculation column.
• For example, if the current column is E, you could write a calculation based on 

columns A, B, C, or D, but not F, G, H, etc.

Print Column Select this check box if you want the column to print in the report. 
• You can “hide” a column in the report output. This option is very useful if you have 

information you want to use in a calculation (therefore, it must be in the report 
definition), but you don’t want the information to display in the report itself.

Width Enter the width of the column. Default width is 20 characters.
• Remember, the column width must be in relation to the report width, which has a 

maximum of 250 characters.
• This column is enabled only if you select the Print Column check box (i.e., you do 

not need to specify a column width if you are not printing the column in the report).
Creating a User-Defined Reports 
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Text Line 1 Enter the first line of the column title. The text defaults to the column type.

Text Line 2 If necessary, enter the second line of the column title. 

Table 7.3—Field Definitions for User-Defined Columns—Data Items

Field Definition

Column Type The default entry is the type of column that you selected by clicking the button. 
However, you can change the column type if necessary by selecting from the drop-
down list.

Data Item Select the historical or employee data item that you wish to display in this column 
from the drop-down list.
• When you select a data item, the Value From text box is enabled.

Value From Select the source of the data to be displayed in the report column. This date is 
relative to the report date entered when you produce the report, not the business 
date or the date you create the report definition.
The options will vary depending on the type of data item. For example, 

• Value of the data item • Value of lookup columns

• Monthly total • Beginning balance

If you select an employee data item, the value is based on the existence (or lack) of 
an edit value:
• If the data item does not have any edit values—The value is determined by what 

is entered for the EDI on the employee record.
• If the data item does have any edit values—The value is determined by the edit 

value name for the EDI entered on the employee record. The lookup is 
determined by the corresponding lookup column for the edit value entered on the 
employee record.

Extract Only enabled if the you have selected an HDI. Select the information to extract from 
the drop-down list (e.g., hours, amount).

Table 7.2—Field Definitions for User-Defined Columns—Calculated Amount (Continued)

Field Definition
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Year Only enabled if the you have selected an HDI. Enter the relative beginning year in 
the first text box. 
• The current year is 0. Last year would be –1, next year would be 1.

Only enabled if the you have selected an HDI. Enter the relative ending year in the 
second text box. 
• The current year is 0. Last year would be –1, next year would be 1.

Sum Column Use this option to sum the values in an EDI column. 

Count Column Use this option to count the number of occurrences of a value in an EDI column.

Print Column Select this check box if you want the column to print in the report. 
• You can “hide” a column in the report output. This option is very useful if you have 

information you want to use in a calculation (therefore, it must be in the report 
definition), but you don’t want the information to display in the report itself.

Width Enter the width of the column. Default width is 20 characters.
• Remember, the column width must be in relation to the report width, which has a 

maximum of 250 characters.
• This column is enabled only if you select the Print Column check box (i.e., you do 

not need to specify a column width if you are not printing the column in the report).

Text Line 1 Enter the first line of the column title. The text defaults to the column type.

Text Line 2 If necessary, enter the second line of the column title. 

Table 7.4—Field Definitions for User-Defined Columns—Worksheet Column

Field Definition

Column Type The default entry is the type of column that you selected by clicking the button. 
However, you can change the column type if necessary by selecting from the drop-
down list.

Separator You can leave this field blank or you can enter a character to help define the 
boundaries of the column.
• The pipe sign (|) is commonly used as a separator character.

Table 7.3—Field Definitions for User-Defined Columns—Data Items (Continued)

Field Definition
Creating a User-Defined Reports 
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14. When you have completed your report definition, click OK to save the 
definition and return to Report Manager. The report is added to the list of User-
Defined Reports. 

TIPS—REPORTS THAT CROSS FISCAL YEARS

• It is helpful to sketch a user-defined report that crosses fiscal years before 
creating the definition in Report Manager.

• A user-defined report setup to cross a fiscal year makes full use of the Year and 
Period options for HDI columns. 

• A user-defined report that crosses fiscal years must be designed:
— With one column for the months of the fiscal year that fall in the current 

calendar year, and
— One (or more) columns for the months of the fiscal year that fall in the prior 

calendar year
• Each time the report is produced, the Report Date must be the last period of the 

fiscal year, to preserve the relativity of the Year and Period for the prior 
calendar year columns.

Print Column Select this check box if you want the column to print in the report. 
• You can “hide” a column in the report output. This option is very useful if you have 

information you want to use in a calculation (therefore, it must be in the report 
definition), but you don’t want the information to display in the report itself.

Width Enter the width of the column. Default width is 20 characters.
• Remember, the column width must be in relation to the report width, which has a 

maximum of 250 characters.
• This column is enabled only if you select the Print Column check box (i.e., you do 

not need to specify a column width if you are not printing the column in the report).

Text Line 1 Enter the first line of the column title. The text defaults to the column type.

Text Line 2 If necessary, enter the second line of the column title. 

Table 7.4—Field Definitions for User-Defined Columns—Worksheet Column (Continued)

Field Definition
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• Figure 7.5 shows how you can sketch out the relative periods for your report. 

Figure 7.5—Example Relative Period Offset

EDITING A USER-DEFINED REPORT

Use the following instructions to edit any user-defined report to meet the needs of your 
organization. 

1.  Select the user-defined report that you wish to edit.

2. Click Edit. The Report Definition window displays the settings of the report.

3. Modify the report definition as necessary. Refer to Creating a User-Defined 
Reports on page 2.144 for further explanation of the report definition fields.

4. At any time, click Apply to save the report and remain in the report definition 
window. When you have completed the report definition, click OK to save the 
report and return to Report Manager. 

PRODUCING THE DISTRIBUTION AFTER NET CALCULATIONS REPORT
The Distribution After Net Calculations report allows you to create a sorted distribution 
report in account dimension(s) order after net calculations and before check production. 
This report contains account distribution information sorted by a dimension or group of 
dimensions from the account structure for employees of a check run in process.
Before you can create the Distribution After Net Calculations report, you must adjust 
the Payroll Account Distribution Report Parameter.

ADJUSTING THE PAYROLL PARAMETER

Use the following steps to adjust the payroll parameter.

Jan Apr May June July Aug Sept Oct Nov DecMarFeb

–9 –6 –5 –4 –3 –2 –1 +1 +2–7–8

This figure shows the relative offsets for a reporting date in October. You would combine these period 
numbers with relative years to determine your reporting period. For example:

December of the previous year would be relative year –1, relative month +2.
March of the next year would be relative year +1, relative month –7.
June of the current year would be relative year 0, relative month –4.
Producing the Distribution After Net Calculations Report 
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1.  Click Setup > Acct Distribution Rpt Param on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Setup > Acct Distribution Rpt Param from the menu bar. The 
Account Distribution Report Parameter displays (Figure 7.6). 

Figure 7.6—Example Account Distribution Report Parameter

2. Type C to change the parameter.

3. Use the ENTER or arrow keys to access Level 5.

4. Enter the report information according to Table 7.5. 

Table 7.5—Parameter Field Definitions

Field Definition

ID Type Enter the ID type for which you will create this report.

Break Enter the dimensions for which the report will break (i.e., sort information).

Dsc By default, the report information is pulled from Descriptive accounts. Press F1 to 
see a list of alternate settings.

Report Enter the dimensions for which the report will create a secondary summary (i.e., a 
subtotal). This must be one of the dimensions included in the break section.
• Note: This design varies from other FundWare distribution report formats.

Act By default, the accounts included in the report will be printed in standard format. 
Press F1 to see a list of alternate settings.
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5. When complete, press ENTER to save the parameter changes. Figure 7.7 shows 
an example that will create a new page for each dimension 1–2 (fund–
department) combination, and subtotals for each unique dimension 1 (fund). 

Figure 7.7—Example Account Distribution Report Parameter

6. Type E to exit this task and close the window.

Dsc By default, the account descriptions included in the report will be printed in 
standard format. Press F1 to see a list of alternate settings.

Sub By default, the account descriptions included in the report will be printed in 
standard format. Press F1 to see a list of alternate settings.

Table 7.5—Parameter Field Definitions (Continued)

Field Definition
Producing the Distribution After Net Calculations Report 
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PRODUCING OTHER REPORTS
There are a number of additional Payroll reports that are produced using Classic 
windows (Table 7.6). 

The following sections provide instructions for producing these reports.

PRODUCING THE DAILY EARNINGS REPORT

Use the following instructions to produce the Daily Earnings Report.

Table 7.6—Classic Reports

Table Title Category

Daily Earnings Predefined Reports

Employee Change Log Predefined Reports

Calculations List Master Records Lists

Check Formats List Master Records Lists

EFT Form Formats List Master Records Lists

Direct Deposit Parameters List Master Records Lists

Distribution Tables List Master Records Lists
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1.  Click Reports > Predefined Reports > Daily Earnings on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Predefined Reports > Daily Earnings 
from the menu bar. The first page of the report parameters task displays (Figure 
7.8). 

Figure 7.8—Daily Earnings Report Parameters—Page 1 of 2

2. Complete the required fields according to Table 7.7. 

Table 7.7—Daily Earnings Report—Page 1 Definitions

Field Options Definition

Date Range valid 
date

Enter a valid range of dates for the report. Only information in this date 
range is included in the report.

Select Items Valid 
data item

Enter up to three earnings historical data items that the system will use to 
compile the report.
• Leave the field blank to include all data items in the report.

Sort Items Valid 
data item

Enter an employee data item (or press F1 to select from a list of data 
items). The system will use the data item to sort the report.
If you do not indicate a sort order of the data items included in your report, 
the report will present employees in employee number order.
You must enter a data item in this field if you want page break totals.

Page break Y
N

Select Y for the report to insert a page break at each change in the change 
of the Sort Item information (e.g., the report starts each new data item on a 
new page).
Producing Other Reports 



Chapter 7—Producing Payroll Reports
3. Press ENTER or PAGE DOWN to move to the next field (Figure 7.9). 

Figure 7.9—Daily Earnings Report Parameters—Item Selection

4. Enter the order number for the item selection and press ENTER. (This number 
simply helps you organize your entries, it is not used in the report.) The second 
page of the Daily Earnings report parameters window displays (Figure 7.10). 

Figure 7.10—Daily Earnings Report Parameters—Page 2 of 2

5. Enter the first and last values to filter the information in the report, and indicate 
if these records are included or excluded.

6. Continue entering items until complete.
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7. When complete, press ESC to display the option menu.

8. Type E to end the session 

9. Type 0 to accept your entries.

10. Press ENTER to file a report (accepting the Yes option). The report 
(PYDEARN.L##, where ## represents your division number) is created and 
saved to your Reports folder and you are asked if you would like to create 
another report.

11. Type Y to create another Daily Earnings report or N exit the task and close the 
window.

12. Access the report through Print Manager (Figure 7.11). 

Figure 7.11—Example Daily Earnings Report

PRODUCING THE EMPLOYEE CHANGE LOG

Use the following instructions to produce the Employee Change Log. The Payroll 
Parameter must be defined to save employee change information (field 2—Log 
employee maintenance) to produce this report.
Producing Other Reports 
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1.  Click Reports > Predefined Reports > Employee Change Log on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Predefined Reports > Employee 
Change Log from the menu bar. The report parameters window displays 
(Figure 7.12). 

Figure 7.12—Employee Change Log Parameters—Page 1 of 1

2. Complete the required fields according to Table 7.8. 

Table 7.8—Employee Change Log—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Date Range valid 
date

Enter a valid range of dates for the report. Only information in this date 
range is included in the report.

Spreadsheet Y
N

If you enter Y, the system saves the file as a .TXT file, using quotes as 
separator characters.
Blackbaud, Inc. 2.159



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.160
3. When complete, press ESC to display the option menu.

4. Type E to end the session 

5. Type 0 and press ENTER to accept your entries. The report (PYSESS.L##, where 
## represents your division number) is created and saved to your Reports folder 
and you are asked if you would like to create another report.

6. Type Y to create another Employee Change Log or N to exit the task and close 
the window.

7. Access the report through Print Manager (Figure 7.13). 

Figure 7.13—Example Employee Change Log

Data Items All or a 
valid 
range

Accept the default entry (includes all employee data items) or enter a range 
to include only the specified employee data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.

User Range All or a 
valid 
range

Accept the default entry (includes changes made by all employees) or 
enter a range to include only the changes made by specific employees. 
If you select Range, you must enter the first (From) and last (To) employee 
numbers of the range.

Table 7.8—Employee Change Log—Field Definitions (Continued)

Field Options Definition
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PRODUCING THE CALCULATIONS LIST

Use the following instructions to produce the Calculations List.
1.  Click Reports > Master Report Lists > Calculations List on the module 

navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Master Report Lists > Calculations 
List from the menu bar. The report parameters window displays (Figure 7.14). 

Figure 7.14—Calculations List—Page 1 of 1

2. Enter a range of data items to include in the report, or accept the defaults to 
include all data items.

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYCALC.L##, 
where ## represents your division number) is created and saved to your Reports 
folder and you are asked if you would like to create another report.

5. Type Y to create another Calculations List or N to exit the task and close the 
window.
Blackbaud, Inc. 2.161



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.162
6. Access the report through Print Manager (Figure 7.15). 

Figure 7.15—Example Calculations List

PRODUCING THE CHECK FORMATS LIST

Use the following instructions to produce the Check Formats List.
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1.  Click Reports > Master Report Lists > Check Formats List on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Master Report Lists > Check Formats 
List from the menu bar. The report parameters window displays (Figure 7.16). 

Figure 7.16—Check Formats List—Page 1 of 1

2. Complete the required fields according to Table 7.9. 

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYFORM.L##, 
where ## represents your division number) is created and saved to your Reports 
folder and you are asked if you would like to create another report.

5. Type Y to create another Check Formats List or N to exit the task and close the 
window.

Table 7.9—Check Formats List—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Data Items All or a 
valid 
range

Accept the default entry (includes all data items) or enter a range to include 
only the specified data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.
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6. Access the report through Print Manager (Figure 7.17). 

Figure 7.17—Example Check Formats List

PRODUCING THE EFT FORM FORMATS LIST

Use the following instructions to produce the EFT Form Formats List.
Producing Other Reports 
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1.  Click Reports > Master Report Lists > EFT Form Formats List on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Reports > Master Report Lists > EFT Form 
Formats List from the menu bar. The report parameters window displays 
(Figure 7.18). 

Figure 7.18—EFT Form Formats List—Page 1 of 1

2. Complete the required fields according to Table 7.10. 

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYEFTFM.L##, 
where ## represents your division number) is created and saved to your Reports 
folder and you are asked if you would like to create another report.

Table 7.10—EFT Form Formats List—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Data Items All or a 
valid 
range

Accept the default entry (includes all data items) or enter a range to include 
only the specified data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.
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5. Type Y to create another EFT Form Formats List or N to exit the task and close 
the window.

6. Access the report through Print Manager (Figure 7.19). 

Figure 7.19—Example EFT Form Formats List

PRODUCING THE DIRECT DEPOSIT PARAMETERS LIST

Use the following instructions to produce the Direct Deposit Parameters List.
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1.  Click Reports > Master Report Lists > Direct Deposit Parameters List on 
the module navigator (if the module is not expanded, click Payroll/Personnel 
first) or select Payroll/Personnel > Reports > Master Report Lists > Direct 
Deposit Parameters List from the menu bar. The report parameters window 
displays (Figure 7.20). 

Figure 7.20—Direct Deposit Parameters List—Page 1 of 1

2. Complete the required fields according to Table 7.11. 

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYEFTS.L##, where 
## represents your division number) is created and saved to your Reports folder 
and you are asked if you would like to create another report.

Table 7.11—Direct Deposit Parameters List—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Data Items All or a 
valid 
range

Accept the default entry (includes all data items) or enter a range to include 
only the specified data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.
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5. Type Y to create another Direct Deposit Parameters List or N to exit the task and 
close the window.

6. Access the report through Print Manager (Figure 7.21). 

Figure 7.21—Example Direct Deposit Parameters List

PRODUCING THE DISTRIBUTION TABLES LIST

Use the following instructions to produce the Distribution Tables List, which lists the 
details of your distribution tables.
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1.  Click Reports > Master Record Lists > Distribution Tables List on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Reports > Master Record Lists > Distribution 
Tables List from the menu bar. A confirmation message displays (Figure 7.22). 

Figure 7.22—Distribution Tables List—Confirmation Message

2. Press ENTER to produce a report (accepting the Yes option). A second 
confirmation message displays asking if you want to file the report.

3. Press ENTER to file a report (accepting the Yes option). The report 
(PYSTDST.L##, where ## represents your division number) is created and 
saved to your Reports folder and you are asked if you would like to create 
another report.

4. Type Y to create another Distribution Tables List or N to exit the task and close 
the window.
Blackbaud, Inc. 2.169



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.170
5. Access the report through Print Manager (Figure 7.23). 

Figure 7.23—Example Distribution Tables List

PRINTING REPORTS
Report Manager lets you send Payroll/Personnel reports directly to your printer. You 
can also print reports from the Preview window or from the FundWare Print Manager.

PRINTING DIRECTLY TO YOUR PRINTER

Use the following steps to print directly to your default printer.
1.  Click the report name on the HomePage. The parameter window displays. 

You can also access the report through Report Manager: select File > 
Report Manager from the menu bar; and select Payroll/Personnel, the 
report category, and the report name; and double-click or click 
Produce.

The report parameters window displays.

2. Set the any filtering options you want for the report. See Producing Payroll/
Personnel Reports on page 2.139.

3. Select the Print check box in the Output To section of the window.

4. Click OK. The report is sent to your Windows default printer.
Printing Reports 
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When Master Record List and Predefined Reports print, they append to 
previously-generated copies stored in Print Manager. Each time you run an 
Employee Master List, for example, it adds to the existing one. If you do not 
want this to occur, delete previous versions of reports from Print Manager 
before running a report.

PREVIEWING REPORTS

Report Manager lets you preview reports on-screen. From the preview window you can 
print reports or export them as files in different formats.

1.  Click the report name on the HomePage. The parameter window displays. 

You can also access the report through Report Manager: select File > 
Report Manager from the menu bar; and select Payroll/Personnel, the 
report category, and the report name; and double-click or click 
Produce.

The report parameters window displays.

2. Set any filtering options you want for the report. See Producing Payroll/
Personnel Reports on page 2.139.

3. Select the Preview check box in the Output To section of the window.

4. Click OK. The report opens in the Print Preview window.

If you do not have a default printer selected for the computer, you will 
receive an error message.
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OPENING PRINT MANAGER

The FundWare Print Manager allows you to view, delete, print, format reports, and 
search for text. To access Print Manager, select File > Print Manager on the menu bar. 
Print Manager launches, displaying the Open dialog box (Figure 7.24). 

Figure 7.24—Opening Print Manager

Refer to the Blackbaud FundWare Print Manager Guide for detail information and 
instruction regarding Printing and the Print Manager Setup Wizard.

EXPORTING REPORT INFORMATION
All FundWare reports, including standard reports, trace reports, even check files, are in 
ASCII format. ASCII is a generic format that most spreadsheet or work processing 
programs can read. You can bring any of your FundWare reports into your favorite work 
processor or spreadsheet and modify them there. 

1.  Produce the report. 

2. Note the name and location of your report (i.e., the file name that you use to 
open the file through Print Manager). 
Exporting Report Information 
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For example, the trial balance is called GLTRBAL.L02 for division 02. 
By default, this report is saved as an ASCII formatted file in your 
FundWare > Data folder. 

3. Using the secondary software program of your choice (e.g., Excel), select File > 
Open to open the FundWare report file.

4. The secondary software may display a “Wizard” to guide you through the 
process of importing and formatting the file. Follow these instructions.
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PAYROLL 941 REPORT AND FORM

The new Payroll 941 Report will allow an organization to create a quarterly  report for 
submission  and is produced on the approved Federal 941 Form through Forms 
Manager.
Dollar amounts are extracted from the Fundware Payroll history files to the report.  
There is a modification program that will allow the user to edit any fields that are needed 
to complete the form.
On initial Setup and subsequent production of the report the following steps will be 
involved:

• "Define Parameter Record
• "Extract 941 Information
• "Modify Fields as necessary
• "Produce the Form for printing in Forms Manager
• "Print the Form through Forms Manager

REPORT SETUP
To define the 941 report, use the Navigator Bar Item, 941 Processing > Define 941 
Report Parameter.
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Figure 8.1—941 Report Parameter

You can also access the Report Parameter programs via the toolbar.
Report Setup 6
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Figure 8.2—941 Report Toolbar

The first time you enter this program, you must do to an A) Add to set up the Report 
Parameter. The information in this parameter can be modified as needed through the C) 
Change function, once it is defined.
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Figure 8.3—Define Parameter Entry

Figure 8.4—Define Parameter Screen 1
Report Setup 8
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The Report Name Defaults to 941.

Figure 8.5—Define Parameter Screen 2

Table 8.1—Define Parameter Screen 1 Fields

Field Definitions and Placement on 941 Form

1) Payer Info Enter the Federal EIN and Employer name and address as it will 
appear on the 941 form Page 1.

2) Deposit state Enter the state abbreviation for the state where you made your 
deposits OR enter "MU" if you made your deposits in multiple 
states.
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Table 8.2—Define Parameter Screen 2 Fields

Field Definitions and placement on 941 Form

3) History Data Items The Payroll Historical Data Item Names from which to pull the 
wages and taxes. These data items are used for both the quarterly 
and monthly calculations on the form.
It is the Basis Amount on the Data Item that is being Extracted

Federal Press F1 and select the data item where you store your Federal 
withholding, normally .FWT.

Fica Press F1 and select the data item where you store the Fica taxes, 
normally .FICA.

Tips Press F1 and select the data item where you store tips, or leave 
the field blank.

Medicare Press F1 and select the data item where you store Medicare 
taxes.

EIC Advance Press F1 and select the data item where you store eic or leave 
blank.

4) Checkboxes Answer Y if  any of the numbered boxes need to have a check in 
Them otherwise leave the default of N.

Monthly deposit Y will X the box that states “You were a monthly schedule 
depositor for the entire quarter. The monthly tax liablility for the 
form can be input later in the “Edit Extracted 941 Data” step.

Semi-wk deposit A Y will X the Box that states “You were a semiweekly schedule 
depositor for any part of this quarter.”

Business closed A Y will X the Box on that states “If your business has closed or 
you stopped paying wages.”

Seasonal emplr A Y will X the Box that states “If you are a seasonal employer and 
you do not have to file a return for every quarter of the year.”

Designee - Y/N A Y will X the box as a Yes to “May we speak with your third-part 
designee?”  An N will X the No box.

Self-Employed Check if you are self-employed.
Report Setup 0
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Figure 8.6—Define Parameter Screen 3

Table 8.3—Define Parameter Screen 3 Fields

Field Definition and placement on 941 Form

5) Designee Info

Name Enter the name of a third-party Designee, or leave blank
The name if entered will appear on Part 4 of the 941 form

PIN Enter a 5 digit PIN used when talking with the IRS
The PIN will appear on Part 4 under the Designee’s Name

6) Signature Info The data entered will appear on Part 5 of the 941 Form

Name The entered name will appear in the “Print your name here” box.

Title The Title will appear in the “Print your title here” box.

Logo path If you have an image file with a signature, enter the file path to its 
location, otherwise leave blank and sign the form manually.
The electronic signature will be printed on the form next to “Sign 
your name here”.
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Figure 8.7—Define Parameter Screen 4

Date Enter the date of the form for Part 5

Phone Enter a phone to print in part 5 next to “best daytime phone”
Phone number may be entered as a full number string without 
dashes.

Table 8.4—Define Parameter Screen 4 Fields

Field Definitions and placement on 941 Form

7) Preparer info This section applies to Paid Preparers only. It should be left blank 
if it does not apply.

Name Enter the name of the Paid Preparer.

Firm name Enter Firm name of Paid Preparer or leave blank.

Table 8.3—Define Parameter Screen 3 Fields

Field Definition and placement on 941 Form
Report Setup 2
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Address Enter the address of the paid preparer or leave blank.

City Enter the city of the paid preparer or leave blank.

State Enter the State of the paid preparer or leave blank.

Zip Enter the zip code of the paid preparer or leave blank.

Date Enter the date the paid preparer signed or leave blank

Phone Enter the phone of the paid preparer.
Phone number may be entered as a full number string without 
dashes.

EIN Enter the Employer Identification number of the paid preparer or 
leave blank.

PTIN Enter the SSN or PTIN of the paid preparer or leave blank.

8) Misc info

Final date Enter the final date you paid wages if the business has closed or 
you stopped paying wages.  Otherwise leave blank.

Table 8.4—Define Parameter Screen 4 Fields

Field Definitions and placement on 941 Form
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Figure 8.8—Exiting the Define Parameter Screen

Once the screen has been completely filled out, select 0 to accept.  You may then 
perform a C)hange to make corrections  or E)nd to exit the screen as above.

REPORT DATA EXTRACTION
To extract data, use the Navigator Bar Item, 941 Processing > 941 Data Extraction.
Report Data Extraction 4
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Figure 8.9—941 Data Extraction

You can also access the Data Extraction programs via the toolbar.
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Figure 8.10—Extracting 941 Data

Table 8.5—Extracting 941 Data Fields

Field Definition and Placement on 941 Form

1) Report year The 4 digit report year for which the report is being generated.
This determines which history will be pulled from Fundware 
Payroll.

2) Report quarter The Quarter being reported  (1 – 4)
This determines which history quarter will be pulled from 
Fundware Payroll.

3) Total deposits The dollar amount of the total tax deposits that have been made 
for the quarter.

4) Refund The refund option is used to determine which checkbox, if any, to 
use for the overpayment amount.
                Spaces = not applicable
                A = Apply to next return 
                S = Send a refund.
Report Data Extraction 6
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Figure 8.11—Accepting the extraction screen

Accept the screen with (0 to accept), if necessary, C)hange or  E) to end, and the initial 
941 extraction  file will be created.

The extraction files are named ##PY9 and ##PY9.IDX, where ## = Division 
number, and will be in the Fundware\data   directory.

REPORT MODIFICATION
To edit data for the 941 report, use the Navigator Bar Item, 941 Processing > Edit 
Extracted 941 Data.

5) COBRA pd 65% 65% of COBRA you paid for eligible individuals

6) # of COBRA indv Number of individuals provided COBRA premium assistance

Table 8.5—Extracting 941 Data Fields

Field Definition and Placement on 941 Form
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Figure 8.12—Edit Extracted 941 Data

You can also access the Edit Extracted 941 Data programs via the toolbar.
Report Modification 8
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Figure 8.13—Display or Change command to edit data

Figure 8.14—Displaying screen 2 of the extracted 941 data
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By doing a D)isplay the data extracted can be viewed. A C)hange will allow changing 
data in any of the visible fields.
When in the screen this program brings up, any of the fields can be modified to 
overwrite the fields pulled from the initial parameter or  to modify dollars amounts if 
needed.
The dollar amounts pulling can be verified by running employee history by period 
reports within Fundware Report Manager.  These reports, if run for the same months or 
quarters as on the 941 report,  will show both the dollars on individual employees and 
totals at the end of the history report that will correspond to the amounts on the 
produced 941 Report.  The reports can be accessed through Report Manager> Payroll> 
Predefined Reports> Employee History by Period.

PRODUCE 941 FORM
To produce the form for the 941 Report, use the Navigator Bar Item, 941 Processing > 
Produce 941 Report.
Produce 941 Form 0
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Figure 8.15—Produce 941 Report

You can also access the Produce 941 Report programs via the toolbar.
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Figure 8.16—Producing the form

Answer Y)es to produce the form.
Produce 941 Form 2
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Figure 8.17—Exiting 941 Production

At “Do you want another report? Answer N)o and the screen will return to System 
Utilities.
Producing the form also creates a verification print, with the name of PY941VR.L## 
where ## equals the Division Number.  This can be opened through Print Manager and 
appears in Figure 8.18 and Figure 8.19.
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Figure 8.18—Page 1 of the 941 Verification Report
Produce 941 Form 4
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Figure 8.19—Page 2 of the 941 Verification Report.

PRINTING THE 941 FORM
From within your Fundware Division, or through Division 00 Access the Forms 
Manager through File>Forms Manager.
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Figure 8.20—Accessing Forms Manager

Select File> Open, or the Open Icon and you will see a file named PY941FM.X## 
where ## is the division number for which the report was produced.  Highlight the File 
and open it.
Printing the 941 Form 6
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Figure 8.21—Forms Manager File Display

On opening the Form, you will receive a message that reads:

Figure 8.22—Forms Manager Message

Press OK.
You can then use any of the available navigation tools within Forms Manager.  The 
form is only 2 pages, so the options are limited
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Figure 8.23—941 Form in Forms Manager

If any changes are needed at this point, use the “Edit Extracted 941 Data” 
to edit any field appearing on those screens. If modifications are needed 
to a name or address field, which do not appear in the edit screens, they 
must be made in the “Define 941 Report Parameter” and the data will 
need to be extracted again. When the 941 form is reproduced, the original 
form will be overwritten, so there will never be more than 2 pages.

RECAP OF PROGRAMS FOR 941 FORM
SETUP PARAMETER

EXTRACT 941 DATA

MODIFY 941 DATA
Recap of Programs for 941 Form 8
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PRODUCE 941 FORM
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 Recap of Programs for 941 Form 0
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MTRS PAYROLL RETIREMENT REPORTS

The new Payroll Retirement Report for the State of Massachusetts will allow an 
organization to create an electronic file for submission to MTRS.
The programs are designed for the Teachers Retirement Report for the State of  
Massachusetts, and meets the Massachusetts MTRS specifications.
On initial Setup and Production of the report the following steps will be involved:

• "Define Parameter Record (this is on initial setup only)
• "Extract employee data
• "Edit Extracted Employee Information
• "Produce Electronic File

REPORT SETUP

To define the Retirement Report, use the Navigator Bar Item, Retirement Processing > 
Define Retirement Paramenter.
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Figure 9.1—Define Retirement Parameter

You can also access the Define Retirement Parameter programs via the toolbar.
 2
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Figure 9.2—Retirement Report Toolbar

The first time you enter this program, you must do an A) Add to set up the Report 
Parameter. The default name of the Parameter will display as MA1S.

• "Any fields that are not filled out will have to be edited as needed in later steps. 
Blackbaud Fundware users that are in Massachusetts will have user-defined 
employee data items on their employee records. 
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Figure 9.3—Parameter Definition Screen 1

Table 9.1—Parameter Definition Screen 1

Field Description

1) Agency Enter the school district four-digit agency code assigned by the 
MTRS. 
If the report is being produced for other purposes, this field may be 
ignored.

2) MTRS eligible Enter the data item used on your system to indicate an employee 
should appear on this report.
Pressing F1 will show a list of data items currently available on 
your system.
 4
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Figure 9.4—Parameter Definition F1 key

Figure 9.5—Parameter Definition Screen 2
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The following definitions have been provided for the Massachussetts report.
SCHOOL ID     The School building location code assigned by the DOE

RATE CODE     Identifies the contribution rate in the record being reported. 
Valid entries on the data item that will be stored and extracted are 05, 07, 08, 09 
or 11.

CONTRACT TERM      The length of the contract, expressed in months, 
covering the member whose deductions are being reported. Valid entries are 09, 
10, 11 and 12. To report payments made to an athletic coach who teaches in 
another district, enter 09 in this field.

PAY DURATION   Pay Duration of the contract for the member being 
reported. Valid values are 09, 10, 11, 12 and LS to indicate the length of time, 
in months, over which the member's contract is paid. The "LS" value is entered 
for members on a 12-month contract cycle, but who collect their summer pay as 
a lump-sum in month 10. 

PAY FREQUENCY     The annual frequency that pay is issued; valid entries 
are 01-53. A member who receives pay every week would have a pay 
frequency of 52. Teachers who receive pay on a bi-weekly schedule usually 
have a pay frequency of 26. 

STATUS   Full-time/part time status. The percentage of full-time the member 
being reported is working; field is 3-digit numeric; full-time is entered as "100"; 
part-time entries are usually "050" through "099". While employees who are 
working less than half-time ("050") are ineligible for MTRS membership, it is 
sometimes necessary to report less than half-time values in this field when a 
member is working in more than one school district. Note that the value listed 
in the annual salary field should show the full-time equivalent salary for 
members who are working and being paid on a part-time basis. 

SALARY     The base annual contractual salary for the member being reported, 
exclusive of any additional compensation (often referred to as "step and 
scale"). This field must be updated whenever a member's salary 
changes. Additional compensation such as coaching pay or stipends must not 

Table 9.2—Parameter Definition Screen 2

Field Description

3) Data items-employee Pressing the F1 key will again show a list of the data items 
available in your payroll system for extraction.
 6
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be included in the annual salary figure. For members who are working less than 
full-time, this should be the full-time equivalent salary. In the monthly 
deduction report the salary figure must conform to the following equation 
where, b = base earnings n = number of pays being reported f = pay frequency 
p = full time factor expressed as a whole number S = annual salary S = [(b/n)f]/
[p (0.01)] 

POSITION The member’s genetic position code derived from an MTRS-
defined table; the valid entries in this field are: SUPT  Superintendent  TEACH   
Teacher  TEACH6  Teach - 6 month wait  COACH  Coach (as primary title)  
ADMIN   Administrator  PRIN   Principal  OTHER  Other LTS Long-term 
substitute NURSE School Nurse

GRANT PCT This field indicates the percentage of the member's eligible 
retirement earnings that are derived from federal grant funds. The field accepts 
values from 1 to 100 and defaults to "0" if no input is provided. A "0" is read by 
the system as "no federal grant component in effect".

CERT NUMBER This is the teacher's certification number issued by the 
Department of Education, or the Board of Allied Health Professionals in the 
case of physical therapists or occupational therapists. Other valid entries in this 
field are: P (certification Pending), C (Charter school - no certification number 
necessary), W (Waiver of certification), P2 (member is working with out-ofstate 
certification).

CERT ISSUER Valid entries are DOE (Department of Education) or AHP 
(Board of Allied Health Professionals).

CERT ISSUE DATE The actual date certification was issued.

DED START DATE The date of the first retirement deduction.
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Figure 9.6—Parameter Definition Screen 3

The following fields are pulling from historical data items which contain 
earnings information for the reporting period.

BASE EARN    Contractual base earnings actually paid to the member during 
the reporting period; the sum reported as base earnings should equal the 
contracted annual salary divided by the annual pay frequency, multiplied by the 
number of pay periods being reported.  

Table 9.3—Parameter Definition Screen 3

4) Data items-history
 8
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COACH EARN     Earnings over and above base earnings paid for athletic 
coaching at such times as they occur. In order to be eligible to participate in the 
system, coaches must be employed and enrolled as teachers. It is common for 
districts to employ coaches who teach at other districts.

BONUS EARN     Earnings paid as cost-of-living bonus. Some employers 
refer to this category of pay as a cost-of-living adjustment. 

LONGEVITY EARN     Earnings paid for longevity. Sometimes this is 
referred to as longevity bonus.

STIPEND EARN     Additional earnings paid as contractual stipends reported 
when they occur; e.g., Choral Director, Department Head, Lead Teacher, 
etc. Per diem earnings for guidance counselors whose contract requires them to 
work extra days are reported in this field if the extra pay is determined to be 
eligible for retirement deductions.

PREMIUM EARN    Premiums paid by the employer for individual life 
insurance, disability earnings insurance or annuity (403b) contracts, when they 
occur. Frequently found in administrator's contracts, these are usually 
deductions from payments that are submitted directly to the insurance provided 
(see section on regular compensation). 

RETR DEDUCTION     The retirement contribution actually deducted for the 
member reported in this record. This is calculated as a percentage of the sum of 
all eligible earnings reported in the previous earnings fields. The deduction 
rates are: 5% for members who entered service prior to January 1, 1975 7% 
for members whose eligible employment began between January 1, 1975 and 
December 31, 1983 8% for members with membership dates between January 
1, 1984 and June 30, 1996 9% for members who established membership 
between July 1, 1996 and June 30, 2001 11% for members who entered service 
on or after July 1, 2001 11% for members who entered service on or before 
June 30, 2001 and elected to participate in RetirementPlus 

RETR DED 2PC     The "30-plus" contribution deducted for the member 
reported in this record. Members subject to this deduction contribute an 
additional 2% of all earnings over $30,000 per year. This additional deduction 
applies to members with membership dates between January 1st 1979 and June 
30th 2001 who have not elected to participate in RetirementPlus. When the 
system determines that a member is subject to the additional 2% withholding, it 
carries out a validation where: e = total eligible earnings being reported n = 
number of pays in the period being reported f = pay frequency T = additional 
2% deduction amount T = {e - [(30000/f) n]}(.02) 
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REPAY     Reserved for reporting pre-tax installment payments in the 
deduction record. Must be combined with a normal contribution input record.

RETIREMENT DATA EXTRACTION
To extract data to the Retirement Report, use the Navigator Bar Item, Retirement 
Processing > Retirement Data Extraction.

Figure 9.7—Extraction Program

You can also access the Retirement Data Extraction programs via the toolbar.
Retirement Data Extraction 0
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Figure 9.8—Extraction Program Report Month and Year

As this program prompts for the month and year of the report, only those paychecks 
within the selected period will be extracted.  This program creates the ##PY4 file where 
## is your division number.  This file can be located in your data directory and is only 
used to hold the extracted data.  The editing program as follows is what is used if 
corrections are needed.
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Figure 9.9—Extraction Program Change or End

Once you have input the Report month and year, you will have the option C) to change 
or E) to End.  Select E if you are ready to extract

DEFINE AND EDIT EMPLOYEE DATA
To edit the extracted data, use the Navigator Bar Item, Retirement Processing > Edit 
Extracted Retirement Data.
Define and Edit Employee Data 2
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Figure 9.10—Edit Extracted Data 

You can also access  Edit Extracted Retirement Data via the toolbar.

The S) Scroll selection may be used to see all the employees that have been extracted.
C) Change will allow selection of the Employee, the Trans type (currently always “N”) 
and the Trans date, or date of the paycheck.
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Figure 9.11—Display or Edit Extracted Data Screen 1

Figure 9.12—Display or Edit Extracted Data Screen 2
Define and Edit Employee Data 4
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Figure 9.13—Display or Edit Extracted Data Screen 3

Figure 9.14—Display or Edit Extracted Data Screen 4
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This task is optional, but provides a good view of the extracted employee 
records in addition to any needed editing. It can be used to manually A)dd 
records that don’t fit within the normal extraction process.

PRODUCE THE MTRS ELECTRONIC FILE
To edit the extracted data, use the Navigator Bar Item, Retirement Processing > Produce 
Retirement Electronic File.

Figure 9.15—Produce the MTRS Electronic File

You can also access Produce Retirement Electronic File via the toolbar.
Produce the MTRS Electronic File 6
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Figure 9.16—MTRS File Header Production

Table 9.4—MTRS File Header Production

Field Description

1) Report month Enter the 2 digit Report month.

2) Report year Enter  the 4 digit  Report year.
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Figure 9.17—MTRS File Production Change and End

Accept the screen with (0 to accept) and then either C)hange to change or  E)nd to 
produce the file and exit the program.

This program is pulling out of the ##py4 file that was previously extracted and/
or edited.  It creates the MTRS file in the Fundware\Data Directory that will be 
sent to the State.   The name will be MA1####, where #### is the tty number of 
the workstation where it was extracted. If being accessed through Print 
Manager, it will only be displayed if “Files of Type” All Files is selected.

It can also easily be viewed through Notepad.

RECAP OF PROGRAMS FOR THE MTRS FILE PRODUCTION
1.  DEFINE PARAMETER

2. EXTRACT MTRS DATA

3. MODIFY MTRS DATA
Recap of Programs for the MTRS File Production 8
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4. PRODUCE ELECTRONIC FILE

5. SEND FILE TO MTRA (FILE NAME MA1####)
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PAYROLL BEST PRACTICES

To help you Payroll system run at its optimum, your organization to follow the best 
practices described in this appendix.

DAILY
• Perform housekeeping procedures:

— Delete any TP*.* files in your data directory when everyone is out of 
FundWare.

• Print any error logs immediately. 
• Contact the FundWare Support department if you get an error message. Stop 

working if the error message includes “notify software support.”
• Backup all the FundWare files! Make sure that these backups are successful and 

that you can restore from them, if necessary.
— You should have a system-wide backup process in place. 
— Do not rely solely on the division backup process available in FundWare.

MONTHLY
• Reorg the PY*.* files for each division. (See the Blackbaud FundWare System 

Administration Guide for more information on the reorg task.)
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PAYROLL PROCESS
When you process payroll, FundWare uses files to store the timesheets and the net pay 
calculations until the checks are logged and the history files are updated. The following 
files (found in the Data folder) are used in the payroll process: 

• ##PYA—Store a pointer to the General Ledger–Project/Grant account number. 
## represents your division number.

• ##PYW—Store the timesheets before they are posted. ## represents your 
division number.

• ##PYX and PYY—Store the detail calculations before the checks are logged.  
## represents your division number.

After you post the timesheets (from the Timesheets folder), Payroll removes all records 
from the PYW and moves the detail into the PYX and PYY files. After you log your 
checks (part of the check writing wizard), Payroll moves the detail from the PYX and 
PYY files into the permanent history files (i.e., the PYK and PYL files). Sometimes the 
files become corrupted which result in errors during payroll processing.

BEFORE POSTING TIMESHEETS

• Make a backup of your system.
• Post timesheets.

BEFORE LOGGING CHECKS

• Make a backup of your system.
— Logging checks is the most vulnerable payroll process for errors to occur. 
— If you made a copy of your data files before logging, and an error does 

occur, you will have an easier recovery. 
• Log checks.

AFTER LOGGING CHECKS

• Delete the ##PYA, ##PYA.IDX, ##PYW, ##PYW.IDX, ##PYX, and 
##PYX.IDX, ##PYY files, and ##PYY.IDX (where ## represents your division 
number).

DO NOT DELETE these files if you have timesheets in process or you 
have checks to log for another bank. 
Payroll Process 
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To verify that the files are empty, you can run the following program at a DOS prompt 
in your data directory: rebuild ##pyw /i. This will return the number of records in the 
file, if it is 0, you can safely delete the files. Since the PYA contains pointers to the 
account numbers, it does not remove the records at the end of the process and will not be 
empty. If you are deleting all three files (PYW, PYX, and PYY), you can safely delete 
the PYA. The files will be recreated when the next payroll is processed. 
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SAMPLE REPORTS

Table B.1 provides a sample of each standard report from FundWare Payroll/Personnel, 
as well as each User-Defined Reports. Your reports will vary from the examples based 
on your selection criteria and page break definitions.

Table B.1—Report Titles and File Names

Title File Name

Master Record Lists

Employee Master List—Reports the details of the employee record, except 
direct deposit information. Produce the Employee Direct Deposit List for 
direct deposit employees.

PYLPYM

Historical Data Items List—Reports all fields of the selected historical data 
item(s). Print and file the details for every HDI; reprint and file whenever you 
change the HDI definition.

PYITEMH

Employee Data Items List—Reports all fields of the selected employee data 
item(s). Print and file the details for every EDI; reprint and file whenever you 
change the EDI definition.

PYITEME

Edit Values List—Reports edit value detail for applicable employee data 
items (i.e., EDIs with edit values). 

CIEDIT

Rates and Tables List—Reports all define rates and tables for the selected 
historical data items.

PYTABLE

Banks List—Reports banks in Use ID order. PYBANK

Employees’ Direct Deposit List—Reports details of direct deposit settings 
for employees.

PYLPYM (shown on 
screen as PYLPYME)

Setup List—Reports comments commands (COMNT) from field 8 of the 
historical data item definition.

PYSETUP

User-Defined Report Definitions List—Lists the definitions of user-defined 
reports.

PYLPYP
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History Reports

Employee History by Period PYEHSTP

One Line Check List PYCK1LN

Check History PYCKHST

Account Distribution PYDIST (if you chose the 
spreadsheet extract 
option, the file name is 
##PYXDST, where ## is 
the division number)

Account Distribution By Account PYDISTA

Distribution After Net Calculations—See Producing the Distribution After 
Net Calculations Report for setup instructions.

PYDISTC

User-Defined Reports

941 Information Report PY941

Employee Address List PYADDRS

Employee Contact List PYCNTCT

Employee Dates PYDATES

Quarterly Earnings Reports PYQEARN

Employee Status Report PYSTAT

Employee Telephone Directory PYTEL

Quarterly Unemployment Report PYUNEMP

Employee Record Update Report PYUPDAT

Table B.1—Report Titles and File Names (Continued)

Title File Name
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MASTER RECORD LISTS

Figure B.1—Employee Master List Parameters

Figure B.2—Employee Master List
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Figure B.3—Historical Data Item Lists Parameters
Master Record Lists 
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Figure B.4—Historical Data Items List

Figure B.5—Employee Data Items List Parameters
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Figure B.6—Employee Data Items List
Master Record Lists 
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Figure B.7—Edit Values List Parameters

Figure B.8—Edit Values List

Figure B.9—Rates and Tables List Parameters
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Figure B.10—Rates and Tables List
Master Record Lists 
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Figure B.11—Banks Lists Parameters

Figure B.12—Banks List

Figure B.13—Employees’ Direct Deposit List Parameters
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Figure B.14—Employees’ Direct Deposit List

Figure B.15—Setup List Parameters
Master Record Lists 
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Figure B.16—Setup List
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Figure B.17—User-Defined Report Definitions List Parameters

Figure B.18—User-Defined Report Definitions List
Master Record Lists 
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PREDEFINED REPORTS

Figure B.19—Employee History By Period Parameters

Figure B.20—Employee History By Period
Blackbaud, Inc. 2.237



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.238
Figure B.21—One Line Check List Parameters

Figure B.22—One Line Check List
Predefined Reports 
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Figure B.23—Check History Parameters

Figure B.24—Check History
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Figure B.25—Account Distribution Parameters
Predefined Reports 
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Figure B.26—Account Distribution
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Figure B.27—Account Distribution By Account Parameters
Predefined Reports 
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Figure B.28—Account Distribution By Account
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Figure B.29—Distribution After Net Calculations Parameters
Predefined Reports 
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Figure B.30—Labor Distribution After Net Calculations
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USER-DEFINED REPORTS

Figure B.31—941 Information Report Parameters
User-Defined Reports 
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Figure B.32—941 Information Report
Blackbaud, Inc. 2.247



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.248
Figure B.33—Employee Address List Parameters
User-Defined Reports 
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Figure B.34—Employee Address List
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Figure B.35—Employee Contact List Parameters
User-Defined Reports 
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Figure B.36—Employee Contact List
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Figure B.37—Employee Dates Parameters
User-Defined Reports 
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Figure B.38—Employee Dates
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Figure B.39—Quarterly Earnings Report Parameters
User-Defined Reports 
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Figure B.40—Quarterly Earnings Report
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Figure B.41—Employee Status Report Parameters

Figure B.42—Employee Status Report
User-Defined Reports 
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Figure B.43—Employee Telephone Directory Parameters

Figure B.44—Employee Telephone Directory
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Figure B.45—Quarterly Unemployment Report Parameters

Figure B.46—Quarterly Unemployment Report
User-Defined Reports 
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Figure B.47—Employee Record Update Report Parameters

Figure B.48—Employee Record Update Report
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 User-Defined Reports 



GLOSSARY

A
Account Mask—Allows you to group accounts using only one entry. A mask uses a 
variable (X) in place of an actual number. See also Masking.
Account Number—The number that stores transaction information in a financial 
reporting system.
Account Number Structure—Describes how accounts are categorized to represent 
funds, departments, subdepartments, GLAs, and so on. 
Additional Basis—A field on the employee record that contains taxes, deductions, and 
employee costs for employee earnings. Contents of this field are added to the Basis For 
field on the earning’s Historical Data Item definition for the total basis for the earning. 

B
Bank—See Financial Institution and Financial Institution Account.
Basis Amounts—The dollar amount that an earning, tax, deduction, or employer cost is 
based on. For example, an entry for the employer’s share of FICA for $76.50 has a 
“basis amount” of $1,000 in earnings. 
Basis For—A field in the historical data item record on the earning. Taxes, deductions, 
and other data items that the earning is subject to are listed here. The earning will 
“output” to System Registers 3 and 4 for each of the data items listed here. See Internal 
Registers on page 1.254 for more informatin.
Business Date—The date used to post an entry to a ledger. Also called the posting date.

C
Calculation Trace Reports—Line-by-line presentation of calculations and results. 
Separate from transaction trace reports. See also Trace Reports.
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Check Date—The date of the original check.
Check Number—The 7-digit external form number on the check, which is posted to 
history by the log checks task.
Cost Codes—A method of accounting for earnings that is used when wage expenses 
need to be coded to a specific project or job. You might want to use Cost Codes for:

• Employees who work in multiple departments (Cost Codes) but make the same 
rate of pay regardless of where they work.

• Employees whose rate of pay varies with the job they work and all employees 
who work that job are paid that rate.

• Employees who work in different departments and have different rates of pay.
Cycles—Up to 9 calculation cycles are allowed to determine when deductions occur for 
a payroll run (i.e., checks and direct deposit).

D
Data Item—See Employee Data Items and Historical Data Items.
Department—The dimensions or combination of dimensions that defines who an 
employee’s wage expense belongs to. For example, Admin, Sales, etc.
Departmentalized Earnings—Earnings for one employee that are expensed to multiple 
departments. The earnings can be Salary, Hourly, or Other and must be given a 
percentage, with the percentages for each type adding up to 100%. This is determined by 
entry in the setup parameters.
Dimension—A group of numbers within the account number. 
Direct Deposit—A feature that produces an NACHA file and stubs rather than physical 
checks. The file is given or transferred to a bank. Direct Deposit was called Electronic 
Funds Transfer (EFT) in the Classic Edition Payroll/Personnel.
Distribution Tables—A method of accounting for earnings that is used when wage 
expenses can be consistently distributed to the same accounts using the same 
percentages. Distribution Tables work best for salaried employees whose wage expense 
accounts are the same every period or hourly employees whose wage expense accounts 
are the same regardless of the number of hours worked. Distribution Tables do not work 
well for employees whose wage expense accounts change from pay period to pay 
period. The account mask from the table is added to by the account number determined 
for the earning. If the table contains no Xs, it is used exactly like it is, without additional 
account numbers from the earning item.
 



Glossary
E
Earnings Item—An historical data item defined as, E—Earnings, T—Taxes, 
D—Deductions, or O—Other (employer costs and benefits). These HDIs are what you 
use to define earnings amounts on employee timesheets.
EDI—See Employee Data Item (EDI).
Edit Value—A value attached to an Employee Data Item to restrict values placed on 
employee records. Up to 10 types of Edit Values can be placed on an Employee Data 
Item.
EFT—See Direct Deposit.
Employee Data Item (EDI)—A field that stores information on the employee record. 
There are 2 kinds of Data Items: System-defined and User-defined. System-defined 
Data Items are the fields on the employee record (e.g., name, phone number, date of 
hire, salary amount). User-defined Data Items are for additional fields that you wish to 
attach to the employee record or to use for sorting or selecting information for reports. 
Employee Record—A record containing employee name, address, phone numbers, 
dates and earnings information. There is one Employee Record for each employee. 
Employee Selector—A feature that allows you to restrict (i.e., filter) the range of 
employees or records to include in a task or on a report. Using the Employee Selector 
may be helpful if you cut checks at different times based on an Employee Data Item like 
Department.

F
Financial Institution—Any entity that has custody of, and/or manages, cash or cash-
equivalent accounts (e.g., banks, savings and loans). A financial institution can have 
more than one account.
Financial Institution Account—A unique and specific account within a financial 
institution. An account will have a separate statement from the financial institution 
recording activity for the period. An account must be within a single financial institution 
(e.g., checking account, savings account). Accounts are “mapped” to each module.
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G
GLA—Literally “General Ledger accounts.” In everyday usage, they often represent the 
“natural” account or object code of an account number and define what the employee 
does or the cost category to which they belong. However, when we refer to GLAs in the 
program, we are referring to an additional piece of your Payroll setup (.H GLA, .S GLA, 
or .O GLA) and a setting on the employee record. You can use the department and GLA 
to refine how Payroll builds your account numbers.

H
HDI—See Historical Data Item (HDI).
Historical Data Item (HDI)—Any taxes, deductions, benefits, or earnings types that 
determine or affect an employee’s check. There are 4 types of Historical Data Items: 
earnings, taxes, deductions and other. Each Historical Data Item that affects your payroll 
must be brought in from the ToolBox or created by you manually. Examples are comp. 
hours accrued, vacation hours accrued, total all FICA deferred deductions, etc.

I
Inquiry—Allows you to view information like employee records, checks, employee 
history, tax rates and tables, or direct deposit information. 

L
Log Checks—Enters the pre-printed check number into Payroll/Personnel. When you 
log check numbers, the system matches the check number to the system number in the 
employee check history record. This task also posts to the payroll history files and to 
General Ledger and Accounts Payable, when so defined in the setup parameter.

M
Marked for Reconciliation—Checks that are in the process of being reconciled.
 



Glossary
Masking—A “wild card” code used to represent a group of accounts for reports, 
maintenance, or for account duplication. Use a mask to represent a group of accounts 
using only one entry. A mask uses an X in the place of an actual number in the account 
number.

N
Negative Checks—A paycheck amount may appear as a negative number if low 
earnings cause the deductions to be higher than the wage, a one-time deduction is higher 
than the wage, incorrect data items appear on the employee record, or an incorrect 
calculation formula was entered. You should correct a negative amount before you 
produce and print checks.
Non-Departmentalized Earnings (Other Earnings)—“Other” can be 
departmentalized, and is determined during parameter setup. Hourly, Salary and Other 
are defined on the employee record to allow for only one department and wage account. 
You may have none or as many as three non-departmentalized earnings.

O
One-Time Deductions—Deductions that are not normally part of an employee’s 
paycheck. For example, use One-time Deductions to pay back an advance, or adjust the 
amount of a tax or deduction. 
Outstanding—Checks that have been issued but have not been cleared by the bank.

P
Parameter—Determines system configuration, check format, ledger posting, and 
journals used.
Pay Frequency—Determined by the number of checks issued in a calendar year. Pay 
Frequency is controlled by the .T FREQ edit values. Do not change these edit values 
since they are used in computing taxes.
Preliminary Check Register—A Preliminary Check Register shows the result of the 
net pay calculation and a preview of the actual check register. 
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Pre-Notification—An information record sent to the employee’s bank to verify routing 
transit numbers and account numbers for a Direct Deposit. You should define pre-
notification one payroll cycle prior to the payroll cycle that the Direct Deposit will be 
activated or changed for an employee. 

R
Rates and Tables—Are attached to Historical Data Items and contain rates, 
percentages, or amounts. They are used to calculate Historical Data Items. 
Reconciled Checks—Checks that have been posted as processed by your bank.

S
Shortcut Menu—Menu displayed when you click the right mouse button (i.e., right-
click).
Standard Reports—Reports that come with the software. The original reports should 
not be customized, but you may wish to make a copy of a standard report and edit it.
System Numbers—A number on each check and Direct Deposit that is automatically 
assigned by the Payroll/Personnel software. The number is printed on both the stub and 
the actual check. The System Number consists of two parts: the internal number and the 
form sequence number. For Direct Deposit employees, only the internal number prints 
on the Direct Deposit form. A sample System Number might look like this: 1609-0001

T
Time Cards—See Timesheets.
Timesheet Entries—Each entry of an “earnings item.” Earning items may be a number 
of different things (e.g., flat dollar amount such as salary, or a dollar amount based on 
hours or units such as sick time). Each timesheet entry is added to a single timesheet for 
the employee.
 



Glossary
Timesheets—A computerized record of earnings for an employee. Each employee has 
one timesheet, which can have multiple “timesheet entries” to accommodate the 
different types of earnings (e.g., one timesheet can have entries for salary, bonus, and 
vacation time for a single employee). In earlier versions of Payroll/Personnel, these 
were called Time cards.
ToolBox—A set of predefined earnings, taxes, deductions, and employer costs 
(historical and employee data items) that you can copy into your system during setup or 
to update your system periodically. Use of ToolBox items can greatly reduce the amount 
of time required to setup a new payroll. American Fundware, Inc. updates the ToolBox 
data items at the beginning of each year. (As necessary, we also may update ToolBox 
throughout the year.)
Trace Reports—An “audit trail” of all entries made into the Payroll/Personnel module. 
If you use a FundWare financial reporting system such as General Ledger, each time a 
transaction is posted through a journal, a trace report is automatically created and saved 
to a file. See also Calculation Trace Reports.

U
User-Defined Reports—Reports you define. User-defined reports can contain both 
historical and employee data items in a columnar format. Several reports are already 
defined for you in the Payroll/Personnel module. 

V
Voided Check—Checks that have been declared invalid after being written or 
produced. When a payroll check is voided, all journal entries and account payable 
obligations associated with the check are reversed.
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Symbols
.DED  . . . . . . . . . . . . . . . . . . . . . . . 1.78
.EARN . . . . . . . . . . . . . . . . . . . . . . 1.78
.H GLA  . . . . . . . . . . . . . . . . . . . 1.3, 2.3
.O GLA  . . . . . . . . . . . . . . . . . . . 1.3, 2.3
.OTHER . . . . . . . . . . . . . . . . . . . . . 1.78
.S GLA . . . . . . . . . . . . . . . . . . . . 1.3, 2.3
.SWT  . . . . . . . . . . . . . . . . . . . . . . 1.104
.TAX  . . . . . . . . . . . . . . . . . . . . . . . 1.78

A
Access

From keyboard  . . . . . . . . 1.22, 2.22
Shortcut menus  . . . . . . . . 1.22, 2.22

Account
Liability . . . . . . . . . . . . . . . . . . 1.34

Account mask  . . . . . . . . . . . . . . . 2.140
Definition  . . . . . . . . . . 1.299, 2.261

Account number
Definition  . . . . . . . . . . 1.299, 2.261

Account number structure
Definition  . . . . . . . . . . 1.299, 2.261

Accounting information . . . . . . . . 2.140
Accounting Information tab

Tips . . . . . . . . . . . . . . . . . . . . . 2.40
Accounting methods

Cost codes . . . . . . . . . . . . . . 1.6, 2.6
Accounts

Resolution . . . . . . . . . . . . . . . 1.261
Accrued account  . . . . . . . . . . . . . . 1.41
Accrued payroll . . . . . . . . . . . . . . . 1.34
Acronyms

Menu  . . . . . . . . . . . . . . . .1.23, 2.23
Active year . . . . . . . . . . . . . .1.43, 1.236
Activity reminder . . . . . . . . . .1.11, 2.11
Adding

Columns to detail pane  . .1.26, 2.26
Departmentalized earnings to the 

employee record . . .1.3, 2.3
Employees . . . . . . . . . . . . . . . . 2.31
Group timesheets . . . . . . .2.65, 2.66
Manual checks . . . . . . . .2.97, 2.107
One-time deductions . . . . . . . . 2.83
Single timesheet  . . . . . . . . . . . 2.69
User-defined reports  . . . . . . . 2.144

Additional basis
Definition  . . . . . . . . . .1.299, 2.261

Additional basis for  . . . . . . . .2.39, 2.40
Adjusting

Payroll parameter  . . . . . . . . . 2.152
ALT key . . . . . . . . . . . . . . . . .1.22, 2.22
Amount format . . . . . . . . . . . . . . . . 1.38
Amount/percent . . . . . . . . . .1.208, 2.42
Amt/Hrs/Units  . . . . . . . . . . . . . . . . 2.71
ASCII . . . . . . . . . . . . . . . . . . . . . . 2.172
Asterisks . . . . . . . . . . . . . . . . .1.15, 2.15
Auto employee . . . . . . . . . . . . . . . . 1.38

B
Balances

Roll forward  . . . . . . . . . . . . . 1.236
Rolling . . . . . . . . . . . . . . . . . . 1.236

Bank
Definition  . . . . . . . . . .1.299, 2.261
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Bank account # . . . . . . . . . . .1.208, 2.42
Bank DFI # . . . . . . . . . . . . . .1.208, 2.42
Bank reconciliation  . . . . . . . . . . . 2.123

Display checks . . . . . . . . . . . . 2.134
Enter reconciliation . . . . . . . . 2.123
Logging unused checks . . . . . 2.112
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Banks
Reports . . . . . . . . . . . . . . . . . . 2.140

Basis . . . . . . . . . . . . . . . . . . . . . . . . 1.96
Basis amounts

Definition . . . . . . . . . . .1.299, 2.261
Basis for

Definition . . . . . . . . . . .1.299, 2.261
Benefits  . . . . . . . . . . . . . . . . . . . . . 1.81
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Bold  . . . . . . . . . . . . . . . . . . . .1.29, 2.29
BRCHKRP . . . . . . . . . . . . . . . . . . 2.131
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BRPROOF . . . . . . . . . . . . .2.129, 2.134
BRPURGE . . . . . . . . . . . . . . . . . . 2.131
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Defaults  . . . . . . . . . . . . . .1.14, 2.14
Definition . . . . . . . . . . .1.299, 2.261
Opening multiple . . . . . . .1.18, 2.18

Business Office  . . . . . . . . . . .1.29, 2.29

C
Calculation Trace report . . . . . . . . . 2.89
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Definition . . . . . . . . . . .1.299, 2.261
Calculations  . . . . . . . . . . . . . . . . . 1.248
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